Peak™

Version 5.2

Software User’s Guide
INSTALL LICENSE AGREEMENT

This legal document is an agreement between you, the end user ("YOU" or "LICENSEE"), and Berkley Integrated Audio Software, Inc. ("BIAS, Inc."). By CLICKING "INSTALL" ON THE FOLLOWING DIALOG, YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES THE SOFTWARE LICENSE AND THE SOFTWARE DISCLAIMER OF WARRANTY (collectively the "Agreement"). CLICK "QUIT" ON THE FOLLOWING DIALOG IF YOU DO NOT ACCEPT THE TERMS OF THIS AGREEMENT. THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND BIAS, INC. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE OR REGISTER THE SOFTWARE AND PROMPTLY RETURN THE SOFTWARE AND THE OTHER MATERIALS (INCLUDING WRITTEN MATERIALS, BINDER(S) OR OTHER CONTAINERS) THAT ARE PART OF THIS PRODUCT TO THE PLACE WHERE YOU OBTAINED THEM FOR A FULL REFUND. YOUR USE OF THIS SOFTWARE SHALL CONSTITUTE ACCEPTANCE OF THIS AGREEMENT; AND ONCE YOU HAVE REGISTERED THE SOFTWARE YOU MAY NOT RETURN IT.

1. BIAS SOFTWARE LICENSE

BIAS offers two distinct license options – SINGLE USER and MULTI-USER SINGLE SITE. If you have purchased a single user license, the license terms in section 1a apply to you. If you have purchased a multi-user single site license (e.g. 5 user lab pack), the license terms in section 1b apply to you.

1a. GRANT OF LICENSE (SINGLE USER). In consideration of payment of the single user license fee, which is part of the price you paid for this product, BIAS, as Licensor, grants to you, LICENSEE, a nonexclusive license to use and display this copy of the BIAS software program (the "SOFTWARE") and accompanying user documentation ("DOCUMENTATION"). LICENSEE may install and authorize the SOFTWARE on one COMPUTER, provided that (a) the COMPUTER is owned by (or leased to) and under exclusive control of the Licensee, (b) the SOFTWARE shall NOT be used simultaneously on more than one COMPUTER at a time, and (c) any COMPUTER(S) with BIAS Software installed shall not be sold, rented, leased, loaned or otherwise be removed from the LICENSEE's possession without first removing and deauthorizing the Software, except as provided in Paragraph 6 (below) pertaining to "TRANSFER RESTRICTIONS." BIAS reserves all rights not expressly granted to LICENSEE.

1b. GRANT OF LICENSE (MULTI-USER SINGLE SITE LICENSE). In consideration of payment of the multi-user single site license fee, which is part of the price you paid for this product, BIAS, as Licensor, grants to you, LICENSEE, a nonexclusive license to use and display this copy of the Software and Documentation. LICENSEE may install and authorize the SOFTWARE on a number of COMPUTERS equal to or less than the number of licenses purchased (e.g. a 5 User Lab Pack allows up to 5 BIAS SOFTWARE licenses at a single SITE to be simultaneously installed, authorized, and used on up to 5 COMPUTERS at said SITE), provided that (a) each COMPUTER is owned by (or leased to) and under exclusive control of the LICENSEE, (b) the SOFTWARE shall NOT be used simultaneously on more COMPUTERS at a time than the number of licenses purchased as part of the multi-user single site license, and (c) any COMPUTER(S) with BIAS Software installed shall not be sold, rented, leased, loaned or otherwise be removed from the LICENSEE's possession without first removing and deauthorizing the Software, except as provided in Paragraph 6 (below) pertaining to "TRANSFER RESTRICTIONS." BIAS reserves all rights not expressly granted to LICENSEE.

2. SOFTWARE AUTHORIZATION. You must register and AUTHORIZE this SOFTWARE either online (via the included BIAS Authorization Manager software) or by phone (1-800-775-2427 41-707-782-1866). Once the SOFTWARE is registered and AUTHORIZED, it may not be returned.

3. OWNERSHIP OF SOFTWARE AND DOCUMENTATION. As LICENSEE, you own the media on which the SOFTWARE and DOCUMENTATION are originally or subsequently recorded or fixed, but BIAS retains title and ownership of the SOFTWARE and DOCUMENTATION and all subsequent copies of the SOFTWARE and DOCUMENTATION, regardless of the form or media on which the original and other copies may exist. This License is not a sale of the original SOFTWARE or any copy or sale of the original DOCUMENTATION.

4. COPY RESTRICTIONS. This SOFTWARE and the DOCUMENTATION are copyrighted. Unauthorized copying of the SOFTWARE, including SOFTWARE that has been modified, merged, or included with other software, or of the DOCUMENTATION is expressly forbidden. You may be held legally responsible for any copyright infringement that is caused or encouraged by your failure to abide by the terms of this License. Subject to these restrictions, and if the SOFTWARE is not copy-protected, you may make one (1) copy of the SOFTWARE solely for backup purposes. You must reproduce and include the copyright notice on the backup copy.

5. USE RESTRICTIONS. As the LICENSEE, you may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used on only one computer at a time if you have purchased a single user license or, if you have purchased a multi-user single site license, on up to the number of computers for which you have purchased a license at one time. You may not electronically transfer the SOFTWARE from one computer to another over a network. You may not distribute copies of the SOFTWARE or the DOCUMENTATION to others. You may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the SOFTWARE. You may not modify, adapt, translate, or create derivative works based on the DOCUMENTATION without the prior written consent of BIAS.

6. TRANSFER RESTRICTIONS. This SOFTWARE is licensed only to you, LICENSEE, and may not be assigned or otherwise transferred to anyone, whether voluntary or by operation of law, without the prior written consent of BIAS. Any authorized transferee of the SOFTWARE must agree to be bound by the terms and conditions of this Agreement, or the transfer shall be invalid. In no event may you transfer, assign, rent, lease, sell, or otherwise dispose of the SOFTWARE on a temporary or permanent basis except as expressly provided herein.

7. LICENSE TO U.S. GOVERNMENT. If LICENSEE is an agency or instrumentality of the United States Government, the SOFTWARE and DOCUMENTATION are "commercial computer software" and "commercial computer software documentation", and pursuant to FAR 12.212 or DFARS 227.7202, and their successors, as applicable, use, reproduction and disclosure of the Software and Documentation are governed by the terms of this Agreement.

8. TERMINATION. This License is effective until terminated. This License will terminate automatically without notice from BIAS if you fail to comply with any provision of this License. Upon termination you shall destroy the DOCUMENTATION and all copies of the SOFTWARE, including modified copies, if any.

9. UPDATE POLICY. BIAS may create, from time to time, updated versions of the SOFTWARE. At its option, BIAS will make such updates available to LICENSEE and transferees who have paid the update fee and returned the registration card to BIAS.

10. BIAS PRODUCT SUPPORT.

Unlimited Complimentary Self Help Options

If you have questions about installing or using your BIAS products, please check the manual or user guide first, and you will find answers to most of your questions there. If you need further assistance, please check the
support section of the BIAS web site, which contains answers to frequently asked questions, troubleshooting tips, and more:

http://www.bias-inc.com/support/faq/

Limited Complimentary Technical Assistance

Ninety days of complimentary technical support assistance for up to three incidents is available with the initial purchase of Type 1 BIAS products (Peak Pro, Peak Pro XT, Master Perfection Suite, SoundSoap Pro, Deck). Ninety days of complimentary technical support assistance for a single incident is available with the initial purchase of Type 2 BIAS products (Peak LE, Deck LE, SoundSoap 2). The support period begins when the product is initially registered and authorized. Type 3 products (OEM versions) are excluded.

An additional thirty days of complimentary technical support assistance for a single incident, beginning on the expiration of the initial ninety days of complimentary support described above, is available with the purchase of paid upgrades to Type 1 and Type 2 BIAS products.

To receive e-mail or telephone technical support, you will need a valid serial number and must be registered for a current BIAS product. Please keep your original product serial number (located on your original owner’s certificate) in a safe place as it will be required for support.

Customers who prefer support by email, please contact:
support@bias-inc.com

Customers who prefer support by telephone, (connect and toll charges apply), please have your computer running and close by the phone and call us at:
+1-707-762-2145
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)

Fee-based Technical Support Options

Fee-based Support is available for those customers whose support period has expired or for Type 3 (OEM versions) customers. Please call:
+1-707-762-1865
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)

For customers living outside of North America, please contact your local BIAS distributor, or contact BIAS directly. A list of BIAS distributors may be found at:
http://www.bias-inc.com/distributors.html

BIAS Support Policy and Hours

BIAS, Inc. support policy and hours are subject to change without notice.

Sales and Non-Technical Customer Service

For product information, sales, and other non-technical customer service, please email or call:
sales@bias-inc.com
US: 1-800-775-BIAS (2427)
International: +1-707-762-1866
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)

No technical support is available at the numbers or email address above.

11. MISCELLANEOUS. This Agreement is governed by the law of the State of California, without regard to conflicts of law principles.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION (INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTIES OF ANY KIND. FURTHER, BIAS DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND NOT BIAS OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES. YOU AGREE TO ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

BIAS warrants to the original LICENSEE that the media upon which the SOFTWARE is recorded and the BIAS Key (USB dongle), if applicable, are free from defects in materials and workmanship under normal use and service for a period of ninety (90) days from the date of delivery as evidenced by a copy of your receipt. Further, BIAS hereby limits the duration of any implied warranty(ies) on the media to the respective periods stated above. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. BIAS’ entire liability and your exclusive remedy as to the media shall be, at BIAS’ option, either (a) return of the purchase price or (b) replacement of the media that does not meet BIAS’ Limited Warranty and which is returned to BIAS with a copy of the receipt. If failure of the media has resulted from accident, abuse, or misapplication, BIAS shall have no responsibility to replace the media or refund the purchase price. Any replacement media will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

The above are the only WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT ARE MADE BY BIAS CONCERNING THE BIAS PRODUCT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY BIAS, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT REly ON ANY SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE), BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

This Disclaimer of Warranty and Limited Warranty is governed by the laws of the State of California, without regard to conflicts of law principles.

Should you have any questions concerning this Agreement, or if you desire to contact BIAS for any reason, please contact in writing:

BIAS Customer Sales and Service
140 Keller Street
Petaluma, CA 94952
USA

Copyright 1996–2006 BIAS, Inc.
BIAS Product Support:

Unlimited Complimentary Self Help Options

If you have questions about installing or using your BIAS products, please check the manual or user guide first, you will find answers to most of your questions there. If you need further assistance, please check:

http://www.bias-inc.com/support.html

for frequently asked questions, an extensive database of related articles, troubleshooting tips, and more.

Limited Complimentary Technical Assistance

Ninety days of technical support assistance for up to three incidents is available with the initial purchase of Type 1 BIAS products (Peak Pro, Peak Pro XT, Master Perfection Suite, Deck, SoundSoap Pro). Ninety days of technical support assistance for a single incident is available with the initial purchase of Type 2 BIAS products (Peak LE, Deck LE, SuperFreq, SoundSoap 2). Type 3 products (OEM versions) are excluded. Thirty days of technical support assistance for a single incident is available with the purchase of paid upgrades to Type 1 and Type 2 BIAS products. The support period begins when the product authorization code (PAC) is initially issued following the product registration. To receive e-mail or telephone technical support, you will need a valid serial number and must be registered for a current BIAS product. Please keep your original product serial number and PAC in a safe place as it will be required for support. For customers preferring e-mail assistance, please use the email form available on our web site at:

http://www.bias-inc.com/support.html

Or, email:

support@bias-inc.com

For customers preferring telephone assistance, (connect and toll charges apply), please have your computer running and close by the phone and call us at:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

Fee-based Technical Support Options

Fee-based Support is available for those customers whose support period has expired or for Type 3 (OEM version) customers. Please call:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

For customers living outside of North America, please contact your local BIAS distributor, or contact BIAS directly. A list of BIAS distributors may be found at:

http://www.bias-inc.com/distributors.html

BIAS Support Policy and Hours

BIAS, Inc. support policy and hours are subject to change without notice.
Sales and Non-Technical Customer Service

For product information, sales, and other non-technical customer service, please email or call:
sales@bias-inc.com

US: 1-800-775-BIAS (2427)
International: +1-707-782-1866

9AM-5PM Monday-Friday PST – excluding BIAS holidays

No technical support is available at the numbers or email address above.
# Table of Contents

## Chapter 1 - Introducing Peak

- Welcome! .............................................................................................................................................................................. 19
- Who is Peak Designed For? .................................................................................................................................................. 20
- What’s New in Peak 5.0/5.2? ...................................................................................................................................................... 20
- Minimum System Requirements .................................................................................................................................................. 21
- Maximizing Peak’s Performance ............................................................................................................................................ 21
- About Your User’s Guide ......................................................................................................................................................... 21
- Getting Help with Peak ............................................................................................................................................................ 23
- Conclusion .................................................................................................................................................................................. 25

## Chapter 2 - Installing, Registering, & Activating Peak

- Installing Peak ......................................................................................................................................................................... 27
- Registration & Authorization ..................................................................................................................................................... 28
- Deauthorizing a Computer ....................................................................................................................................................... 30
- Conclusion .................................................................................................................................................................................. 30

## Chapter 3 - Peak Basics

- Introduction .................................................................................................................................................................................. 33
- A Brief Explanation of Digital Audio ......................................................................................................................................... 33
- Sampling & Sample Rate ............................................................................................................................................................. 33
- Bit Resolution ................................................................................................................................................................................ 33
- About Disk-Based Recording & Editing .................................................................................................................................. 34
- Nonlinear Versus Linear Recording ........................................................................................................................................... 34
- Nondestructive Editing ............................................................................................................................................................... 34
- Hard Disk Storage Requirements ................................................................................................................................................. 34
- Hard Disk Maintenance ............................................................................................................................................................... 34
- Creating a New Peak Document ................................................................................................................................................... 35
- Opening Existing Audio Documents ............................................................................................................................................ 35
  - Opening WAVE Files ............................................................................................................................................................... 35
  - Opening Compressed Audio Documents ................................................................................................................................... 35
  - Recently Opened Documents .................................................................................................................................................. 36
- Opening Dual Mono Files ............................................................................................................................................................ 36
- Dragging & Dropping Folders, Disks, & CD Audio Tracks ......................................................................................................... 37
- Recovering Damaged Audio Files ............................................................................................................................................... 37
- Saving & Closing Documents ........................................................................................................................................................ 38
  - Using the Save As & Save A Copy As Commands .......................................................................................................................... 39
  - Using POW-r™ Dithering ............................................................................................................................................................ 39
  - Saving Compressed Audio Documents ...................................................................................................................................... 39
- Closing Audio Documents .......................................................................................................................................................... 40
- Peak Windows & Palettes ............................................................................................................................................................ 40
- Peak Audio Document Window ................................................................................................................................................... 40
- Transport Window ........................................................................................................................................................................ 43
Contents Window..................................................................................................................................................................................45
Setting Preferences..................................................................................................................................................................................44
Setting Peak’s Playback Parameters...................................................................................................................................................44
Dynamic Scrub Time..................................................................................................................................................................................44
Scroll During Playback.............................................................................................................................................................................45
Move Waveform During Playback......................................................................................................................................................45
Show Marker Times..................................................................................................................................................................................46
Auditioning...............................................................................................................................................................................................46
Blending.................................................................................................................................................................................................46
Auto-Import Dual Mono..............................................................................................................................................................................47
Choosing Colors for the Audio Document Window..........................................................................................................................47
Choosing a Time Format.........................................................................................................................................................................47
Audio File Meter, Tempo & Timestamp Settings................................................................................................................................48
Choosing A Scratch Disk..........................................................................................................................................................................48
Keyboard Shortcuts....................................................................................................................................................................................49
The Toolbar.............................................................................................................................................................................................50
Quitting Peak..........................................................................................................................................................................................51
Conclusion...............................................................................................................................................................................................51

Chapter 4 - Playback & Recording

Introduction............................................................................................................................................................................................55
Core Audio..............................................................................................................................................................................................55
Configuring Peak for Playback.........................................................................................................................................................56
Playback Options....................................................................................................................................................................................57
Core Audio Settings Dialog................................................................................................................................................................58
Configuring Peak for Virtual Instrument Playback..........................................................................................................................59
Playing Audio with Peak.......................................................................................................................................................................60
The Transport Controls..........................................................................................................................................................................60
Triggering Playback of Multiple Audio Documents.......................................................................................................................60
Playing Virtual Instruments....................................................................................................................................................................61
Configuring Peak for Recording.........................................................................................................................................................61
Recording Options..................................................................................................................................................................................62
Record Settings.......................................................................................................................................................................................62
Multi-Document Recordings (Long Recordings).....................................................................................................................................64
Recording Audio.....................................................................................................................................................................................64
The Record Dialog................................................................................................................................................................................65
Configuring Peak to Record Through Effects Plug-Ins.........................................................................................................................65
Recording.............................................................................................................................................................................................66
Recording into a QuickTime Movie......................................................................................................................................................67
Importing a Track from an Audio CD..................................................................................................................................................67
Making Audio Connections..................................................................................................................................................................68
Using the Macintosh’s Built-In Inputs & Outputs................................................................................................................................68
Third-Party Audio Interfaces................................................................................................................................................................70
Conclusion...............................................................................................................................................................................................71

Chapter 5 - Editing

Introduction............................................................................................................................................................................................75
Editing Audio with Peak.........................................................................................................................................................................75
Interactive Editing..................................................................................................................................................................................75
Table of Contents

Nondestructive Editing........................................................................................................................................................................75
Unlimited Undo & Redo.............................................................................................................................................................................75
The Audio Document Window.................................................................................................................................................................76
  An Audio Waveform...........................................................................................................................................................................76
  A Selection..........................................................................................................................................................................................76
  A Marker..........................................................................................................................................................................................78
  A Loop..................................................................................................................................................................................................78
Audio Between Adjacent Markers.............................................................................................................................................................78
Audio Info Area.....................................................................................................................................................................................78
Audio Info Dialog.................................................................................................................................................................................79
Selecting Audio.....................................................................................................................................................................................79
  Markers & Selections as Navigational Aids............................................................................................................................................80
Auditioning Audio..................................................................................................................................................................................80
Scrubbing........................................................................................................................................................................................................80
  Dynamic Scrubbing...........................................................................................................................................................................80
  Jog Scrubbing..................................................................................................................................................................................81
  Tape-Style Scrubbing......................................................................................................................................................................82
Using Unlimited Undo & Redo...............................................................................................................................................................82
Essential Editing Functions.................................................................................................................................................................84
  Scratch Disks..................................................................................................................................................................................84
  Clearing the Clipboard to Reclaim Disk Space........................................................................................................................................84
  Cutting Audio..................................................................................................................................................................................85
  Deleting Audio..............................................................................................................................................................................85
  Copying Audio................................................................................................................................................................................85
  Pasting Audio................................................................................................................................................................................85
  Replacing Audio..............................................................................................................................................................................86
  Inserting Audio..............................................................................................................................................................................86
  Duplicating Audio..........................................................................................................................................................................86
  Cropping a Selection......................................................................................................................................................................87
  New Document from Selection...........................................................................................................................................................87
  Silencing a Selection.......................................................................................................................................................................87
  Inserting Silence into a Document...................................................................................................................................................88
  Repairing Clicks & Pops....................................................................................................................................................................88
Show Edits...........................................................................................................................................................................................90
Using Crossfades & Blending to Smooth Edits......................................................................................................................................90
Creating Fade Ins & Fade Outs.................................................................................................................................................................92
  Editing a Fade In/Fade Out Envelope..................................................................................................................................................92
  Creating & Using Markers..............................................................................................................................................................94
  Creating Markers..............................................................................................................................................................................94
  Delete Markers.................................................................................................................................................................................96
Regions.......................................................................................................................................................................................................98
Creating Loops....................................................................................................................................................................................99
  Turn Loop Flag On/Off on Save.......................................................................................................................................................101
Crossfading Loops................................................................................................................................................................................101
  The Crossfade Loop Dialog...........................................................................................................................................................101
  Crossfade Variations...................................................................................................................................................................101
Using Loop Surfer................................................................................................................................................................................103
  Making Loops into Regions............................................................................................................................................................105
Using the Guess Tempo & Threshold Commands to Find Tempo..................................................................................................106
Using Loop Tuner....................................................................................................................................................................................106
Exporting Regions................................................................................................................................................................................107
Editing QuickTime Soundtracks in Peak...............................................................................................................................................109
Conclusion......................................................................................................................................................................................................109
Chapter 6 - Playlists & CD Burning

Introduction ............................................................................................................................................................................................... 113
Basic Playlist Concepts ........................................................................................................................................................................... 116
Creating a Playlist .................................................................................................................................................................................. 116
Adding Regions to a Playlist ............................................................................................................................................................... 116
About the Move Event & Trim Event Cursor Modes .......................................................................................................................... 117
Deleting Playlist Events ......................................................................................................................................................................... 117
Using Undo & Redo .................................................................................................................................................................................. 118
Creating Transitions between Playlist Events .................................................................................................................................... 118
Auditioning Transitions ........................................................................................................................................................................... 118
Burning an Audio CD ............................................................................................................................................................................. 119
Saving a Playlist ..................................................................................................................................................................................... 119
Detailed Overview of Controls, Modes & Tools .................................................................................................................................. 119
Miscellaneous Controls............................................................................................................................................................................. 120
Saving, Closing & Opening Playlists .................................................................................................................................................... 120
Adding Regions to a Playlist ............................................................................................................................................................... 120
Undoing & Redoing .................................................................................................................................................................................. 123
Indexes .................................................................................................................................................................................................. 123
Control Area ............................................................................................................................................................................................ 123
Playlist Function Buttons ...................................................................................................................................................................... 123
Transport Controls .................................................................................................................................................................................. 127
Crossfade Audition Controls ............................................................................................................................................................... 127
Slip & Shuffle Mode Controls ............................................................................................................................................................. 128
Nudge Controls ..................................................................................................................................................................................... 131
Mode Checkboxes & Behaviors ........................................................................................................................................................ 137
Adding Disc-Specific CD-TEXT Metadata ........................................................................................................................................ 139
Waveform View Area............................................................................................................................................................................. 140
View Controls .......................................................................................................................................................................................... 140
Waveform Display Area ......................................................................................................................................................................... 142
Cursor Modes & Tools ............................................................................................................................................................................ 145
High-Precision Editing Mode .................................................................................................................................................................. 147
Selecting Playlist Events ....................................................................................................................................................................... 147
Deleting Playlist Events ........................................................................................................................................................................... 148
Creating Transitions between Playlist Events ................................................................................................................................ 148
Setting Track Start Offsets .................................................................................................................................................................... 152
List View Area ...................................................................................................................................................................................... 153
List View Columns, Controls, & Data Fields ...................................................................................................................................... 155
Changing the Order of Columns ............................................................................................................................................................ 159
Selecting Playlist Events ....................................................................................................................................................................... 159
Deleting Playlist Events ........................................................................................................................................................................... 159
Changing the Names of Playlist Events ............................................................................................................................................... 160
Changing the Order of Playlist Events ................................................................................................................................................ 160
Creating Transitions between Playlist Events .................................................................................................................................. 161
Editing Crossfades ................................................................................................................................................................................ 162
Setting Track Start Offsets .................................................................................................................................................................... 164
Adding Metadata to Discs & Tracks ...................................................................................................................................................... 165
Applying Effects Plug-Ins to Playlist Events ................................................................................................................................... 167
Output Options ...................................................................................................................................................................................... 170
Burning Audio CDs ............................................................................................................................................................................... 170
CD Burning Options ............................................................................................................................................................................. 170
Chapter 7 - DSP

Introduction..................................................................................................................... 177
Processing Audio with Peak's DSP Tools................................................................. 177
Peak's Audio Processing Tools..................................................................................... 177
Add.................................................................................................................................. 178
Amplitude Fit.................................................................................................................... 178
Auto-Define Tracks...................................................................................................... 179
Bit Usage......................................................................................................................... 182
Change Duration............................................................................................................ 182
Change Gain................................................................................................................... 182
Change Pitch.................................................................................................................. 184
Convert Sample Rate.................................................................................................... 185
Convolve......................................................................................................................... 186
Crossfade Loop............................................................................................................... 186
Envelope from Audio..................................................................................................... 188
Fade In & Fade Out........................................................................................................ 189
Find Peak....................................................................................................................... 189
Gain Envelope............................................................................................................... 189
Harmonic Rotate......................................................................................................... 190
ImpulseVerb.................................................................................................................. 190
Invert.............................................................................................................................. 192
Loop Tuner..................................................................................................................... 192
Mono to Stereo & Stereo to Mono............................................................................... 192
Mix................................................................................................................................. 193
Modulate....................................................................................................................... 194
Normalize....................................................................................................................... 194
Normalize (RMS)......................................................................................................... 195
Panner............................................................................................................................ 196
Phase Vocoder.............................................................................................................. 196
Rappify.......................................................................................................................... 197
Repair Click................................................................................................................... 197
Repair Clicks................................................................................................................ 198
Remove DC Offset....................................................................................................... 199
Reverse Boomerang..................................................................................................... 200
Reverse.......................................................................................................................... 200
Strip Silence.................................................................................................................. 200
Swap Channels.............................................................................................................. 202
Threshold...................................................................................................................... 202
Conclusion...................................................................................................................... 204
Chapter 8 - Plug-Ins

Introduction.................................................................................................................................207
Plug-Ins Included with Peak 5....................................................................................................207
Installing Plug-Ins.....................................................................................................................209
   Audio Units Plug-Ins..............................................................................................................209
   BIAS Plug-Ins........................................................................................................................209
   VST Plug-Ins........................................................................................................................209
Organizing Plug-Ins with Folders............................................................................................210
Using Effects Plug-Ins................................................................................................................210
   Inserts..................................................................................................................................210
   Vbox.....................................................................................................................................210
The Vbox Matrix.........................................................................................................................212
   Box Controls........................................................................................................................212
Editing Effect Plug-In Parameters...........................................................................................214
Moving Plug-Ins.........................................................................................................................214
Changing Input Routing..........................................................................................................215
Creating Serial Plug-Ins Chains...............................................................................................215
Creating Parallel Plug-Ins Chains............................................................................................215
Master Wet/Dry Controls.........................................................................................................215
Master Input/Output Levels.....................................................................................................215
Loading & Restoring Vbox Presets..........................................................................................216
A/B Comparisons......................................................................................................................216
Vbox Preferences......................................................................................................................216
Recording Through Effect Plug-Ins..........................................................................................216
Plug-Ins Envelope.....................................................................................................................217
Plug-In Latency Compensation...............................................................................................217
Using Effect Plug-Ins with the Batch Processor.................................................................218
Using Virtual Instrument Plug-Ins...........................................................................................219
   Configuring Peak for Virtual Instrument Playback..........................................................219
   Loading Virtual Instruments on Inserts............................................................................220
Playing Virtual Instruments.....................................................................................................220
Recording Virtual Instruments...............................................................................................220
Deactivating Virtual Instruments.............................................................................................221
Playing Virtual Instruments Alongside Audio Documents.....................................................221
Conclusion.................................................................................................................................222

Chapter 9 - Batch File Processor & Apple Events

Introduction.................................................................................................................................225
Batch File Processor..................................................................................................................225
   Input Area..............................................................................................................................226
   Process Area........................................................................................................................226
   Save Changes Area..............................................................................................................227
Errors & Cancelling Batch Processes.....................................................................................228
Peak’s Audio Librarian Tools.................................................................................................229
   Apple Events Support........................................................................................................229
   “Savvy” Core Suite of Apple Events..................................................................................229
   Apple Events......................................................................................................................229
   Example Scripts..................................................................................................................230
Conclusion.................................................................................................................................230
Chapter 10 - Samplers

Introduction ............................................................................................................................................................................................... 233
Working with SMDI Samplers ................................................................................................................................................................. 233
SMDI Samplers .......................................................................................................................................................................................... 233
SMDI Sampler Error Messages & Troubleshooting ............................................................................................................................. 235
A Note about the Yamaha A3000 .......................................................................................................................................................... 236
The Sampler Preferences Dialog ............................................................................................................................................................ 236
Conclusion ........................................................................................................................................................................................................... 236

Chapter 11 - Peak Menus

Introduction ............................................................................................................................................................................................................ 239
Peak Pro Menu ........................................................................................................................................................................................ 239
About Peak ............................................................................................................................................................................................... 239
Help .............................................................................................................................................................................................................. 239
Preferences .................................................................................................................................................................................................... 239
Hide Peak ................................................................................................................................................................................................... 245
Hide Others .......................................................................................................................................................................................... 245
Quit Peak .................................................................................................................................................................................................... 245
File Menu ..................................................................................................................................................................................................... 245
New ................................................................................................................................................................................................................. 245
Open ............................................................................................................................................................................................................. 245
Close .............................................................................................................................................................................................................. 245
Close All .................................................................................................................................................................................................. 245
Save .............................................................................................................................................................................................................. 245
Save As ........................................................................................................................................................................................................ 245
Save a Copy As ..................................................................................................................................................................................... 245
Import CD Track .................................................................................................................................................................................. 245
Import Dual Mono ................................................................................................................................................................................ 245
Recover Audio File ............................................................................................................................................................................... 246
Export Dual Mono ................................................................................................................................................................................ 246
Export Regions ...................................................................................................................................................................................... 246
Export as Text ...................................................................................................................................................................................... 246
Batch Processor ................................................................................................................................................................................... 246
Burn Audio CD ................................................................................................................................................................................... 246
Recently Opened Documents ........................................................................................................................................................... 246
Edit Menu .................................................................................................................................................................................................... 248
Undo .............................................................................................................................................................................................................. 248
Redo ........................................................................................................................................................................................................ 248
Edits ........................................................................................................................................................................................................... 248
Cut .............................................................................................................................................................................................................. 248
Copy ............................................................................................................................................................................................................ 248
Paste ........................................................................................................................................................................................................... 248
Replace ...................................................................................................................................................................................................... 248
Duplicate .................................................................................................................................................................................................. 248
Insert ........................................................................................................................................................................................................... 249
Insert Silence ...................................................................................................................................................................................... 249
Silence ....................................................................................................................................................................................................... 249
Delete ........................................................................................................................................................................................................ 249
Delete Except Audio ......................................................................................................................................................................... 249
Crop ........................................................................................................................................................................................................ 250

Table of Contents
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampler Menu</td>
<td>270</td>
</tr>
<tr>
<td>Envelope from Audio</td>
<td>262</td>
</tr>
<tr>
<td>Crossfade Loop</td>
<td>262</td>
</tr>
<tr>
<td>Gain Envelope</td>
<td>263</td>
</tr>
<tr>
<td>Find Peak</td>
<td>263</td>
</tr>
<tr>
<td>ImpulseVerb</td>
<td>264</td>
</tr>
<tr>
<td>Loop Tuner</td>
<td>264</td>
</tr>
<tr>
<td>Mix</td>
<td>265</td>
</tr>
<tr>
<td>Modulate</td>
<td>265</td>
</tr>
<tr>
<td>Normalize</td>
<td>266</td>
</tr>
<tr>
<td>Normalize (RMS)</td>
<td>266</td>
</tr>
<tr>
<td>Panner</td>
<td>266</td>
</tr>
<tr>
<td>Phase Vocoder</td>
<td>267</td>
</tr>
<tr>
<td>Repair Click</td>
<td>267</td>
</tr>
<tr>
<td>Repair Clicks</td>
<td>267</td>
</tr>
<tr>
<td>Remove DC Offset</td>
<td>269</td>
</tr>
<tr>
<td>Reverse Boomerang</td>
<td>269</td>
</tr>
<tr>
<td>Reverse</td>
<td>269</td>
</tr>
<tr>
<td>Strip Silence</td>
<td>269</td>
</tr>
<tr>
<td>Swap Channels</td>
<td>269</td>
</tr>
<tr>
<td>Threshold</td>
<td>270</td>
</tr>
<tr>
<td>Audio Info</td>
<td>274</td>
</tr>
<tr>
<td>Auto-Adjust Bounce for Latency</td>
<td>274</td>
</tr>
<tr>
<td>Auto-Import Dual Mono</td>
<td>275</td>
</tr>
<tr>
<td>Auto Snap</td>
<td>275</td>
</tr>
<tr>
<td>Keyboard MIDI Input</td>
<td>275</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>xv</td>
</tr>
</tbody>
</table>
Appendix 1 – Keyboard Shortcuts

Appendix 2 – Peak Actions

Appendix 3 – Troubleshooting

Appendix 4 – Recording & Playback with Mac OS X Audio HAL & FireWire DV

Glossary

Index
Chapter 1: Introducing Peak

Welcome!

BIAS Peak™ is an advanced audio application that provides superior tools for recording, editing, and processing digital audio on the Macintosh computer. Peak was specifically designed to meet the needs and demands of audio professionals. By combining high-quality direct-from-disk digital audio editing features with lightning fast destructive & nondestructive editing environments, Peak provides unsurpassed audio editing power, and makes a superb addition to multitrack audio application programs, such as BIAS Deck™, Cubase™, Digital Performer™, Live™, Logic™, Pro Tools™, and practically any other application that deals with digital audio. Peak offers advanced sampler support, and works directly with many popular MIDI sampling keyboards and rackmount samplers. Peak is also the perfect audio complement to digital video editing programs, such as iMovie™ and Final Cut Pro™.

Peak Features:

- Direct-to-disk recording and playback at all sample rates supported by the sound hardware on your Macintosh, or supported through third-party audio hardware
- User-configured waveform display
- Support for commonly used audio document formats, including AIFF, Sound Designer II™, WAVE, QuickTime™, Raw, System 7 Sound, Sonic AIFP, Paris™, Jam Image, AU, MP3, and MP4(AAC) formats
- Non-destructive file-based editing with unlimited undo and redo
- Professional editing abilities, including user-definable fade curves, silence, and complete support for cut/copy/paste with multiple undo and redo
- By using an application that supports Apple Events, such as FileMaker Pro™, you can catalog your Peak sound files and audition them from within the application
- Support for third-party digital audio hardware, such as M-Audio™ or Mark of the Unicorn™ digital audio interfaces, through Core Audio.
- Support for 8-, 16-, 24-, and 32-bit audio files
- Support for third-party VST™ & Audio Units effects and instrument plug-ins, allowing you to add advanced signal processing features to Peak. Plug-ins from companies such as BIAS, Cycling `74™, Steinberg™, Waves™, and Apple™ can be used with Peak for digital filtering, noise reduction, reverb, equalization, and other effects in real time
- The ability to create 100% Red Book compliant (with CD-TEXT, ISRC codes, and PQ subcodes) audio CDs directly from a Peak Playlist or audio document
- Sophisticated Tools for looping, including Loop Surfer™, Loop Tuner™, and Guess Tempo™
- Sampler Support
- Advanced Playlist editing and mastering options
- Automated batch file processing
- Customizable Toolbar and Keyboard Shortcuts
- QuickTime Movie window with scrubbing
Who Is Peak Designed For?

Peak is designed for a wide variety of users, ranging from composers and multimedia producers to sound designers, mastering engineers, video editors, and remix editors. Peak’s comprehensive recording, editing, mastering, looping, and processing capabilities make it a powerhouse tool for virtually any aspect of digital audio production. If you are interested in sound and possess imagination and creativity, Peak is for you.

What’s New in Peak 5.0/5.2?

Version 5.2 of Peak software offers the following updates and enhancements:

- Universal application supports both Intel and PowerPC-based Macs
- Updated authorization system allows Peak to be authorized by serial number or USB key

Features new as of version 5.0 include:

- Completely redesigned Playlist with unlimited undo/redo
- International Standard Recording Code (ISRC) support
- PQ subcode support
- CD-TEXT support
- DDP File Export*
- POW-r™ Dither in Playlist
- Advanced Change Pitch algorithm
- Advanced Change Duration algorithm
- Advanced Sample Rate Conversion algorithm
- VBox 2.0 effects routing interface — now supports Audio Units plug-ins, and VST/Audio Units instruments
- MIDI support (for virtual instruments)
- Freq-4 v. 2.0 EQ Plug-In
- Automatic plug-in latency compensation
- Adjust Parameters while recording through plug-ins
- Support for Unicode & long file names (longer than 32 characters)
- More accurate waveform display
- Auto-Define Tracks DSP tool
- Strip Silence DSP tool
- Envelope from Audio DSP tool
- RMS Normalize DSP tool
- New Region Split
- High Resolution Tape-Style Scrubbing
- Snap To options: CD Frames, Sony PS2™ & Microsoft XBox™ loop boundaries, and custom units
- Recover Audio File
- Preserve File Attributes in Batch Processor
- Multi-Document Recording (Long Recordings)
- Edit History in File Drawer
- HD Time Units (59.97 & 60 fps)
- Save Loop Flags in On/Off position
- Automatic Window Tiling
- New ImpulseVerb User Interface
- New Toolbar icons
- Support for Mac OS X v. 10.4 “Tiger”
Minimum System Requirements

To use Peak you will need:

- G4, G5, or Intel-based Mac (>500MHz processor recommended)
- Macintosh OS 10.3.9 minimum (10.4 recommended, Intel-based Macs, and burning CD-TEXT require 10.4)
- Minimum 1024 x 768 screen resolution
- 256 MB RAM (512 MB or more recommended)
- 330 MB available free disk space
- 18 ms hard drive (average seek time) or faster
- QuickTime 6.0 or later
- Support for third-party audio hardware may require compatible Core Audio drivers

For the most up-to-date information, please visit:
http://www.bias-inc.com/products/peak/

Mac OS X v. 10.4 “Tiger” and a compatible CD burner are required for burning CD-TEXT and subcode metadata from a Peak Playlist document.

Maximizing Peak’s Performance

The following tips are optional, and will help you get the best performance out of Peak and your Macintosh, but they are not required.

To maximize Peak performance:

- Set your monitor to no more than thousands of colors (the lowest setting that displays properly is recommended for older Macintosh computers).
- Turn File Sharing off, unless you need it.
- Disconnect your Macintosh from any networks and turn off AppleTalk, unless you need to be on a network.
- Optimize your hard drive. (See Chapter 3 to learn about proper hard disk maintenance.)
- Use a separate (i.e., a drive that is not also hosting the operating system or Peak application) fast hard drive as a scratch disk/record disk — BIAS recommends at least a 7200 RPM rotational speed, 8 MB cache or higher, 18ms access time or better, and a fast data transfer connection, such as SCSI, FireWire 400/800, ATA, etc.

About Your User’s Guide

Peak is designed to be simple and intuitive. Your User’s Guide is designed to help you set up and use Peak for digital recording and editing as quickly and easily as possible.

This User’s Guide assumes that you are familiar with standard Macintosh operating techniques, including:

- Setting up, starting, and using your Macintosh
- Choosing commands from menus
- Clicking, double-clicking, selecting, Shift-selecting, dragging with the mouse, and other common operations
- Opening, copying, saving and deleting files
- Opening, closing, scrolling, moving, re-sizing, and selecting Macintosh windows

If you don’t know how to perform these tasks, please refer to your Macintosh User’s Guide and spend a little time learning about your Macintosh before going any further. This will make using Peak much easier and more enjoyable.

The Chapters in your Peak User’s Guide are arranged in
the order in which you would typically perform tasks when embarking on an audio project:

- Chapter 1 introduces you to Peak and explains some of the requirements for using it
- Chapter 2 explains how to install Peak and configure your Macintosh for recording and playback
- Chapter 3 introduces you to some basic concepts of digital audio and disk-based recording, as well as basic Peak operations
- Chapter 4 explains how to configure, record to, and playback audio from hard disk in Peak using Core Audio. It also explains how to import audio from compatible CD-ROM drives
- Chapter 5 introduces you to the concepts and techniques of nondestructive editing with Peak
- Chapter 6 explains how to create regions and sequence their playback using Playlists, as well as how to burn audio CDs export a variety of common file formats
- Chapter 7 explains how to use Peak’s native DSP tools
- Chapter 8 explains how to use Audio Units & VST plug-ins, and how to use Vbox to enhance Peak’s audio production capabilities
- Chapter 9 explains how to use Peak’s Batch File Processor as well as how to use Apple Events for file management
- Chapter 10 explains how to import samples directly from compatible samplers (to edit or process the audio using all of Peak’s functions) and send the modified sample back to the sampler
- Chapter 11 describes each of the commands found in Peak’s menus
- Appendix 1 lists the default Keyboard Shortcuts for Peak
- Appendix 2 provides a troubleshooting guide for commonly encountered problems
- A Glossary and Index complete your Peak User’s Guide

Look for important tips and notes whenever you see this exclamation mark.

About Peak LE

Peak LE is a limited-feature edition of “Peak Pro”, and not all features are available. Peak LE has a streamlined feature set and includes the essential tools required for music production, basic CD mastering, and editing the audio content in files commonly used in non-linear video editing systems.

If you are using the limited edition (LE edition) of Peak, not all features will be available. Specifically, the following features are not available in Peak LE:

- Add
- Advanced Playlist functions – Peak LE features a basic Playlist
- Amplitude Fit
- Bit Depth and Sample rate limited to 24-bit/96kHz
- Bit Usage
- Convolve
- Crossfade Loop
- Customizable Keyboard Shortcuts
- Customizable Toolbar
- Dither
- Envelope from Audio
- Find Peak
- Harmonic Rotate
- Import Dual Mono
- ImpulseVerb
- Includes a 2-band edition of the Freq EQ plug-in
Getting Help with Peak

Peak provides a variety of helpful resources when you run into questions. The first type is Toolbar Help, which shows you the function of each icon in the Toolbar or Transport. If you hold the mouse cursor over a Toolbar/Transport icon for 2 seconds, the Toolbar Help for that icon’s function will appear.

The next type of help is available under the Peak menu. Choosing Help will open the .pdf format Peak User’s Guide, which was installed along with Peak.

You may also use the Links menu to access additional documentation, tutorials, and technical support online, via the BIAS website.

BIAS recommends using these resources before contacting Technical Support. The answers to most common technical questions can be found online. Best of all, using online help resources is free, easy, and available 24 hours a day, 7 days a week, 365 days a year. If you do need to contact Technical Support, please see the BIAS Technical Support Policy on page 5 of this user’s guide.

Conclusion

Now that you know a little about Peak, proceed to the next chapter to learn how to install your software and get started using it.
Chapter 2
Installing, Registering, & Authorizing Peak
Chapter 2: Installing, Registering, & Authorizing Peak

Installing Peak

Peak’s auto-installer software makes installation very easy. The steps below will guide you through the process.

Your complete Peak system consists of:

• CD-ROM installer
• Serial number
• Authorization File

Before you install Peak, please check the Minimum System Requirements on Page 21.

To Install Peak:

1. If you are using any virus protection software, turn it off or temporarily remove it, and restart your Macintosh.
2. Insert the Peak installer CD-ROM into your CD-ROM drive – when its icon appears on your computer’s desktop, double-click the Install Peak icon.
3. When prompted about the Installer package running a program to determine if it can be installed, click the Continue button.
4. When the Installer dialog appears, click the Continue button.
5. Read the Software License Agreement – then click the Continue button to proceed.
6. Click the Agree button if you agree to the terms of the Software License Agreement.
7. Select the hard drive/volume on which you wish to install Peak, and click the Continue button.
8. Click the Install/Upgrade button (depending on the configuration of your user account, you may need to enter your account password. If prompted for your password, enter it and click the OK button. If you do not know your account password, please contact your system administrator for assistance).
9. When the installation is complete, a message will appear indicating that the installation was successful. Click the Close button to quit the Installer. (Don’t forget to turn back on any virus-protection software that you may be using the next time you restart the computer).

What Peak Installs:

• Peak Application
• Plug-Ins
• Peak Impulses
• Peak Envelopes
• Documentation

If you upgraded from an earlier version of Peak which used a BIAS USB Key for authorization, and prefer to continue using the key for authorization – simply plug in the key and Peak will work with it.
Registration & Authorization

Peak must be authorized to work on your computer. You must register Peak with BIAS in order to authorize it. BIAS offers a variety of methods to authorize your computer — though registering and authorizing via the internet with the computer on which Peak will be run is by far the fastest and easiest method. This and alternate methods are outlined below.

Serial Number-Based Authorization System

Peak's standard authorization system consists of the following components:

- **BIAS Authorization Manager** — A simple application for managing BIAS software licenses.
- **Serial Number** — Located on Owner’s Certificate.
- **Registration Account** — Your registration and authorization information on the BIAS Server.
- **Authorization Request File** — A file transferred from your computer to the BIAS server, which adds the computer you are authorizing to your BIAS Registration Account.
- **Authorization File** — A file transferred from the BIAS server to your computer, which authorizes it to run Peak.

Optional BIAS USB Key-based Authorization

Users who prefer the BIAS USB key-based authorization system to the standard serial number authorization system may purchase a key separately, or use an existing, authorized USB key from a previous version of Peak. Multi-user or site-license keys are also available, and may be more convenient than using serial numbers in academic “lab”, or corporate settings. For more information on purchasing BIAS USB keys, please contact BIAS Sales, at:

US Toll-Free: 1-800-775-2427
International: +1-707-782-1866
Email: sales@bias-inc.com

The registration/authorization process provides the following services:

- Registers your software with BIAS - making you eligible for technical support and product updates.
- Authorizes your computer so it can run Peak. You may authorize up to two computers for use with Peak — for example, a studio or office computer, and a laptop for home or mobile use.

Remember that for each license of Peak — the software may only be used by one user, on one computer system at a time. If you have used both of your authorizations, and need to authorize a new computer, you will need to first de-authorize one of the authorized computers before you are issued a new authorization for the new computer.

To Register & Authorize a Computer to Run Peak:

1. Launch Peak — the first time it is launched on an unauthorized computer, you will be prompted to use it in trial mode, or to authorize it — click the Authorize button.
2. When the BIAS Authorization Manager appears, select BIAS Peak Pro 5.x in the “Please Choose a Product” section — then enter your Peak serial number and email address in the appropriate fields, and click the Authorize button.
If you use more than one email address, be sure to make a note of which one you registered with – this will make managing your BIAS Registration Account faster and simpler in the future.

3a. If you have previously registered another BIAS product, using the same email address, Peak will be authorized automatically – please continue to step 4.

3b. If the BIAS Registration system does not recognize your email address (i.e., if this is the first BIAS product you are registering, or if you enter a different email address than with previously registered BIAS products) – a dialog will appear, prompting you to enter your registration information. Enter your registration information, and click the Submit button – a dialog will appear indicating that you have been successfully registered – please continue to step 4.

4. A dialog will appear indicating successful authorization – click the OK button, and then click the Done button to exit the Authorization Manager, and begin using Peak.

Alternate Methods of Registration/Authorization

If the computer on which you plan to use Peak cannot be temporarily connected to the Internet, even for this one-time authorization process, there are a number of other ways to register and authorize Peak.

Authorizing Peak with an existing BIAS USB Key (Dongle)

If you have upgraded from an earlier version of Peak, which used a BIAS USB Key for copy protection, and prefer to continue using key-based authorization – simply plug in the key and your computer will be authorized with the existing Peak authorization on it.

Registering & authorizing Peak using another computer with Internet access

To use this method of registration/authorization, you will need to run the BIAS Authorization Manager application from your installer CD-ROM – or copy the BIAS Authorization Manager application from your installer CD-ROM to the internet-equipped computer’s hard drive.

To Register & Authorize using Another Computer with Internet Access:

1. Launch Peak on the computer where Peak will be used (i.e., the computer without internet access) – the first time an unauthorized copy is launched, the Welcome to Peak dialog appears, click the Authorize button.

2. In the BIAS Authorization Manager dialog, select BIAS Peak Pro 5.x in the “Please Choose a Product” section – then enter your Peak serial number and email address – your Peak serial number is printed on the Owner’s Certificate included in the Peak package (see picture on previous page).

3. Click the Alternate Authorization button – the Alternate Authorization dialog appears.

4. In the Alternate Authorization dialog, click the Generate Authorization Request button – the Serial Number/Email Address dialog appears.

5. Confirm that the email address and serial number are correct, and click the OK button to save an Authorization Request File to your hard drive.

6. Transfer the Authorization Request File to another computer that has Internet access (via a LAN, by burning it to CD, copying to a floppy diskette, flash drive, external hard drive, iPod, digital camera, etc.)

7. Launch the BIAS Authorization Manager application on your internet-equipped computer.

8. In the “Please Choose a Product” section, choose BIAS Peak Pro 5.x.

9. Click the Alternate Authorization button in the BIAS Authorization Manager application.

10. Go directly to step 3 in the Alternate Authorization dialog – click the Open Authorization Request button.

11. In the Open dialog that appears, locate and select
the Authorization Request File, then click the Open button – this will transmit the Authorization Request File to the BIAS Server.

12a. If you have previously registered another BIAS product, using the same email address, the BIAS server will transmit an Authorization File back to your internet-equipped computer – click the Save button to save this to the internet-equipped computer’s hard drive. Please proceed to step 13.

12b. If the BIAS Registration system does not recognize your email address (i.e., if this is the first BIAS product you are registering, or if you enter a different email address than with previously registered BIAS products) – a dialog will appear, prompting you to enter your registration information.

12c. Enter your registration information, and click the Submit button, then click the OK button when the successful registration dialog appears.

12d. You will be prompted to open the Authorization Request File a second time – locate it, and then click the Open button – The BIAS server will transmit an Authorization File back to your internet-equipped computer – click the Save button to save this to the internet-equipped computer’s hard drive.

13. Click OK to exit the Authorization Successful dialog, then click the Done button in the Alternate Authorization dialog, and again in the BIAS Authorization Manager.

14. Transfer the Authorization File (the file is called “BIAS Peak Pro 5.x”) from the internet-equipped computer back to the host computer where Peak will be used (via a LAN, by burning it to CD, etc.).

15. Go directly to step 4 in the Alternate Authorization dialog – click the Open Authorization File button.

16. In the Open dialog that appears, locate and select the Authorization File, then click the Open button.

17. Click OK in the Authorization Complete dialog, and Done in the Authorization Manager.

To De-Authorize a Computer

If you need to de-authorize a particular computer that will no longer be used to run Peak, you can do so by following the steps below.

The computer running Peak must be connected to the internet in order to deauthorize it.

To De-Authorize a Computer:
1. Launch Peak – and choose Authorization Manager from the Peak menu (or launch the BIAS Authorization Manager application from your installer CD-ROM).
2. In the BIAS Authorization Manager, select the product you wish to de-authorize – the serial number and email address used to authorize that product will be automatically recalled and will appear in the Serial Number and Email Address fields.
3. Click the Deauthorize button.
4. Click the Deauthorize button to confirm the deauthorization process – the Deauthorization Successful dialog appears.
5. Click the OK button – then click the Done button in the BIAS Authorization Manager.

Conclusion

Now that you have installed, registered, and authorized Peak, please proceed to the next chapter to learn several basic concepts and functions essential to using Peak.
Chapter 3: Peak Basics

Introduction

This chapter explains several key Peak concepts and functions, including how to open, close, and save audio documents.

A Brief Explanation of Digital Audio

If you are new to digital hard-disk-based recording, you may wish to acquaint yourself with a few of the principles behind digital audio before you dive into using Peak software. This section explains a few key concepts that will give you a good general understanding of how Peak does what it does.

What we hear as sound is actually a pattern of pressure waves that move through the air. The frequency of these waves determines the pitch of the sound – how low or high it sounds. Sound frequency is measured in cycles per second, or Hertz (Hz). The range of human hearing is generally considered to be from about 20 Hz at the low end to 20 kHz at the high end. In practice, however, most adults hear only as high as 12 kHz to 18 kHz, especially those of us who may have spent more time than we should have with headphones or at loud rock concerts.

Sampling and Sample Rate

Your Peak software-equipped Macintosh computer stores audio digitally. This means that analog electrical signals from microphones or other sources are converted into numbers by a circuit called an analog-to-digital converter and stored on hard disk. The analog-to-digital (A/D) converter uses a technique called digital sampling to convert analog electrical signals into numbers. Digital sampling is the sonic equivalent of taking a snapshot. By taking thousands of little digital samples per second and storing them to a hard drive, an A/D converter can capture an accurate sample-by-sample representation of a sound, much like a movie is a frame-by-frame representation of a moving image. The number of samples taken of the audio in a second is called the sample rate. The sample rate determines the recording’s upper frequency response. A higher sample rate delivers higher frequency response. As a rule of thumb, a digital recording’s upper frequency response is roughly half of its sample rate (known as the Nyquist frequency). The audio on compact discs, for example, is recorded at 44,100 samples each second, or 44.1 kHz. This sample rate is the standard for professional-quality digital audio, and provides an upper-end frequency response of approximately half the sample rate (known as the Nyquist frequency): 22.5 kHz, somewhat higher than most people’s hearing range.

Bit Resolution

Another factor that affects the quality of the audio is the resolution of each sample. The greater the resolution, the better the quality. To use an analogy from the film world, just as image resolution and quality increase with film size (8 millimeter film is much lower in image quality than 70 millimeter film) greater bit resolution (8-bit, 16-bit, 24-bit, and 32-bit) results in better fidelity digital audio. Audio CDs have a resolution of 16-bits.
In practice, the bit resolution determines the recording’s dynamic range—that is, how many distinct steps you have to describe a sound’s level, from quiet to loud. For instance, an 8-bit recording has 256 \(2^8\) levels available, which is the equivalent of 48 decibels (dB) of dynamic range. On the other hand, a 16-bit recording has 65,536 \(2^{16}\) levels available, equivalent to 96 dB dynamic range. (The rule of thumb for determining the dynamic range in decibels is to take the bit rate and multiply it by 6.)

**About Disk-Based Recording and Editing**

If you are new to hard-disk-based recording, you will be impressed by the power and control that Peak software provides for recording and editing digital audio. You will encounter several new concepts and techniques for using a disk-based system such as Peak. Perhaps the most important among these is the concept of nondestructive manipulation of audio.

**Nonlinear Versus Linear Recording**

Nondestructive audio manipulation is possible thanks to the nature of Peak’s recording medium: a hard disk instead of a roll of analog tape. Unlike analog tape, which is a linear recording medium, hard disks provide a nonlinear, or random-access medium. This is because audio is stored on hard disk as digital information which the hard disk can access immediately or randomly (hence the term “random-access”), simply by moving its read/write head to the appropriate location and reading the appropriate data. This allows you to perform such miraculous feats as cutting and pasting “pieces of sound” and rearranging material long after it has been recorded.

**Nondestructive Editing**

Perhaps most impressive is the fact that with disk-based audio production you need not actually modify the original source material in any way to accomplish these feats. In most cases, by cutting and pasting you are in reality only asking the hard disk to access portions of the audio file in a slightly different order. Since Peak doesn’t normally cut up, move around, or delete the actual recording on the hard drive, it’s said to be a nondestructive editing system. Peak does not rewrite the file until you choose to save your edits. Other manipulations, such as playing audio material backwards, can be accomplished by reading the data in reverse order. The power and flexibility of disk-based audio production software such as Peak far surpasses the capabilities of traditional analog audio production tools.

**Hard Disk Storage Requirements**

The actual recording of audio to hard disk requires a significant amount of storage. This is directly affected by the sample rate and bit resolution at which you record: the higher the fidelity, the greater the requirements for storage. As a guideline, 16-bit, 44.1 kHz audio requires roughly 5 megabytes per minute of mono recording. Stereo 16-bit, 44.1 kHz audio requires roughly 10 megabytes per minute. Stereo 24-bit, 44.1 kHz audio requires roughly 15 megabytes per minute.

**Hard Disk Maintenance**

Because audio recording and playback is a hard disk-intensive task, it is important that your hard drive be in good operating condition. In the computer world, this means keeping it from becoming fragmented by using hard drive maintenance software. Fragmentation occurs as your hard drive begins to run out of contiguous (uninterrupted) space where it can write files. If the data that makes up a file is stored at a single location on your drive, it is much easier and faster for your drive to find the data and read it. However, as
contiguous space runs out, the drive may not be able to write the entire file in one location and instead must fragment the file by writing pieces of it at various locations in whatever smaller open areas it can find. This requires that the drive search near and far to read the pieces of the file. Too much fragmentation can lead to errors in recording and playback as the hard drive struggles to keep up with the demands of your audio application. In general, you should keep your hard disk below 10% fragmentation. Most hard drive maintenance software packages let you monitor the degree of fragmentation on your drive and defragment it by rewriting files into contiguous blocks of data. In addition to defragmenting your drive regularly, you should also back up your files and reformat your drive on a regular basis to keep your system in top operating condition. By doing this, you will ensure maximum performance from your Macintosh and Peak software, and keep your studio running smoothly. Now that you understand some of the basic principles behind digital audio and disk-based recording, take a few moments to learn some of the basic operations of Peak. These are covered in the sections that follow.

Creating a New Peak Document

Peak will allow you to create an empty audio file of zero duration by choosing a new mono or stereo document. However, you would typically record a new audio file in Peak or open an existing audio file into Peak for editing. Peak allows you to have multiple audio documents open at the same time.

To create a new audio document:

Choose New (\File\New) from the File menu or Toolbar. This command provides a hierarchical menu, which allows you to choose either a mono or stereo format for the new document.
To open an audio file:

1. Choose Open (\-O) from the File menu.
2. In the dialog that appears, locate the file that you wish to open. From this dialog, you can open AIFF, Sound Designer II, WAVE, QuickTime, Raw, System 7 Sound, Sonic AIFF, Paris, Jam Image, AU, and MP3 formatted audio files.
3. When you find the file you wish to open, click the Open button and Peak will open the audio file into a new audio window, displaying an overview of the entire sound. Shift-click or \-click to open multiple files.

Recently Opened Documents

Peak automatically remembers up to the last eight audio documents that you have opened and keeps a list of these at the bottom of the File dialog. This allows you to easily select a document’s name and reopen it without having to search on your hard drive. Peak can find and open a document even if you have changed its location on your hard drive. If you change the name of the file, the next time you open Peak, it will automatically update the name in its internal list.

Opening “Dual Mono” Files

Certain audio applications, such as BIAS Deck, do not directly support stereo interleaved files, and instead use “dual mono” files, which comprise the right and left channels of stereo material. Peak allows you to open such dual mono files, and in the process creates a new interleaved stereo audio document. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono files.

Please note that the Import Dual Mono command requires that both files be mono files and have the same sample rate.

To open a dual mono file:

1. Choose Import Dual Mono from the File menu.
2. In the dialog that appears, locate the desired files.
3. Select either half of the dual mono file and click Open. Peak imports the first file and then prompts you for the second.

4. Select the second audio file and click Open. When Peak has finished creating the new stereo audio document you can begin editing.

For simpler importing of Dual Mono files, turn on the Auto Import Dual Mono feature in the Options menu. With this feature activated, you can automatically import dual mono files by choosing Open from the File menu and selecting one of the dual mono file’s channels. Peak will then create a new stereo document containing both channels. Please note that these dual mono files must have exactly the same file name with the suffix “L” for the left channel and “R” for the right channel.

Peak also allows you to export your stereo audio documents in Dual Mono format, which means that it’s easy to import dual mono tracks from BIAS Deck into Peak, edit and process them within Peak, and then export them as Dual Mono files to be reincorporated into your Deck sessions.

Recovering Damaged Audio Files

This feature is particularly useful when used with Peak’s Batch File Processor.

Peak 5 includes a new tool called Recover Audio File, which allows you to open a damaged file, and attempt to recover the audio data contained in it. This tool extracts audio data only, and ignores all other information contained in the file’s header, such as information about loop points, regular markers, region markers, etc. When audio data is successfully recovered, it is placed into a new audio document and must be saved.

There are a few pieces of information that Peak requires, in order to attempt file recovery – these include the number of channels, the file’s bit depth and sample rate, the audio data location, and the byte order. With these few bits of information (and depending on the degree of damage), Peak may be able to recover many otherwise unusable audio files. To attempt to recover a file, you must supply correct data.
information about the format the file was originally recorded in, otherwise, you may end up with white noise, or a file that plays at the wrong speed, etc.

When the Recover Audio File encounters corrupt sectors with media, file, or I/O errors, it will attempt to continue recovering whatever audio data is available, and will write the sections containing errors as silence in the new audio file that is created.

Saving and Closing Documents

It is good practice to save regularly throughout a project to avoid losing valuable work in the event of a power failure or other unfortunate occurrence. The Save command saves the changes you have made to your audio document by writing it to your hard disk.

The Save command cannot be undone. If you want to be able to continue to undo your edits, use the Save a Copy As command under the file menu. Peak allows you to save your audio documents in a variety of common audio file formats, each of which is described below. Be aware that different formats allow different information to be stored with the file. Peak preserves this information unless you save the file into a different file format. Saving a file in a format different from its original format may, however, cause some information stored in the file to be discarded.

---

New in version 5 is support for Unicode characters. This allows non-English characters to be used when saving files, and also allows the use of ‘long’ filenames (longer than 32 characters).

---

Peak supports the following audio file formats:

- **AIFF:** This is Apple’s Audio Interchange File Format. It is also Peak’s default file format and is supported by many Macintosh software applications.

- **Sound Designer II:** This is Digidesign’s audio file format for its digital audio products. Use this format if you wish to use an audio document in a Digidesign audio application.

- **WAVE/.WAV:** This is Microsoft’s Windows Audio File Format. It is supported by many Windows software applications and some Macintosh applications. The WAVE format is best if you plan to use an audio document in an application that supports or requires WAVE format files.

- **QuickTime:** This is Apple’s audio file format for QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Macromedia Director™. QuickTime includes formats such as AAC/mp4.

- **Raw:** This is the header-less raw file format that may be useful for some game platforms.

- **System 7 Sounds:** This is the Apple audio file format used for Macintosh Operating System Sounds.

- **Jam Image file:** This is the Jam audio image file format. Jam audio image files may be created in Peak and used in Roxio Jam for burning audio CDs.

- **Sonic AIFF:** The file format used by Sonic Solutions audio workstations.

- **.paf:** This is the file format used by E-mu’s Paris audio system. Note this file format favors mono and dual mono files.

- **.au:** This file format is commonly used on the World Wide Web and in Java audio applets – it is supported by many platforms and programs.

- **MP3:** This saves your document in MP3 format.

---

Encoding as mp3 format requires that the LAME encoder be installed. For more information on downloading and installing this encoder, please see Appendix 3, which contains step-by-step directions for using the LAME encoder.
To save a Peak document:
1. Choose Save from the File menu or press ⌘-S on your keyboard.
2. Select a file format from the File Type menu. AIFF is Peak’s default audio file format.
3. Enter a name for the new audio document, select where you want to save the new file, and then click Save.

Using the Save As and Save A Copy As Commands

The Save As command allows you to save a copy of the current document under a different name, or in a different location on your hard disk. Since the Save As command closes the current document and lets you keep working on the renamed copy, it is useful for saving successive stages of a project. This allows you to save each major step under a different name. Later you can retrace your steps should you want to go back to an earlier version. The Save A Copy As command will save a copy of the file you are working on, but it will keep the copy you are working on open. This allows you to continue working on your audio and still be able to undo any edits you executed prior to using the Save A Copy As command.

To save an audio document under another name:
1. Choose Save As (⌘-Shift-S) or Save A Copy As (⌘-Option-S) from the File menu. The Save dialog appears:
2. Select the desired file format from the File Type pop-up menu. AIFF is Peak’s default audio file format.
3. If you wish to save the audio document to a different bit depth resolution, click the bit depth pop-up. It is strongly recommended that you enable the POW-r™ dithering option if you are saving to a lower bit depth (e.g., 24-bit to 16-bit).
4. Enter a name for the new audio document, select where you want to save the new file, and click Save.

Using POW-r Dithering

If you are saving to a lower bit depth (e.g., 24-bit to 16-bit), it is strongly recommended that you enable the POW-r dithering option. Choose the POW-r Dither Settings from the Preferences dialog to adjust the settings for POW-r dither. For mono files, or stereo files with a narrow stereo field (e.g., recordings of solo instruments), use POW-r 1; for more stereophonically complex material, use POW-r 2; for full-spectrum audio with a wide stereo field, use POW-r 3.

Saving Compressed Audio Documents

AIFF/AIFC and QuickTime files with compression such as MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or Alaw are compatible with Peak.

⚠️ You can only Save with file compression using AIFF or QuickTime file formats.
Audio compression should be the last step in mastering your audio documents. Decompressing and re-compressing audio documents will degrade their sound quality each time they are re-compressed, so it is best not to save with compression until all editing and mastering has been completed.

To save an audio document with compression:

1. Choose Save As (⌃-Shift-S) from the File menu. The Save As dialog appears.

2. Choose the audio compressor you wish to use from the Compressor pop-up menu. Some compression formats only work with 8-bit or 16-bit data, so the compression options may be grayed out, depending on your setting in the bit depth pop-up menu. Some of the types of available audio file compression include: MACE 3:1, MACE 6:1, QDesign Music, ALaw 2:1, 32-bit Floating Point, 64-bit Floating Point, IMA 4:1, 24-bit integer, 32-bit integer, 16-bit Little Endian, and 16-bit Big Endian.

3. Click the Options button to adjust the settings for the specified compression format, and then click OK.

4. Type the name of the new audio document, select the folder you wish to save the audio document, and click Save.

Closing Audio Documents

To close a file in Peak, choose Close from the File menu (⌃-W). If you have made any changes to your document since the last time you saved, Peak will ask you if you want to save them. If you do, choose Yes; if you do not, choose No. If you change your mind and wish to continue your session, choose Cancel. To close all files currently open in Peak, choose Close All from the File menu (⌃-Option-W).

Peak Windows and Palettes

There are several windows and palettes when you open Peak that either appear by default or are available to you under Peak’s Windows menu. Windows that appear in Peak by default include an audio document window for each audio file you have open. Windows and palettes that you can turn on or off include the Transport, the Toolbar, the Contents Window, and the Movie Window. This section will cover the basic function of these Peak Windows and Palettes.

Peak Audio Document Window

Peak Audio Document windows contain a Waveform Display, an Audio File Info Bar, a Max Level Indicator in the lower left corner, and an expandable contents drawer which contains information about markers, regions, and loops. The Waveform Display is a graphic representation of the audio file, the Audio File Info Bar shows the sample rate, bit resolution, file format and file size of the audio file, and the Max Level Indicator shows the highest amplitude level in the audio file. On top of the Audio Document window is the File Overview, if it is enabled under the Peak Options menu. The contents drawer is similar to the Contents Window, but offers a convenient way to view regular, region, and loop markers on a document-by-document basis, as well as a complete edit history for that document. The Audio Window is described in more detail in Chapter 5.

Peak’s audio document window also contains several different tool icons representing different cursor modes. The default cursor is a standard Arrow Cursor. You can also use the cursor palette to select a Hand Cursor for scrolling a Pencil Tool for drawing directly on the waveform at the sample level, and a Magnifying Glass Tool for zooming the waveform view in and out. The ESC key on your computer keyboard will toggle through the four cursor modes.
To access any of these cursors or functions, just click on the corresponding icon. To change the cursor tool, click on a new icon. The various cursors and editing modes are discussed briefly below, and in greater detail in Chapter 5: Editing.

**Blending On/Off Button**

When Blending is turned on, Peak creates very short crossfades between sections of audio that are cut, pasted, copied, or inserted. Blending helps to avoid clicks and pops that can occur when cutting an audio waveform at a non-zero crossing, or when combining material with significantly different amplitude. The left-most button toggles Blending on and off, and the Caps Lock key on your keyboard may also be used to toggle it on and off. More information on using Blending is available in Chapter 5: Editing.

**Horizontal Lock Button**

The Horizontal Lock button allows both the Begin & End markers in a loop or region to be moved simultaneously. This feature is very useful in situations where the duration of a selection needs to be maintained, but the selection needs to be made in a different part of an audio document. The second-from-left button toggles Horizontal Lock on and off.

**Vertical Lock Button**

The Vertical Lock button allows back-to-back Region markers sharing the same space between samples to be moved simultaneously. This is very useful when cutting a long DJ mix or live recording into “tracks” — when you need to adjust where a track break will occur, without introducing any gaps between the two regions.

**Arrow Cursor Tool**

The Cursor Tool is the default tool. It is the standard “arrow” tool that lets you click and select on-screen items.
Hand Tool

The Hand Tool lets you scroll a waveform in its window.

Magnifying Glass ("Zoom Tool")

To use the Magnifying Glass tool, simply click on the tool in the audio document window, then move the cursor over the waveform. A “plus” (+) sign will appear inside the Magnifying Glass. Click on the waveform to zoom in; each click of the mouse will zoom in farther. To zoom out, option-click on the waveform. A “minus” (-) sign will appear in the Magnifying Glass, and you can click on the waveform to zoom out. Double-clicking on the Magnifying Glass will open the Zoom Amount dialog where you can specify the Zoom Amount.

Pencil Tool

The Pencil Tool lets you draw directly on the waveform at the sample level. This is very useful for drawing out clicks in the waveform. Double-click on the Pencil Tool icon for the Drawing Tool Smoothing Settings.

Cursor and Selection Information

The lower section of the audio document window’s Contents Drawer displays the X (time) and Y (amplitude) coordinates of the cursor point, Sel: the duration of any currently selected audio), DTR (Distance to Reference Marker), and BPM: the tempo in beats per minute. You can type a value in for the X, Sel, and BPM parameters.

The same information can also be displayed by toggling the transparent cursor overlay to the “on” position, which appears next to the mouse cursor, and moves along with the mouse cursor. Transparent cursor information can be turned on and off under Peak’s Options menu (Shift-T).

The time format displayed in these fields depends on which time format (Samples, Min:Sec:ms, SMPTE, or Bars|Beats) you have chosen with the Time Units command under the Options menu.

Here is how to read the cursor and selection information that appears in the Cursor Location display.

\[
\begin{align*}
Y &= \text{the current cursor position along the vertical scale (amplitude), or start point of a selection} \\
X &= \text{the current cursor position} \\
[L] &= \text{the cursor is positioned over the left channel} \\
[R] &= \text{the cursor is positioned over the right channel} \\
DTR &= \text{distance to the nearest reference marker} \\
Sel &= \text{the duration of the current selection} \\
+/- &= \text{indicates positive or negative phase} \\
BPM &= \text{beats per minute}
\end{align*}
\]
**Transport Window**

The Transport window is a floating, resizeable window. It contains four main components: a time display showing elapsed time, the Transport controls (Return to Zero, Stop, Play, Go to End, Record, and Loop during playback), audio level meters with clip/peak indicators, and a master fader for playback volume control.

**Time Display**

Peak’s Time Display serves a number of functions. While audio is playing, the Time Display shows the elapsed time in the selected time units format, and tracks the “playback head”, or cursor. When audio playback is stopped the Time Display shows the current cursor location within the audio waveform. Clicking the Time Display opens Peak’s Go To Time dialog, and allows you to enter a time value — the insertion point cursor jumps to this time location in the audio document.

This display will also show the time remaining while performing Open, Save, DSP processing, or CD-burning actions.

**Meters**

Peak’s meters are much like the VU or LED meters on a mixing board or tape recorder. They are bar graph meters that show the relative volume or loudness of the audio as it plays. They are also designed to show peak volume and whether the signal has “clipped,” or distorted.

**The Meters dialog**

You can configure the Meters display by choosing Meters from the Audio menu, or by clicking the appropriate button in the Toolbar. Using the Meters dialog, you can select the Peak Hold time and Clip Indicator Hold Time.

The Peak Hold indicators appear as yellow bars at the far right of each of the bar graphs as audio plays, and selecting a hold time causes the indicator to pause for easy reading of the peak value during playback. The Clip Indicators appear as red bars at the far right of each of the bar graphs as audio plays, and are triggered when audio distorts, or “clips”, and selecting a hold time causes the indicator to pause for easy reading of any clipping or distortion that occurs during playback. Setting the Peak Hold and Clip Indicator Hold Times to None turns these features off.

**Progress Bar**

The Meters display changes to a progress bar during audio processing, and while saving or opening audio files.

**Master Fader**

The Master Fader is located just below the level meters, and is used to control the level of audio documents being played back in Peak.

**Contents Window**

Peak has a floating Contents Window that will display all regular, Region, and Loop markers contained in any open audio document.
audio documents. There are three buttons at the bottom of the palette that allow you to select which items to view—from left to right: the Region Button, the Marker Button and the Loop Button. Option-double-clicking on any item in the Contents window will bring up the Edit Region or Edit Marker dialog.

The Contents Window

To resize the Contents Window:
- Click and drag on the lower right hand corner of the Contents window to resize the Contents Window.

To resize columns in the Contents Window:
- Click and drag to the right of the column’s title bar that you want to resize. For example, to make the Name column wider, click and drag the line between Name and Time to the right.

To sort columns in the Contents Window:
- Click the title of the column by which you want to sort. For example, to sort by Time, click on Time.

To change the sort order in the Contents Window:
- Click the sort order button in the column title to change the sort order.

Setting Preferences

You can customize a number of Peak’s parameters so you can work with the program in a way that best suits you. Most of these parameters are found in the Preferences dialog and Options menu. These include the controls for playing back audio documents, the selection of the icons in the Toolbar, and the colors that you want for the audio document window. Once you have set these preferences as you like, they will stay that way until you decide to change them again. This section explains how to set several of these parameters. For any menu items not covered here, please refer to Chapter 11: Peak Menus. There you will find explanations of each command in the Preferences dialog and other Peak menus. Items from the Preferences dialog and Options menu are also covered throughout this manual where their discussion is relevant.

Setting Peak’s Playback Parameters

Peak’s Playback Preferences dialog allows you to control the master output volume, hard disk playback buffer size, and window buffer size.
Playback Master Volume

Peak provides a master volume control for audio playback. In the Playback Preferences dialog, set Peak's output volume to the level that you desire by adjusting the slider or entering a number value from 0 (silent) to 7 (loudest). If you are controlling your playback volume with the volume control of your playback system, you’ll probably want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the program uses when playing back audio documents. In general, lower is better. A playback buffer setting of 32 - 64k is a good place to start. If you are experiencing clicks in your playback, working with fragmented files, using processor-intensive real-time DSP, or are using a slow hard drive, you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the program uses to cache audio data and the size of each processing chunk. Use larger values if you are working with a few large files, and smaller values if you are working with many smaller files.

Dynamic Scrub Time

Peak provides a unique audio auditioning technique called dynamic scrubbing. This feature is very useful for precisely pinpointing and selecting a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. When you have found the location you are looking for, let go of the mouse and the insertion point will be exactly where you want it to be. Peak allows you to choose the length of this playback loop with the Dynamic Scrub Time command in the Options menu. You can also select Tape-Style Scrubbing in this dialog. For a full description of scrubbing audio in Peak, please see Chapter 5.

To select a loop duration for dynamic scrubbing:
1. Choose Dynamic Scrub Time from the Options menu, and choose a duration from the hierarchical submenu. Typically, a value of between 40 to 80 milliseconds works well.
2. You can also select Tape-Style Scrubbing by selecting it in this submenu. To deselect Tape-Style Scrubbing, just click any duration value in the submenu.

Scroll During Playback

With the Scroll During Playback command enabled, Peak will “scroll” through the audio document as playback progresses. This allows you to visually follow the progress of audio playback. A check next to this menu item indicates that it is enabled.

To enable Scroll During Playback:
1. Select Scroll During Play from the Options menu. A check next to this item indicates it is enabled.
2. To disable Scroll During Playback, simply re-select Scroll During Play from the Options menu. The absence of a check next to this item indicates it is disabled.

Move Waveform During Playback

With the Move Waveform During Play command enabled, Peak will move the waveform under the cursor as playback progresses, so that the playhead cursor is always in the middle of the waveform display. A check next to this menu item indicates that it is enabled.

To enable Move Waveform During Playback:
1. Select Move Waveform During Play from the Options menu. A check next to this item indicates it is enabled.
2. To disable Move Waveform During Playback, simply re-select Move Waveform During Play from the Options menu.

**Show Marker Times**

With the Show Marker Times command enabled, all Peak markers will show a time value as well as the marker name.

*To enable Show Marker Times:*

1. Select Show Marker Times from the Options menu. A check next to this item indicates it is enabled.

2. To disable Show Marker Times, simply deselect Show Marker Times from the Options menu. The absence of a check next to this item indicates it is disabled.

**Auditioning**

Peak’s Auditioning command allows you to audition a selection along with a specific amount of audio preceding or following it. The Auditioning dialog allows you to select a desired amount of pre-roll or post-roll when you play the selection. To play a selection with the selected amount of pre- and postroll, press Control-Spacebar.

*To configure Auditioning:*

1. Select Auditioning from the Preferences dialog – The Auditioning Preferences dialog appears.

2. Enter the desired amount of Pre-roll and Post-roll, and click OK.

**Blending**

Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document when they are modified by cutting, deleting, or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you have cut, pasted, or inserted audio into a document, you may wish to enable blending to smooth things out a bit. It can be toggled on or off by clicking the Blending button in the Audio Document Window, or by using the caps lock key on your keyboard.

*To configure Blending:*

1. Select Blending from the Preferences dialog. Enter the Duration over which you wish Blending to occur into the dialog box.

2. To edit the Blending Envelope, click on the Edit Blending Envelope button. Click OK to exit the dialog and click Save Preferences Now to save the change.

For detailed instructions on how to use blending or how to edit the blending crossfade envelope, see Chapter 5: Editing.

**Auto-Import Dual Mono**

Certain audio applications, such as BIAS Deck and Digidesign’s Pro Tools, do not directly support interleaved stereo files, and instead use “dual mono” files—a pair of files, one for the left channel and one for the right channel. These files have typically been exported with the suffix “.L” for the left channel, and the suffix “.R” for the right channel. Auto-Import Dual Mono, when selected, will allow you to select just one channel of the dual mono file in the Open dialog. Peak will automatically “grab” the other half of the file, and convert both files into a single stereo Peak document.
Please note that the Import Dual Mono command requires that both files be mono files, have the same sample rate and bit depth, and the must have the exact same name followed by the suffixes "L" and "R". If you are using file type extensions (.aif, .wav, etc) the format must be "Filename.Side.Extension". For example – "Song1.L.aif" and "Song1.R.aif".

To enable Auto-Import Dual Mono:
1. Select Auto-Import Dual Mono from the Options menu. A check next to this item indicates it is enabled.
2. To disable Auto-Import Dual Mono, simply reselect Auto-Import Dual Mono from the Options menu. The absence of a check next to this item indicates it is disabled.

Choosing Colors for the Audio Document Window

Peak allows you to customize the colors used to display the elements in audio documents. You can use this dialog to set the background color, waveform color, and colors for markers and loops. You can select either a preset color combination, or individual colors for each element in the audio document window, as well as picking your own custom colors from a color palette. Changes made using the Colors dialog affect both the current audio document's colors, and any subsequent new audio document's colors.

To customize the colors of the waveform display:
1. Choose Colors from the Preferences dialog.
2. To select a preset color combination, click the Theme pop-up menu and choose the preset that you desire.
3. Alternatively, to select individual colors for each element in the audio document window, choose Custom from the Theme pop-up menu and then select the desired colors from the Background, Waveform, Markers, Loops, and Regions pop-up menus.
4. If you wish, you can use this dialog to further customize any element in the audio document window. Pick an element to customize, choose Custom from the Theme pop-up menu, and select User Color. A standard Macintosh color palette will appear. Use this wheel to select any color you wish. Click OK to return to the Colors dialog.
5. To close this dialog, click Change (to change one color) or Change All (to change the colors for all open audio documents). The audio document window is now set to the colors and look you've selected.

Choosing a Time Format

The Time Units command allows you to choose a time format for the audio timeline in Peak's audio document window. You can choose Samples, Seconds, SMPTE frames, and Bars | Beats. The format you choose will depend on the...
nature of the project that you are working on.

**To choose Peak’s time format:**

1. Choose Time Units from the Options menu.
2. From the submenu, choose the time format that you desire: Samples, Min:Sec:ms, SMPTE frames, Bars|Beats, or CD Frames. The timeline in Peak’s audio document window and Transport switches to the format that you choose.

**Audio File Meter, Tempo, and Timestamp Settings**

If your audio document is using bars|beats as its units, you will want to tell Peak what the tempo of the audio document is. Use the Audio Info command from the Options menu or enter the BPM in the Cursor palette to set the tempo of the audio document. You can also enter the meter of an audio document using the Audio Info dialog. The numerator represents the number of beats per measure, and the denominator represents the value of a beat, where 4 = quarter note, 8 = eighth note, 16 = sixteenth note, and so forth.

You may also enter a timestamp for the audio document in seconds. If the audio document has a timestamp, then the displayed time in an audio document will be offset from this time rather than starting at zero. For example, if the timestamp for an audio document is four seconds, then the first sample in the audio document will appear in the audio document with a time of 4 seconds instead of zero seconds.

**Choosing a Scratch Disk**

Because audio data can be very large, Peak utilizes a portion of your hard disk’s free space to hold audio data that has been cut or copied, as well as for temporary or scratch files for undo purposes. If your hard disk is short on space, you may not be able to cut, copy, or modify large selections. If you have more than one hard drive attached to your Macintosh, the Scratch Disks section in the Preferences dialog allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose-usually you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the Allow Servers checkbox. Any available servers will then appear in the Scratch Disks pop-up menu. This feature is recommended only if you have access to a high speed Ethernet, or other fast server.

**To choose a scratch disk for temporary files:**

1. Choose Scratch Disks from the Preferences dialog. The Scratch Disks dialog appears.
2. The Scratch Disks dialog will show all hard drives currently connected to your Macintosh. Choose the
hard drive(s) that you wish Peak to use when it creates temporary files by clicking the checkboxes next to the drives in the list. To choose the Primary Disk, or the default disk for temporary files, click on the Primary button next to that disk. If you are connected to a file server and would like to use storage available there as well, enable the Allow Servers checkbox.

3. Click OK to close this dialog. Peak will use the disk you have selected as your Primary scratch disk, and, if it becomes full, will then use the other disks you’ve chosen.

---

The hard drive with the original audio file must have the equivalent amount of free space (i.e., a 60MB file would require that there be an additional 60MB of free space on the hard drive on which the file resides).

---

You must have write permissions for the selected Scratch Folders and Disks or else Peak will report an error. Contact your System Administrator if you need assistance changing Directory or Disk permissions.

---

**Keyboard Shortcuts**

Peak allows you to customize any Peak menu item with a keyboard shortcut. To change your keyboard shortcuts, go to the Preferences dialog and select the Shortcuts and Toolbar item. Preferences are stored in a file called Peak 5.0 Shortcuts, located in:

```
Users/\YourUserAccount>/Library/Preferences/
```

Peak’s default Keyboard Shortcuts are listed in Appendix 1 at the end of this manual.

**To add a new Keyboard Shortcut:**

1. Choose Shortcuts & Toolbar in the Preferences dialog.

2. Scroll through the list of menu items, or, with the list box selected, simply type in the first few letters of the menu item you wish to assign. Then click on the name of the Peak menu item you wish to assign a new keyboard shortcut.

3. Use the Shortcut Key box to enter the letter you wish to use for a shortcut. You may select the Command, Option, Shift or Control keys as additional modifiers by clicking on the checkboxes in this dialog.


**To remove a Keyboard Shortcut:**

1. Choose Keyboard Shortcuts in the Preferences dialog.

2. Scroll through the list of menu items, and click on the name of the Peak menu item for which you wish to remove a keyboard shortcut.

3. Click on the Clear button.


---

User-defined Keyboard Shortcuts and Toolbar customization are not supported in Peak LE.

---

**Making a Keyboard Shortcuts “Cue Card”**

It’s easy to make a “cue card” that you can keep on your desk with all the Peak shortcuts you’ve assigned. Using the supplied FileMaker Pro template, you can import all of your shortcuts from a text file describing each keyboard shortcut generated from Peak.

**To Create A Custom “Cue Card” of your Keyboard Shortcuts:**

1. Choose Shortcuts/Toolbar Preferences in the Preferences dialog.

2. Click on the Save As Text button.

3. Enter the name of the keyboard shortcuts text file...
you wish to save, and choose the disk and folder you wish to save into. Click Save.

4. Switch to the Finder and Launch FileMaker Pro.
5. Choose Open from the File menu in FileMaker Pro.
6. Open the supplied “Peak Shortcuts Template” FileMaker Pro template.
7. Choose Import Records from the File menu in FileMaker Pro.
8. In the pop-up menu at the bottom of the Open dialog in FileMaker Pro, choose Tab-Delimited.
9. Find the shortcuts text document you saved in step 3 and click Open.
10. FileMaker Pro will add the records to the database.
11. Use the Print option in FileMaker Pro’s File menu to print out your keyboard shortcuts. You can also sort the imported keyboard shortcut commands by description or shortcut. Consult your FileMaker Pro User’s Guide for more information on importing records, sorting records, and printing.

FileMaker Pro is not included with Peak.

The Toolbar

Peak allows you to select almost any Peak command for the Toolbar. The Shortcuts & Toolbar menu allows you to group together the functions you use most often, so that you can simply click a button instead of going to the menus. For example, if you frequently use Normalize and Pitch Change, you can choose to have the icons for these functions in the Toolbar, so that all you have to do to use one of them is to make an audio selection and click a button. The Toolbar is an easy way to make your work in Peak faster and more efficient, allowing you to customize the program to suit the way you work.

To add or subtract items from the Toolbar, use the Shortcuts & Toolbar item in the Preferences dialog. Toolbar selections are stored in a preference file called “Peak 5.0 Shortcuts” located in:

Users/UserName/Library/Preferences/.

To reshape and resize the Toolbar by clicking on the lower right corner of the Toolbar window and dragging to the desired shape and size. The Toolbar can be arranged horizontally, vertically, or as a “cluster” of buttons. Icons in the Toolbar can be sized anywhere between 16 x 16 pixels to 64 x 64 pixels.

To add a new icon to the Toolbar:
1. Choose Shortcuts/Toolbar Preferences from the Preferences dialog.
2. Scroll through the list of menu items, and click on the name of the Peak menu item you wish to have appear in the Toolbar.
3. Click on the “Place In Toolbar” checkbox to select the icon to add to the Toolbar. If there is no icon, the menu item cannot be placed in the Toolbar.

To remove an icon from the Toolbar:
1. Choose Shortcuts/Toolbar Preferences from the Preferences dialog.
2. Scroll through the list of menu items, and click on the name of the Peak menu item you wish to remove from the Toolbar.
3. Click on the checkbox to uncheck the item you wish to remove.

Customizable Toolbar is not supported in Peak LE

To resize icons in the Toolbar:
1. Choose Shortcuts/Toolbar Preferences from the Preferences dialog.
2. Move the Toolbar Icon Size slider to the left for smaller icons, or to the right for larger icons.
3. Close the Shortcuts/Toolbar Preferences dialog.

Conclusion
You now know how to create, open, import audio files, export, close, and save Peak documents. You also know how to set the preferences for operating Peak. The next chapter explains how to use your Peak software to record audio to disk.

Quitting Peak
When you have finished a project or wish to end an editing session, the Quit command allows you to quit Peak and return to the Finder. If you haven't saved changes, Peak will warn you before allowing you to quit.

To quit Peak:
• Choose Quit from the Peak menu (⌘-Q).

If you have made any changes to your document since the last time you saved, Peak will ask you if you want to save them. If you do, choose Yes; if you don't, choose No. If you change your mind and wish to continue your session, choose Cancel.

If you wish to close all currently open windows without saving, hold down the Option key and click Don't Save.
Chapter 4: Playback and Recording

Introduction

In this chapter you’ll learn how to play and record audio with Peak. Peak allows playback of many digital audio file formats, and can record any audio source that’s connected to your Macintosh. Playback and recording may be performed using either the built-in audio hardware in your Macintosh, or with a wide variety of third-party audio hardware interfaces (USB, FireWire, PCI, PCMCIA, etc).

Peak may also be used as a host for playing and recording virtual instrument plug-ins, recording soundtracks for QuickTime movies, and importing tracks from audio CDs.

Core Audio

Peak supports Apple’s Core Audio when using the Mac’s built-in audio hardware, as well as with third-party interfaces, such as those made by Digidesign™, Edirol™, M-Audio™, MOTU™, PreSonus™, Tascam™, and many others.

A list of many compatible audio hardware interfaces is available on the BIAS website:

http://www.bias-inc.com/support/hardware/

Please note that this list reflects interfaces that have been tested with Peak, and is updated regularly. If an interface is not listed here, it does not mean that it is not compatible with Peak. The general rule for hardware compatibility is, if a compatible Core Audio driver is provided by the hardware’s manufacturer, or Mac OS X natively supports the hardware device – Peak is compatible with it.

For Peak to work properly with third-party audio hardware devices, they must either be natively supported by Mac OS X – or, you will need to install a compatible Core Audio driver provided by the audio hardware manufacturer. Be sure to consult the audio hardware manufacturer’s instructions when installing & configuring your audio interface.

Using Core Audio is highly recommended. Using the Sound Manager (i.e., Mac OS X HAL or FireWire DV) settings is uncommon and is not addressed in this chapter. The only reason to record or play back audio using Sound Manager (Mac OS X HAL or FireWire DV) is because you are using a third-party audio hardware interface or other device (such as a DV camera) as an input or output device – that is not compatible with Core Audio. For more information on recording and playback using Sound Manager (Mac OS X HAL or FireWire DV) audio, please see Appendix 4.
Configuring Peak for Playback

Whether you are using the built-in audio hardware in your Macintosh, or a third-party interface, there are some basic configuration steps you must perform before playing back audio.

When launching Peak for the first time, a dialog appears asking whether you would like to configure your Audio/MIDI preferences. To quickly set up your audio hardware for the first time, click Yes.

To Configure Peak for Audio Playback:

1. If applicable, install/connect your third-party audio interface and its software according to the manufacturer’s instructions.
2. Reboot your Macintosh.
3. Launch the System Preferences, and choose Sound.
4. Select your third-party audio interface for Output.
5. Configure the audio interface’s own utility software or control panel (if one is included with your interface).
7. From the Audio menu, select Sound Out>Core Audio.
8. Select the Clock Source, Sample Rate, Play Through, and Sample Rate Converter Quality settings from the pop-up menus in the Core Audio Playback dialog. Click OK, or for further options, click the Hardware Settings button.

The Output section of the Sound Preferences

Hardware Settings: M-Audio Delta Control Panel

The Sound Out submenu under the Audio menu

Core Audio Playback dialog
Most audio interfaces can be adequately configured using the Apple Sound Preferences. Some more advanced audio interfaces may require additional configuration. In this case the Apple Audio MIDI Setup Utility may be used to configure your audio hardware. The Audio MIDI Setup Utility is installed in the following directory, located in:

/ Macintosh HD/Applications/Utilities/

9. Select the Input Device, Output Device, Buffer Size, and Input Level. Click OK to close the Core Audio Settings dialog, and click OK again to close the Core Audio Playback dialog.

![Core Audio Playback dialog]

![The Audio MIDI Setup Utility]

Playback Options

Various playback configurations are available within the Core Audio Settings dialog. Depending on the audio hardware you are using, you may need to configure these items with specific settings.

Clock Source Pop-Up Menu

This menu lets you choose the clock source for digital sync.

Sample Rate Pop-Up Menu

This menu allows you to choose the sample rate for playback. The default sample rate setting is “Auto”. Unless you specifically need to use another setting, this is best left set to “Auto”.

Play Through Pop-Up Menu

This menu lets you choose the channels on your audio interface that you wish audio to play out of. For example, if you are using a hardware interface with multiple outputs, you can select the appropriate outputs to route audio output through to your monitors/headphones.

Not all hardware devices allow control over the input level from within the Core Audio Settings dialog.

Peak is now configured for playback with Core Audio.

Chapter 4: Playback & Recording
Sample Rate Converter Quality Pop-Up Menu

Peak features on-the-fly sample rate conversion, used when playing back audio files with a sample rate not natively supported by the audio hardware being used. A setting of 1 gives the lowest quality sample rate conversion, and uses the least amount of CPU resources. A setting of 5 gives the highest quality, and uses more CPU power. Depending on your Macintosh system’s speed, you may need to experiment with this setting for the best performance.

Be aware that the setting used for Sample Rate Converter quality also affects the quality of Tape-Style Scrubbing. BIAS recommends using the highest setting possible that your computer system is capable of.

Output Device pop-up menu

This pop-up menu allows you to choose the desired audio hardware device to use for output, when more than one is available.

Buffer Size pop-up menu

This menu controls the buffer size used, and is directly related to the amount of latency that is encountered. It is recommended that you use the lowest possible setting that your computer is capable of. The easiest way to determine the lowest setting your computer is capable of is by doing test recordings – if you notice distortion, or dropouts in the recorded audio, you will need to use a higher setting. If you do need to raise this setting, it’s best to do it by one setting at a time, for example, if your system cannot handle using a 512k buffer size, raise it to 1024k and try again.

If your computer requires a relatively high buffer size for smooth recording, and you need to monitor your audio source, it is recommended that you set up your equipment to allow direct monitoring from a mixer, or from an audio interface that features direct monitoring. Direct monitoring will eliminate the problem of latency, in which you hear what is being recorded after a slight delay, which is directly proportional to the buffer size setting being used.

If you are playing virtual instruments and notice a significant delay from the time you play a note, and the time you hear it, you may want to experiment with lower buffer sizes, to reduce the latency to the lowest possible level that still provides smooth audio playback.

Core Audio Settings Dialog

Additional Core Audio options are available in the Core Audio Settings dialog, which may be accessed by choosing Hardware Settings from the Audio menu, or by clicking the Hardware Settings button in the Core Audio Playback dialog. These options include the following:

Input Device pop-up menu

This pop-up menu allows you to choose the desired audio hardware device to use for input, when more than one is available.

Input Level slider

The Input Level slider allows you to configure the input level prior to making a recording. This slider, and the input level slider in the System’s Sound Preference pane serve the same
purpose – adjusting it in Peak will affect the setting in the Sound Preference pane, and vice-versa. This slider is not compatible with all audio devices. If you are using an audio hardware device that is not compatible with the Input Level slider, it is normal for it to appear greyed out.

Configuring Peak for Virtual Instrument Playback

Peak supports VST and Audio Units format virtual instruments.

Virtual instruments may be played by clicking keys in Peak’s MIDI keyboard window, or by enabling keyboard MIDI control (uses your computer’s keyboard as a MIDI input), or by using an external MIDI keyboard.

To Configure Peak for Virtual Instrument Playback with Peak’s MIDI Keyboard Window:

- From the Window menu, select MIDI – Peak’s MIDI Keyboard window appears.

Active virtual instruments now receive input when keys in Peak’s MIDI Keyboard are clicked.

To Configure Peak for Virtual Instrument Playback with your Computer’s keyboard:

- From the Option menu, select Keyboard MIDI Input.

Active virtual instruments now receive input when keys on your computer’s keyboard are pressed.

Note that when a virtual instrument is active, audio documents will not play back unless the instrument is bypassed.

1. Connect a MIDI interface to your Macintosh and follow its installation/setup instructions. After you have configured your MIDI interface, launch Peak.
2. Open Peak’s Preference Panel>MIDI Preferences.
3. Select the desired MIDI device and click OK – then click the Save button to exit Peak’s Preference panel.

Active virtual instruments now receive input when keys on your MIDI controller are pressed.
More information on using virtual instruments is available in Chapter 8: Plug-Ins.

Playing Audio with Peak

Once you have finished the configuration steps in the previous section, you’re ready to start playing back audio files. The next section will familiarize you with the various controls and methods used to control file playback.

The Transport Controls

The Transport Controls that appear in the Transport window are useful tools for initiating both playback and recording. They function much like the controls on a tape recorder. As they appear below, from left to right, they are Return to Zero, Stop, Play, Go to End, and Record.

To start playback from the beginning of a document:
• Press the Spacebar, or click the Play button in the Transport. Playback begins from the beginning of the document.

To stop playback, press the Spacebar again or click the Stop button in the Transport.

To “rewind” playback to the beginning of a document:
• Click the Stop button twice, or click the Return to Zero button in the Transport. You can also press the Return key if playback has been stopped.

To start playback from a specific point in a document:
• Click the cursor at the desired location in the audio document and press the Spacebar on your computer keyboard. Playback begins from the cursor location and continues to the end of the document.

or:
• Double-click the mouse at the desired location in the audio document. Playback begins from the location that you double-clicked and continues to the end of the document.

or:
• Click anywhere in the Audio Waveform Overview to begin playback from that point.

• To stop playback, press the Spacebar.

Triggering Playback of Multiple Audio Documents

As explained earlier, Peak allows you to have multiple audio documents open at the same time. Peak assigns each of these documents a number based on the order in which it was opened. Peak provides you with a convenient way of triggering playback of any open audio document by pressing a number key on your computer keyboard. This can be a very useful feature for applications such as “live” sound effects playback, since you can open multiple audio documents and play them from your Macintosh keyboard.

To trigger sequential playback of multiple audio documents:
1. Open several audio documents, taking note of the number that Peak assigns them in the Window menu. (This is based on the order in which the documents were opened.)
2. Press the number which corresponds to the document(s) you wish to play. (Note: the numeric keypad will not work for this function, you must use the numbers at the top of the keyboard). You don’t need to wait until a document has finished playing to press the next number: typing a numerical sequence on your keyboard will “queue up” all of the corresponding files. They will then play in the order you choose.

3. If you wish to stop playback and jump to the next document in line, press the Return key. Peak initiates playback of the next document in sequence.

Playing Virtual Instruments

Peak supports VST and Audio Units format virtual instruments. Virtual instrument support in Peak offers a simple method for recording performances— and greatly expands the scope of Peak’s sound design possibilities.

To configure Peak to play virtual instruments, please see the section on Configuring Peak for Virtual Instrument Playback, earlier in this chapter.

To Play a Virtual Instrument with Peak’s MIDI Keyboard Window:

1. From the Window menu, select MIDI – Peak’s MIDI Keyboard window appears.
2. Open a virtual instrument.
3. Click a key in the MIDI Keyboard window to play a note.

To Play a Virtual Instrument with your Computer’s keyboard:

1. From the Option menu, select Keyboard MIDI Input.
2. Open a virtual instrument.
3. Press a key on your computer keyboard to play a note.

To Play a Virtual Instrument Playback using an External MIDI Keyboard:

1. Open the desired instrument (assuming you have already configured your MIDI equipment as described in the previous section).
2. Play a note on the MIDI keyboard.

Configuring Peak for Recording

To record in Peak via Core Audio, you will first need to have configured Peak for playback with Core Audio. Once Peak is configured for playback, you can open the Record Settings dialog and configure Peak for recording with Core Audio. The Record Settings dialog can be accessed from under the Audio menu (Option-R) as well as from the Toolbar.

To Configure Peak for Recording:

1. From the Audio menu, choose Record Settings.
2. Click the Device and Sample Format button – the Core Audio Record Settings dialog appears.
3. Select the input source to Record Through, the Sample Rate, Clock Source, Channels (Mono or

More information on using virtual instruments is available in Chapter 8: Plug-Ins.
Stereo), and Bit Depth.

4. Click OK.

Peak is now configured for recording with Core Audio.

**Recording Options**

Various recording configurations are available within the Core Audio Record Settings dialog. Depending on the audio hardware you are using, you may need to configure these items with specific settings.

**Record Through Pop-Up Menu**

This menu allows you to choose which inputs on your audio interface (the “source”) you wish to record through. For example, if you are using an audio interface with multiple inputs, you can designate the appropriate inputs.

**Sample Rate Pop-Up Menu**

The Sample Rate pop-up menu allows you to select the sample rate at which you wish to record. Some sample rates may not be available depending on the limitations of the audio card and its Core Audio driver. Please note that if you are recording from a digital source you will want to record at the same sample rate as your digital source. For more information on sample rates, see the Glossary.

*The “Auto” setting in the Sample Rate pop-up menu will record at whatever sample rate the device is currently set to. To record at a specific sample rate, it is best to choose the specific rate in this menu.*

**Channels Radio Buttons**

These radio buttons allow you to specify whether to record in mono or stereo format.

**Bit Depth Radio Buttons**

These radio buttons allow you to specify the desired bit depth for a recording. Please note that you will be limited to recording at bit depths that are supported by your audio hardware and its Core Audio driver. For more information on bit depths, see the Glossary.

*Be sure to set the Clock Source to digital in the Core Audio dialog if you plan to record via Core Audio from a digital source.*

**Record Settings**

When you select Record Settings from the Audio menu (Option-R) or Toolbar, the Record Settings dialog appears. This dialog is used to configure your settings for recording with Peak.

You will notice several pop-up menus, buttons, and checkboxes in the Record Settings dialog. These allow you to select which hard drive to record to, what file format you’d like to record in, as well as a number of other options (described below). You may also wish to record through plug-ins. The next few paragraphs describe how to set all of these parameters using the Record Settings dialog.
Record Disk Pop-Up Menu

The Record Disk pop-up menu allows you to choose which hard drive you would like to record to. If you have more than one hard drive connected to your Macintosh, use this pop-up to select your record drive. (This option will default to the largest drive currently available to your Macintosh unless you select otherwise.)

File Format Pop-Up Menu

The File Format pop-up menu allows you to select the file format for the audio being recorded. You may choose from AIFF or Sound Designer II. If you need the newly recorded audio file to be in a different format, you can always use the Save As function to save it as another format once recording is complete. If you do not select a file format for recording, Peak will default to AIFF.

Auto Gain Control Checkbox

The Auto Gain Control checkbox allows you to enable/disable the Automatic Gain Control feature used by the Sound Manager system with some Macintosh microphone inputs. If the recording device you are using supports this feature, and you wish to use Auto Gain Control, check the Auto Gain Control checkbox. It is normal for this checkbox to be greyed out (unavailable) when using Core Audio.

Monitor Checkbox

The Monitor checkbox allows you to monitor the audio throughput while you are recording.

Split Stereo Files Checkbox

The Split Stereo Files checkbox allows you to record the incoming stereo audio as dual mono files rather than a single stereo file. Dual mono files are used in programs like Pro Tools, or BIAS Deck, so this option is useful if you need to record dual mono files (i.e., split stereo).

Append to Document Checkbox

The Append to document checkbox allows you to record into an existing audio document. To record new audio into an existing document, place the insertion point in the existing audio document at the point where you want to insert the new audio. If the insertion point is at the beginning of the file, the newly recorded audio will be inserted at the beginning of the file. If the insertion point is at the end of the file, the newly recorded audio will be appended to the end of the existing file. If the insertion point is somewhere in the middle of the file, the newly recorded audio will be inserted at that point. If you make a selection of audio, the Append to document feature will allow you to replace the current audio with newly recorded audio from the beginning of the selection through the end of the document or wherever you stop the recording.

Record Timer Checkbox

The Record timer checkbox allows you to designate a specific duration for recording. Peak will stop recording after this set time and then open the Save dialog in order for you to save your recording. Checking the Record timer checkbox will bring up the Recording Time dialog. In the Recording Time dialog, designate the duration for recording in seconds and click OK. For example, to record for ten minutes, enter “600” in the Seconds field.
Open After Saving Checkbox

The Open after saving checkbox determines whether the audio document is opened in Peak after it is recorded.

Device and Sample Format Button

Clicking the Device and Sample Format button will open the Core Audio Record Settings dialog, where you can specify various recording options.

Hardware Settings Button

Clicking the Hardware Settings button in the Record Settings dialog brings up the Core Audio Settings dialog, where you can specify which hardware device to use (when multiple devices are connected to your computer), the buffer size, and the input level (if the device supports adjustable input level).

Multi-Document Recordings (Long Recordings)

If you plan to make long recordings with Peak, be aware that each individual audio document that Peak creates has a maximum file size of just under 2 gigabytes (1.99 to be precise). If a recording exceeds this length/file size, Peak automatically creates a new document and continues recording seamlessly. When a multi-document recording is finished, Peak will present multiple Save dialogs (one for each 2 GB file, or fraction thereof), so each document may be saved separately. The maximum recording length will vary depending on the number of channels used, as well as bit depth and sample rate. The maximum amount of disk space that can be used in multi-document recording is 10 GB, spread across five individual audio documents. This amounts to approximately 16.5 hours of continuous recording at CD quality settings (Stereo/16-Bit/44.1kHz). The recording settings you choose will affect how long a recording you can make.

For example, if you were to record 10 hours of audio at 16-Bit/44.1kHz, you would be using approximately 600 MB of disk space per hour. At this rate, after about 3.3 hours of recording, you would have used about 2 GB of disk space. When this 2 GB limit is reached, Peak would continue recording, but now into a new document – the first document is stored as a temporary file on the hard disk. After another 3.3 hours, another 2 GB file is created, and Peak continues recording into a third file. When we reach 9.9 hours, Peak begins recording into a fourth document – this one being the remainder, or .1 hours (6 minutes). When we stop Peak at the 10 hour mark, four consecutive Save dialogs would be presented, allowing the four pieces of this long recording to be saved. It's a good idea to develop a naming convention to address multi-document recordings, such as naming your files “Part 1/4”, “Part 2/4”, “Part 3/4”, “Part 4/4”, or something similar, that identifies each file as part of the whole recording.

When editing files created during multi-document recording, each one appears in Peak as a separate audio document.

Recording Audio

Once you have finished the configuration steps in the previous section, you’re ready to start recording audio. This section will familiarize you with the various controls and methods used to control file playback.
The Record Dialog

When you select Record from the Audio menu (⌘-R), Transport, or Toolbar, the Record dialog appears. There are transport buttons along the bottom to Start, Pause and Stop the recording, an Audio Source display that shows you the waveform as it is being recorded, and a Notepad window. There are also text displays showing you the sample rate, bit depth, and number of channels you selected in the Record Settings dialog, as well as the amount of time you have left to record on the selected Record Disk.

The Notepad feature in the Record dialog allows you to type in text descriptions, transcribe a recording, or type in comments called Notepad Cues at specific points during the recording of an audio document. The Notepad feature is available from the Record dialog and may be used once a recording starts.

If you enable the Notepad checkbox, you can create markers while recording. Each time you press the Return key, a new Notepad Cue (marker) is generated for the current recording time. You may then begin typing text to describe the audio recording at that time (i.e., naming the marker). When you hear the next significant event in the recording, press the Return key to create another cue, and so forth.

When you are finished recording, Peak will create markers in the audio document that correspond to each Notepad Cue you have entered. If you also enable the Notepad Regions, Not Markers checkbox, Peak will create regions during recording.

Notepad Cues are not available in Peak LE.

Configuring Peak to Record Through Effect & Instrument Plug-Ins

If you have plug-ins installed, you can record through them in real-time when using Core Audio. This is useful if you want to use a noise reduction, equalizing, or dynamics plug-in during recording. While recording through plug-ins, you are free to adjust plug-in parameters — however, be aware that you will be making permanent changes to the material that is recorded, and will not be able to undo these adjustments.

To configure Peak to record through Effects Plug-Ins:

1. From the Plug-Ins menu, open and configure the plug-in(s) you wish to record through.
2. Select Record Settings from the Audio menu. The Record Settings dialog will appear.
3. Check the Record Through Plug-Ins checkbox and click OK.
4. Select Record from the Audio menu (⌘-R) or Toolbar. You are now ready to record audio through the plug-in(s).
5. Be sure to disable the active effects plug-in(s) after you have made the recording. (If effects plug-ins are active when playing audio back, the signal passes through the
plug-in, and will double the effect of the plug-in on the signal, and will not give an accurate representation of the material being played back).

Peak can only record through plug-ins when using Core Audio.

You may want to monitor your recording. To do this, open the Record Settings dialog and check the Monitor On/Off checkbox.

Recording

Once you have configured Peak for recording, you may use the following directions to record audio from any source connected to your Macintosh.

To start recording:

1. Turn down the volume of your instrument or audio source.
2. Connect the instrument or audio source to the audio input jack on the rear of your Macintosh. If you are using third-party audio hardware device, use the connectors on this device; many audio devices have an external interface box which contains the input and output connectors, if this is the case, use these.
3. Choose Record Settings from the Audio menu (Option-R) or Toolbar, and configure the settings as described in the previous section. If you wish to listen to the audio being recorded, make sure that you have checked the Monitor On/Off checkbox in the Record Settings.
4. Select Record from the Audio menu (command-R) or the Record button in the Transport. The Record dialog will open.
5. Play your instrument or audio source. You should see the signal levels register on Peak’s Audio Meters in the Transport window.
6. Adjust the output of your audio source so that its signal registers relatively high on the meters but never hits top (indicated by the red Clip Indicators.). Remember to always leave 6 dB or so of headroom on the meters so that you don’t clip. Use the yellow and orange meter lights and red Clip indicators to help you make this adjustment.
7. Click the Record button in the Record dialog. You are now recording to disk. You should see the audio waveform begin to scroll in the Audio Source Display window.
8. To stop recording, click the Stop button. To pause, click the Pause button.
9. Once you have stopped recording, the Save dialog appears and prompts you to name the audio document. You must save the audio document to the same hard drive you selected in the Record Settings dialog. Enter a name and click Save. Peak automatically saves the document in the audio file format you selected in the Record Settings dialog. If you wish to later save the document in a different audio file format, use the Save As command.
When recording through an effects plug-in, be aware that you will not be able to undo this effect. If you are not satisfied with the recording, you will have to re-record. If you are unsure about recording through a plug-in, you may wish to record a dry signal, and apply the effect after you have saved the recording. This way, you can experiment with effect settings and commit to them only when you are satisfied.

Importing a Track from an Audio CD

If your Macintosh computer is equipped with a compatible CD-ROM drive, you can use Peak to import audio directly from an audio CD.

To import tracks from an audio CD:

1. Insert an audio CD in your CD-ROM drive.
2. Choose Import CD Track from the File menu or click the Import CD Track button in the Toolbar.
3. In the dialog that appears, select the CD track that you wish to import and click Mark. You may mark multiple tracks for import. If you wish to import all of the tracks on the CD, click on the Mark All button.
4. To name a selected CD track, click the Track Name button.

Recording into a QuickTime movie

Peak can record audio into a silent QuickTime movie. This is a useful feature for adding a soundtrack or voiceover to a QuickTime movie.

To Record into a QuickTime Movie:

1. Create a new stereo or mono document (from the File menu>New)
2. Open the movie
3. Open the Record Settings dialog, and check the Append to Document checkbox
4. Choose Record from the Audio menu (command R), or click the Record button in the Toolbar.
5. Click the Movie icon in the Record dialog.
6. Click the Record button in the Record dialog.
7. When finished recording, click the Stop button in the Record dialog.
8. Save the recording.
9. Choose Save As... and select QuickTime as the file format.
If you have iTunes™ installed, and your computer is connected to the internet – iTunes will automatically launch (unless it has been disabled in the Mac OS CD/DVD Preference pane) when an audio CD is inserted into the computer’s CD-ROM drive. iTunes default behavior is to automatically get the track names from the CDDB™ online CD database. Once a CD’s tracks are labeled, that information is available to any application that imports a track, including Peak. This is a convenient way to automatically name a CD’s tracks.

5. To select only a portion of the track, click on Set Import Times button or double-click on the track in the list. The CD Import Track Range dialog will appear.

![The Import CD Track Range dialog](image)

6. By adjusting the Start and End time controls in this dialog you can import the entire CD track, or a just specific portion of the track. You may also click directly on the timeline to adjust start and end points. Click Play to audition the CD track (or selected portion of the CD track). Click OK when you are happy with the selection.

7. Check the Open tracks after importing checkbox if you want the CD track(s) you are importing to open in Peak.

8. Click the Import button in the The Import CD Audio dialog to import the selected tracks and the Save dialog appears. Use the pop-up menu at the top of the dialog to navigate to the volume where you wish to save the audio file. Click Save to save the file to disk. Peak will save the file(s) in the AIFF audio format.

Making Audio Connections

While it is possible to listen to audio playback in Peak using a Macintosh’s built-in speaker or headphones, most people will prefer to listen through a better quality external speaker system.

It is very easy to set up audio connections between your Macintosh and a mixer or speaker system. Your exact setup will differ slightly depending on whether you are using the built-in sound input and output connectors on your Macintosh, or those of a third-party audio interface.

Using the Macintosh’s Built-In Inputs and Outputs

To use your Macintosh’s built-in audio inputs and outputs for recording and playback, do the following:

1. Turn down the volume on your playback system. Peak can be used with a variety of playback systems, including:
   - Headphones
   - A stereo receiver or amplifier and speakers
   - A mixer, amplifier, and a pair of speakers
   - A mixer and a pair of amplified (self-powered) speakers
   - A pair of amplified (self-powered) speakers, smaller versions of which are often called “multimedia” speakers.

2. Connect your audio source output to the Macintosh’s audio input connector. Your audio source can be one of a variety of devices, such as:
   - A cassette or DAT deck output
- A mixer output
- A stereo receiver line output (such as “tape deck record” output)
- An instrument line output (such as the output of a synthesizer or guitar preamp)

The Mac’s audio input and output jacks are standard stereo mini-plug (1/8-inch) connector. Most mixer, receiver, and amplified speaker inputs are equipped with XLR, 1/4-inch, RCA, or mini-plug jacks. To make the proper connection, you may need to use an adapter.

Some Macintosh models may not have a built-in sound input – in which case you will have to use a third-party audio interface for sound input.

For advanced users: Certain professional mixing consoles, DAT decks, or other audio sources may have a nominal output level of +4 dBu, whereas the Macintosh expects to see a nominal -10 dBV level. Be aware that you may need to adjust your mixer’s output levels accordingly to prevent overloading the Macintosh’s input; or alternately, you may need to use a “+4 to -10” line-matching transformer.

**Common connections when using the Mac’s built-in sound**

*Diagram shows connections via a mixer, which is not required – if connecting directly to speakers, use their volume control, or the volume control on your Macintosh.*

---

**Audio Input**
Receives input from any line-level audio source (mixer, amplifier, etc.)
Connects to Mac with 1/8” stereo mini-plug

**Audio Output**
Sends line-level audio signal out of Mac to headphones, mixer, amplifier, or self-powered speakers.
Connects to Mac with 1/8” stereo mini-plug

**Macintosh CPU**

**Mixer Inputs**
Receive audio input from Mac’s audio outputs.
Common types of input connections include 1/4”, XLR, or RCA – refer to your mixer’s documentation to see which you should use.

**Mixer Outputs**
Sends audio output to Mac’s audio input.
When recording an audio signal through a mixer, the Aux Outputs allow the computer to record the signal, while the mixer’s Main Outputs send the signal to the speakers/headphones, so you can monitor what you are recording.

**Speakers**
Monitor audio signals coming from Mac, or any other audio sources routed through the mixer – also allows monitoring audio signals being recorded into the Mac.

**Mixer Main Outputs**
Sends audio output to amplifier, or self-powered speakers.
Common types of output connections include 1/4”, XLR, or RCA – refer to your mixer’s documentation to see which you should use.

**Mixer Auxiliary Outputs**
 Sends audio output to Mac’s audio input.

---

Chapter 4: Playback & Recording
3. Connect your Mac’s audio output to your playback system’s input.

4. Connect your playback system’s output (typically an auxiliary or bus send) to your Mac’s audio input. Be very careful to avoid feedback loops (the audio signal feeds back into itself) when recording. Feedback can damage both your equipment and your hearing. The Monitor option in the Record Settings dialog should be disabled if monitoring a recording will cause feedback.

5. Raise the volume on your mixer or playback system. Your system should now be properly configured and ready for recording and playback.

**Third-Party Audio Interfaces**

If you have a Core Audio-compatible PCI, PCMCIA (CardBus), USB, or FireWire audio interface installed in your computer and wish to use its inputs and outputs, do the following:

1. Turn down the volume on your mixer or playback system.
2. Make sure that you have installed the third-party

---

**Common connections with a third-party audio hardware device***

- **Audio Input**: Receives input from any line-level or microphone-level audio source (connections will vary with different devices). Typically connects to Mac with RCA, 1/4", or XLR cables.

- **Audio Output**: Sends audio signal out of Mac to headphones, mixer, amplifier, or self-powered speakers. Typically connects to Mac with RCA, 1/4", or XLR cables.

- **Mixer Inputs**: Receive audio input from audio hardware’s outputs. Common types of input connections include 1/4", XLR, or RCA — refer to your mixer’s documentation to see which you should use.

- **Mixer Auxiliary Outputs**: Sends audio output to audio hardware’s input. When recording an audio signal through a mixer, the Aux Outputs allow the computer to record the signal, while the mixer’s Main Outputs send the signal to the speakers/headphones, so you can monitor what you are recording.

- **Mixer Main Outputs**: Sends audio out to amplifier, or self-powered speakers. Common types of output connections include 1/4", XLR, or RCA — refer to your mixer’s documentation to see which you should use.

- **Speakers**: Monitor audio signals coming from Mac, or any other audio sources routed through the mixer — also allows monitoring audio signals being recorded into the Mac.

*Diagram uses a PCI audio card as an example — other devices, such as USB or FireWire interfaces connect to the computer differently (i.e., USB/FireWire cable), but generally have the same types of inputs & outputs, and can be connected to mixers and other audio equipment in a similar manner.*
3. Install the Core Audio drivers (if required) for your audio interface according to the manufacturer’s instructions.

4. Connect your source’s outputs to the inputs of your audio interface.

5. Connect the outputs of your audio interface to the inputs of your mixer or playback systems.

6. Raise the volume on your mixer or playback system. Your system should now be properly configured and ready for recording and playback.

A typical mixer/computer configuration is to have the computer outputs go to channel inputs on your mixer and to have the auxiliary or bus sends from the mixer go to the inputs of the computer. Instruments you want to record may be plugged into other channel inputs on the mixer and routed out the auxiliary or bus sends on the mixer to be recorded by the computer. The mixer’s main outputs go to the amplifier/speakers.

Conclusion

You have now learned about how to configure Peak for recording and playback with Core Audio, and how to connect various types of audio equipment to your computer. You’ve also learned how to record and playback audio documents, and how to record through plugins, play & record virtual instruments, record into QuickTime movies, and to import audio CD tracks.

Now that you’re familiar with setting up your equipment to get audio into and out of Peak, continue along to the next chapter, where you will learn how to edit audio with Peak’s powerful set of digital editing tools.
Chapter 5
Editing
Chapter 5: Editing

Introduction

This chapter introduces you to the concept of digital audio editing. You will learn how to edit digital audio with Peak’s many powerful editing tools.

Editing Audio with Peak

Peak provides you with a powerful interactive, nondestructive environment for editing and manipulating audio. In this environment, not only are virtually all editing actions completely “undo-able” and “redo-able,” but they can be performed interactively while audio playback is engaged.

Interactive Editing

Interactive editing means that you can cut, paste, loop, and process audio with many of Peak’s DSP functions and plug-ins, even while playing back the very audio that you are editing. For example, you can start playback, cut a selection of audio and paste or insert it later in the document, and when Peak reaches the location of the inserted audio, it will play it as if it were there all along. This revolutionary capability makes Peak a supremely fast and flexible audio production tool that makes conventional recording and editing methods, such as analog tape and a razor blade, seem primitive and archaic by comparison.

Nondestructive Editing

Peak’s nondestructive editing capabilities mean that the edits you perform to an audio document do not permanently change the original source recording until you finally save the document. Thus, you can cut, copy, paste, fade in and out of, and otherwise completely change a recording, and still be able to return back to square one – the original untouched state of the recording – up until the time that you save the document to disk. At that time, all edits are permanently written into the document.

Unlimited Undo and Redo

As an editing session progresses, Peak maintains an internal list of the edits that you perform. Changes that you make to an audio document are not permanently applied to the file until you ultimately save it. This is what gives Peak its unprecedented unlimited undo and redo capability. Through the use of the Macintosh’s standard Undo and Redo commands, you can undo or redo your actions sequentially, or by using the Edits command, using a “playlist-style” editing event list. This is a very exciting technology that allows you to maintain complete creative freedom of choice – right up until the last moment before you save your project to disk.
The Audio Document Window

The heart of Peak's powerful editing capabilities is the audio document window. The audio document window provides you with a “window into sound,” allowing you to make good use of both your eyes and ears to perform extremely precise editing tasks. The audio document window gives you a time-domain representation of sound, that is, you see the amplitude of the sound over time.

An Audio Waveform

If you have never seen sound displayed in a visual format before, it may not be immediately obvious how to “read” an audio waveform. It is actually quite easy to navigate through a recording with a waveform as your road map. The peaks in the waveform are areas of high amplitude (loud spots). The valleys in the waveform are areas of low amplitude (quiet spots). If the audio material is music with a pronounced, regular beat, it is generally very easy to pick out where the beats are simply by looking for peaks. Using this information, and the guidelines given shortly in the “A Selection” section, you will be able to successfully locate and select a desired portion of the audio document and perform the edits that you wish. The cursor marks the current location, and also serves as an insertion point.

Peak 5’s improved waveform display gives an even more accurate representation of the digital audio signal than in previous versions, and provides more information about positive and negative phase.

Vertical Scaling

Peak allows you to control the vertical magnification of audio waveforms. This feature is useful if you are editing and viewing a document with very quiet audio material.

To increase the vertical scaling magnification:

• Hold the Control key down and press the Up Arrow key.

To decrease the vertical scaling magnification:

• Hold the Control key down and press the Down Arrow key.

Audio Waveform Overview

Peak provides an Overview display of the entire audio waveform along the top of the screen under the menu bar. This provides you with a convenient visual reference of the overall document when you are editing only a portion in the audio document window. The highlighted area in the Overview display shows the area of the audio waveform currently visible in the audio document window. If desired, you can hide the Overview display to allow the audio document window to occupy more of the computer screen.

To show/hide the Audio Waveform Overview:

• Select Show Overview in the Options menu (command-\). – a check next to this item indicates it is enabled, and the absence of a check means it is disabled (or click the disclosure triangle in the upper left corner of the audio document window).

A Selection

A selection is just what it sounds like: a portion of audio that you have selected by clicking and dragging with the mouse. You must select audio in order to perform an editing action on it. To make good selections for editing, the best rule of
thumb is to begin a selection just before a peak in the waveform and end it just after a peak in the waveform. In other words, try to make selections start and end in areas of low amplitude (“valleys” in the waveform).

It is also important, when possible, to begin and end a selection at a point where the waveform meets the zero crossing line (the center line through the waveform). This helps you avoid creating pops and clicks if you later cut or paste the audio, because the point at which the waveform meets the zero crossing is a point of no amplitude in the sound wave. Pops and clicks generally only occur if you make a careless selection and begin or end on a portion of the sound wave where the amplitude is high (where the waveform is high above, or far below the center point). Enable Auto-Snap in the Options menu, and select Snap To>Zero Crossings from the Action menu to have Peak nudge your selection to the nearest zero crossings automatically.

In addition to snapping to zero crossings in the audio waveform, Peak features a number of other Snap To options. These options allow a selection to be “snapped” to a preset number of samples, or to a custom selection length. Other Snap To boundaries include:

- Bars/Beats
- CD Frames (588 samples or multiple thereof)
- Sony PS2 Loop Boundaries (28 samples or multiple thereof)
- Microsoft Xbox Loop Boundaries (64 samples or multiple thereof)
- Custom Units (user-definable number of samples)

The Snap To units you choose will depend on the type of editing work you will be doing. Most users will probably use Zero Crossings or Bars/Beats for most musical applications. Multimedia and video game sound designers will especially appreciate these new options when producing audio for a particular delivery platform. For example, when creating audio loops and sound effects for a Playstation 2 video game, audio edits need to be made at increments of 28 samples in order to loop/play back smoothly in the PS2’s audio engine. By choosing the Snap To PS2 loop boundary setting, any edits that are made will automatically be made in units that will translate smoothly to the PS2’s playback system.

Once markers are placed in the waveform, they may need to be moved. By holding down the Shift key while dragging the markers the selected Snap To behavior will be applied, and the markers may be shifted slightly so as to conform to the selected Snap To format.

The Zoom In function helps you make very precise selections by letting you zoom in to a higher magnification and select exactly the portion of the waveform you desire. Also, once you have made a selection, you can adjust the beginning or the end of the current selection by holding down the Shift key and clicking with the mouse. Your selection will be shortened or lengthened accordingly.

**Channel Independent Processing**

To select only the Left channel, move the cursor over it and above the left channel’s waveform. The cursor will show a small “L” at the insertion point. To select only the Right channel, move the cursor over it and below the left channel’s waveform. The cursor will show a small “R” at the insertion point. You can process one channel of an audio document using most of Peak’s native DSP or third-party plug-ins.

Peak allows you to select and process the left and right channels of a stereo file independently, but you cannot edit (i.e., Cut, Paste, Delete, etc.) the left and right channels of a stereo file independently.
A Marker

A marker can be placed in a document to identify a point of importance. A marker appears as a line with a solid triangular base. Peak allows you to place markers into a document in order to mark a given location or Region in a document for later selection, navigation, or editing. Markers can be moved, named and renamed, “anchored” to a particular location on a waveform, and given other attributes. The use of markers is covered in greater detail later in this chapter.

A Loop

A loop refers to a section of audio that is bounded on either side by loop markers. In the illustration above, the area that falls between the loop markers “beg loop” and “end loop” is looped. Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file.

Audio Between Adjacent Markers

Audio between adjacent markers refers to a section of audio that is bounded by markers. In the illustration above, the area that falls between the Beat 1 and Beat 2 markers is audio between markers. (Note: A selection of audio between markers is different than an audio Region. Regions are described later in this chapter, as well as in Chapter 6, Playlists and Audio CD Burning.)

Audio Info Area

In the lower left corner of each Peak Audio Document is the Audio Info Area. The Info Area shows the maximum amplitude, sample rate, bit resolution, file format, and file size of the audio file.
Clicking on the Max dB section of the Audio Info Area will open the Change Gain dialog, so that you can change the gain for the entire audio file, or the current selection. For more information on the Change Gain DSP function, please refer to Chapter 7: DSP. Clicking on any other portion of the Audio Info Area will open the Audio Info dialog.

**Audio Info dialog**

Selecting Audio Info from the Options menu (⌘-I) – or clicking on the Audio Info area – opens the Audio Info dialog. The Audio Info dialog allows you to change the sample rate, duration, root key (for use in a sample playback instrument), and high and low key range. Note that by changing the sample rate, the pitch and duration of the audio will be affected. (To change the sample rate of an audio document without changing the pitch, use the Convert Sample Rate command from the DSP menu, or click on the appropriate Toolbar icon.) The Audio Info dialog is described in more detail later in this chapter, as well as in Chapter 11: Menus.

---

**Selecting Audio**

In order to perform any type of editing action on an audio document, first you must select the portion of the document that you wish to modify. Peak has several techniques for making and modifying selections.

### To make a selection with the mouse:

- Click the cursor at the desired start location in the audio document and drag to select the desired range.

### To extend or shorten a selection:

1. Make a selection with the mouse as explained above.
2. Hold down the Shift key and click on the end of the selection that you wish to modify.
3. Drag the mouse to extend or shorten the selection. When you are satisfied with the length of the selection, release the mouse.

### To select audio between two markers:

1. Hold down the Command key (⌘) and click anywhere in between two markers. (Markers are explained in detail in the next section.) Peak selects the audio between the markers.
2. If there are additional markers in the document and you wish to extend the selection to encompass other portions of audio that fall between the markers, hold down the Shift key and the Command key, and click between another two markers. The selection will extend from the originally selected audio to the audio that you just added.
3. Repeat as desired to navigate to and select additional audio between markers.

### To select audio between two markers with the Tab key:

1. Create markers at several locations in the document with one of the techniques explained in the next section.
2. Press the Tab key on your computer keyboard.
Peak selects the portion of the waveform that lies between the first two markers in the document.

3. Press the Tab key again to select the portion of audio between the next two markers. (If you hold down the Shift key while tabbing the selection through the audio file, you can append each successive space between markers to the current selection.)

4. Repeat as desired to navigate to and select additional audio.

To select all audio in a document:

- Choose Select All from the Edit menu or press \[command\]-A on your Macintosh keyboard.

Markers & Selections as Navigational Aids

The presence of Regions, loops, or markers — and selected portions of the waveform can be very helpful in navigating through an audio document.

When markers are present, the Tab key on your keyboard may be used to select the audio between markers. Pressing the Tab key again selects the next space between markers — when Peak reaches the end of the document, it will “wrap” back to the beginning. Using the Option & Tab keys together will select the spaces between markers in the opposite direction.

This keyboard shortcut makes it very easy to navigate to specific areas, for example: Imagine you are working with a recording of an LP, and have placed a marker in the space between each song (the silent area). To quickly navigate to the beginning of song 5, simply press the Tab key five times, and then press the up arrow key on your keyboard — this would select the space between markers that bound the fifth song, and the up arrow key would locate Peak’s cursor to the beginning of the selection.

Many other useful tips can be found in Appendix 2: Peak Actions.

Auditioning Audio

It is often useful to audition a selection along with just a bit of audio preceding or following it — without actually including this material in the selection itself. Peak’s Auditioning command allows you to do this by specifying a desired amount of pre-roll or post-roll when you play the selection.

To audition audio with pre-roll or post-roll:

1. Choose Auditioning from the Preferences panel — the Auditioning Preferences dialog appears.

2. Enter the desired amount of pre-roll and post-roll and click OK.

3. Click the cursor in the audio document and drag to select the desired range.

4. Press \[command\]-Spacebar — Peak plays the selection, adding the specified amount of pre- and post-roll.

Scrubbing

Peak offers a number of ways to scrub audio, these are described below.

Dynamic Scrubbing

Peak provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for precisely pinpointing and selecting a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. When you have found the location you are looking for, you can commence editing. Peak allows you to choose the length of this playback loop with the Dynamic Scrub Time command in the Options menu. Peak provides two types of dynamic scrubbing: dynamic shuttle scrubbing and dynamic jog scrubbing. Both are described below.

**To select a loop duration for dynamic scrubbing:**

- Choose Dynamic Scrub Time from the Options menu, and choose a duration from the hierarchical submenu. Typically, values between 40 and 80 milliseconds work well.

3. To make a selection starting at the current scrub point, stop scrubbing, hold down the Shift key, and click the mouse to extend the selection from the insertion point to the desired end location.

### Jog Scrubbing

Peak provides a variation of the dynamic scrubbing feature, which is similar to a technique known in recording studios as jog scrubbing. With this technique, Peak actually engages playback and moves through the file at its normal pace, but allows you to control the playback point by dragging the mouse. You can control the direction (forward or backward) of playback by dragging the mouse forwards or backwards. This scrubbing mode affords a greater degree of control when you are “zoomed out” in the audio document window.

**To use dynamic “jog” scrubbing:**

1. Hold down the Control key and Option key and drag the mouse across a portion of the waveform in an audio document window. As you drag the mouse, Peak engages playback while it loops a short portion of the audio at the insertion point. Dragging the cursor farther away from the current insertion point increases the velocity of scrubbing.

2. Release the mouse button to stop scrubbing. The insertion point will be exactly where you left off scrubbing.

3. To make a selection starting at the current scrub point, stop scrubbing, hold down the Shift key, and click the mouse to extend the selection from the insertion point to the desired end location.

Since jog scrubbing mode is engaged by pressing the Option key in combination with the Control key, it is possible to toggle back and forth between jog and shuttle modes simply by pressing or releasing the Option key.
Tape-Style Scrubbing

In addition to dynamic scrubbing feature, Peak provides high resolution tape-style scrubbing. To enable tape-style scrubbing, set the Dynamic Scrub Time under the Options menu to Tape-Style.

To start tape-style scrubbing:
- Hold down the Control key on your keyboard, and then click and drag the mouse at the location in the waveform where you wish to begin scrubbing.

To deactivate tape-style scrubbing:
- Release the mouse and Control key.

To control "tape" speed in tape-style scrubbing:
1. As you drag the mouse towards the right, scrubbing speed will increase.
2. As you drag the mouse toward the left, scrubbing will slow down.
3. If you drag the mouse to the left of the point where you started scrubbing, the scrub direction will change from forward playback to backwards playback.

The top of the playhead cursor will display the scrubbing speed, which can vary from +/- 2.25 times the original speed.

Using Unlimited Undo and Redo

Peak maintains an internal list of the edits that you perform during the course of an editing session. These changes are not permanently applied to the file until you save it. This gives Peak unlimited undo and redo capability. Through the use of the Macintosh’s standard Undo (⌘-Z) and Redo (⌘-Y) commands, you can undo and redo your actions sequentially; or by using the Edits command, using a "playlist-style" editing event list. This powerful capability allows you to maintain complete creative freedom of choice — right up until the last moment before you save your project to disk. The only limitation in using Redo is that if you insert a new action when a redo action is available, you will no longer be able to redo. Remember, as soon as you perform an editing action other than Undo in Peak, Redo is no longer available.

To undo an action:
1. Perform an edit (such as cutting audio or moving a marker).
2. Choose Undo from the Edit menu (⌘-Z) or Toolbar. The action is undone.
3. You can continue undoing actions until you return to the original state of the audio document (the state at which it was last saved). When there are no actions left to undo, the Undo menu item will appear grayed out.

To redo an action:
1. If you wish to redo the action that was undone, choose Redo from the Edit menu (⌘-Y) or Toolbar. The action is redone.
2. You can continue redoing actions until none are left to redo. When there are no actions left to redo, the Redo menu item will appear grayed out.

Using the Edits Command to Undo a Series of Actions

Peak’s Edits command provides you with a second unique and powerful method of undoing virtually
any number of editing actions performed on an audio document since you last saved it. You can think of the Edits command as an “event-based” listing of all your editing actions since you last saved. Using this list, you can navigate back in time to the point at which you performed a particular edit, and if you wish, undo it. Once you have returned to an earlier state in the project, you are free to start editing from that point on.

The Edit history list is available in two locations – one is in the Edits dialog, located under the Edit menu.

To use the Edits dialog to return to or undo an action:

1. Perform several edits. (Don’t use the Save command or you won’t be able to undo any edits that occurred before you saved.)
2. Choose Edits from the Edit menu. A dialog appears listing the edits you have performed since you last saved the document.
3. In the list, double-click on the description of the action you wish to return to (or select an action and click the Revert to Item button). Peak returns the document to the state it was in at the time of that edit.
4. When you have finished, click Done.

The other location where the Edit history may be accessed is in the Audio Document Window’s Contents Drawer.

To use the Edits list in the Contents Drawer to return to or undo an action:

1. Perform several edits. (Don’t use the Save command or you won’t be able to undo any edits that occurred before you saved.)
2. From the Window menu, choose Toggle Contents Drawer (F6), and click the Show History button in the lower right portion of the drawer – a list of edits you have performed since you last saved the document appears.
3. In the list, double-click on the description of the action you wish to return to. Peak returns the
document to the state it was in at the time of that edit.

4. When you have finished, click Done.

---

**Essential Editing Functions**

Peak supports all of the Macintosh’s essential editing functions such as cut, copy, and paste and provides several more specifically designed for audio editing. This section explains how to use each of these functions.

Because Peak allows you to have multiple audio documents open at the same time, it is possible to conveniently cut, copy, paste, and insert audio between documents. This makes combining material from several audio documents very fast and easy.

**Scratch Disks**

Because audio data can be very large, Peak utilizes a portion of your hard disk’s free space to hold audio data that has been cut or copied, as well as for temporary or “scratch” files for undo purposes. If you have more than one hard drive attached to your Macintosh, the Scratch Disks section of the Preferences panel allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose — ideally you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the Allow Servers checkbox (that is if you have a very fast server connection). Any available servers will then appear in the Scratch Disks pop-up menu. This is recommended only if you have access to a high-speed ethernet, or other fast server.

---

**Clearing the Clipboard to Reclaim Disk Space**

If you no longer need the clipboard contents, you can free up the disk space occupied by the clipboard by choosing the Clear Clipboard command from the Edit menu.

**Cutting Audio**

The Cut command (\(\text{command-X}\)) allows you to cut a selected range out of an audio document. Audio that occurs after the cut slides over to fill in the gap. By cutting and pasting “pieces” of audio, you can freely rearrange material in an audio document. This can be a powerful tool for creating audio remixes for music-oriented applications, as well as an indispensable tool for general sound design tasks. When you cut a selection, the Macintosh holds the cut audio data in its internal memory (the Clipboard) in case you wish to paste it elsewhere. Because all real-time editing you do with Peak is nondestructive, the audio isn’t actually removed from the original audio document until you finally save the file to disk with the Save command. At that time, all edits are saved and any changes that you have made are permanently saved to the audio document.
To cut a selection:

1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Cut from the Edit menu (§X) or Toolbar.
3. The selected range is removed from the audio document(s) and held on the Clipboard. Audio occurring after the cut slides over to fill in the gap.

Deleting Audio

If you wish to remove a section of audio from an audio document without using the Cut command, you can use the Delete key, or the Delete button on the Toolbar. As with the Cut command and other editing functions, the audio isn't actually removed from the original audio document until you save the file to disk.

To delete a selection:

1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Press the Delete key, or click the Delete button on the Toolbar.
3. The selection is removed from the audio document. Audio occurring after the deleted section slides over to fill in the gap.

Copying Audio

The Copy command (§C) copies the current selection to the Macintosh’s Clipboard (or internal memory buffer) so that you can paste it, insert it, or use it with optional “Clipboard-based” processing such as Add, Convolve, Mix, Modulate, and ImpulseVerb. As with the Cut command, copying and pasting “pieces” of audio, allows you to freely rearrange material in a document. This can be a powerful tool for creating audio remixes for music-oriented applications, and is an indispensable tool for sound design.

To copy a selection:

1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Copy from the Edit menu (§C) or Toolbar.
3. The selection is copied to the Clipboard.

At this point, you can use the Paste, Insert, or Duplicate commands to place the copied audio into an audio document. Each of these commands is explained below.

Pasting Audio

The Paste command (§V) allows you to paste the contents of the Clipboard into a location that you choose by placing an insertion point. Pasting audio deletes any selected audio and inserts the clipboard audio at the insertion point. Blending can be used with the Paste command if you have made a selection – the pasted audio will be crossfaded with the audio on either side of the selection according to the Blending Envelope and Blending Envelope Duration settings.

By cutting and pasting pieces of audio, you can freely rearrange material in an audio document. In musical applications, this gives you the freedom to entirely “rewrite” compositions by changing the order of things, repeating desired sections, and so on. In sound design applications, this gives you the power to “compose” with sound by creating audio collages.
To paste audio into an audio document:

1. Click the cursor at the point where you wish to paste the audio data in an audio document or make a selection of audio you want to delete and replace with the contents of the clipboard.

2. Choose Paste from the Edit menu (⌘-V) or Toolbar.

The Clipboard contents are pasted into the audio document(s), beginning immediately after the insertion point. Any selected audio at the location of the paste is overwritten when the pasted data is inserted into the audio document.

Replacing Audio

The Replace command allows you to paste audio data over existing audio – to paste audio into an audio document without pushing all data to the right of the insertion point farther to the right (later in time) to accommodate the newly pasted audio. The Replace command is useful for “laying over” a portion of audio while maintaining the timing of the original document.

To replace audio into an audio document:

1. Click the cursor at the point where you wish to replace the audio data in an audio document.

2. Choose Replace from the Edit menu or Toolbar. All data to the right of the replaced audio maintains their time position.

Inserting Audio

The Insert command (⌘-D) allows you to paste audio data into an audio document without overwriting any existing data at the insertion point. When you paste data with the Insert command, all data to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio. The Insert command is one of Peak’s most useful tools for restructuring the contents of an audio document. It is particularly good for “composing on the fly” since it allows you to cut and insert pieces of audio – musical phrases, riffs, or simply textural sounds – to create a composition or soundscape.

To insert audio into an audio document:

1. Click the cursor at the point where you wish to insert the audio data in an audio document.

2. Choose Insert from the Edit menu (⌘-D) or Toolbar. All data to the right of the insertion point is pushed farther to the right (later in time) to accommodate the newly pasted range.

Duplicating Audio

The Duplicate command has a number of different behaviors, depending on whether you are working in an audio document or in a Playlist. The behavior in Playlists is covered in Chapter 6: Playlists – this section covers the behaviors of the Duplicate command in audio documents.

If no selection is made when this command is invoked, the Duplicate command allows you to paste multiple copies of audio data into an audio document without overwriting any existing data at the insertion point. When you paste data with the Duplicate command, all data to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio. The Duplicate command allows you to specify how many times you would like to Duplicate the audio data contained in the clipboard. The Duplicate command is very useful for creating longer audio documents that need to repeat a
certain piece of audio, such as creating a 4 bar drum loop out of a 1 bar drum loop.

**To Duplicate audio:**

1. Select a range of audio, and choose Copy from the Edit Menu (⌘-C).

2. Click the cursor at the point you wish to insert duplicate copies of the audio selected in step 1.

3. Choose Duplicate from the Edit menu.

4. Use the Duplicate slider to indicate how many copies should be inserted, or type in the number of desired copies.

5. Click the OK button. All data to the right of the insertion point is pushed farther to the right (later in time) to accommodate the newly pasted range.

If there is a selection in the waveform when the Duplicate command is invoked, then Peak automatically fills the selection with the Clipboard contents. Peak determines how many times the Clipboard contents must be duplicated in order to fill the selection. If the selection is not evenly divisible by the duration of the Clipboard contents, Peak includes a fraction of the Clipboard contents to make the duplication completely sample accurate to the original selection.

**To Duplicate audio to fit a Selection:**

1. Select a range of audio, and choose Copy from the Edit Menu (⌘-C).

2. Select a range of audio that will be the “target”, and will be filled with the Clipboard contents.

3. Choose Duplicate from the Edit menu – Peak fills the selection with as many copies of the Clipboard contents as possible, and fraction of Clipboard contents if there is not enough space left in the selection for another duplicate of the full Clipboard contents.

**Cropping a Selection**

The Crop command (⌘-`) allows you to make a selection in an audio document and quickly remove all other audio from the audio document except the selection. The Crop command is a particularly useful tool for editing material to be used as samples or sound effects, since it allows you to isolate and save just the desired portion of a recording.

**To crop a selection:**

1. Click the cursor at the desired location in the audio document and drag to select the desired range.

2. Choose Crop from the Edit menu (⌘-`). All audio but the selection is removed from the audio document.

**New Document from Selection**

The New Document from Selection command will automatically create a new Audio Document containing the selected audio from the source document.

**To create a new document from a selection:**

1. Make a selection in any open audio document that you want to have as its own document.

2. Choose Document from Selection from the New submenu under the File menu (Control-N).

3. A new audio document will be created with the selected audio.
Silencing a Selection

The Silence command (⌘-E) replaces the selected portion of an audio document’s waveform with silence. This feature is very useful for silencing nonessential portions of a recording that contain an unusual amount of noise. This can be used very successfully with spoken material such as dialog or narration to remove noise between words or during pauses in speech. It can also be used to remove pops or clicks that occur in such material.

To silence a selection:

1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Silence from the Edit menu (⌘-E) – the selected audio is replaced with silence.

Inserting Silence into a Document

The Insert Silence command allows you to insert a specific amount of silence into an audio document at the current insertion point. This feature is very useful for inserting pauses of a desired duration into a recording, and can be particularly useful in adjusting the timing or rhythm of spoken material such as dialog or narration. When you choose this command, Peak will prompt you to enter the amount of silence you wish to insert. You can enter this value in samples, milliseconds, or seconds. All audio occurring after the insertion point is moved later in time by the amount of the silence that you insert.

To insert silence of a specific duration into a document:

1. Click the cursor at the desired location in the audio document.
2. Choose Insert Silence from the Edit menu.
3. In the dialog that appears, enter the amount of silence that you wish to insert into the audio document – Peak inserts the specified amount of silence into the document.

Repairing Clicks & Pops

Clicks & pops are common artifacts in digital audio – they occur in various ways, such as: performing cut/copy/paste-type edits at non-zero crossings in the audio waveform, recording vinyl records, faulty recording equipment or cables, digital sync problems, etc. There are two main categories of clicks that Peak’s tools can repair.

Analog clicks – such as those found in digital recordings of vinyl records – are caused by scratches or other surface imperfections on a record. This type of click usually appears in the audio waveform as an abrupt, jagged anomaly.
Digital clicks are generally caused by digital sync problems with audio hardware interfaces, bad digital cables, or recording with improper buffer settings. This type of click generally has a square shape to it.

Peak's Pencil Tool can repair either type, though in the case of digital clicks you may want to use the Repair Click and Repair Clicks DSP tools, which are specifically designed for this purpose (more information on Repair Click and Repair Clicks is available in Chapter 7: DSP).

In either case, to use the Pencil Tool, you must be zoomed in to sample level (sample level being the first zoom level at which you can see individual audio samples) or beyond. Additional information on settings for the Pencil Tool is available in Chapter 3: Peak Basics.

To repair a click with the Pencil Tool:

1. Locate a click in the audio waveform — it will appear as an abrupt “spike”.

2. Place the insertion point/cursor directly over the click.

3. From the Action menu, select Zoom to Sample Level — you should now be able to see the individual samples that make up the click.

4. In the tool area of the audio document window, select the Pencil Tool.

5. Click into the waveform, and “draw” across the anomaly, trying to approximate the shape of the waveform on either side of the click. When you have repaired the click, don’t forget to switch back to the Arrow Cursor.
It is useful to place a marker over a click, and then zoom in to repair it using the Pencil Tool. Markers are covered in detail later in this chapter. When you are zoomed in to allow viewing the waveform in detail, it is very easy to scroll past a click—having a marker in place makes it easy to locate the click, should you lose your place.

Show Edits

When you enable the Show Edits command, Peak indicates areas of an audio document that you have edited by enclosing these areas with hatched lines. This provides you with a convenient visual reference to portions of the document that have been affected by your editing actions. Once you save a document, the edits are saved, and these indicators will no longer appear.

To Enable Show Edits:

- Choose Show Edits from the Options menu. A check next to this item indicates it is enabled.

To Disable Show Edits:

- Choose Show Edits again from the Options menu. The absence of a check next to this item indicates it disabled.

Using Crossfades and Blending to Smooth Edits

Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document where they are modified by cutting, deleting, pasting, or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you are going to edit (i.e., Cut, Paste, Delete, etc.) a document, you may wish to enable blending to smooth things out a bit. You can toggle blending on or off by clicking the Blend enable/disable button in the audio document window, or by pressing the Caps Lock key on your keyboard.
Be aware that Blending can interfere with certain DSP processes available under Peak’s DSP menu, such as Fade In/Out and Normalize. You will typically only want to enable Blending only when you intend to make an edit in which Blending may be desirable.

**To enable blending:**

- Click the blending button in the audio document window, or press the Caps Lock key on your keyboard. The blending button will light up in blue when blending is turned on.

**To disable blending:**

- Click the blending button in the audio document window, or press the Caps Lock key on your keyboard. The blending button will not be illuminated when blending is turned off.

**To set blending parameters:**

1. Choose Blending in Peak’s Preferences panel.
2. Enter a value in milliseconds in the Duration field. Peak will apply a crossfade of this duration across the edit.
3. If you wish to edit the shape of the crossfade that the blending function applies, click the Edit Blending Envelope.
4. Peak’s Crossfades are calculated logarithmically to preserve volume levels for crossfaded material. If you want Peak to calculate the Blending Crossfade linearly, check the Linear Blend Calculations checkbox.
5. Click OK when you have finished.

**To quickly access the Blending Envelope editor:**

- Press the Option key while clicking the Blending button in the tool area at the upper right of an audio document window.

**To select and edit the blending envelope:**

1. Choose Blending in Peak’s Preference panel and click the Edit Blending Envelope button. The Blending Envelope Editor appears. The envelope shape shown here represents the shape of the crossfade. Peak also comes with several commonly used preset envelopes that appear in the pop-up at the top of all of Peak’s Envelope Editing windows (see also Editing a Fade In/Out Envelope). These are stored in the Peak Envelopes folder in the Preferences folder of your home directory.
2. Click anywhere on the line and a new moveable “breakpoint” will appear.
3. Drag the breakpoint to the desired location.
4. Continue creating and dragging breakpoints until you have created the envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.
5. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.
6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

If you save your custom blending envelope into:

/MacintoshHD/ Users/ <YourUserAccount>/ Library/ Preferences/ Peak Envelopes/

it will automatically appear in the Envelope pop-up menu in the Blending Envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope until you change it again.

Note that the Blending Envelope will only be applied to an edit if it is configured prior to making the edit.

If Linear Blend Calculations is checked in the Blending dialog, the Equal Power X-fade envelope is very effective for a smooth crossfade that will not result in a dip in the energy of the audio data.

Creating Fade Ins and Fade Outs

Peak allows you to create fade ins or fade outs at any point in an audio document. Fade ins/outs can be very useful for smoothly fading in or out of an audio document, or for fading out of one type of audio material into another. Very short fade ins can also be useful for smoothing or removing clicks and pops in a recording. Peak allows you to control the exact “shape” of the fade in/out by providing you with preset envelope shapes as well as very precise user-definable envelope controls for the fade. Peak also comes with several commonly used preset envelopes that appear in the pop-up at the top of the Envelope Editing windows. These are stored in the Peak Envelopes folder in your Peak folder.

To create a Fade In:

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade In will be applied to the audio within this selection.

2. Choose Fade In from the DSP menu, or click the Fade In button in the Toolbar. Peak applies the Fade In to the selection you have made in the audio document.

3. To hear the completed Fade In, press Option-Spacebar. You will hear the selected audio complete with your Fade In.

To create a Fade Out:

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade Out will be applied to the selected audio.

2. Choose Fade Out from the DSP menu, or click the Fade Out button in the Toolbar. Peak applies the Fade Out to the selection you have made in the audio document.

3. To hear the Fade Out, press Option-Spacebar. You will hear the selected audio complete with your Fade Out.

Editing a Fade In/Fade Out Envelope

Peak allows you to control the exact shape of Fade Ins/Outs by providing you with controls for editing the Fade In/Out envelope. These are found in the Fade In
Envelope and Fade Out Envelope sections in the Preferences panel.

To edit and save a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope) from the Preferences panel. The Fade Envelope Editor appears. The envelope shape shown here represents the shape of the fade, and overlays the selected audio to show where the curve is graphically applied to the waveform representation of the audio.

2. Click anywhere on the line and a new moveable “breakpoint” will appear.

3. Drag the breakpoint to the desired location on the envelope’s curve.

4. Continue creating and dragging breakpoints until you have created the fade envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

5. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.

6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope every time you apply a Fade In (or Fade Out) until you change it again.

---

If you save your custom Fade In/Out envelope into:

/MacintoshHD/Users/<YourAccount>/Library/Preferences/Peak Envelopes/

it will automatically appear in the Envelope pop-up menu in the Fade In/Out Envelope editor.

---

To quickly access the Fade Envelope editor, press the Option key while clicking the Fade In/Out buttons in the toolbar, or while picking these commands from the DSP menu.

---

Note that the Fade In/Fade Out Envelope will only be applied to a selection if it is configured prior to applying the Fade In/Fade Out DSP function.
To load a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope) from the Preferences panel. The envelope editor appears.
2. Click the Load button.
3. In the dialog that appears, locate and select the fade envelope that you desire, and click Open.
4. Click Change to confirm this new envelope and close the envelope editor. Peak will use this envelope until you change it again.

Creating Markers

The next few pages describe in detail the various ways to create markers – by dropping them “on the fly” during playback, inserting them during recording with Notepad Cues, defining them with the mouse when playback is stopped, creating markers using the Threshold DSP command, or using the Markers from Tempo command to insert multiple markers at regular intervals. Of the various ways to create markers, the mouse method is perhaps the more precise. However, since it is possible to fine tune the location of a marker at any time by dragging it, (or by using the Edit Marker dialog, explained later) all methods work equally well – the method you choose to insert markers will depend largely on the task at hand.

Creating and Using Markers

Peak has a very powerful set of features to control the placement and modification of markers. Markers are locations in an audio document that you define as important. By marking specific locations in a recording, you can navigate easily to a location for selection, editing or playback purposes.

Markers can also be made into loops. Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file. Loops are covered in detail later in this chapter.

A marker in the Waveform Display

Remember that if Auto Snap is enabled the insertion point will snap to the nearest selected Snap To unit. This will cause your marker to be placed at the nearest Snap To unit when you use the mouse to create or place a marker.

Once you have created a marker, you can assign or edit the marker’s attributes in the Edit Marker dialog. Double-click the triangular base of the marker to open the Edit Marker dialog.
You may wish to give markers meaningful names (up to 256 characters long) based on their locations in an audio document. Peak gives markers default numeric names based on the name of the audio document and the order in which the marker was defined. To name or rename a marker, simply type the new name in to the Text field of the Edit Marker dialog.

You can easily find any marker, Region, or loop that you have named by simply typing the first few letters of its name. For example, if you want to locate a marker called “Solo,” just type the letters “s”-”o”-”l”, and Peak will automatically scroll to the marker called “Solo.” If you hit Enter or Return after typing the characters, Peak will also automatically place the insertion point at that marker. If more than one marker matches the letters you type in, Peak will locate the first marker with that name. (Note that numerical marker name entries will only work from the keypad, not the numbers keys along the top of your keyboard.)

If you re-name the first marker in a document to “1” — then all subsequent markers will be automatically named “2”, “3”, “4”, and so on. You can then quickly locate to the desired marker by typing its number on the numeric keypad (the numbers at the top of the keyboard serve another purpose) and pressing Enter.

Marker Position

The Marker Position field allows you to move a marker to a specific time location in an audio document by entering the desired value. The pop-up menu to the right of this field allows you to choose a time format (samples, Minutes:Seconds:Milliseconds, etc.) for the value that you enter in the Marker Position field.

Marker, Loop Start, and Loop End

These three radio-style buttons allow you to define whether the marker is a regular marker or a loop marker. If you choose to designate the marker as loop marker, you can define it as either the loop start or the loop end by clicking on the corresponding radio button.

Anchor To Sample Checkbox

When you insert or delete audio that is near a marker, you may want the marker to move with that particular location on the waveform. This will compensate for the insertion or deletion, so that the marker remains with the particular portion of audio you want it to be associated with. By enabling the Anchor feature for a marker, you can assure that Peak will “tie” the marker to a location on a waveform, causing it to stay with that location even when audio is inserted or deleted into the document. By default, Peak enables this feature for markers, loops and Regions.

Be a Reference Marker Checkbox

By defining a marker as a reference marker, you can use the marker as a reference when you make selections or move other markers. Selecting or dragging the marker will then automatically display the distance to the closest reference marker in whatever time format (Samples or Seconds) is currently selected in the Peak application. This may be useful, for instance, if you know that you want a particular sound event (such as a car door slam) to happen a certain number of seconds before or after another sound event (such as a tire squeal).
Deleting Markers

The Delete Marker button allows you to remove the currently selected marker from an audio document.

The following section explains how to create markers and define their attributes.

To create a marker when playback is stopped:

1. Click the mouse at the desired location in the audio document – a dotted vertical line appears, indicating the insertion point.
2. Press `/command`-M on your computer keyboard or choose New Marker from the Action menu or Toolbar – Peak places a marker at that location.

To create a marker during playback:

2. At the desired point during playback, press `/command`-M on your computer keyboard. Peak will drop a marker at that location.
3. Repeat as desired as playback continues. Each marker will appear at the appropriate location in the audio document window.

To create a marker during recording:

1. Open the Record dialog.
2. Check the Notepad checkbox.
4. Press the Return key to place a marker – then type a name for the marker. To place another marker, press the Return key and type a name for the second marker, and so on.

Pressing the Return key first, and then typing the marker’s name ensures that markers are placed accurately – for instance, if an error was made when typing in the marker’s name, it might take longer than anticipated to enter the corrected name, and the marker would be placed later in time. By pressing the Return key first, and then typing the name, you can be sure that the marker is placed in the correct location.

To create a marker using dynamic scrubbing:

1. Hold down the Control key (or Control-Option for jog-type scrubbing) and drag the mouse across the desired location to scrub playback.
2. At the desired point during playback, release the mouse to stop scrubbing.
3. Press `/command`-M on your computer keyboard. Peak will drop a marker at that location.

To name a marker or set other marker attributes:

1. Double-click on the triangular base of the marker that you wish to edit. The Edit Marker dialog appears.
2. Enter a name for the marker.
3. Change other attributes of the marker as desired. For an explanation of each of these attributes, refer to the beginning of this section.
4. When you have finished, click OK to close the Edit Marker dialog – the marker now has the attributes you selected.

or:

• You may also open the audio document’s Contents...
Drawer and click the desired marker’s name — it will become editable text and can be re-named. When you press the Return key, the marker’s name is updated.

**To move a marker to a new location:**

1. Click on the triangular base of the marker and drag it to the desired location.
2. To make a marker’s position snap to a zero-crossing (the point at which a waveform crosses the center phase line) as you drag it, hold down the Shift key while you drag.

**To move a marker to a new location numerically:**

1. Double-click on the triangular base of the marker. The Edit Marker dialog appears.
2. Choose the desired time units (Samples, Seconds, or Milliseconds) from the time format pop-up menu.
3. In the Position field, enter the precise time location that you wish to move the marker to.
4. Click OK to close this dialog — Peak moves the marker to the location you entered in the dialog.

**or:**

• You may also open the audio document’s Contents Drawer and click the desired marker’s duration — it will become editable text and a new value can be entered. Once the duration is altered and the Return key is pressed, the marker will snap to the new location.

**To nudge a marker or a selection of markers to a new location:**

1. Make a selection that includes the marker (or markers) that you wish to nudge.
2. Choose Nudge Markers from the Action menu or Toolbar — the Nudge Markers dialog appears.
3. In the “Nudge Markers By” field, enter the number of seconds (positive or negative) by which you wish to nudge the marker.
4. Click OK to close this dialog — Peak nudes the marker by the value you entered in the dialog.

**To delete a marker:**

1. Double-click the triangular base of the marker — the Edit Marker dialog appears.
2. Click the Delete button — the marker is deleted from the audio document.
3. Click OK to close the Edit Marker dialog.

**To delete markers in a Selection:**

1. Make a selection in the audio document that contains the markers you want to delete.
2. Choose Delete All Except Audio (Option-Delete) from the Action menu and all markers, Regions, and loops in the selection will be deleted.

**To Copy/Paste only Markers:**

1. Select the desired range of audio, which contains the markers you wish to copy.
2. From the Edit menu, choose Copy (§-C).
3. Select a different range of audio (in the same
document or in a different document).

4. Hold down the Option key, and choose Paste from
the Edit menu – just the markers are pasted over
the current selection.

To paste just the markers, you must hold down the
Option key and choose Paste from the Edit menu –
using the ⌘-V keyboard command will paste the
audio on the Clipboard, as well as the markers.

Regions

Regions are portions of an audio document defined by
Region Markers using the New Region command from
the Action menu (⌘-Shift-R) or Toolbar. Regions
present in currently open audio documents will be listed
in the Contents window.

Regions can be saved only into AIFF, Sound Designer II, and
WAVE files. However, Peak will also read Regions stored from
other programs in Sound Designer II files. The method Peak
uses to store Regions in AIFF files is specific to Peak and is
not necessarily supported by other software applications. If
you are using Regions with other programs, you will want to
store your files as Sound Designer II or WAVE files.

To define a new Region:

1. Make a selection in an opened audio document.

2. Choose New Region from the Action menu (⌘-Shift-R) or Toolbar.

To modify the length of the Region by changing the start or end:

• Drag the start or end marker of the Region in the
audio document window.

To move a Region without changing its length:

• Hold down the Option key and drag either the start
or end marker of the Region.

or:

• Click the Horizontal Lock button in the tool area of
the audio document window, and then drag either
the start or end marker of the Region.

To edit a Region’s start, end, or length manually:

1. Double-click on either the start or end marker of
the Region in the audio document window. The
Edit Region dialog will appear.

2. Enter new values for Start, End, or Length times,
then click OK.

To change the name of a Region:

1. Double-click on either the start or end marker of
the Region in the audio document window. The
Edit Region dialog will appear.

2. Type the new name of the Region into the dialog
and click OK.

or:

• You may also open the audio document’s drawer and click the desired marker’s name – it will become editable text and can be re-named. When you press the Return key, the marker’s name is updated.

To locate a Region:

• Double-click the Region’s name in the Contents Window or in the audio document window’s Contents Drawer. The Region will automatically snap into view, with the Region selected.

or:

• Type the first few letters of the Region’s name, and the Region will snap into view automatically. Please note that if multiple Regions share similar names, such as “TheIntro” and “TheEnd”, you would need to type at least one character beyond “t-h-e-” for Peak to be able to distinguish between these similar names. If you plan on using this technique to locate to Regions, it is recommended that you not use spaces in the Regions’ names, as when you attempt to locate to them, pressing the Space Bar on your keyboard will initiate playback.

To split a Region:

1. Place insertion point cursor at the the desired location.

2. Choose New Region Split (Ctrl-Shift-R) from the Action menu. The cursor’s position determines the split point. Any part of the document before the split point becomes one Region, and any part after the split point becomes another Region.

To Copy/Paste only Regions:

1. Select the desired range of audio, which contains the Region markers you wish to copy.

2. From the Edit menu, choose Copy (⌘-C).

3. Select a different range of audio (in the same document or in a different document).

4. Hold down the Option key, and choose Paste from the Edit menu – just the Region markers are pasted over the current selection.

To paste just the Region markers, you must hold down the Option key and choose Paste from the Edit menu – using the ⌘-V keyboard command will paste the audio on the Clipboard, as well as the Region markers.

Creating Loops

If you’re editing music or other rhythmically-based material, it is generally a good idea to test a selection to make sure it contains an even number of beats before you cut, copy, or paste it. A good way to do this is to loop the selection and listen to the loop as it plays. As described in the next section, Peak includes Loop Surfer, which can automate the process of finding a rhythmically “correct” length of audio to loop, assuming you know the tempo and the number of beats you wish to loop. You can also use the Loop Tuner, found in the DSP menu, to adjust the loop start and end points. The Loop Tuner is also described in the next section.

Loops are useful in material that you plan to transfer to a sampler. Loop markers created with Peak are recognized by samplers as sustain loops. Peak allows you to create one loop per audio document.
When using a single loop per audio document, there is a quick and easy way to mark multiple desired sections for looping. With the loop markers in the desired location, choose Select Loop from the Edit menu, then, choose New Region from the Action menu — a Region is created that is the same length as the loop. Using this technique allows you to create as many Regions as desired within a single audio document. To loop any of these Regions, simply Option-click between a Region's markers to select the Region (or press the Tab key until the desired Region is selected), and then choose Loop this Selection from the Action menu.

To play a loop in Peak, select Use Loop in Playback command (Option-L) from the Options menu or click the loop button in the Transport window, begin playback, and when Peak reaches the loop, it will continue to repeat until you stop playback. If Use Loop in Playback is not enabled, Peak will simply play right through the loop to the end of the audio document or selection.

To change regular markers into loop markers:
1. Create markers in an audio document.
2. Double-click on the triangular base of the marker that you wish to define as the loop start point. The Edit Marker dialog appears.
3. Click the Loop Start button and click OK. The marker becomes a Loop Start marker.
4. Double-click on the triangular base of the marker that you wish to define as the loop end point. The Edit Marker dialog appears.
5. Click the Loop End button and click OK. The marker becomes a Loop End marker. You have now defined a loop in your audio document.

To create a loop from a selection:
1. Click the cursor at the desired location in the audio document and drag to select the range you want.
2. Choose Loop This Selection from the Action menu (Option-Shift-“-“) or Toolbar. Your selection is now looped. Loop markers appear at the beginning and end of the loop.
3. To listen to the loop, choose the Use Loop in Playback command (Option-L) from the Options menu (a check next to this menu item indicates it is enabled), or click the Loop button in the Transport window, and start playback by pressing the Spacebar on your keyboard.
4. You can interactively fine-tune a loop by dragging the loop start or end markers while loop playback is engaged. As you drag a loop marker to a new location, Peak will adjust the playback loop to reflect the changes you make. You can also use the Loop Tuner to call up a dialog that allows you to visually fine tune the loop, and even play the loop while adjusting it to listen to the changes.

To move a pair of loop markers together:
- Hold down the Option key and drag one of the loop markers to the desired location. Both markers move in tandem as you drag.
- Click the Horizontal Lock button in the audio document window, and drag the begin loop or end loop marker — both markers move in tandem. Be sure to turn off Horizontal Lock to move the loop markers independently.

The Horizontal Lock button
To listen to the loop only:

1. Choose Select Loop (⌘-“-”) from the Edit menu to select the loop.

2. Make sure loop playback is enabled using the Use Loop in Playback command (⌘-L) from the Options menu (a check next to this menu item indicates it is enabled), or by pressing the Loop button on the Transport.

3. Press the Spacebar to begin playing back the loop.

Turn Loop Flag On/Off on Save

This feature allows the loop flag in AIFF files to be turned on or off when saving a file. The state of this loop flag when a file is saved determines the file’s playback behavior when loaded into Peak again, or into another application capable of reading embedded loop flags.

The loop flag is now toggled on or off when saving, depending on the state of the Loop Playback setting in Peak.

To Save an AIFF File with the Loop Flag On:

1. From the Options menu, choose Use Loop in Playback (⌘-L), or click the Use Loop in Playback button in the Transport. A check next to the menu item, or an illuminated button in the Transport indicates the loop flag is turned on.

2. Save the AIFF file – the loop flag is saved in the on position.

To Save an AIFF File with the Loop Flag Off:

1. From the Options menu, choose Use Loop in Playback (⌘-L), or click the Use Loop in Playback button in the Transport. The absence of a check next to the menu item, or a non-illuminated button in the Transport indicates the loop flag is turned on.

2. Save the AIFF file – the loop flag is saved in the off position.

Crossfading Loops

Peak allows you to crossfade the start and end points of a loop. Crossfading a loop can be very useful for smoothing the transition between the end of the loop and its beginning as it repeats. Peak allows you to control the envelope of the crossfade, the duration, and other parameters in the Crossfade Loop dialog.

The Crossfade Loop dialog

The four checkboxes at the top of the Crossfade Loop dialog allow you to customize how the end of the loop is faded into the beginning of the loop. These boxes indicate where in the loop the crossfade is applied. For most loops, you should be able to leave the default checkbox checked and get good results.
**Crossfade Variations**

If you consider the crossfades “A”, “B”, “C”, and “D” from left to right, then:

- “A” = Crossfade between A and C
- “B” = Crossfade between B and D
- “C” = Crossfade between C and A
- “D” = Crossfade between D and B

Crossfade positioning options – different uses for loops may call for different loop crossfade settings – With position “C” checked, a crossfade is applied as indicated by the red “X”.

The way these crossfade variations are configured depends on where the loop is destined to be used – for most purposes the default crossfade position (Position “C”) works well – if however, you plan on transferring these loops to a sample playback instrument such as a SMDI sampler, then you may want to experiment with different crossfade positions/combinations. Some hardware based samplers offer advanced playback controls, allowing loops to be played forward, backward, and in various other ways. By changing where in the loop crossfades are applied, you can customize your audio content for a particular sampler and for the desired effect.

Another application that may require using loop crossfade position(s) other than the default position “C”, are when creating audio loops intended to be used in a proprietary video game audio engine. Depending on the requirements of a particular video game’s audio engine, users may need to adjust the position of the crossfades used in their loops, to achieve the desired effect. Depending on the application requiring crossfades, users may need “loop with release” (plays the tail of the audio document – the section of audio that lies outside the loop markers – after the loop stops playing/sampler’s key is released) or “loop hold” (doesn’t play the audio after the loop when the key is released). Because of these different modes, users may need to turn some crossfades on or off.

**To crossfade a loop:**

1. Create a loop using one of the techniques explained earlier in this chapter.
2. Choose Crossfade Loop from the DSP menu or Toolbar.
3. In the Crossfade Loop dialog that appears, enter a duration for the crossfade-in milliseconds and click OK.
4. To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Options menu (⌘-L) or click the Loop button on the Transport, and press the Spacebar. You will hear the loop, complete with your crossfade.

**To edit a Crossfade Loop Envelope:**

- Click on the Envelope button in the Crossfade Loop dialog and the Blending Envelope Editor appears.

---

*Note that this is the same Blending Envelope Editor that is accessed from the Blending dialog.*
2. Click anywhere on the line and a new moveable “breakpoint” will appear.

3. Drag the breakpoint to the desired location.

4. Continue creating and dragging breakpoints until you have created the envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

5. If you wish to reverse the shape of the envelope you have created, click the “<>” button. This creates a mirror image of the envelope.

6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope until you change it again.

To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Options menu or click the Loop button on the Toolbar, and press the Spacebar. You will hear the loop, complete with your crossfade.

If you save your custom Blending envelope into:

/MacintoshHD/Users/<YourAccount>/Library/Preferences/Peak Envelopes/

it will automatically appear in the Envelope pop-up menu in the Fade In/Out Envelope editor.

The Crossfade Loop dialog is not available in Peak LE.

Using Loop Surfer

Peak’s Loop Surfer feature automates some of the steps for setting up loop points. Loop Surfer allows you to “Loop Surf” (adjust your loops during playback) quickly, easily and in a musically intuitive manner.

If you’re working with music, and know the music’s tempo in beats per minute, you can use Loop Surfer to create a loop which lasts for a rhythmically “correct” length of time.

To use Loop Surfer based on a musical tempo:

1. Place the cursor where you wish to begin the loop (it’s okay to place it approximately, rather than exactly, where you wish to start).

2. Choose Loop Surfer from the Action menu (⌘J). The Loop Surfer dialog appears.

To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Options menu or click the Loop button on the Toolbar, and press the Spacebar. You will hear the loop, complete with your crossfade.
3. Type in the music’s tempo. If you are not sure of the tempo, you can use the Tempo Calculator to determine the tempo. Simply select a portion of audio, and type in the number of bars and beats in the selection. The calculator will determine the tempo based on your selection. If you are unsure, and have used a drum machine or sequencer to create the music, you might wish to refer back to its settings determine the time signature and tempo. Additionally, you can use the Threshold command from the DSP menu to select a portion of audio that should correspond to the beat; see “To use Loop Surfer based on a selection” below.

4. Type in the number of beats that you wish the loop to last. The beats are based upon quarter-notes, in terms of musical time. For instance, if your song was in a 4/4 time signature, typing “4” beats would mean the loop would be one measure in length; if the song were in 7/4 time, typing “14” would mean the loop would be two measures in length. (If you are interested in exploring syncopations, however, there’s no reason why you can’t type a beat value that doesn’t correspond to the time signature, such as “5” if the music is actually in “3/4” time.)

5. If you then select the Start Surfing button (the default), Peak will automatically:
   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
   e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Options menu.
   f) begin looped playback of the audio selection, stopping only once you hit your keyboard’s Spacebar or press Stop on the Toolbar.

6. If you select the Make Loop button, Peak will automatically:
   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
   e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Options menu.
   f) At this point, you must start playback manually using the Spacebar or the Toolbar if you wish to begin Loop Surfing.

While you’re Loop Surfing (adjusting your loop during playback), you’re free to perform all standard looping functions as described in the previous section, including adjusting the Loop Start and End points during playback. Most importantly, you’ll now have a selection that lasts for a rhythmically correct period of time (that matches the beat). If you move the markers in tandem, by holding down the Option key and clicking and dragging one of the loop markers to the desired location with the mouse, you’ll find it’s a great way to set up interesting rhythms and syncopations! Peak’s interactive editing capabilities also allow you to use the Loop Surfer dialog while a loop plays to adjust the tempo, beats and so on.
If you’re not working with music (or if you simply don’t know the tempo of the music you’re working with), you might choose to Loop Surf based upon a selection (or use the Threshold feature), rather than starting at a cursor insertion point.

To use Loop Surfer based on a selection:

1. Place the cursor where you wish to begin the loop, and using the mouse, select the portion of audio you wish to loop. (You can make your selection in a variety of other ways, also, as described earlier, including selecting between markers by /command-clicking with the mouse).
2. Select Loop Surfer from the Action menu. The Loop Surfer dialog appears.
3. If you check the Use Selection box and select either the Start Surfing or Make Loop button, Peak will automatically:
   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
   e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Options menu;
   f) begin looping and playing. The selection will begin looped playback (if you have selected Start Surfing);
   or:
   g) wait for you to start playback manually using the Spacebar or the Toolbar if you wish to begin Loop Surfing (if you have selected Make Loop).

Making Loops into Regions

As you “Loop Surf”, that is, as you move the loop points simultaneously through an audio document while audio plays, you may find sections that you would like to set aside for later. These sections can be saved as Regions, which can be used to create a remix within a Peak Playlist, may be exported as new audio documents, or used in a loop-based sequencing application, such as Ableton Live or Apple SoundTrack or GarageBand.

Since Peak allows only one loop per audio document, you can turn the loops that you like into Regions.

To create Regions from Loops:

1. As a loop plays, choose Select Loop (/command-”) from the Edit menu.
2. With the loop selected, choose New Region (/command-R) from the Action menu. Name the Region and click OK.
3. Hold down the Option key (or click the Horizontal Lock button in the Toolbar) and drag the begin loop or end loop marker to a new position in the audio document — both loop points will move simultaneously.
4. When you locate another section of the audio document that you would like to set aside for later use, choose Select Loop (/command-“”) from the Edit menu.
5. With the loop selected, choose New Region (/command-R) from the Action menu. Name the Region and click
OK. Continue Loop Surfing and creating Regions as desired.

You may continue placing as many Regions as desired using this technique. To later loop any of the Regions you have created, just select the desired Region, and choose Loop this Selection from the Action menu.

To create a remix in a Peak Playlist, simply create a new Playlist, and add the desired Regions to it. For more information on using Playlists, please see Chapter 6: Playlists & CD Burning.

To export these Regions as new audio documents, or to use within another application, please see the section on Exporting Regions, later in this chapter.

Loop Surfer is not available in Peak LE.

Using the Guess Tempo and Threshold Commands to Find Tempo

If you are working with music and don't know the tempo – and your music has a relatively pronounced or obvious beat – you can use the Guess Tempo command to have Peak automatically guess the tempo of a selection. Make a selection and choose Guess Tempo from the Action menu. There will be a pause while Peak scans your selection and calculates the tempo for you. A dialog will then appear showing you the estimated tempo in BPM, or beats per minute. You can then enter the estimated tempo in BPM in the Loop Surfer dialog’s Tempo field or in the Audio Information dialog’s Tempo field, or click Loop-It to automatically place the guessed tempo value into the Loop Surfer dialog.

As you Loop Surf, you may automatically change the number of beats in a loop by selecting the loop (Shift-“.”), opening the Loop Surfer dialog (J), and entering a new value for beats.

You can also use the Threshold command (described in greater detail in Chapter 7: DSP) to define a number of markers or Regions based on amplitude peaks. If you then select audio with start and end points that correspond to these sections, you should have a selection that precisely matches the musical beat. Using Loop Surfer, you could then automate the process of looping the selection by following the steps described directly above.

Guess Tempo works best with audio selections that contain one full measure of audio with pronounced attacks on the beats, which appear visually on the waveform as taller sections of the audio. Using the Normalize feature on the selection prior to Guess Tempo can improve the accuracy of its deduction.

Guess Tempo is not available in Peak LE.

Using Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop to get a smooth transition at the loop points. Loop Tuner also allows you to listen to the effects of these adjustments as you make them. If you wish to “tune” a loop you’ve made, simply select Loop Tuner from the DSP menu or Toolbar, and a dialog will appear. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window. The two zoom buttons – magnifying glass icons – in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample...
Level. You can listen to the effects of the adjustments as you make them by clicking on the Play button. To exit this dialog, click on OK to accept the changes, or Cancel to leave the original loop unaffected.

Loop Tuner is not available in Peak LE.

Exporting Regions

If you have placed markers or Regions in an audio document, Peak’s Export Regions command allows you to export those Regions from the source document and save each of these Regions as a separate audio document. This feature is very convenient if you wish to divide a larger file into Regions and transfer them as samples into a sample playback instrument, or divide a live concert record into Regions and export those Regions as separate files. Furthermore, you can use Peak’s Batch File Processor to process a file’s Regions with any of Peak’s DSP functions and third party plug-ins during the automatic exporting of Regions into new files.

To export Regions from an audio document:

1. Select the Regions that you wish to export. (You can use the Tab key, Shift-Tab, or if you wish to select the entire document, press /command-A.)

2. Choose Export Regions from the File menu.

3. In the Export Regions dialog, choose the parameters that you wish to use for selecting the Regions to export.

4. Using the Region Detection options, choose which Regions are to be exported.

5. Using the Output Format options, choose the format and resolution you wish for the exported Regions.

6. Using the Output Directory options, choose the destination for the exported Regions.
7. If you wish the newly exported Regions to appear as new open Peak documents, choose Output to new windows.

8. To save the exported Regions to disk, select Save To Disk and choose whether you would like to save the Regions into the same folder as the source files, or to a different folder. If you prefer to save to a new folder, use the Set Path button.

9. To export the Regions, click Begin. Peak exports each of the Regions into its own audio document.

Region Detection area

To export all Regions in an audio document, click the Export Regions button. To export audio between adjacent markers, click the Export Audio between Markers button. To export only Regions that are bounded by specific marker names, click the Only Regions button and enter the parameters that you wish to use to select the desired Regions. For instance, if you wish to export only Regions bounded by markers with the word “hit” in them, click the pop-up menu, choose containing, and type the word “hit” in the field next to the pop-up. Conversely, if you wish export all Regions except those with the word “hit” in them, click the pop-up menu, choose not containing, and type the word “hit” in the field next to the pop-up menu.

Output Format area

Choose the file format, bit depth resolution, and Stereo or Mono from these pop-up menus for the resulting exported audio documents. You can set the Sample rate in kHz for the resulting files in the Rate field (please note that this will not do sample rate conversions). You can also designate whether the resulting audio documents contain Regions or Markers or not.

Output Directory area

Resulting audio documents can either be output to new open audio document windows or saved to the hard drive. Choose Output to New Windows if you want to have the resulting audio documents open in Peak or choose Save To Disk if you just want to write the new audio files to disk without opening them in Peak. If you Save To Disk, you can simply choose to use the original audio document’s folder or you can specify another folder on your hard drive(s) to save the resulting audio documents by choosing Set Path. The Name Prefix field allows you to include a specified prefix to all the resulting audio documents. The default prefix is the name of the file. Each and every one of the resulting audio documents will be named with the prefix plus the name of the individual Region.

Another exciting feature of the Export Regions function is that you can Export Regions through Peak’s Batch File Processor. First configure the Batch File Processor and turn it on, then, go to Export Regions and check the Use Batch File Processor checkbox. When you begin exporting Regions, each one will be affected by the processes you choose in the Batch File Processor dialog (see Chapter 7: DSP & Chapter 8: Plug-Ins).

---

Do not save the output of the Batch File Processor to the input directory (i.e., the same directory that contains the files being batch processed).

---

Export Regions is not available in Peak LE.
**Editing QuickTime Soundtracks in Peak**

Peak allows you to edit QuickTime movie soundtracks. While you cannot edit QuickTime video in Peak, you can use Peak as a full-featured audio post-production tool for QuickTime movies. This makes Peak an ideal tool for editing and cleaning up soundtracks, as well as adding sound effects or music to QuickTime movies.

How to open and edit QuickTime sound tracks in Peak:

1. Select Open from the Edit menu (⌘-O) or Toolbar.
2. In the dialog that appears, locate the QuickTime movie that you wish to open.
3. Click the Open button, and Peak will open the QuickTime movie in a movie window, and open the movie’s audio track in an audio document window. Select Movie ➤ Movie Sound Tracks from the Options menu to Enable or Disable the movie’s other audio tracks. You can also use this dialog to toggle multiple soundtracks contained in a movie on and off to check balances or “solo” certain tracks. Click on the Set button to accept the changes, or Cancel to leave the movie unaffected. To toggle the Movie Window on or off, choose Movie from the Window menu. A check next to this item indicates it is enabled.
4. You may now edit the movie’s audio track as you would any other audio document. The movie will “scrub” along with the audio, and the placement of the insertion point in the audio document window will also scroll the movie to that point.
5. When you are finished editing the QuickTime sound track, use Peak’s “Save As” command to save the movie with its new sound track.

**Conclusion**

You have now learned how to manipulate audio with Peak’s various editing tools, including how to work with Markers, Loops, and Regions. In the next chapter you will learn more about the use of Regions in Playlists.

---

Be careful not to change the duration of the audio using cut, delete, or insert, as this will cause the audio and video to fall out of sync.
Chapter 6
Playlists & CD Burning
Chapter 6:
Playlists & CD Burning

Introduction

This chapter explains how to sequence Regions in a Playlist document, and to create a “master” CD – from which all subsequent copies are produced. Peak’s Playlist allows non-destructive editing, crossfading, setting custom gap times between tracks, applying effects plug-ins, setting custom track start offsets, embedding various types of metadata, such as International Standard Recording Codes (ISRC), CD-TEXT data, and much more.

A Playlist is a list of Regions strung together in a specific order. Once Regions have been added to a Playlist, they are referred to as Playlist Events. The Peak Playlist is a set of instructions that tell the hard disk which Regions to “read”, and in what order. Playlist editing does not permanently alter the original audio data on your hard disk. No matter how many changes you make, your original recordings remain intact. This type of nondestructive editing is one of Peak’s most significant and powerful features.

When editing in Peak’s Playlist window you are not permanently deleting, moving, replacing, and adding actual audio as you would if you were cutting and splicing analog tape. Instead, Peak is creating a “map” of your audio file. This map, or “playlist,” simply describes the order in which you want portions of the recording to be played. If you’d like to hear the middle of a song first, the end next and the beginning last, you may arrange your Regions in this order. Peak will read (e.g., play) from the hard disk (where the audio data is stored) from any number of possible points originally designated by Region markers, and these Regions can be auditioned in the Playlist in any number of possible arrangements.

Playlist editing allows you to adjust and re-sequence segments of audio (e.g., Regions) with ease. Edits can be heard as soon as you perform them. In addition, Peak allows you to apply unique effects settings to individual playlist events. Peak’s Playlist offers a fast, flexible, and powerful approach to editing and processing digital audio.

Peak’s Playlist allows you to output in many ways, from burning audio CDs directly, to creating various file formats used in the CD manufacturing process. Peak burns fully Red Book compliant audio CDs from Playlists, that will play in any CD-R compatible player. If you are using Peak for commercial mastering, you will be pleased to know that the master CD you create with Peak can easily be used in mass duplication, and with an optional
Peak Playlist: Graphical User Interface (GUI)

Control Area
This portion of the Playlist interface contains the Playlist Function controls, Audition controls, Nudge controls, Transport controls, and editing mode controls. These are described in detail on the following pages.

Waveform View Area
The Waveform View Area contains the Waveform Display, as well as any controls specific to working in Waveform View.

List View Area
The List View Area contains the columnar List Display, tools for working with CD-TEXT and subcode metadata, Vbox effects, as well as any controls specific to working in Waveform View.

Playlist Function Controls
The Playlist Function controls are used for adding and deleting Regions, burning CDs, and a number of other common tasks.

Audition Controls
The Audition Controls allow you to preview individual parts of a crossfade, or the entire crossfade, with or without pre- & post-roll.

Slip/Shuffle Mode Controls
These buttons allow you to choose between Slip and Shuffle editing modes.

List View Columns/Data Fields
This portion of the Playlist's List View contains all the controls to make precise edits – to within one millisecond. Most of the same kinds of edits may be made within the List View and Waveform View.
Chapter 6:  Playlists & CD Burning

Waveform Display Area
The Waveform Display shows Playlist Events graphically, as well as displaying crossfades, and the timeline. This display may be viewed using Linear or Staggered Modes.

Counter Display
This part of the interface displays the current track number (as it will appear on an audio CD), as well as the current position in the timeline.

Nudge Controls
These controls allow Playlist Events/Regions to be nudged by a custom amount, in any of Peak's Time Units formats.

Transport Controls
These buttons allow you to play, stop, rewind, fast forward and navigate between Playlist Events/Regions (in the same way as a CD player’s controls).

Mode Controls
These checkboxes let you select Preserve Timing, Scroll Regions, or Audio CD Playlist modes.

ISRC, Emphasis, Copy Protection, and CDTEXT Columns
These specialized columns within the List View Area allow adding/editing a variety of CD-TEXT and subcode channel metadata.

Vbox Column
This specialized column features the controls used to apply unique effects settings to each Playlist Event.
extension package, Peak can also export a Playlist in DDP (Disc Description Protocol), a format preferred over CD by many duplication companies. You can also use Peak’s Playlist to create a Jam Image file for burning audio CDs using Roxio’s Jam™. You can also bounce (i.e., write to disk) your Peak Playlist as a Sound Designer II file and then import the Playlist Events as Regions into other applications capable of reading Regions from SDII files.

Regions are covered in Chapter 5: Editing. Please familiarize yourself with Regions before attempting to work with Playlists. As Regions are the only items that may be added to a Playlist, it is important to understand how to create and edit them, before working with Playlists.

The Playlist window is split into three main areas: The Control Area, the Waveform View Area, and the List View Area. This chapter will teach you how to quickly assemble a Playlist and burn an audio CD, and then goes over each of the Playlist’s three main sections in detail, explaining each control, function, and mode.

**Basic Playlist Concepts**

This section deals with the basic hands-on aspects of working with Peak Playlist documents. You will learn how to create a playlist, add Regions, perform edits, and output a finished Playlist as an audio CD. Later in this chapter, you will find detailed descriptions of the various options.

**Creating a Playlist**

Before any Playlist operations can be performed, you will need to open the audio documents containing the Regions you wish to sequence, and a new Playlist document must be created. This section goes over the most basic elements of working with Playlists. It is recommended that you read this section before creating any Playlist-based projects.

**To Create a new Playlist:**


**Adding Regions to a Playlist**

There are a number of ways to add Regions to a Playlist – here, we’ll use the Add Regions button. Information on the other methods appears later in this chapter.

**To Add a Region to a Playlist using the Add Region Button:**

1. In the upper left portion of the Playlist interface, click the Add Region Button – a pop-up menu containing a list of all Regions in all open audio documents appears.

2. Select the Region you wish to add to the Playlist – it is added to the end of the Playlist. If no other items are in the Playlist, it becomes the first item.
Selecting Playlist Events

Once Regions have been added to a Playlist, they are referred to as Playlist Events. Playlist Events will usually need to be edited in some way. This editing may include trimming, nudging, entering metadata, etc. Regardless of the type of edit to be performed, it is important to know how to make selections, as this is how particular Playlist Events are targeted for editing processes.

To Select a Playlist Event in theWaveform View Area:

- Click the desired Playlist Event – you will know it is highlighted because it will appear in a different color than other, unselected Playlist Events. (Colors will vary depending on your color preference settings).

A selected Playlist Event appears in a different color than unselected Events – by default, they appear in yellow

About the Move Event & Trim Event Cursor Modes

Many of the edits you will make in a Playlist will be done using the Move Event and Trim Event tools. The cursor switches between these two modes automatically, depending on where the cursor is in relation to certain parts of a Playlist Event’s Waveform representation. When the mouse cursor is located over the waveform, it is in Move Event mode. Clicking and dragging left or right while in this mode will move the entire Event earlier or later in the timeline. When the mouse cursor is placed within a few pixels of the edge of a Playlist Event’s Waveform display, it switches to Trim Event mode, and can be used to trim or extend the Playlist Event.

To use the Move Event tool:

1. In the Waveform Display Area, hover the mouse cursor over the middle portion (i.e., not near the edges), the cursor will be in Move Event mode, and will look like this:

To use the Trim Event tool:

1. In the Waveform Display Area, hover the mouse cursor near the Begin or End Boundary of a Playlist Event, the cursor will be in Trim Event mode, and will look like this:

2. Click and hold the mouse button down, and drag the Event left or right, to the desired position – the Event moves to an earlier or later position in the timeline.

Deleting Playlist Events

Selected Playlist Events may be deleted in Waveform View or in List View.

To Delete a Playlist Event:

- Select the Playlist Event(s) you wish to delete in the Waveform or List View areas, and click the Delete
Playlist Event Button in the upper left of the Playlist interface, or press the Delete key on your keyboard.

Using Undo/Redo

Peak’s Playlist features unlimited levels of undo/redo. If any mistakes are made along the way, they can easily be undone. These steps show how to undo and redo edits one at a time. More information about using the graphical Edit History list appears later in this chapter.

To Undo Edits one at a time:
- From the Edit menu, choose Undo, or press Z on your keyboard.

To Redo Edits one at a time:
- From the Edit menu, choose Redo, or press Y on your keyboard.

Creating Transitions between Playlist Events

A variety of different types of transitions may be created in the Playlist – we’ll be working with a crossfade in this step. A crossfade is a transition in which two Events overlap in time – that is, before the earlier Event ends, the later Event has already started. In the area where the two Events overlap, the earlier Event fades out, as the later Event fades in. In a typical crossfade, the overall volume level remains more or less constant, though Peak offers many options, making it possible to achieve practically any effect desired. More information about other types of transitions is available later in this chapter.

Crossfades may be performed in either Waveform View or List View.

To Crossfade Playlist events in Waveform View:
1. Locate two adjacent Events you wish to crossfade together.
2. Click on the earlier (or “Out”) Event, and drag it (using the Move Event tool) to the right (later in time), so an overlap in time is created between the two Events. (Or, click on the later (or “In”) Event, and drag it to the left, or earlier in time, until an overlap is created.

To Crossfade Playlist Events in List View:
1. Locate two adjacent events you wish to crossfade together in List View.
2. In the earlier (or “Out Event”) Event’s row, click in the O-XF-T Column (or “Out Crossfade Time”) – the field becomes editable.
3. Enter an earlier value than the Start Time of the following Event and press the Return key on your keyboard (the value that appears in the following Event’s Start Time Column).

Auditioning Transitions

Before committing to a crossfade or other transition, you will probably want to audition it to ensure that it is the right length, and that the two Playlist Events blend together in the intended way. This step shows a simple crossfade audition, though there are a number of variations on how auditioning can be used. For more information, please see the detailed overview of the XFade Audition Controls, later in this chapter.

To Preview a crossfade:
- Click the Audition XFade button (or press the X key on your keyboard) – the crossfade plays from beginning to end.
Burning an Audio CD

Burning audio CDs is one of the most common ways to output the contents of a Playlist. Provided that your Playlist was made in Audio CD mode (i.e., with the Audio CD Playlist checkbox checked), the resulting CD will conform to the Red Book standard, and will be playable in any CD player. Burning a CD not made in Audio CD mode may play on a standard CD player, but this will depend largely on the CD player’s capabilities. For maximum compatibility, it is recommended to burn in Audio CD mode. For more information, please review the section on Audio CD mode which appears later in this chapter.

To Burn an Audio CD from a Playlist:

1. With the Playlist window in the foreground, choose Select All (⌘-A) from the Edit menu.
2. In the upper left portion of the Playlist interface, click the Burn Playlist to Audio CD button – the Burn Audio CD dialog appears.
3. In the Burn Audio CD dialog, choose the desired burning options.
4. Insert a blank CD – the Burn button becomes available.
5. Click the Burn button – the Playlist is burned to CD.

Saving a Playlist

Playlist documents may be saved and recalled later. These steps will teach you how to save a Playlist you are working on. More information about opening, closing, and saving Playlists appears later in this chapter.

To Save a Playlist:

1. With the Playlist window in the foreground, choose Save from the File menu.
2. You will be presented with the Save dialog – enter a name, choose a directory, and click the Save button.

Detailed Overview of Controls, Modes, and Tools

The Playlist’s sophisticated editing controls allow you to choose from a variety of editing tools, modes, and behaviors. Most editing controls are found in a beveled section of the interface, below the Counter Display, and to the right of the Crossfade Audition controls. The various editing controls are described in detail below.
**Miscellaneous Controls**

Most of the controls discussed in this section are not located in the Playlist, but are relevant to working with Playlists.

**Saving, Closing, and Opening Playlists**

Playlist documents may be saved and recalled later. When working with Playlist-based projects, it’s a good idea to save the Playlist and all source audio documents in a single folder on your hard drive. This can help to avoid inadvertently deleting an audio document your Playlist refers to. These steps will teach you how to close and save a Playlist you are working on, as well as how to re-open saved Playlists.

**To Close a Playlist:**

- With the Playlist window in the foreground, choose Close from the File menu – if the Playlist has not had its latest edit saved, it will present you with a Save dialog, giving you an opportunity to save your work. To save the Playlist, click the Save button – if you do not wish to save the Playlist, choose the Don’t Save button.

**To Open a Playlist:**

1. From Peak’s File menu, choose Open.
2. Use the Open dialog that appears to locate the Playlist on your computer’s hard drive.
3. When you locate the Playlist, select it and click the Open button.

**Adding Regions to a Playlist**

There are a number of ways to add Regions to a Playlist. Regions can be dragged into the Playlist from Peak’s Contents Window or Contents Drawer, or from within the Playlist itself, using the Add Region button.

**To Add a Region to a Playlist using the Add Region Button:**

1. In the upper left portion of the Playlist interface, click the Add Region Button – a pop-up menu containing a list of all Regions in all open audio documents appears.
2. Select the Region you wish to add to the Playlist – it is added to the end of the Playlist. If no other items are in the Playlist, it becomes the first item.

**To Add a Region to a Playlist from Peak’s Contents Window:**

1. From Peak’s Window menu, choose Contents – the Contents Window appears.
2. In the Contents Window, locate the name of the audio document which contains the Region you wish to add to the Playlist.
3. Click the disclosure triangle to the left of the Region’s name – a list of all Regions contained in that audio document appears.

4. Click on the name of the Region you wish to add to the Playlist, and drag it into the List View, located in the bottom half of the Playlist interface. If no other Playlist Events are in the List, this becomes the first Playlist Event. If other Playlist Events exist in the List, and the Region is dragged to the end of the...
List, it becomes the last item. If a number of Playlist Events are in the List, and you wish to place a new Region in a specific location (i.e., between two other Playlist Events), drag the new Region over the Playlist Event that you wish it to appear before, and release the mouse button. The highlighted Playlist Event is pushed further down the List (and later in time) to accommodate the new Region.

Be sure the Contents Window is displaying Regions, rather than Loops or Markers. The three buttons at the bottom of the Contents Window determine what is being displayed – when the left button is clicked, Markers are displayed, when the center button is clicked, Regions are displayed, and when the right button is clicked, Loop markers are displayed.

To Add multiple Regions to a Playlist from Peak’s Contents Window:

1. From Peak’s Window menu, choose Contents – the Contents Window appears.

2. In the Contents Window, locate the name of the audio document which contains the Region you wish to add to the Playlist.

3. Click the disclosure triangle to the left of the audio document’s name – a list of all Regions contained in that audio document appears.

4. Command-click (for discontiguous selections), or Shift-click (for contiguous selections) on the names of the Regions you wish to add to the Playlist, and drag them into the List View, located in the bottom half of the Playlist interface. If no other Playlist Events are in the List, these become the first few Playlist Events, and appear in the same chronological order as they do in their source audio document. If other Playlist Events exist in the List, and the new Regions are dragged to the end of the List, they become the last few items. If a number of Playlist Events are in the List, and you wish to place the new Regions in a specific location (i.e., between two other Playlist Events), drag the new Regions over the Playlist Event that you wish them to appear directly before, and release the mouse button. The highlighted Playlist Event is pushed further down the List (and later in time) to accommodate the new Regions, which are placed before it in the same chronological order as in their original source document.

To Add a Region to a Playlist from an audio document’s Contents Drawer:

1. In the audio document containing the Region you wish to add to the Playlist, click the Toggle Contents Drawer button (Command-F) – the document’s Contents Drawer opens from the right side of the document window.

2. In the Contents Drawer, locate the name of the audio document containing the Region you wish to add to the Playlist.
3. Click the disclosure triangle to the left of the audio document’s name – a list of all Regions contained in that audio document appears.

4. Click on the name of the Region you wish to add to the Playlist, and drag it into the List View, located in the bottom half of the Playlist interface. If no other Playlist Events are in the List, this becomes the first item. If other Playlist Events exist in the List, and the Region is dragged to the end of the List, it becomes the last item. If a number of Playlist Events are in the List, and you wish to place the new Regions in a specific location (i.e., between two other Playlist Events), drag the new Regions over the Playlist Event that you wish them to appear directly before, and release the mouse button. The highlighted Playlist Event is pushed further down the List (and later in time) to accommodate the new Region.

To Add multiple Regions to a Playlist from an audio document’s Contents Drawer:

1. In the audio document containing the Regions you wish to add to the Playlist, click the Toggle Contents Drawer button (⌘ F) – the document’s Contents Drawer opens from the right side of the document window.

2. In the Contents Drawer, locate the name of the audio document containing the Regions you wish to add to the Playlist.

3. Click the disclosure triangle to the left of the audio document’s name – a list of all Regions contained in that audio document appears.

4. ⌘-click (for discontiguous selections), or Shift-click (for contiguous selections) on the names of the Regions you wish to add to the Playlist, and drag them into the List View, located in the bottom half of the Playlist interface. If no other Playlist Events are in the List, these become the first few Playlist Events, and appear in the same chronological order as they do in their source audio document. If other Playlist Events exist in the List, and the new Regions are dragged to the end of the List, they become the last few items. If a number of Playlist Events are in the List, and you wish to place the new Regions in a specific location (i.e., between two other Playlist Events), drag the new Regions over the Playlist Event that you wish them to appear directly before, and release the mouse button. The highlighted Playlist Event is pushed further down the List (and later in time) to accommodate the new Regions, which are placed before it in the same chronological as in their original source document.

Undoing/Redoing

Peak’s Playlist features unlimited levels of undo/redo. Before diving into the various editing tools, modes, and options, it’s probably a good idea to learn how to use the unlimited Undo/Redo features. This way, if any mistakes are made along the way, they can easily be undone.

Undo or redo actions may be performed one at a time, or by using Peak’s graphical edit history window.

To Undo Edits one at a time:

- From the Edit menu, choose Undo, or press ⌘-Z on your keyboard.
To Redo Edits one at a time:

- From the Edit menu, choose Redo, or press \( \mathcal{H}-Y \) on your keyboard.

To Undo a Series of Edits:

- From the Edit menu, choose Undo repeatedly, or press \( \mathcal{H}-Z \) on your keyboard repeatedly – until you have undone the desired number of edits.

Or:

1. From the Edit menu, choose Edits – Peak’s graphical edit history window appears.
2. Select the Edit/point in the project you wish to return to.
3. Click the Revert to Item button.
4. Click the Done button.

Be aware that if you undo a series of edits, and then perform new edits, you will not be able to return to the series of edits that were undone – these edits will be replaced by the new edits in the edit history list.

Indexes

In addition to track indexes, which designate the start or end of a CD track, you may also burn standard indexes to audio CDs using Peak. Indexes are created by placing Markers in the desired location within a source audio document/Region that is used in a Playlist. Index markers are not visible when working in the Playlist, but are burned to CD. Indexes are commonly used on classical music CDs, where a track may be relatively long (i.e., 20 minutes or more), and indexes appear at various intervals or points of interest, within a single CD track.

With CD indexes in place, a listener can navigate to the index location using the indexing controls on a compatible CD player. Most CD players do not support navigation using indexes.

Control Area

The Control Area, located in the upper portion of the Playlist window, contains all global controls (those that affect both the Waveform and List Views). This part of the Playlist interface is always available, even when one of the other portions of the interface is hidden. This section covers the function of each parameter and control in this part of the interface.

Playlist Function Buttons

The Playlist Function Buttons are found in the upper left portion of the Playlist interface, and include controls for adding and deleting items from the Playlist, burning a completed Playlist to CD, exporting a Playlist, and a number of other controls.

Crossfade Type Button

This control allows you to choose the fade type to be used when crossfading two Playlist Events together. Peak provides you with the flexibility to create many common crossfade types. These include “Linear Crossfade,”
Synchronizing Playlist Events with Source Regions

Before working in a Playlist, Regions are created in an Audio Document...

Here are the same two Regions, after being added to a Playlist – and now known as Playlist Events...

If edits are made in the Playlist that affect the duration or content of a Playlist Event (with the Trim Event Tool or Scroll Regions Tool), the edited Events may be synchronized with the original source Regions, which exist in an Audio Document...

Here we have the original source Regions in the Audio Document, after having been synchronized – note that the position of the Region markers has been updated to reflect the trimmed Playlist Events.
“Equal Power Crossfade,” “Slow in but fast out Crossfade,” “Fast in but slow out crossfade,” and “Butt Splice”. More information about crossfade types is available in both the Waveform and List View sections, later in this chapter.

**Add Region Button**

This control allows you to add any Regions from any open audio documents to the Playlist. When clicked, a pop-up menu appears with a list of all available Regions. When a Region is picked from this menu, it is added to the Playlist. When other items are present in the Playlist, a newly added Region is added as the last Playlist Event.

**Duplicate Playlist Event Button**

This control duplicates the selected Playlist Event. This is especially useful when creating remixes or working with loops, as it offers an easy way to extend the duration of the Playlist to meet a specific length requirement.

**Butt to Previous Event End Button**

This control “snaps” a selected Playlist Event’s Begin Boundary to the End Boundary of the preceding Playlist Event, creating a “butt” edit. When multiple Playlist Events are selected, each one is butted with the Event that appears before it in the timeline. Be aware that The Butt to Previous Event End control overrides the behaviors of both Slip and Shuffle editing modes, and can alter the relationships between Playlist Events. More information on this and other types of transitions is available in both the Waveform and List View sections, later in this chapter.

**Synchronize Playlist Event to Region Button**

This control synchronizes the position of Region markers in a Playlist Event’s source audio document. By default, Peak does not update the position of Region markers in source audio documents when trim or scroll edits are performed in the Playlist. When this command is used, selected Playlist Events will have their corresponding Region markers in their source audio documents updated. This control is useful for users who perform trim and scroll edits in the Playlist, and need to have the original Regions in the source audio documents updated to reflect these edits. Using the Synchronize Playlist Event to Region command allows additional Playlists to be created, based on edits made in a prior Playlist, and also allows exporting Regions from original source documents that are identical to those used in a Playlist.

Depending on the nature of your project, you may wish to synchronize edits made to Playlist Events with the source Regions in the source audio documents. If you have made additional edits (i.e., trimming, Scroll Regions, etc.) to Regions after they have been brought into the Playlist, you can synchronize the positions of the Region markers in the source audio documents in just a few easy steps. By synchronizing, you can be sure that the source Regions will correspond exactly with the Playlist Events used in a Playlist-based project.

**To Synchronize Playlist Events with Source Regions:**

1. Select the Playlist Events you wish to synchronize with their source Regions.
2. In the upper left portion of the Playlist, click the Synchronize Playlist Event to Region button — the Region markers in the source audio document(s) are repositioned to reflect any additional edits that
have been made to the Events since they were brought into the current Playlist.

If you use the Synchronize Playlist Event to Region command, be sure to save the source audio documents containing the Regions that were synchronized before quitting Peak. If you do not do this, Region markers may not be in the positions you expect when you open the audio document at a later time.

CD Info Button

The CD info button brings up a CD-TEXT data entry dialog, which allows entering CD-TEXT data that is applicable to the entire disc, including Disc Title, Performer, Songwriter, Composer, Arranger, Message, Genre, Disc Identifier, MCN (EAN or UPC), etc.

Any text entered in the Message field of the CD-TEXT (for disc) dialog also appears in an exported DDPID file, one of several files created as part of a DDP Fileset export.

Delete Playlist Event Button

This control deletes the selected Playlist event(s). It is the equivalent of pressing the Delete key on your keyboard.

Burn CD Button

The Burn CD button will burn a Playlist as a Red Book format audio CD. When first pressed, the Burn Audio CD dialog is presented, with options such as, which CD burner to use (when more than one burner is connected to your computer), burn speed, and various data burning options, such as using POW-r dithering, including CD-TEXT, ISRC codes, etc.

Bounce Playlist Button

The Bounce Playlist control is used to export the contents of the Playlist as a file, rather than as an audio CD. File format options include AIFF, Sound Designer II, Jam Image, or as a DDP (Disc Description Protocol) 2.0 file set. More information on burning audio CDs and file export options appears in the Output Options sections, later in this chapter.

Counter Display

The Playlist’s Counter display appears at the center of the Control Area, and provides a number of useful functions. In addition to the functions described below, the Counter Display may also be used for scrubbing.

Track Number Display

The current Track Number appears on the left side of this display. This shows either the Track Number of the Playlist Event currently being played, or the Playlist Event that is selected (when Playback is stopped).

Time Display

When the Playlist is being played back, the display shows the elapsed time from the beginning of the Playlist. When playback is stopped, it shows the current position of the playhead cursor within the Playlist’s timeline.
To scrub audio using the Counter:

1. Click into the Display area, and hold the mouse button down.

2. Drag the mouse cursor to the left or right – dragging to the left scrubs backwards through the Playlist, and dragging to the right scrubs forwards.

Transport Controls

The Playlist’s Transport Controls appear in the upper right corner of the Playlist interface. The controls are used for starting and stopping playback, as well as for navigating the tracks in a Playlist. These controls are described in further detail below, in the order they appear from left to right.

Previous Track Button

Clicking this button will locate the playhead cursor to the beginning of the previous track. If you are located at the beginning of the Playlist and this button is clicked, the playhead cursor will “wrap” to the beginning of the last event in the Playlist. Using the Previous track button also changes the selected Playlist Event. The keyboard equivalent for this control is the Up Arrow key.

Rewind Button

Clicking the Rewind button while audio is playing will play audio backward rapidly until the button is released. Clicking this button while playback is stopped has the same effect as using the Previous Track button – the playhead cursor will locate to the beginning of the previous Playlist Event, the selected Playlist Event changes.

Stop Button

Clicking the Stop button stops playback. The keyboard equivalent for this control is the Space Bar.

Play Button

Clicking the Play button initiates playback. The keyboard equivalent for this control is the Space Bar.

Fast-Forward Button

Clicking the Fast-Forward button while audio is playing will play audio forward rapidly until the button is released. Clicking this button while playback is stopped has the same effect as using the Next Track button – the playhead cursor will locate to the beginning of the next Playlist Event.

Next Track Button

Clicking this button will locate the playhead cursor to the beginning of the next track. In either case, if you are located at the end of the Playlist and this button is clicked, the playhead cursor will “wrap” to the beginning of the first event in the Playlist. Using the Next track button also changes the selected Playlist Event. The keyboard equivalent for this control is the Down Arrow key.

Crossfade Audition Controls

The Crossfade Audition Controls are located in the beveled section of the Control Area near the top of the Playlist interface, and labeled “X-Fade Audition”. These controls allow auditioning of both the individual “in” and “out” elements of a crossfade, as well as both at the same
time. They are particularly useful for fine-tuning crossfades that require precise timing adjustments.

As mentioned earlier, there are a number of different types of transitions that can be created between Playlist Events. These include butt edits, crossfades, gaps, and pauses. While the following controls are technically designed for previewing crossfades, they can also be used for previewing other types of transitions.

Previews can be made with or without a user-defined amount of Pre- & Post-roll. Pre- & Post-roll are useful, as they play a bit of audio material before and after the transition being previewed, and help to put the transition in context of the material that appears before and after the transition. The user-defined amount of Pre- & Post-roll are specified in the Pre- & Post-roll fields in the XFade Audition control area.

Pre-roll Amount Field

This field allows adding a specific pre-roll value to crossfade auditions. Whatever amount of pre-roll time is entered in this field will be added to the overall crossfade audition time. For example, when auditioning with a pre-roll value of three seconds, you will hear three seconds of the Out Event’s audio content prior to the beginning of the crossfade.

To Set Pre-Roll Amount:

1. Double-click in the Pre-Roll field to make it editable.
2. Enter the desired value (in seconds), and press the Return key on your keyboard.

Be aware that the Time Units format you have chosen in the Nudge Amount Format Pop-Up Menu (covered in the next section) also dictates the format you will use when entering pre- and post-roll values – if you have chosen to use Minutes, Seconds, and Milliseconds (MM:SS:ms), as your Time Unit of choice, be sure to enter a pre- or post-roll value in this format. Likewise, if you have chosen Samples as your preferred Time Unit format, enter your pre- and post-roll values with this format in mind.

Post-roll Amount Field

This field allows adding a specific post-roll value to crossfade auditions. Whatever amount of post-roll time is entered in this field will be added to the overall crossfade audition time. For example, when auditioning with a post-roll value of five seconds, you will hear five seconds of the In Event’s audio content following the end of the crossfade.

To Set Post-Roll Amount:

1. Double-click in the Post-Roll field to make it editable.
2. Enter the desired value (in seconds), and press the Return key on your keyboard.

When you create transitions between Playlist Events (i.e., crossfades, butt edits, gaps, or pauses), you will most likely want to test them out before committing to burning them to an audio CD. The Audition Pre- & Post-Roll fields allow you to specify how much audio is included before and after a transition that is being auditioned. Having a bit of program material before and after a transition is helpful, because it puts the transition in context with the material that precedes and follows it. Once a Pre- & Post-roll amount has been set, it is applied when using the Audition Crossfade controls (these tools are covered later in this chapter in the section called “Previewing Transitions between Playlist Events”).
Audition Crossfade-In

Clicking the Audition Crossfade-In button plays only the Playlist Event that is being faded into — also referred to as the “In Event”. The keyboard equivalent for this control is the I key.

To Preview the In portion of a crossfade:

- Click the Audition XFade In button (or press the I key on your keyboard) — the “In” portion of the crossfade is soloed.

To Preview the In portion of a crossfade with Pre- & Post-roll:

- Hold the Ctrl key on your keyboard, and click the Audition XFade In button (or press Ctrl-I on your keyboard) — the “In” portion of the crossfade is soloed with Pre- & Post-roll.

Audition Crossfade-Out

Clicking the Audition Crossfade-Out button plays only the Playlist Event that is being faded out of — also referred to as the “Out Event”. The keyboard equivalent for this control is the O key (the letter O, not the number zero).

To Preview the Out portion of a crossfade:

- Click the Audition XFade Out button (or press the [letter] O key on your keyboard) — the “Out” portion of the crossfade is soloed.

To Preview the Out portion of a crossfade with Pre- & Post-roll:

- Hold the Ctrl key on your keyboard, and click the Audition XFade Out button (or press Ctrl-O on your keyboard) — the “Out” portion of the crossfade is soloed with Pre- & Post-roll.

Audition Crossfade

Clicking the Audition Crossfade button plays the entire crossfade — or, both the Out Event and the In Event simultaneously, as one fades out and the other fades in. The keyboard equivalent for this control is the X key.

To Preview both components of a crossfade together:

- Click the Audition XFade button (or press the X key on your keyboard) — both portions of the crossfade are soloed.

To Preview both components of a crossfade with Pre- & Post-roll:

- Hold the Ctrl key on your keyboard, and click the Audition XFade button (or press Ctrl-X on your keyboard) — the crossfade is soloed with Pre- & Post-roll.

To Preview Butt Edits, Gaps, and Pauses:

1. Set an appropriate amount of Pre- & Post-roll — so that the preview will span a greater duration of the timeline than the transition you wish to preview. For example, if you wish to audition a ten second gap, your combined Pre- & Post-roll time should be at least ten seconds.

2. Hold the Ctrl key on your keyboard, and click the Audition XFade button (or press Ctrl-X on your keyboard) — both portions of the crossfade are soloed.

To Preview both components of a crossfade with Pre- & Post-roll:

- Hold the Ctrl key on your keyboard, and click the Audition XFade button (or press Ctrl-X on your keyboard) — the crossfade is soloed with Pre- & Post-roll.
keyboard)– the crossfade is soloed with Pre- & Post-roll.

**Audition Loop**

Clicking the Audition Loop Button will repeat whichever type of crossfade auditioning you choose. For example, engaging Audition Loop, and then clicking the Audition Crossfade button will play both parts of the crossfade transition (the In & Out Events) in loop mode. If pre- and post-roll values have been specified, the loop’s length will increase to reflect these. The keyboard equivalent for this control is the L key.

**To activate Looping for Previews:**

- Click the Loop Audition button (or press the L key on your keyboard) – the “Out” portion of the crossfade is soloed. When looping is active, the Loop button is highlighted in blue.

**To de-activate Looping for Previews:**

- Click the Loop Audition button again (or press the L key again on your keyboard) – the “Out” portion of the crossfade is soloed.

**Slip/Shuffle Mode Controls**

Slip and Shuffle mode are both invaluable to the editing process, as there are situations where different behaviors are required. For example, a selected Playlist Event (or several selected Events) may need to be moved independently of all other Events – this is ideal for using Slip mode, as when you use Slip mode, only the selected Events are moved. However, there may be other times when after dozens of careful edits you realize that something that occurs very early in the timeline may need a change. By using Shuffle editing mode, you can make the edit early on in the timeline, and have all subsequent Playlist Events maintain their distance relationships – if you have carefully set up crossfades, gaps, etc., these will all be preserved, as all Events that occur later in the timeline than the current edit move in unison.

**Slip Mode Button**

Clicking the Slip Mode button puts the Playlist into Slip Editing mode. In Slip editing mode, a selected Event (or Events) moves independently of all other Playlist Events – when multiple Events are selected the relationship between selected Events remains intact, and the selected group moves independently of all other Events. Slip mode editing is used when it is important to move only the selected Event(s), and not disturb the placement of other Events relative to the Playlist’s timeline. The keyboard equivalent for selecting Shuffle editing mode is the tilde (~) (or S) key – pressing the tilde (or S) key on your keyboard will toggle between Slip and Shuffle editing modes.

Moving a selected Event or Events with the mouse while in Slip Mode does not affect the position of preceding or following unselected Regions relative to the timeline.
Moving a selected Event or Events in Slip Mode does not affect the duration of the crossfades for the Out Event directly preceding the first selected Event, and the In Event directly following the last of the selected Events (when multiple Events are selected – when a single Event is selected, the same holds true for the Out Event directly preceding it, and the In Event directly following it).

The behaviors above hold true for all Playlist Event movements made using the mouse. A number of variations are available when moving Events using the Nudge controls – for more information on these variations, please see the section on Nudge Controls later in this chapter.

To choose Slip Mode:

- Click the Slip Mode button – when selected, the Slip Mode button illuminates in blue.

To Toggle between Slip & Shuffle Modes:

- Press the tilde (~) or S key on your keyboard – the selected mode’s button illuminates in blue.

Shuffle Mode Button

Clicking the Shuffle Mode button puts the Playlist into Shuffle Editing mode. In Shuffle editing mode, a selected Event (or Events) moves independently of all other Events that precede it, and in unison with all Events that follow it, keeping the relationships between the selected Event and following Events intact. Shuffle editing mode is used when it is important to edit a crossfade between two Events that appear mid-Playlist (somewhere after the beginning of the Playlist, but before the end). By using Shuffle Edit mode, any crossfade transitions following the current edit point (that may have already been fine-tuned) are not disturbed. The keyboard equivalent for selecting Shuffle editing mode is the tilde (~) (or S) key – pressing the tilde or S keys on your keyboard will toggle between Slip and Shuffle editing modes.

Whether a single Event or multiple Events are selected produces the same effect in Shuffle editing mode – all Events after the first selected Events are all moved in unison.

Moving a selected Playlist Event or Events with the mouse while in Shuffle Mode does not affect the position of preceding Events relative to the timeline, and all following Events are moved by an equal amount, preserving the relationships between them.

To choose Shuffle Mode:

- Click the Shuffle Mode button – when selected, the Shuffle Mode button illuminates in blue.
To Toggle between Slip & Shuffle Modes:

- Press the tilde (~) or S key on your keyboard – the selected mode’s button illuminates in blue.

Nudge Controls

Nudging allows a user-defined amount of Playlist Event movement, per click of one of the four Nudge buttons. The four Nudge buttons that appear in the beveled area just above the Waveform View Area control the following movements:

- **Nudge In Event Earlier**
- **Nudge In Event Later**
- **Nudge Out Event Earlier**
- **Nudge Out Event Later**
- **Nudge Amount Field**

Nudge keyboard equivalents

You may also find it handy to use the keyboard equivalents for the four Nudge buttons. These commands are:

- **Nudge “Out Event” Earlier in timeline** = Shift + Comma (or <)
- **Nudge “Out Event” Later in timeline** = Shift + Period (or >)
- **Nudge “In Event” Earlier in timeline** = Comma (or <)
- **Nudge “In Event” Later in timeline** = (or >)

It is important to understand that a crossfade is made up of two component Playlist Events. The one that is being faded out of is referred to as the “Out Event”, and the one being faded into is the “In Event”. When using the nudge buttons, keep in mind that each crossfade is considered a group, made up of the In and Out Events being blended together. As such, it is important to understand that when nudging a crossfade’s two components, you will always want to select the In Event. A crossfade is said to be “selected” when its “In” portion is selected. When multiple Events are selected, the earliest one (in terms of position along the timeline) is said to be a part of the selected crossfade – or, to be more precise, its In Event is part of the selected crossfade.

When a single Playlist Event is selected, the selected crossfade is the one that occurs between it and the Playlist Event that appears just before it in the timeline.

When multiple Playlist Events are selected, the selected crossfade is the one that occurs between the earliest selected Event and the Event that appears just before it in the timeline.

Playlist Events may also be nudged when they are not part of a crossfade with another Playlist Event. When nudging an Event in this scenario, it must be selected,
and only the Nudge In Event buttons should be used. Using the Nudge Out buttons in this scenario results in moving the Event that occurs just before the selected Event.

The Playlist’s Nudge Controls are used for fine-tuning the position of Regions relative to each other, as well as to the Playlist’s timeline. In many cases, by nudging the Events that are being crossfaded together, you may also be altering the duration of the crossfade.

A number of the nudge controls and behaviors are user-configurable, allowing users to nudge an Event by any amount desired, using any of Peak’s available Time Units measurements. For example, if a user is working on a Playlist destined to become an audio CD, perhaps they need to nudge by Seconds or CD Frames – if they are working on a Playlist that combines dozens of very short sound effects destined for use in the next big video game, perhaps they need to nudge using Samples as the Time Unit of choice.

There are two sets of Nudge buttons – one is used for nudging the “In Event” (in a crossfade, the Event that’s being faded into), and the other is used for nudging the “Out Event” (in a crossfade, the Event that’s being faded out of). The Nudge controls exhibit a variety of different functions that allow a selected Event or group of Events to be moved by precise amounts.

The behavior of the Nudge controls will vary depending on whether you are using Slip or Shuffle editing mode (described in the previous section). Generally, when you nudge regions in Slip mode, you are editing just the position of the two Events that make up a given crossfade. When you nudge the same Events in Shuffle mode, you are editing the Events in the given crossfade, and all the Events that occur after the In Events (in the given crossfade) are locked to the In Event’s movements, preserving the relationships between the In Event and all subsequent Events. In this scenario, the In Event and all the Events that follow it may move relative to the timeline, but will not move relative to each other.

### Nudge Out Event Earlier in Timeline

This control nudge the Out Event of a crossfade toward the beginning of the Playlist’s timeline, or earlier in time. To nudge an Out Event, the crossfade’s counterpart In Event must be selected. The keyboard equivalent for the Nudge Out Event Earlier in Timeline control is pressing the Shift key + Comma key together.

An easy way to remember this keyboard shortcut is that the Comma key is shared with the < symbol, which indicates the direction that a Region will actually be nudged.

In Slip editing mode, the Nudge Out Event Earlier in Timeline button will move only the Out Event of the selected crossfade. It shortens the crossfade duration of the selected crossfade, and lengthens the duration of the preceding crossfade, as the Out Event is “slipping” along toward the beginning of the timeline, while all other elements remain locked to it.

If multiple Events are selected, only the Out Event of the selected crossfade (ie, the Out Event preceding the selected In Events) will be nudged.

In Shuffle editing mode, the Nudge Out Event Earlier in Timeline button will move both the In and Out Events that comprise the selected crossfade. The duration of this crossfade is maintained, as are the durations of all subsequent crossfades – as they are all “shuffled” in unison, being pulled toward the beginning of the timeline. The duration of the preceding crossfade is lengthened.

Before nudging – note that the “In” Region is selected, and that its position does not move relative to the timeline
The "Out" Region moves to a later point in the timeline

Before nudging – note that the "In" Region is selected, and that its position does not move relative to the timeline

The "Out" Region moves to an earlier point in the timeline

If multiple Events are selected, the Out Event preceding the first of the selected Events will be nudged – the In Event and all subsequent Events will be nudged by an equal amount, preserving the relationships between all Events that follow in the entire Playlist.

**Nudge Out Event Later in Timeline**

This control nudges the Out Event of a crossfade toward the end of the Playlist’s timeline, or later in time. To nudge an Out Event, the crossfade’s counterpart In Event must be selected. The keyboard equivalent for the Nudge Out Event Earlier in Timeline control is pressing the Shift key + Period key together.

---

An easy way to remember this keyboard shortcut is that the Period key is shared with the > symbol, which indicates the direction that an Event will actually be nudged.

---

In Slip editing mode, the Nudge Out Event Later in Timeline button will move only the Out Event of the selected crossfade. It lengthens the crossfade duration of the selected crossfade, as and shortens the duration of the preceding crossfade, as the Out Event is “slipping” along toward the end of the timeline, while all other elements remain locked to it.

If multiple Events are selected, only the Out Event preceding the first of the selected Events will be nudged.

In Shuffle editing mode, the Nudge Out Event Earlier in Timeline button will move both the In and Out Events that comprise the selected crossfade. The duration of this crossfade is maintained, as are the durations of all subsequent crossfades – as they are all “shuffled” in unison, being pushed toward the end of the timeline. The duration of the preceding crossfade is shortened.

If multiple Events are selected, the Out Event preceding the first of the selected Events will be nudged – the In Event and all subsequent Events will be nudged by an equal amount, preserving the relationships between all Events that follow in the entire Playlist.

**Nudge In Event Earlier in Timeline**

This control nudges the In Event of a crossfade toward the beginning of the Playlist’s timeline, or earlier in time.
To nudge an In Event, it must be selected. The keyboard equivalent for the Nudge In Event Earlier in Timeline control is pressing the Comma key on your keyboard.

An easy way to remember this keyboard shortcut is that the Comma key is shared with the < symbol, which indicates the direction that an Event will actually be nudged.

In Slip editing mode, the Nudge In Event Earlier in Timeline button will move only the In Event of the selected crossfade. It lengthens the crossfade In duration for the selected crossfade, and shortens the duration of the subsequent crossfade, as the Out Event is “slipping” along toward the beginning of the timeline, while all other elements remain locked to it.

If multiple Events are selected, they will both be nudged toward the beginning of the timeline in unison. The crossfade from the preceding Event to the first of the selected Events is lengthened, and the crossfade from the last of the selected Events to the first subsequent Event is shortened.

In Shuffle editing mode, the Nudge In Event Earlier in Timeline button will move the selected In Event toward the beginning of the Playlist’s timeline. The duration of the selected crossfade is lengthened, and the duration of all subsequent crossfades is maintained – as they are all “shuffled” in unison, being pulled toward the beginning of the timeline.

When multiple Events are selected, the behavior is the same.

Be aware that when multiple Events are selected, that the Event appearing first (in terms of distance from the beginning of the timeline) is considered to be a component of the “selected” crossfade – it is important to understand this, so that while editing your Playlist, you nudge the Event you intend to.

Nudge In Event Later in Timeline

This control nudge the In Event of a crossfade toward the end of the Playlist’s timeline, or later in time. To nudge an In Event, it must be selected. The keyboard equivalent for the Nudge In Event Later in Timeline control is pressing the Period key on your keyboard.

An easy way to remember this keyboard shortcut is that the Period key is shared with the > symbol, which indicates the direction that an Event will actually be nudged.

In Slip editing mode, the Nudge In Event Later in Timeline button will move only the In Event of the
selected crossfade. It shortens the crossfade In duration for the selected crossfade, as and lengthens the duration of the subsequent crossfade, as the Out Event is “slipping” along toward the end of the timeline, while all other elements remain locked to it.

![Image](https://example.com/peak交叉淡入.png)

Before nudging – note that the “In” Region is selected, and that its position moves relative to the timeline, while the “Out” Region remains locked to the timeline.

If multiple Events are selected, they will both be nudged toward the end of the timeline in unison. The crossfade from the preceding Event to the first selected Event is shortened, and the crossfade from the last of the selected Events to the first subsequent Event is lengthened.

![Image](https://example.com/peak交叉淡出.png)

The “In” Region moves to a later point in the timeline.

In Shuffle editing mode, the Nudge In Event Later in Timeline button will move the selected In Event toward the end of the Playlist’s timeline. The duration of the selected crossfade is shortened, and the duration of all subsequent crossfades is maintained – as they are all “shuffled” in unison, being pushed toward the end of the timeline.

When multiple Events are selected, the behavior is the same.

---

**Be aware that when multiple Events are selected, that the Event appearing first (in terms of distance from the beginning of the timeline) is considered to be a component of the “selected” crossfade – it is important to understand this, so that while editing your Playlist, you nudge the Event you intend to.**

---

**To fine-tune an Event’s position by nudging:**

1. Select the desired Nudge Amount and Format (More information available in the Setting Nudge Amount & Format section, earlier in this chapter)
2. Select the Event you wish to nudge
3. Click the Nudge button that corresponds to the Event and Direction you wish to nudge – for example, to Nudge the Out Event later in time, click the Nudge Out Event Later in Timeline button (Shift-Period [or >])

---

**To fine-tune multiple Event’s positions by nudging:**

1. Select the desired Nudge Amount and Format (More information available in the Setting Nudge Amount & Format section, earlier in this chapter)
2. Select the Events you wish to nudge
3. Click the Nudge button that corresponds to the Events and direction you wish to nudge – for example, to Nudge the Out Event later in time, click the Nudge Out Event Later in Timeline button (Shift-Period [or >]), or to Nudge all selected Events, click the Nudge In Earlier or Later buttons.
When using the Playlist’s Nudge buttons to fine-tune the position of a Playlist Event(s), you can specify how small or large an increment each click of the button will move the selected Playlist Event(s). In addition, you can also choose the Time Units format used. Generally, you will want to use a format that suits the type of audio project you are working on. For example, if you are mastering an audio CD, you will probably want to be working in Minutes:Seconds:Milliseconds (MM:SS:ms) or CD Frames – if you are working on the soundtrack for a digital video project, you will probably want to work in SMPTE units).

Nudge Amount Field

The Nudge Amount field lets you specify how many Time Units to nudge an Event by, when using the four nudge buttons mentioned above. For example, if you had the Playlist’s Nudge Format set to Seconds, and you wanted to nudge Events by one second with each click of a nudge button, you would enter “1”.

To Set a nudge amount:

• Click into the Nudge Amount field, and edit the existing value (or double-click to enter a completely new value).

Nudge Format Pop-Up Menu

The Nudge Format lets you specify what type of Time Units should be used when nudging. Time formats available include Samples, Minutes:Seconds:Milliseconds (MM:SS:ms), SMPTE (24, 25, 29.97, 30, 59.97, and 60 fps), Bars/Beats, and CD Frames.

To Set a nudge format:

• From the Time Units pop-up menu, choose the desired Time Units format.

Mode Checkboxes & Behaviors

Preserve Timing Mode Checkbox

Scroll Regions Mode Checkbox

Audio CD Playlist Mode Checkbox

Preserve Timing Mode Checkbox

Checking the Preserve Timing mode checkbox allows you to move a crossfade’s location relative to the timeline, without changing its overall duration. When using Preserve Timing mode, the position of the In and Out Events in question does not change relative to the timeline, only the crossfade’s position moves. When the Preserve Timing checkbox is checked, any Event trimming will always extend the other component Event’s boundary. You may temporarily toggle the Playlist into Preserve Timing mode by holding down the Option key on your keyboard, when the tool cursor is in Trim Event mode. If the Preserve Timing mode checkbox is checked, holding down the Option key has no effect.

Preserve Timing allows you to fine-tune the location of a crossfade, and keep the overall duration of the two component Events that are being crossfaded constant. When trimming one component Event of a crossfade with Preserve Timing mode engaged, the other component Event is “untrimmed” by an equal amount. The end result is that you are able to “slide” the crossfade over both component Events simultaneously. By doing this, you keep the audio content of both Events locked to the timeline, and you preserve the duration and envelope characteristics of the crossfade.
The beginning of the “Out” Event, and the end of the “In” Event do not change position when editing in Preserve Timing mode.

In Preserve Timing mode, when you edit a crossfade’s position, you are essentially trimming one component of a crossfade, and simultaneously extending (or “untrimming”) the crossfade’s other component Region. This has the overall effect of shortening one of the component Regions, lengthening the other by an equal amount, and maintaining the overall duration, or timing of the entire Playlist.

Preserve Timing mode is especially useful when compositing different recording takes together, or when trying to locate the ideal crossfade position when working with material that needs to have its tempo maintained, such as electronic music with a constant tempo.

To engage Preserve Timing mode:

- Check the Preserve Timing checkbox – the presence of a check means Preserve Timing mode is active.

To temporarily engage Preserve Timing mode:

- Hold down the Option key on your keyboard while trimming one component Event that makes up a crossfade.

To move a crossfade while preserving its duration:

1. Create a crossfade between two Playlist Events.
2. Place a check in the Preserve Timing checkbox (or hold down the Option key to temporarily toggle into Preserve Timing mode.
3. Trim one of the component Events that makes up the crossfade – the other component Event is trimmed/extended by an equal amount.

Scroll Regions Mode Checkbox

Checking the Scroll Regions Mode checkbox allows you to scroll the audio content within fixed Playlist Event boundaries. When the Scroll Regions mode checkbox is checked, any use of the Move Event Tool will scroll a Playlist Event’s content, keeping its beginning and end boundaries locked to the timeline. To temporarily toggle into Scroll Regions mode, hold down the Option key on your keyboard while attempting to use the Move Event Tool, rather than moving the Event, you will scroll its content. If the Scroll Regions mode checkbox is checked, holding down the Option key has no effect.

Scroll Regions is another mode which can also preserve the overall duration of a Playlist. It allows you to keep the beginning and end boundaries of a Playlist Event locked in place, and to vary the audio content that appears in the “window” between them. Since the beginning and end of the Playlist Event do not move relative to the timeline, the Playlist’s duration does not change.

If a Region in a source audio document is equal to the length of the entire document, you will not be able to use Scroll Regions mode within the Playlist, as there is no other audio content to scroll. This feature requires that there be additional audio content outside the Region markers in the source audio document. If a Region in a source audio document is shorter that the document itself, then you can scroll the Region’s audio content within the Playlist.
To engage Scroll Regions Mode:

- Click the Scroll Regions checkbox – the presence of a check means Scroll Regions mode is active.

To temporarily engage Scroll Regions mode:

- Hold down the Option key on your keyboard while clicking and dragging a Playlist Event (using the Move Event tool) – the source Region’s content is scrolled within the fixed Begin/End Boundaries.

To use Scroll Regions Mode:

1. Place a check in the Scroll Regions checkbox (or hold down the Option key to temporarily toggle into Scroll Regions mode).
2. Select a Playlist Event (or multiple Events).
3. Click over the selected Playlist Event’s Waveform, and (with the Move Event tool) drag to the left or right – the Waveform moves, while the Playlist Event’s boundaries stay in a fixed location relative to the timeline. (If scrolling the content of multiple selected Playlist Events, it does not matter which you click and drag in, as all selected items will scroll an equal amount.

If a Region in a source audio document is equal to the length of the entire document, you will not be able to use Scroll Regions mode within the Playlist, as there is no audio content outside the Region, into which you can scroll. This feature requires that there be additional audio content outside the Region markers in the source audio document. If a Region in a source audio document is shorter than the document itself, then you can scroll the Region’s audio content within the Playlist.

Audio CD Checkbox

When working with a Playlist destined to become a Red Book audio CD, this box should be checked. When the Audio CD checkbox is checked, the Playlist enters a special Red Book compliant mode, which ensures that any CDs burned from it will be Red Book compliant as well. When this box is checked, a two second gap is automatically placed at the beginning of the timeline, edits are automatically “snapped” to CD frame

In this example, you can see the effect of scrolling the audio content within the fixed Begin/End boundaries of a Region...

Note that the Region’s Begin/End boundaries have not moved relative to the timeline – so the overall duration of the Playlist is maintained.
The “CD-Write” category displayed will show the capabilities of the CD burner in question. The CD burner used in this example is capable of burning CD-TEXT, Index Points, and ISRC codes.

To engage Audio CD Mode:

• Check the Audio CD checkbox.

2. Enter the desired metadata, and click OK – this disc-specific information will be included when the Playlist is burned to CD.

In addition to requiring Mac OS X v.10.4 or later to burn CD-TEXT, ISRC codes, and subcode metadata, your Macintosh must also have a CD burner capable of burning this type of data. You may want to check with your CD burner’s manufacturer to find out about what types of data is capable of burning, or you can use a handy UNIX command in the Terminal utility. The Terminal application is located in the Utilities folder, within the Applications folder.

To check your CD burner’s compatibility with the Terminal:

1. Open the Terminal application (from /Macintosh HD/Applications/Utilities/)

2. At the $ prompt, type: “drutil info” and press Return – you will see something that looks like this:

   ![Terminal Command Output]

The “CD-Write” category displayed will show the capabilities of the CD burner in question. The CD burner used in this example is capable of burning CD-TEXT, Index Points, and ISRC codes.

Adding Disc-Specific CD-TEXT Metadata

Various types of disc-specific metadata may be added to Playlist project, and will be added to CDs burned from it. These types of metadata include Disc Title, Performer, Songwriter, Composer, Arranger, Message, Genre, Disc Identifier, MCN (EAN or UPC), etc.

To Add CD-TEXT to a Disc:

1. In the upper left portion of the Playlist interface, click the CD-Info button – the CD-TEXT for Audio CD dialog appears.

   ![CD-TEXT for Audio CD]

   Longer audio CDs (usually up to about 79 minutes) may also be created when using the Playlist in standard mode (i.e., not in Audio CD mode). Many modern CD players can play audio CD-Rs that violate the 74-minute limitation of the Red Book standard, as long as all other Red Book guidelines are observed. Keep in mind, that audio CD-Rs longer than 74 minutes, created in standard mode may not play on all CD players, and cannot be used as pre-masters.

   ![Warning]

Waveform View Area

The Waveform View Area appears just below the Crossfade Audition and Nudge Controls, and contains a graphical representation of the Events used in a Playlist, as well as various controls for configuring options related to the graphical Playlist Event view. The Waveform View...
Area is particularly useful for creating and editing crossfade transitions between Playlist Events, as its waveform displays graphically convey information about an Event’s audio content and amplitude to the user. The various controls and options available in the Waveform View Area are discussed in detail in this section.

**View Controls**

The Playlist’s View Controls allow you to configure various options to suit the work that you are doing. These controls affect only the Waveform View Area and have no impact on settings in the List View or Control Area.

**Show/Hide Waveform View Disclosure Triangle**

This small black triangle appears to the left of the “Waveform View” label in the interface. This is a standard Mac OS control that is typically used to show or hide additional information or interface controls. When the Waveform View disclosure triangle is pointing to the right (closed position), it is hiding the entire Waveform View portion of the Playlist’s interface. When the disclosure triangle is pointing downward (open position) it is showing, or “disclosing”, the Waveform View portion of the interface.

**Linear View Button**

When the Linear View button is clicked, the audio waveform display appears much like a single mono track. When a crossfade between Events is created, the Events’ waveforms appear superimposed over each other for the duration of the crossfade, with each Event displayed in a different color.

![A crossfade between two Events shown here in Linear View](image)

**Staggered View Button**

When the Staggered View button is clicked, the audio waveform display appears much like two adjacent mono tracks in a DAW – where the first Event appears on the upper track, the next Event appears on the lower track, and so on, creating a staggered arrangement of Events between the two tracks. When a crossfade between Events is created, there is a clear overlap in time between the upper and lower waveform displays.

![The same crossfade between the same Regions, shown in here in Staggered View.](image)

**View Left Channel Waveform Radio Button**

When this button is clicked (Linear or Staggered View), only the left audio channel of a stereo Event’s audio is used to calculate the waveform display.

![View: L, R, L+R](image)
**View Right Channel Waveform Radio Button**

When this button is clicked (Linear or Staggered View), only the right audio channel of a stereo Event’s audio is used to calculate the waveform display.

**View L+R Channels Waveform Radio Button**

When this button is clicked (Linear or Staggered View), the sum of both the left and right audio channels of a stereo Event’s audio are used to calculate the waveform display.

---

Despite the waveform display appearing to be composed of a single audio channel/waveform when in L + R Channel mode, this single waveform is actually a sum of the Left and Right channels, being displayed simultaneously. When working in a mono Playlist, only the View Left Channel Waveform Radio button is available.

---

Being able to vary your view of Events along the Playlist’s timeline is very important. There may be times when you need the perspective of being zoomed out all the way, so as to get an overview of how imported Regions are arranged. Some kinds of edits may require the precision of a high zoom level, so as to align the beats in the waveforms of two Events you are trying to beat-match. The following few steps, along with the section on Playlist Navigation will teach you how to get around quickly in the Playlist interface.

**Zoom In Button**

The Zoom In button is used to magnify the Waveform View horizontally. To get a closer look at a particular section, click this button to zoom in. The keyboard equivalent for the Zoom In control is 36-.

**Zoom Out Button**

The Zoom Out button is used to de-magnify the Waveform View horizontally. To get more of a big picture view of the audio waveform, click this button to zoom out. The keyboard equivalent for the Zoom Out control is 36-.

**Waveform Display Area**

The Playlist’s Waveform area contains quite a number of visual elements which are important to understand. This section will familiarize you with these elements, the majority of which will be used in every Playlist project you undertake.

**Playlist Event Display**

The Playlist Event Display shows audio that is contained between Region markers in the original source audio document. By default, a Playlist Event appears in blue, and when selected, in yellow. These colors may vary, depending on whether you have assigned custom themes or colors in Peak’s Preference Panel.

**Playlist Event Name Display**

The Playlist Event Name display appears in the upper left corner of the Playlist Event Display. If a Playlist Event’s Display is moved partially off-screen because of window scrolling activity, the Event’s name will remain in view as long as any portion of the actual Region Display is visible. When a Track Offset is set, the Region Name Display position defaults to the Offset’s position. If the Offset’s position is moved partially off-screen due to window scrolling, the Event Name Display remains visible, even when the Offset itself is no longer visible.
**Detail of Waveform Display Area**

**Playlist Event Begin Boundary**

The Playlist Event Begin Boundary is essentially the beginning of a Playlist Event, or, the Playlist Event’s earliest point along the timeline. A Playlist Event’s Begin Boundary may vary depending on many factors, such as trimming, moving, or nudging of the Event. A Playlist Event’s Begin Boundary also serves as the default position of a CD track index, when working with a Playlist destined to be burned as an audio CD.

When a custom Track Start Offset is set for a particular Event, it becomes the CD track index for that Event.

When using the crossfade audition controls, the Begin Event boundary serves as the audition starting point, and when auditioning with pre-roll, is the point from which a pre-roll amount is measured.

**Playlist Event End Boundary**

The Playlist Event End Boundary is essentially the end of a Playlist Event, or, the Playlist Event’s latest point along the timeline. A Playlist Event’s End Boundary may vary depending on many factors, such as trimming, moving, or nudging of the Event. Note that when burning to CD, or exporting the Playlist as a file, that the end boundary of one Event is the beginning boundary of the next Event, so silent gaps are added to the end of the earlier track, and extend its duration.

When using the crossfade audition controls, the End Event boundary serves as the audition ending point, and when auditioning with post-roll, is the point from which a post-roll amount is measured.

**Playlist Event Begin Time Display**

A Playlist Event’s Begin Time appears in the lower left
corner of a Playlist Event when the Event is selected. The
Playlist Event’s Begin Time display is live, and updates as
a Playlist Event is moved along the timeline. A Playlist
Event’s Begin Time is also the default start time of a CD
track, when working with a Playlist destined to be burned
as an audio CD, and no custom Track Offset has been set.

Double-clicking the envelope opens the Event Crossfade
Out editor, where you may select a new envelope shape,
or create your own custom envelope shape. The
envelope shape dictates the audio’s amplitude level over
time. A steeper slope creates a more rapid change in
amplitude, and a more gradual slope creates a fade out
with a slower change in amplitude.

Crossfade In Duration
A Playlist Event’s Crossfade In duration may optionally be
displayed by selecting Show Marker Times from Peak’s
Options menu. When this option is enabled, a Playlist
Event’s Crossfade In duration is displayed directly below
the Event Name Display when the Event is selected. This
is a live display, and updates in real time when the Event
is being moved.

Crossfade Out Duration
A Playlist Event’s Crossfade Out duration may optionally be
displayed by selecting Show Marker Times from
Peak’s Options menu. When this option is enabled, a Playlist
Event’s Crossfade Out duration is displayed directly below the Event Name Display when the Event is
selected. This is a live display, and updates in real time
when the Event is being moved.

Track Start Offset Indicator
Track Start Offsets are used when a different time than an
Event’s Begin Time needs to be used as a CD track index.
The Track Start Offset appears by default in the exact
same position as an Event’s Begin Boundary, and is
represented by a bold white line that overlaps the Event’s
Begin Boundary. When a Track Start Offset is used, it
becomes the CD Track index for the Event it is set for. A
custom Track Offset may be created by dragging this
indicator to a position earlier or later than the Event’s
Begin Boundary. The offset created is represented by a
shaded area that appears directly before or after the
Event’s Begin Boundary.

Double-clicking the envelope opens the Event Crossfade
Out editor, where you may select a new envelope shape,
or create your own custom envelope shape. The
envelope shape dictates the audio’s amplitude level over
time. A steeper slope creates a more rapid change in
amplitude, and a more gradual slope creates a fade out
with a slower change in amplitude.
Offset duration is displayed just to the right of the Offset, and is indicated with a delta (Δ), and a positive or negative time value, depending on whether the Offset is created before or after the Event’s actual Begin Boundary.

**Gap/Pause Indicator**

Gaps and Pauses are used to create silent gaps between CD tracks -- or to create pauses between CD tracks that contain audio. By default, this indicator appears in the same position as a Playlist Event’s Begin Boundary and Track Start Offset. A custom Gap/Pause may be created by dragging this indicator to a position earlier or later than the Event’s Begin Boundary. The Gap/Pause is represented by a shaded area that appears directly before or after the Event’s Begin Boundary.

A typical use for a Gap is having two seconds or so of silence between two CD tracks. A common use for a Pause containing audio is in creating an audio CD of a live recording, where the audience applause between songs is placed in the pause -- in this scenario, if a listener advances to this CD track, they can skip over the applause and go right to the song, but if they listen to the CD from beginning to end, they would hear the applause between songs.

**Timeline**

The Timeline provides a reference as to where Playlist Events exist in relation to the beginning of the timeline (time zero). The Timeline appears horizontally along the bottom of the Waveform View Area, and is regularly marked at major time intervals. These marked intervals will vary depending on the Time Units you have chosen to use, and also depending on the zoom level you are using to view the Waveform View Area. For example, if you have chosen to use Minutes:Seconds:milliseconds as your Time Unit format, and you have zoomed all the way out, you will see the Timeline marked at one minute intervals. As you zoom in, you will see the Timeline marked at intervals of several seconds, and when zoomed in all the way, the intervals appear every second.

**Playhead Cursor**

The Playhead Cursor indicates which portion of the Playlist is currently being played back. Its position corresponds to the numerical position indicated by the Counter Display. Clicking anywhere along the Timeline moves the Playhead Cursor to that location, and starts playback.

**Horizontal Scrollbar**

The Horizontal Scrollbar is the bottom-most graphical element of the Waveform View Area, and appears only when there is more graphical content than can be displayed on-screen at the current zoom level. This control is used for changing the view only, and does not actually move Events or other Playlist elements relative to the timeline or to each other. The keyboard equivalent for the horizontal scrollbar is pressing the Control key and the Left or Right Arrow keys -- Press Control + Left Arrow to scroll to the left, or earlier in the timeline, or press Control + Right Arrow to scroll to the right, or later in the timeline.

**Horizontal Scroll Arrow Buttons**

The horizontal Scroll Arrows appear to the right of the horizontal Scrollbar, and much like the Scrollbar, are used solely for changing the view of the Waveform View Area. Whereas the Scrollbar allows moving as much or as little as desired, the Scroll Arrows move by a fixed
increment with each click. The amount the Waveform is scrolled with each click depends on the zoom level. At lower zoom levels, one click scrolls by a larger amount than at a higher zoom level. The keyboard equivalent for the horizontal Scroll Arrows is pressing the Control key and the Left or Right Arrow keys – Press Control + Left Arrow to scroll to the left, or earlier in the timeline, or press Control + Right Arrow to scroll to the right, or later in the timeline.

If you use a Mac OS X compatible mouse with a scroll wheel, the wheel may also be used for Horizontal Scrolling in the Playlist.

Cursor Modes/Tools

The Playlist automatically switches between its two cursor modes, depending on the location of the cursor relative to a Playlist Event’s Begin and End Boundaries. When the cursor is positioned near one of the Boundaries, it changes to the Trim Event tool, and when it is positioned over the Waveform Display portion of an Event, it changes to the Move Event tool. Aside from positioning the cursor, no user interaction is required.

Move Event Tool

The Move Event tool is used for moving Regions forward or backward in the Playlist’s timeline with the mouse. It is represented by a <-> cursor. The keyboard equivalents for the Move Event tool are the Comma and Period keys (Comma moves an Event earlier in time, Period moves it later in time) – these are the same as the Nudge In Event keyboard commands, though using the key commands moves/nudges an In Event by the amount specified in the Nudge Amount Field (See section on Nudge Controls for more information).

To Use the Move Event Tool:

1. Place your mouse cursor over a Playlist Event’s waveform – the cursor appears as a <->.
2. Click on the waveform – you can now drag the Event to a new position, earlier or later in the timeline.

Trim Event Tool

The Trim Event tool is used to trim or extend an Event’s begin or end boundary. It is represented by a ->] or [< cursor, depending on whether you are trimming the beginning or end of an Event. There is no keyboard equivalent for the Trim Event tool.

The Trim Event tool trims the begin or end boundary of the Playlist Event the mouse cursor is placed over. Trimming (extending) the begin boundary of a Playlist Event to the left, gives that Event an earlier start time in the timeline and extends the duration of the Event. Trimming the begin boundary of a Playlist Event to the right, gives that Event a later start time and shortens the Event. Trimming the end boundary of a Playlist Event to the left, gives that Event an earlier end time in the timeline and shortens the Event. Trimming (extending) the end boundary of a Playlist Event to the right, gives that Event a later end time and lengthens the Event.

To Use the Trim Event Tool:

1. Place your mouse cursor near the begin or end
boundary of a Playlist Event — when you are close
to the boundary, notice that the cursor changes to
the Trim Event tool cursor (\([<->]\)).

2. When the Trim Event tool has become active, click
and drag over the Playlist Event’s begin or end
boundary — to move the boundary earlier in the
timeline, drag to the left, and to move it later, drag
to the right.

**High-Precision Editing Mode**

When using the Move Event Tool, Trim Event Tool, Scroll
Regions Mode, or Preserve Timing Mode, you can use a
modifier key to temporarily toggle into High-Precision
Editing Mode. The modifier key is the Control (Ctrl) key
on your keyboard. Whenever this key is held down while
using one of the aforementioned tools or modes, the
tool/mode will make edits in one millisecond
increments. For example, if you use the Trim Event tool
while holding down the Ctrl key, the Event boundary will
be trimmed by one millisecond at a time.

If the Audio CD mode checkbox is checked, High-
Precision Editing mode will make edits at increments of
one CD Frame at a time.

**Selecting Playlist Events**

Once a few Regions have been added to a Playlist (and
are now referred to as Playlist Events), they will usually
need to be edited in some way. This editing may include
trimming, nudging, entering metadata, etc. Regardless
of the type of edit to be performed, it is important to
know how to make selections, as this is how particular
Playlist Events are targeted for editing processes.

**To Select a Playlist Event in the Waveform View Area:**

- Click the desired Playlist Event — you will know it is
  highlighted because it will appear in a different
color than other, unselected Playlist Events.
  (Colors will vary depending on your color
  preference settings).

**To Select multiple Playlist Events in the Waveform View
Area:**

- Click the desired Playlist Event — you will know it is
  highlighted because it will appear in a different
color than other, unselected Playlist Events.
  (Colors will vary depending on your color
  preference settings).

- With the initial selection still active, hold down the
  Command (⌘) key and click another Playlist Event
  — two Playlist Events are now selected.

- To add additional Playlist Events to the selection,
click on other Playlist Events while continuing to
  hold down the Command (⌘) key.
Holding down the Command (⌘) key while making selections allows you to select non-adjacent Playlist Events. Holding down the Shift key while making selections automatically selects the entire range of Playlist Events that appears between two non-adjacent Playlist Events.

Deleting Playlist Events

Any selected Playlist Events may be deleted in Waveform View or in List View.

To Delete a Playlist Event in Waveform View:

- Select the Playlist Event(s) you wish to delete in the Waveform View area, and click the Delete Playlist Event Button in the upper left of the Playlist interface, or press the Delete key on your keyboard.

Creating Transitions between Playlist Events

There are four distinct types of transitions available between adjacent Playlist Events. These include butt edits, crossfades, gaps, and pauses.

Butting Playlist Events Together

Butt edits are the default type of transition created as multiple Events are added to a Playlist. In a butt edit, two Events are positioned back-to-back, with no space between them.

In the case that an Event is no longer butted against its preceding Event, it is easy to put it back into this position.

Crossfading Playlist Events Together

Another type of transition between Playlist Events is a crossfade. A crossfade is a transition in which two Events overlap in time — that is, before the earlier Event ends, the later Event has already started. In the area where the two Events overlap, the earlier Event fades out, as the later Event fades in. In a typical crossfade, the overall volume level remains more or less constant, though it will depend on the audio content. Peak offers many
crossfading options, making it possible to achieve practically any effect desired.

To Crossfade Playlist events in Waveform View:

1. Locate two adjacent Events you wish to crossfade together.
2. Click on the earlier (or “Out”) Event, and drag it to the right (later in time), so an overlap in time is created between the two Events. (Or, click on the later (or “In”) Event, and drag it to the left, or earlier in time, until an overlap is created.

To Change the Duration of a crossfade in Waveform View with the Move Event Tool:

- Using the Move Event tool, click and drag one of the component Events that make up a crossfade to the left or right – moving the “Out Event” to the left (earlier in time) shortens the crossfade, and moving it to the right (later in time) lengthens the crossfade. Moving the “In Event” to the left (earlier in time) lengthens the crossfade, and moving it to the right (later in time) shortens the crossfade.

To Change the Crossfade Type in Waveform View:

1. Select the crossfade you wish to edit (remember that to “select” a crossfade, you must select the “In” component of the crossfade).
2. In the upper left portion of the Playlist interface, click the Crossfade Type button, and choose the desired type of crossfade from the pop-up menu – both components of the selected crossfade receive a new fade envelope shape.

To Change the Duration of a crossfade in Waveform View with the Trim Event Tool:

- Using the Trim Event tool, click and trimming the “Out Event’s” end boundary to the left (earlier in time) shortens both the Event and the crossfade, while trimming (extending) the end boundary lengthens the Event and crossfade. Trimming (extending) the “In Event’s” begin boundary to the left (earlier in time) lengthens both the Event and the crossfade, while trimming it to the right shortens both the Event and the crossfade.
To Create a custom Fade Envelope In Waveform View:

1. Double-click directly over the fade envelope you wish to edit (i.e., the “In” or the “Out”) – the Playlist Event Crossfade editor dialog appears.

2. In the Playlist Event Crossfade editor, you may choose a preset from the pop-up menu, or you may create your own by modifying the existing envelope shape.

3. Click anywhere on the line and a new moveable “breakpoint” will appear.

4. Drag the breakpoint to the desired location on the envelope’s curve.

5. Continue creating and dragging breakpoints until you have created the fade envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

6. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.

7. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

8. When you are finished, click the OK button – the custom fade is applied to the Event’s/Region’s waveform display.

If you save your custom Fade In/Out envelope into:

/MacintoshHD/Users/<YourAccount>/Library/Preferences/Peak Envelopes/

it will automatically appear in the Envelope pop-up menu if the Fade In/Out Envelope editor. Please note that you must apply the custom fade in/out for it to later appear in the pop-up menu.

Setting a custom gap or pause between Playlist Events

Gaps and pauses are very similar in most regards – they create a short delay between two Playlist Events – but pauses can be used in a unique way, that gaps cannot. A gap can only be used to create a silent space between two Playlist Events.

This picture shows a short gap between two Playlist Events.
A pause can be used for the same purpose, and can also be used to create a space that contains audio. For example, you might be mastering a live concert recording, which contains long sections of audience applause between songs. By creating a pause containing audio (the audio in this example being applause) between two songs, you can create an audio CD which when played through from beginning to end will play both the songs, and the applause between them. If the listener navigates using the next track or previous track controls on the CD player, the player will jump directly to the beginning of the song, and will skip the applause that occurs before it.

When a gap is created between two Playlist Events, the gap’s duration is added as silence to the end of the preceding Event, and the silence is considered to be part of the earlier Event. When burned to CD, a CD player’s counter treats a gap as part of the preceding track.

When a pause is created between two Playlist Events, the pause’s duration is a unique entity, it is not added to the preceding Event, nor is it added to the following Event. When burned to CD, a CD player’s counter does not add the pause to the preceding or following track, but instead, when the preceding track ends, the counter counts backwards (on players that support this) for the duration of the pause, and when it ends, the track counter is incremented, and the next track begins playing.

To Create a Gap between Playlist Events in Waveform View:

1. Locate the two Events you wish to create a custom gap between.
2. Using the Move Event tool, drag the later Event to the right (later in time), until the desired gap length is created between the two Events.
3. To Preview the gap, click in the timeline, a few seconds ahead of the gap – audio playback starts from this point. (For other previewing options, see the upcoming section on Previewing transitions between Playlist Events).

To Create a silent Pause between Playlist Events in Waveform View:

1. Locate the two Events you wish to create a custom pause between.
2. Using the Move Event tool, drag the later Event to the right (later in time), until the desired pause length is created between the two Events.
3. Drag the later Event’s Pause indicator to the left (earlier in time), until it is aligned with the earlier Event’s end boundary.
4. To Preview the pause, click in the timeline, a few seconds ahead of the gap – audio playback starts from this point. (For other previewing options, see
To Create a pause containing audio between Playlist Events in Waveform View:

1. Locate the two Events you wish to create a custom pause between.

2. Drag the later Event’s Pause indicator to the left (earlier in time), until it is at an earlier point in the timeline than the end boundary of the preceding Event.

Setting Track Start Offsets

Track Start Offsets are used to create “virtual” start times – that is, they trigger where the counter display advances to the next track and dictate where a CD track index is placed. When an audio CD featuring Track Start Offsets is played back in a CD player, these offsets determine the point where the CD player’s counter advances to the next track. They also determine the point within a track’s content that audio playback starts, when the next track or previous track controls are used.

Track Start Offsets are particularly useful when you need to precisely position a track’s start time within a crossfade between two Playlist Events. By default, an Event’s/Track’s start time is located at the same position as the Event’s own begin boundary. In a crossfade between two Events, the use of a custom Track Start Offset allows the actual start time to occur at any point within the crossfade.

To Set a Track Start Offset earlier than an Event’s begin boundary in Waveform View:

- Click and drag the Track Start Offset to the desired position.

An Event’s Track Start Offset cannot occur earlier in the timeline than the preceding Event’s Track Start Offset, or later than the Event’s end boundary.
List View Area

The various controls and data fields found in the List View portion of the Peak Playlist are described in this section. Keep in mind that the columns and data fields are described in the order they appear by default. Due to Peak’s highly customizable nature, you are free to click and drag the columns and fields into any order desired, but be aware that if you have changed them from their default position, that the documentation may not appear in the same order, though there is no difference in functionality.

List View Columns, Controls, and Data Fields

This section describes each of the controls found in the List View Area.

Show/Hide List View disclosure triangle

This small black triangle appears to the left of the “List View” label in the interface. This is a standard Mac OS control that is typically used to show or hide additional information or interface controls. In this case, when the List View disclosure triangle is pointing to the right (closed position), it is hiding the entire List View portion of the Playlist’s interface. When the disclosure triangle is pointing downward (open position) it is showing, or “disclosing”, the List View portion of the interface.

Peak LE does not feature this disclosure triangle, as it uses only one Playlist view (List View).

Program Duration Time Display

Directly opposite from the Show/Hide List View disclosure triangle, you will find the Program Duration display. This display shows the duration of all the contents in the Playlist, from beginning to end, and takes into account all crossfades and gap times. By default, this display appears in the interface frame which separates the Waveform View from the List View. When the Waveform View is hidden, the Program Duration appears above the List View, below the Nudge Controls, and when the List View is hidden, it appears in the window frame, just below the Waveform View Area.

Track Number Column

The Track Number column displays the track number of each Playlist Event. The number displayed in this
column will become the CD track number if the Playlist is burned as an audio CD, and also represents the Playlist Event position when the Playlist is bounced to a new audio document containing Region markers. This number is not editable – the only way to change a Track Number is by changing the order of Events in a Playlist.

**Track Name Column**

The Track Name column displays the names of Events used in a Playlist. By default a Track Name appears exactly as the Region's original name appears in its source audio document, though it can be edited in the Playlist. A single click on an item under the Track Name column makes the text editable, and a new name may be entered. Changing the name in the Playlist does not affect the name of the original source Region in its audio document.

**Track Start Offset Time Column**

The Track Start Offset column displays a Track Start Offset Time value, if one is used – and corresponds to the position of the Track Start Offset in the Waveform View display area. By default, a track’s start time is set to an Event’s Begin Boundary, and displays a value of zero seconds (or equivalent in the chosen Time Units). A Track Start Offset allows the actual track start time to have an independent value, so that a track’s actual start time can be set before or after an Event’s Begin Boundary. To edit a Track Start Offset in List View, click in an Event’s TS Offset data field under the TS Offset column – the Edit Track Start Offset dialog will appear.

**Track End Time Column**

This column shows the End Time for a Playlist Event. This value corresponds with the position of the Event End Boundary. A single click on an item under the Track End Time column makes the value editable, and a new End Time may be entered.

**Track Duration Column**

This column shows the overall duration between a Playlist Event’s Begin and End Boundaries. A single click on an item under the Track Duration column makes the value editable, and a new Duration may be entered.

**Gap/Pause Duration Column**

The Gap/Pause Duration Column displays a Gap/Pause Duration value, if one is used – and corresponds to the position of the Gap/Pause indicator in the Waveform View display area. By default, the Gap/Pause between tracks is zero seconds (or equivalent in other Time Units) – this is displayed in the Gap/Pause column, and the Gap/Pause indicator (in Waveform View) is locked to an Event’s Begin Boundary. A typical use for a Gap is having two seconds or so of silence between two CD tracks. A typical use for a Pause containing audio is in a live recording, where the audience applause between songs is placed in the pause – in this scenario, if a listener advances to this CD track, they can skip over the applause and go right to the song, but if they listen to the CD from beginning to end, they would hear the applause between songs. Clicking in a Playlist Event’s Gap/Pause field makes it editable, and a new value may be entered.

**Crossfade In Shape Field/Column**

Fields appearing under this column display a thumbnail representation of the Fade In envelope shape being used for the Playlist Event. Double-clicking on the thumbnail graphic will open the Playlist Event Crossfade In editor dialog, allowing you to modify the shape of the fade envelope. A number of preset fade envelope shapes are
available in the Current Envelope Pop-Up menu — these include:

**XFade Block In** – When this fade envelope is used, a fade in occurs instantaneously. This type of envelope is useful when performing butt edits, and the transition between Playlist Events needs fine-tuning, or when the In component of a crossfade needs to fade in instantaneously, while the Out component fades out over time.

**XFade Equal Power Blend** – When this fade envelope is used, a fade in occurs over time — if the Out component of the crossfade uses the same envelope shape, the overall amplitude of audio across the entire duration of the fade will remain relatively constant.

**XFade Linear Blend** – When this fade envelope is used, the rate at which the amplitude increases is linear, and amplitude increases smoothly at all stages of the fade in. This is the default fade type, and is also the most commonly used fade type.

### Crossfade Out Shape Column

Fields appearing under this column display a thumbnail representation of the Fade Out envelope shape being used for the Playlist Event. Double-clicking on the thumbnail graphic will open the Playlist Event Crossfade Out editor dialog, allowing you to modify the shape of the fade envelope. A number of preset fade envelope shapes are available in the Current Envelope Pop-Up menu — these include:

**XFade Block Out** – When this fade envelope is used, a fade out occurs instantaneously. This type of envelope is useful when performing butt edits, and the transition between Playlist Events needs fine-tuning, or when the Out component of a crossfade needs to fade out instantaneously, while the In component fades in over time.
**XFade Equal Power Blend** – When this fade envelope is used, a fade out occurs over time – if the In component of the crossfade uses the same envelope shape, the overall amplitude of audio across the entire duration of the fade will remain relatively constant.

**XFade Linear Blend** – When this fade envelope is used, the rate at which the amplitude decreases is linear, and amplitude decreases smoothly at all stages of the fade out. This is the default fade type, and is also the most commonly used fade type.

**Crossfade In Duration Column**
Fields displayed under this column show how long it takes the “In” component of a crossfade to fade.

**Crossfade Out Duration Column**
Fields displayed under this column show how long it takes the “Out” component of a crossfade to fade.

**Gain Change Amount Column**
Fields displayed under this column show the amount of non-destructive gain change – from the original level in the source audio document. Changes applied here affect only the Playlist Event, not the source Region in the source audio document. A Playlist event’s gain setting can be used to control the balance of the event in a Playlist. You may need to raise the volume or lower the volume of some Playlist events to maintain a proper balance of volume levels. You can make adjustments to the gain of individual Playlist Events as you playback the Playlist.

Be careful not to set a Playlist event’s gain too high as you may overload the signal and cause clipping to occur. You may also introduce clicks between Playlist events if the difference in gain between the two playlist events is too large. Crossfades can help smooth these transitions.

**ISRC Display Column**
Fields displayed under this column show the ISRC code for each Playlist Event. Single-clicking a Playlist Event’s ISRC data field makes it editable, allowing ISRC code entry only. Double-clicking on this data field opens the Per-Track CD-TEXT dialog, which contains an ISRC code field – as well as fields for other per-track CD-TEXT data, such as Track Title, Performer, etc.
ISRC-formatted codes are composed of four sections – a Country Code, Owner Code, Year of Reference Code, and Serial Number.

- **Country Code** – An ISO (International Standards Organization) member country’s designation. This portion of the code consists of two capital letters.

- **Owner Code** – The owner’s (sound recording copyright owner) country. This portion of the code consists of three alphanumeric characters.

- **Year of Reference Code** – The year in which the ISRC is allocated to the recording – represented by the last two digits of the year. This portion of the code consists of two digits.

- **Serial Number** – The code assigned to the track by the owner. This code may not be repeated within the same calendar year. This portion of the code consists of five digits.

To find out more about ISRC codes, please visit the International Federation of Phonographic Industry website, at:

http://www.ifpi.org/isrc/

---

**CD-TEXT (per Track) Dialog**

This dialog contains a number of fields in which various track-specific CD-TEXT data may be entered. This data is burned to CD only when both the CDTXT checkbox in the Playlist, and the Burn CD-TEXT from Playlist checkbox in the Burn Audio CD Dialog are both checked. The fields available in this dialog include:

- Title
- Performer
- Songwriter
- Composer
- Arranger
- ISRC

**Emphasis Column**

This column’s checkboxes indicate whether a Playlist Event is flagged for emphasis. The emphasis flag is one of several available CD data subcode control bits that trigger various behaviors when the CD is played. Depending on the CD player, this flag may cause an internal high pass filter to be engaged, boosting the high frequency content of the track. Emphasis is not commonly used.
Copy Protection Column

This column’s checkboxes indicate whether a Playlist Event is flagged for serial (SCMS) copy protection. The copy protection flag is one of several CD data subcode control bits that trigger various behaviors when the CD is played. When this flag is turned on for a track, it could prevent digital copies from being made.

Vbox Effects Pop-Up Menu

Peak’s Playlist allows VST and Audio Units effects plug-ins to be used (via the Vbox routing interface) on Playlist Events. Each Playlist Event can have a unique effects “snapshot” assigned to it. These effects are applied as the Playlist is auditioned, and also when bounced as a new document, or when burned to audio CD.

CD-TEXT Column

This column’s checkboxes indicate whether the CD-TEXT data for a track is valid for burning to CD.

Some of the List View’s fields may be changed simultaneously, for multiple Playlist Events. The fields that allow this are Track Start Offset, Gap/ Pause, I-XF, O-XF, I-XF-T, and O-XF-T. To change values in these fields for multiple items, you must select the desired Playlist Events, and then double-click in the field you wish to change. A dialog appears, allowing a value to be entered – this value is then applied to the respective field for all selected Playlist Events.

Vertical Scrollbar

The vertical scrollbar appears along the right side of the Playlist window, when List View is showing. This scrollbar is used for moving up and down through the list of Playlist Events, when there are more than can be displayed at the current window height.

Horizontal Scrollbar

The horizontal scrollbar is one of the bottom-most graphical elements of the List View Area, and appears only when there is more graphical content than can be displayed on-screen at the current Playlist window width.

Selecting Playlist Events

Once a number of Regions have been added to a Playlist (and are now referred to as Playlist Events), chances are, they will need to be edited in some way. This editing
may include trimming, nudging, entering metadata, etc. Regardless of the type of edit to be performed, it is important to know how to make selections, as this is how particular Playlist Events are targeted for editing processes.

**To Select a Playlist Event in the List View Area:**

- Click the desired Playlist Event – you will know it is highlighted because it will appear highlighted. (Highlight color will vary depending on your Mac OS Appearance preference settings).

**To Select multiple Playlist Events in the List View Area:**

- Click the desired Playlist Event – you will know it is highlighted because it will appear highlighted. (Highlight color will vary depending on your Mac OS Appearance preference settings).

- With the initial selection still active, hold down the Command (⌘) key and click another Playlist Event – two Playlist Events are now selected.

- To add additional Playlist Events to the selection, click on other Playlist Events while continuing to hold down the Command (⌘) key.

**Deleting Playlist Events**

Deleting Playlist Events requires that the unwanted Events are selected. The previous section discusses ways to select Playlist Events.

**To Delete a Playlist Event in List View:**

- Select the Playlist Event(s) you wish to delete in the List View area, and click the Delete Playlist Event Button in the upper left of the Playlist interface, or press the Delete key on your keyboard.

**Changing the Names of Playlist Events**

There may be times when you wish to change the names of Playlist Events. This can be done only in the List View Area, but be aware that this does not change the name of the Region in the original source document. To change the name of a source Region, please refer to Chapter 5: Editing.

**To Rename a Playlist Event:**

1. In the List View portion of the Playlist, click on the name of the Playlist Event you wish to rename – after a short delay, the name becomes editable text.

2. Enter a new name for the Playlist Event and press the Return key on your keyboard.
Changing the Order of Playlist Events

Changing the order of Playlist Events is something that is only possible using List View.

To change the order of a single Playlist Event:

1. Select the Event you wish to move to a new position.

2. Drag the selected Event up or down, to desired position in the List of Playlist Events, highlighting the name of the Event you wish the selected Event to appear before.

For example, to move the second Event into the third position in the List of Events, you would select, click, and drag the second Event, moving it over the third event (third event will become highlighted), and release the mouse button. In this scenario, Events 2 and 3 change place, and no other Events are affected.

To change the order of multiple adjacent Playlist Events:

1. Select the Events you wish to move to a new position.

2. Drag the selected Events up or down, to desired position in the List of Playlist Events, highlighting the name of the Event you wish the selected Events to appear before.

For example, to move the first, second, and third Events into the third, fourth, and fifth positions in the List of Events, you would select, click, and drag the first, second, and third Events, moving them over the fifth event (fifth event will become highlighted), and release the mouse button. In this scenario, Events 1, 2, and 3 now become Events 3, 4, and 5, and Events 4 and 5 are pushed up the list to become the first and second Events.
Changing the order of multiple Playlist Events requires that the selected Events to be adjacent to each other.

Creating Transitions between Playlist Events

There are four distinct types of transitions available between adjacent Playlist Events. These include butt edits, crossfades, gaps, and pauses.

Butting Playlist Events Together

Butt edits are the default type of transition created as multiple Events are added to a Playlist. In a butt edit, two Events are positioned back-to-back, with no between them.

In the case that an Event is no longer butted against its preceding Event, it is easy to put it back into this position.

To Butt an Event to the preceding Event in List View:

1. Click the desired Playlist Event’s Gap/Pause data field – the field becomes editable.
2. Enter a value of zero, and press the Return key – the Event is butted against the preceding Event’s end boundary.

Crossfading Playlist Events Together

Another type of transition between Playlist Events is a crossfade. A crossfade is a transition in which two Events overlap in time – that is, before the earlier Event ends, the later Event has already started. In the area where the two Events overlap, the earlier Event fades out, as the later Event fades in. In a typical crossfade, the overall volume level remains more or less constant, though it will depend on the audio material. Peak offers many crossfading options, making it possible to achieve practically any effect desired.

To Crossfade Playlist Events in List View:

1. Locate two adjacent events you wish to crossfade together in List View.
2. In the earlier Event’s (the “Out Event”) row, click in the O-XF-T Column (or “Out Crossfade Time”) – the field becomes editable.
3. Enter an earlier value than the Start Time of the following Event (the value that appears in the following Event’s Start Time Column) and press the Return key on your keyboard.

Or:

1. Locate two adjacent events you wish to crossfade together in List View.
2. In the later Event’s (the “In Event”) row, click in the I-XF-T Column (or “In Crossfade Time”) – the field becomes editable.
3. Enter a later value than the End Time of the preceding Event (the value that appears in the preceding Event’s End Time Column) and press the Return key on your keyboard.
Editing Crossfades

Crossfades may be edited in either Waveform View or List View. This section deals specifically with editing crossfades in List View – for details on crossfading in Waveform View, please see the section that focuses on Waveform View, earlier in this chapter.

To Change the Duration of a Crossfade in List View:

1. Locate the crossfade whose duration you wish to alter.
2. In the earlier Event’s (the “Out Event”) row, click in the O-XF-T Column (or “Out Crossfade Time”) – the field becomes editable.
3. Enter an earlier value than the Start Time of the following Event (the value that appears in the following Event’s Start Time Column) and press the Return key on your keyboard.

Or:

1. Locate the crossfade whose duration you wish to alter.
2. In the later Event’s (the “In Event”) row, click in the I-XF-T Column (or “In Crossfade Time”) – the field becomes editable.
3. Enter a later value than the End Time of the preceding Event (the value that appears in the preceding Event’s End Time Column) and press the Return key on your keyboard.

To Change the Crossfade Type in List View:

1. Select the “In” component Event of the crossfade (i.e., the Event that’s being faded in).
2. In the upper left portion of the Playlist interface, click the Crossfade Type button, and choose the desired type of crossfade from the pop-up menu – both components of the selected crossfade receive a new fade envelope shape.

To Create a custom Fade Envelope In List View:

1. Locate the Event you wish to assign a custom fade envelope to, and double-click directly on its I-XF or O-XF shape column, depending which envelope you wish to edit (i.e., the “In” or the “Out”) – the Playlist Event Crossfade editor dialog appears.
2. In the Playlist Event Crossfade editor, you may choose a preset from the pop-up menu, or you may create your own by modifying the existing envelope shape.
3. Click anywhere on the line and a new moveable “breakpoint” will appear.
4. Drag the breakpoint to the desired location on the envelope’s curve.

5. Continue creating and dragging breakpoints until you have created the fade envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

6. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.

7. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

8. When you are finished, click the OK button – the custom fade is applied to the Event’s thumbnail waveform display in the I-XF or O-XF column.

If you save your custom Fade In/Out envelope into:
MacintoshHD/Users/<YourAccount>/Library/
Preferences/Peak Envelopes/

it will automatically appear in the Envelope pop-up menu in the Fade In/Out Envelope editor. Please note that you must apply the custom fade in/out for it to later appear in the pop-up menu.

Setting Custom Gaps or Pauses between Playlist Events

Gaps and pauses are very similar in most regards – they create a short delay between two Playlist Events – but pauses can be used in a unique way, that gaps cannot. A gap can only be used to create a silent space between two Playlist Events. A pause can be used for the same purpose, and can also be used to create a space that contains audio.

For example, you might be mastering a live concert recording, which contains long sections of audience applause between songs. By creating a pause containing audio (the audio in this example being applause) between two songs, you can create an audio CD which when played through from beginning to end will play both the songs, and the applause between them. If the listener navigates using the next track or previous track controls on the CD player, the player will jump directly to the beginning of the song, and will skip the applause that occurs before it.

When a gap is created between two Playlist Events, the gap’s duration is added as silence to the end of the preceding Event, and the silence is considered to be part of the earlier Event. When burned to CD, a CD player’s counter treats a gap as part of the preceding track.

When a pause is created between two Playlist Events, the pause’s duration is a unique entity, it is not added to the preceding Event, nor is it added to the following Event. When burned to CD, a CD player’s counter does not add the pause to the preceding or following track, but instead, when the preceding track ends, the counter counts backwards (on players that support this) for the duration of the pause, and when it ends, the track counter is incremented, and the next track begins playing.

To Create a Gap between Playlist Events in List View:

1. Locate the Events you wish to create a gap between.

2. In the later Event’s row in List View, double-click
under the Gap/Pause column – the Playlist Event Gap Time column appears.

3. Enter the desired Gap length, and click OK – the later event is moved later in the timeline by whatever amount was entered in the Playlist Event Gap Time dialog.

To Create a silent Pause between Playlist Events in List View:

1. Locate the Events you wish to create a pause between.

2. In the later Event’s row in List View, single-click the Event’s Gap/Pause field – after a short delay, it will become editable.

3. Enter the desired pause length, and press the Return key on your keyboard – the later event is moved later in the timeline by the amount you entered in the Gap/Pause field, and the Pause indicator is automatically aligned with the end boundary of the preceding Event.

To Create a pause containing audio between Playlist Events in List View:

1. Locate the Events you wish to create a pause between.

2. In the later Event’s row in List View, click the Event’s Gap/Pause field – it will become editable.

3. Enter the desired pause length, and press the Return key on your keyboard.

4. For the same Event, click the Start Time field – it will become editable.

5. Adjust this value by subtracting the duration of the pause from the previous Start Time.

For example, if the Event originally had a Start Time of 00:10:30:000, and the pause amount entered in Step 3 was 5 seconds, the new Start Time should be 00:10:25:000. This has the same effect as creating a silent pause, and then dragging the later Event to a position 5 seconds earlier in the timeline using Waveform View. Note that the Butt to Previous Event End command may also be used in place of steps 4 and 5 above.

Setting Track Start Offsets

Track Start Offsets are used to create “virtual” start times – that is, they trigger where the counter display advances to the next track and dictate where the CD track index is placed. When an audio CD burned from a Playlist featuring Track Start Offsets is played back in a CD player, these offsets determine the point where the CD player’s counter would advance to the next track. They also determine the point within a track’s content that audio playback starts, when the next track or previous track controls are used.

Track Start Offsets are particularly useful when you need to precisely position a track’s start time within a crossfade between two Playlist Events. By default, an Event’s/Track’s start time is located at the same position as the Event’s own begin boundary. In a crossfade between two Events, the use of a custom Track Start Offset allows the actual start time to occur at any point within, before, or after the crossfade.

To Set a Track Start Offset in List View:

1. Click once over the desired Playlist Event’s Track Start Offset (TS Offset) data field – after a short delay, the field contents become editable.

2. Enter a new Track Start Offset value, and press the Return key on your keyboard – the Event’s corresponding waveform display has its Track Start Offset indicator moved to reflect the new value.
A Track Start Offset cannot occur earlier in the timeline than the preceding Event's Track Start Offset, or later than the Event's own end boundary.

**Adding Metadata to Discs & Tracks**

A variety of metadata may be added to entire discs, and to individual CD tracks. Metadata is added in two formats – CD-TEXT, and embedded subcode data. CD-TEXT appears in the display of compatible CD players, and subcode data triggers certain behaviors (such as emphasis or copy protection) on compatible players.

Subcode data is not displayed – it is read by compatible CD players and used for a variety of purposes, such as tracking copyrights and royalties (with ISRC codes), or looking up a CD's info via an online service such as Gracenote’s CDDB™, which is used by some software-based CD players like Apple’s iTunes™.

While Peak’s Playlist supports writing the entire spectrum of metadata on both a per-disc and per-track basis, be aware that most CD players do not support reading/displaying this data. In addition, compatible CD players will vary in the types of metadata they read or display.

**Track-Specific Metadata**

Various types of track-specific metadata may be added to a Playlist project, and will be added to CDs burned from it. These types of metadata include: Track Title, Performer, Songwriter, Composer, Arranger, and ISRC code.

To Add CD-TEXT to a Track:

1. Check the CDTXT checkbox for the desired Playlist Event – the CD-TEXT for Track dialog opens.

2. Enter the desired types of metadata, and click OK – when burned to audio CD, the metadata will be included.

3. When you burn the Playlist to CD, check the Burn CD-TEXT from Playlist checkbox in the Burn Audio CD dialog.

**About ISRC Codes**

ISRC codes can be burned to CD as CD-TEXT, and/or as embedded subcode channel data.
To add an ISRC Code to a track as CD-TEXT:

1. In the desired Playlist Event’s row, click the CDTXT checkbox – the CD-TEXT for Track dialog opens.
2. In the ISRC field, enter your ISRC code, and click OK – be sure the CDTEXT checkbox is checked.
3. When you burn the Playlist to CD, check the Burn CD-TEXT from Playlist checkbox in the Burn Audio CD dialog.

Burning CD-TEXT requires Mac OS X v. 10.4 or later, and a compatible CD burner!

To add an ISRC Code to a track as subcode channel data:

1. In the desired Playlist Event’s row, enter your ISRC code in the ISRC field.
2. When you burn the Playlist to CD, check the Write ISRC Codes checkbox in the Burn Audio CD dialog – the ISRC codes in the Playlist are burned as subcode data.

ISRC codes may be entered either in the CD-TEXT dialog, or directly into a Playlist Event’s ISRC data. Be aware that having entered an ISRC code, and having the CDTXT checkbox checked will only burn ISRC codes as CD-TEXT data, which is displayed on compatible CD players as the CD is played back. To burn ISRC codes as audio CD subcode data, which is used for commercial CD copyrights, etc. you must have entered an ISRC code, and checked the Write ISRC Codes checkbox, which appears in the Burn Audio CD dialog.

Burning ISRC codes as subcode data operates independently of the CDTXT checkbox – whether it is checked or not determines only whether an ISRC code (and other fields in the CD-TEXT dialog) is burned as CD-TEXT, which is displayed on a compatible CD player, but is not related to copyrights and royalty tracking.

ISRC codes may be burned as both CD-TEXT and embedded subcode data simultaneously by following both sets of steps outlined above. To do this, you must enter an ISRC code, check the Playlist’s CDTXT checkbox, and also check the Write ISRC Codes checkbox in the Burn Audio CD dialog.

CD-TEXT compatible CD players vary in what embedded information they actually display. The most common information displayed is the CD Title, Performer, and Track Title. Check the documentation that was included with your CD-TEXT compatible CD player for more information on what types of CD-TEXT data it is capable of displaying.

Editing Subcode Data

Peak’s Playlist is capable of editing Emphasis and Copy Protection subcode data bits. While these subcodes are rarely used, there may be times when you wish to enable these subcodes. More information about using these subcodes is available earlier in this chapter.
To add an Emphasis (Emp/PE) Flag to a Track:

- Check the Emphasis (Emp) checkbox for the desired Playlist Event – when burned to audio CD, this track will trigger compatible CD players to turn on a high pass filter to boost high frequencies.

To add a Copy Protection flag to a Track:

- Check the Copy Protection (CP) checkbox for the desired Playlist Event – when burned to audio CD, this track will feature digital copy protection.

Indexes

In addition to track indexes, which designate the start or end of a CD track, you may also burn standard indexes to audio CDs using Peak. Indexes are created by placing Markers in the desired location within a source audio document that is referred to by a Playlist. Indexes are not visible when working in the Playlist, but are burned to CD. Indexes are commonly used on classical music CDs, where a track may be relatively long (i.e., 20 minutes or more), and indexes appear at various intervals or points of interest, within a single CD track. With CD indexes in place, a listener can navigate to the index location using the indexing controls on a compatible CD player. Most CD players do not support navigation using indexes.

CD Burner Compatibility

In addition to requiring Mac OS X v.10.4 or later to burn CD-TEXT, your Macintosh must also have a CD burner capable of burning this type of data. You may want to check with your CD burner’s manufacturer to find out about what types of data is capable of burning, or you can use a handy UNIX command in the Terminal utility. The Terminal application is located in the Utilities folder, within the Applications folder.

To check your CD burner’s compatibility with the Terminal:

1. Open the Terminal application (from /Macintosh HD/Applications/Utilities/)
2. At the $ prompt, type: “drutil info” and press Return – you will see something that looks like this:

The UNIX command “drutil info” reveals the capabilities of the CD/DVD burner in a Macintosh. In this picture, we can see that the drive in question supports writing CD-Text, as well as Index Points, and ISRC codes.
**Applying Effects Plug-Ins to Playlist Events**

Unique effects “snapshots” may be assigned to each Playlist Event. These effects are applied to each Event during Playlist preview, as well as when bouncing/exporting the Playlist, and burning audio CDs. Effects snapshots contain information about the arrangement of effects within the Vbox matrix, as well as the settings of each individual plug-in.

There are a number of controls used to configure Vbox’s effects settings for each Playlist Event. These controls are:

**Off** – The Off control turns off/bypasses any effects that are assigned to a Playlist Event.

**On** – The On control activates effects that are assigned to a Playlist Event. If Vbox is not active, the On control activates Vbox on the first available effects insert (i.e., if no effects are active, Vbox will be activated on effect Insert 1. If an effect is already active on Insert 1, Vbox will be activated on Insert 2, and so on.)

**Set** – The Set control takes a snapshot of the current Vbox state for the selected Playlist Event. This snapshot includes information about which effect(s) are active and which box(es) they occupy, as well as each effect’s current settings.

**Make Active** – The Make Active control displays the settings that are assigned to the selected Playlist Event. This control is especially useful when you wish to apply the same effect(s) snapshot to multiple Playlist Events. You can select the Playlist Event that has the desired snapshot assigned to it, and choose the Make Active menu item, which displays the settings for that Playlist Event. Then you can assign these settings to another Playlist Event which does not have a snapshot already assigned to it, by selecting the target Playlist Event, and choosing the Set menu item. The first Playlist Event’s snapshot is applied to the targeted Playlist Event, and they both share an identical effect(s) snapshot.

**Clear** – The Clear control clears any snapshot assigned to the selected Playlist Event.

This section will teach you how to configure these effects. More general information about using Vbox and effects plug-ins is available in Chapter 8: Plug-Ins.
To enable Vbox state automation for a Playlist Event:

• From the Vbox pop-up menu, choose On – If Vbox inactive, this command opens it. If Vbox is already open, this command has no additional effect.

To disable Vbox state automation for a Playlist Event:

• From the Vbox pop-up menu, choose Off – Vbox is disabled for this Playlist Event, though the Vbox interface will remain active and visible.

To take a “snapshot” of the current plug-in settings:

1. From the Vbox pop-up menu, select On – If Vbox inactive, this command opens it. If Vbox is already open, this command has no additional effect.
2. Configure Vbox with the desired effects plug-ins.
3. From the Vbox pop-up menu, select Set – a “snapshot” of the current state is saved.
4. Select the next Playlist Event (and repeat for all subsequent Events on which you wish to use “snapshot” automation).
5. From the Vbox pop-up menu, select On.
6. From the Vbox pop-up menu, select Set – a “snapshot” of the current state is saved for this Playlist Event.

To Make a Playlist Event’s “snapshot” active:

1. Select the Playlist Event which contains the “snapshot” you wish to make active.
2. From the Vbox pop-up menu, select Make Active.
3. Select a different Playlist Event, on which you wish to assign the “snapshot” made active in the previous step.
4. From the Vbox pop-up menu, select Set – the “snapshot” used on the Playlist Event chosen in Step 1 is assigned to the Event selected in Step 3.

To clear a Playlist Event’s “snapshot”:

1. Select the Playlist Event which contains the “snapshot” you wish to clear.
2. From the Vbox pop-up menu, select Clear – the selected Playlist Event no longer contains a saved “snapshot”.

Clicks or pops may occur if your effect snapshots include any settings that instantiate and de-instantiate plug-ins. The reason for this is that there is always a very short delay between actually choosing a plug-in from a menu, and that plug-in being instantiated. When a Playlist is going from one Event to another very rapidly (especially on slower computers) clicks and pops may occur. Therefore, it is recommended that if you want to use different plug-in configurations for each Playlist Event, configure Vbox with all the plug-ins you want to use for all Playlist Events, and then create snapshots for each Playlist Event with the plug-ins that you don't want to use on that Playlist Event muted or bypassed. (For more information on using Vbox, please refer to Chapter 8: Plug-Ins)
If you plan on creating crossfades and using effects snapshots in a Playlist, it is recommended that you apply effects plug-ins to Regions in their source documents, before adding them to the Playlist. The Playlist uses state automation, and "snaps" from one effects setting to the next instantly. If the effects used from one Playlist Event to another differ greatly, the result can be an abrupt transition from Event to the next. By applying the effects in the original source documents, the transition from one Playlist Event to another will occur smoothly, and effects differences between Events will be smoothed out by the crossfade between them.

Output Options

Peak's Playlist offers a wide variety of output options, including burning audio CDs, exporting an entire Playlist as a single audio document, as a text file, as a DDP (Disc Description Protocol) file set, or as a Jam Image file.

Burning Audio CDs

Burning audio CDs is one of the most common ways to output digital audio projects edited in Peak. CDs may be burned directly from an audio document, or from a Playlist document. When burning from a Playlist made in Audio CD mode (i.e., with the Audio CD checkbox checked), the resulting CD will conform to the Red Book standard, and will be playable in any CD player (except for player that are not compatible with CD-R media). Burning a CD not made in Audio CD mode may play on a standard CD player, but this will depend largely on the CD player's capabilities. For maximum compatibility, it is recommended to burn in Audio CD mode. For more information, please review the section on Audio CD mode which appears earlier in this chapter.

CD Burning Options

The Burn Audio CD dialog contains a number of CD burning options, which are described below.

Burner Pop-up Menu

This menu allows you to choose which CD burner you wish to use (when more than one burner is connected to your computer).

Burn Speed Pop-up Menu

This menu allows you to choose the desired burn speed. Generally, lower speeds will produce the most reliable CDs. It is a good idea to check the burn speed rating of the blank CD media you are using to find out what its maximum recommended burn speed is.

Use POW-r Dither Checkbox

The state of this checkbox determines whether POW-r dither should be applied to a Playlist during the burning process. If you are working with 24-bit content, it is recommended that you check this box, so as to reduce the bit depth to 16-bit, while maintaining the highest possible quality through dithering. If this box is not checked, 24-bit files are simply truncated.
**Verify After Burn Checkbox**

The state of this checkbox determines whether a burned CD is compared to the audio data contained in the Playlist and source audio documents, to verify its accuracy. To verify a CD, be sure this box is checked.

**Burn in Simulation Mode Checkbox**

The state of this checkbox determines whether Peak burns in simulation mode. In simulation mode, a CD is not actually burned — instead, Peak goes through all the motions of burning, and will uncover any problems with a Playlist before committing to a burned CD. This option is helpful as “burning” in simulation mode can help save blank media. To use simulation mode, be sure this box is checked, and be sure to uncheck it when you are ready to burn a CD.

**Use Buffer Underrun Protection Checkbox**

The state of this checkbox determines whether Buffer Underrun Protection is used while burning a CD. Buffer underrun errors result from a hard drive not being able to transmit audio data to a CD burner fast enough while burning a CD. It is recommended that this box be checked during the burning process, though most drives support this automatically.

**Burn CD-TEXT from Playlist Checkbox**

The state of this checkbox determines whether CD-TEXT entered in the Playlist is burned to CD. To burn CD-TEXT to disc, be sure this box is checked.

**Write ISRC Codes Checkbox**

The state of this checkbox determines whether ISRC codes entered in the Playlist are burned to CD as embedded subcode data. To burn ISRC codes to disc, be sure this box is checked.

**Regions are Tracks Checkbox**

The state of this checkbox determines whether each Event should become a separate CD track. If this box is not checked, one long track will be burned.

---

**Markers are Indexes**

The state of this checkbox determines whether Markers placed in a Region’s source audio document are burned to CD as indexes within tracks.

**Burning from a Playlist**

Peak can burn audio CDs either from a Playlist, or from an audio document. This section covers burning from a Playlist — burning from a document is covered later in this section.

**To Burn an Audio CD from a Playlist:**

1. With the Playlist window in the foreground, choose Select All (⌘-A) from the Edit menu (or select only the desired Events).
2. In the upper left portion of the Playlist interface, click the Burn Playlist to Audio CD button — the Burn Audio CD dialog appears.
3. In the Burn Audio CD dialog, choose the desired burning options.

4. Insert a blank CD – the Burn button becomes available.

5. Click the Burn button – the Playlist is burned to CD.

**Burning from an Audio Document**

In addition to the advanced options available in the Playlist, Peak can also burn audio CDs directly from an audio document. When burning from a document, the same Burn Audio CD dialog is presented, so you may choose from many of the same burning options.

**To burn an audio CD from a Peak Audio Document:**

1. Open the desired audio document.

2. From the File menu, choose Burn Audio CD – the Burn Audio CD dialog appears.

3. In the Burn Audio CD dialog, choose the desired burning options.

4. Insert a blank CD – the Burn button becomes available.

5. Click the Burn button – the Playlist is burned to CD.

**Burning from a Jam Image file**

1. Open the Jam Image file exported from Peak in Roxio Jam.

2. Click the Burn CD Button – the Jam Image file is burned as an audio CD.

3. In the Bounce Playlist dialog, select the desired options for the file to be output, and click the Bounce Playlist button (or choose New>Document from Playlist from the File menu) – a new file is generated, taking into account all edits and effects applied in the Playlist, as well as all settings made in the Bounce Playlist dialog.
Exporting a DDP Fileset

With the optional DDP extension installed and active, Peak is capable of exporting a Playlist in DDP (Disc Description Protocol) 2.0 format, which is commonly used when delivering a finalized mastering project for CD manufacturing. DDP files ensure that audio files, crossfades, edits, and all other data used in a Playlist remains exactly in the state it was in when exported from Peak. This highly secure format ensures that the audio data being burned to CD in the manufacturing process is identical to the mastering engineer’s intentions when creating the Playlist in Peak. Exporting as a DDP File Set results in a folder being created with the following four files:

**DDPID** – DDPID contains the DDP level identifier, Master ID and UPC/EAN number. It also locates the DDPMS map stream for physically addressed direct access input media. The DDP level identifier specifies the level of DDP implemented and the interpretation of the other DDP streams.

**DDPMS** – DDPMS contains information to locate and process each stream of TS (Text), DS (Subcode) or DM (Main channel) input data. It contains enough information to automatically develop PQ subcode data.

**SUBCODES.DAT** – The subcode information referred to by the DDPMS

**AUDIO.DAT** – The audio data referred to by the previous files in little endian format

To export a DDP file from a Playlist:

1. With the Playlist in the foreground, choose Select All (⌘-A) from the Edit menu.
2. In the upper left portion of the Playlist interface, click the Bounce Playlist button.
3. In the Bounce Playlist dialog, choose DDP 2.0 File Set from the File Format menu, and click the Bounce button – a Save dialog appears.
4. Choose the desired save location, click the Save DDP Fileset button, and name the folder to which the DDP Fileset will be saved – the Playlist is exported as a DDP file set.

Exporting in DDP format requires the optional Peak DDP Extension. If you do not have the DDP Extension, and need to deliver files in this format, please contact BIAS for purchase information, at:

**US:** 1-800-775-2427

**International:** +1-707-782-1866

**Email:** sales@bias-inc.com

**Web:** http://www.bias-inc.com

Exporting a Jam Image File

In addition to the aforementioned Playlist delivery
options, Peak is also able to export Jam Image files, which may be opened and burned using Roxio Jam, a popular audio CD burning application.

To Export a Jam Image file from a Playlist:

1. With the Playlist in the foreground, choose Select All (⌘-A) from the Edit menu.

2. In the upper left portion of the Playlist interface, click the Bounce Playlist button.

3. In the Bounce Playlist dialog, choose Jam Image File from the File Format menu, and click the Bounce button – a Save dialog appears.

4. Choose the desired save location, and click the Save button – the Playlist is exported as a Jam Image File.

Exporting as Text

There may be times when you need to output the details of a Playlist as a simple text file. An exported text file uses a tab-delimited format which can be easily imported into a database, spreadsheet, or word processing application.

To create a Text file from a Playlist:

1. With the Playlist in the foreground, choose Select All (⌘-A) from the Edit menu (or select only the desired Events).

2. From Peak’s File menu, choose Export as Text – a Save dialog appears.

3. Choose the desired save location, and click the Save button – a text version of the Playlist is exported.

Conclusion

You have now learned all about creating and editing Playlist documents, and outputting them in a wide variety of formats. Please continue along to the next chapter, where you will learn all about Peak’s extensive DSP (Digital Signal Processing) tools.

Playlists exported as text appear in the format shown above, and can easily be imported into most database, spreadsheet, and word processing applications.
Chapter 7: DSP

Introduction

Peak allows you to transform your audio with a variety of powerful Digital Signal Processing (DSP) tools. You can apply these tools at any time by first making a selection in an audio document and then choosing the desired menu command from the DSP menu.

Processing Audio with Peak's DSP Tools

The following general procedure describes how to process a selection in an audio document, or the entire document, with a particular DSP function. The specific capabilities and parameters of the DSP function will vary.

To process audio with a DSP function:

1. Select the portion of the audio that you wish to process with the DSP function. If no selection is made, the entire document will be processed.

2. Select the type of process you wish to use from the DSP menu.

3. A dialog appears allowing you to set the parameters for the DSP function.

4. Set the parameters for the DSP function as desired and click OK. Peak processes the selection with the DSP function or plug-in.

Note that if no selection is made, Peak will apply processing to the entire audio document.

Peak's Audio Processing Tools

Peak's DSP capabilities provide composers and professional sound designers with many interesting and useful audio effects and processing tools. Peak's many DSP functions include Add, Amplitude Fit, Auto Define Tracks, Bit Usage, Change Duration, Change Gain, Change Pitch, Convert Sample Rate, Convolve, Crossfade Loop, Envelope From Audio, Fade In, Fade Out, Find Peak, Gain Envelope, Harmonic Rotate, ImpulseVerb, Invert, Loop Tuner, Mono to Stereo, Stereo To Mono, Mix, Modulate, Normalize, Normalize (RMS), Panner, Phase Vocoder, Rappify, Repair Click, Repair Clicks, Remove DC Offset, Reverse Boomerang, Reverse, Strip Silence, Swap Channels, and Threshold.
The following sections explain how to use each of these functions.

Add

The Add command adds any selection of audio copied to the clipboard into the audio document at the selection point. To use the Add command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material. The Add command can also be customized using an envelope. If you wish to Add material with a variable level, click the envelope button in the Add dialog. The Add function differs from the Mix function slightly, in that the Add function never alters the amplitude level of the target audio material you are adding to — you can only specify the level of the material you are adding.

To use the Add command:

1. Select the audio that you wish to Add to another audio document and choose Copy from the Edit menu (CTRL-C) or Toolbar.
2. Select the audio that you wish to add the copied material into.
3. Choose Add from the DSP menu or Toolbar.
4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to add into the target audio document. To add copied material with a variable level, click the envelope button, create the desired envelope, click the Change button, and then click the Add button. Be careful not to add too high an amount, which can potentially clip the signal.
5. Click OK. Peak adds the two signals together.
6. To hear the results, press the Spacebar.

Amplitude Fit

Amplitude Fit provides granular normalization of an audio selection on a grain-by-grain basis. Grains are small groups of samples, often around 30ms. As each grain is read in, it is normalized according to the Amplitude Fit Envelope – each normalized grain crossfaded with the previous grain and written out as the result. Amplitude Fit can be used to maximize the level of an audio selection, or to make quiet passages as loud as louder passages.

To apply the Amplitude Envelope to an audio selection:

1. Select the audio material you wish to process.
2. Choose Amplitude Envelope from the DSP menu.
3. Draw the amplitude envelope you wish to apply to the audio selection in the envelope editor. Points above and below the 0% line will normalize the selected audio using the grain-by-grain normalization technique.

Amplitude Fit is not available in Peak LE.

Auto Define Tracks

The Auto Define Tracks tool allows you to automatically split audio recordings into separate Regions, each of which will become an individual CD track when an audio CD is burned. This tool is useful for quickly editing LP and cassette recordings, in preparation for burning them to CD, or exporting them for use with a portable music player, such as Apple’s iPod.

This DSP tool works by automatically placing Region markers into an audio document based on audio level, minimum period of silence between songs, and minimum song duration. Peak analyzes the audio levels throughout a document, and places Region markers around each song. The louder parts are considered to be songs, and the quieter parts are the gaps between them.

Since some songs may contain very quiet parts that could mistakenly be interpreted as gaps between tracks, a few parameters are available to help Peak correctly distinguish between songs and the gaps between them.

Minimum Silence Between Tracks

This field is used to enter the minimum gap time between songs in the audio document you are working with. If a recording you are working with contains two second gaps between each song, start with the default...
value of “2.00” in this field. If the gaps between songs vary in length, enter the value of the shortest gap in the entire recording.

If you need to measure the gap time between songs, activate the Cursor Info overlay by selecting Show Cursor Info (\texttt{\textasciitilde\textasciitilde}-\texttt{T}) from the Options menu, and then select the gap between songs in the audio waveform – the Cursor Info overlay will tell you the length of the selected area. You may also need to set your preferred Time Units to Min:Sec:ms – this can be done in the Options Menu > Time Units.

Minimum Track Duration

Peak needs to have some information about the length of each song, in order to accurately divide a long recording into individual songs. The Minimum Track Duration parameter tells Peak how long the shortest song in a recording is, and helps ensure that Region markers are placed in the correct location in the audio waveform – that is, a begin Region marker just before a song starts, and an end Region marker just after a song ends – even if the audio level falls below the threshold value set with the Silence is Audio Below slider (see next section). If a recording you are working with contains songs that are all approximately 4-5 minutes long, a good value to enter in this field would be 240 seconds (4 minutes).

Silence is Audio Below slider

This slider controls the threshold level between audio material you wish to define as a Region and the gaps between it. As this slider is moved, you will notice Region markers appearing in the audio waveform in the background, and you will also notice the value in the Number of Songs field changing. (More information on the Number of Songs field is in the next section). For example, if you are working with a recording from a cassette, the gaps will typically contain hiss or other noise that is not completely silent, but has a significantly lower amplitude level than the program material that you are trying to isolate into tracks. By adjusting the Silence is Audio Below slider, you can make the judgment as to what should be silence, even if it does contain some low level audio such as tape hiss, or other background noise.

Number of Songs field

This numerical field is tied to the Silence is Audio Below slider, and displays the number of songs that Peak automatically detects in a recording, based on the settings used for Minimum Silence Between Songs, Minimum Track Duration, and Silence is Audio Below. Depending on the settings you choose, Peak will detect a different number of songs, and this field will display different numbers. When the Silence is Audio Below slider is moved, the number of songs detected will update, and typing in a new value in the Number of Songs field will update the Silence is Audio Below slider. Typically, the automatic number of songs detected is very accurate, provided you have entered accurate settings for the other parameters that define tracks. There may be times however, where Peak detects more or fewer songs than the recording actually contains. You may choose to define the number of tracks using the Silence is Audio Below slider, or by typing in a known number of songs in the recording, and then fine tuning with the Silence is Audio Below slider. Be aware that the values you enter in the Number of Songs field, and the values you set with the Silence is Audio Below slider may override each other.

To Auto Define Tracks:

1. Open a recording from a cassette or LP.
2. Select All (\texttt{\textasciitilde\textasciitilde}-\texttt{A}).
3. From the DSP menu, choose Auto Define Tracks.
4. In the Minimum Silence Between Songs field, enter the shortest amount of time (gap time) between any two songs in the entire recording.
5. In the Minimum Track Duration field, enter the length of the shortest song in the recording.

6. Adjust the Silence is Audio Below slider until the Number of Songs field reflects the actual number of songs in the recording – Peak inserts Region markers for each song detected (you can visually scan the waveform of the entire recording and count the number of individual songs).

7. Click OK.

**Tips for using Auto Define Tracks**

**Before Auto Defining Tracks**

When recording cassettes and LPs, you will be working with fairly long audio documents, and there are a few things you can do to get the most accurate results with the Auto Define Tracks tool.

- Zoom out all the way, so that you can see the entire audio document from beginning to end. This way, when setting parameters in the Auto Define Tracks dialog, Region markers being placed into the audio waveform will be visible throughout the document.

- Delete excess silence – if you have recorded excess silence at the beginning or end of the audio document, or recorded a long pause when “flipping” a cassette or LP, it’s a good idea to edit this out before attempting to use the Auto Define Tracks tool.

- You may want to apply noise reduction for clicks, crackles, pops, broadband noise, and hum before auto-defining tracks. These types of noise are reflected in the audio waveform and may interfere with accurate placement of markers. Some of Peak’s built-in tools can help reduce/remove certain kinds of unwanted noise, but for the best results, BIAS recommends using SoundSoap or SoundSoap Pro. More information is available at: http://www.bias-inc.com/products/soundsoap/
  http://www.bias-inc.com/products/soundsoappro/

- Get an idea of the length of songs and gap times between songs – this will give the most accurate results in placing Region markers/creating tracks. From the Options menu, choose Show Cursor Info (⌘-Shift-T), this will show you the duration of the selected portion of the waveform.

- Visually scan the audio waveform, while looking for:
  - The number of songs in the recording – you should be able to see how many individual songs there are by counting the number of high amplitude areas.
  - The shortest song – select the shortest song from beginning to end, and then turn on Cursor Info, which will show the length of the selected part of the waveform. You may need to zoom in to make a more accurate selection.
  - The shortest gap time between songs – select the gap between songs and measure using the Cursor Info overlay.

**After Auto Defining Tracks**

There may be times when an anomaly in the audio waveform, or a less than ideal setting causes a track/Region marker to be placed in the wrong location. In some cases, when most of the tracks have been identified correctly, but one or two have not, it may be easiest to simply adjust the markers that are in the wrong position.
Region markers may be moved by clicking and dragging the triangular base to the left or right. Also, by engaging Peak’s Vertical Lock mode, you may move the end of one song/Region and the beginning of the next at the same time.

This technique is especially useful when working with live recordings or DJ mixes, where it’s important to preserve the overall duration and timing — but a track index needs to be adjusted into the correct position.

**Nudging Markers**

If all the Region markers placed into an audio document are incorrectly placed, but are off by a small amount, you may wish to use the Nudge feature to adjust them all simultaneously. To nudge a group of markers, select the portion of the audio waveform that contains the markers you wish to nudge, and then choose Nudge from the Action menu. Now that you know a bit about Peak’s Auto Define Tracks tool, give it a try! This feature can save a great deal of time, and the more you use it, and get a feel for how the various parameters need to be set, the faster it will work.

**Bit Usage**

The Bit Usage meter allows you to monitor bit saturation, degradation, and the “true” bit depth of a file.

To use the Bit Usage meter:

1. Select the desired range of audio you wish to examine.
2. Choose Bit Usage from the DSP menu – The bit usage meter will appear, and plot a graph showing the status of bit usage in the selected area of audio.

---

Bit Usage is not available in Peak LE.

**Change Duration**

You can specify the change in duration by a value in seconds, a percentage of the original, or, for rhythmically-oriented material, beats per minute. In addition, when working with rhythmically-oriented material, a special Transient mode may be used for optimal results.

A change in duration by a reasonable amount, about 85% to 115%, can be very convincing. Exaggerated time stretching, 200% or more, can result in some very interesting granular textures. Try experimenting with the Change Duration function on drums, rhythm loops, speech, sampled instruments or sound effects to achieve a wide variety of useful effects.
To change the duration of a selection:

1. Select the portion of the audio that you wish to process.

2. Choose Change Duration from DSP menu. The Change Duration dialog appears.

3. Click the radio button for one of the following fields, and enter the value that you wish for the change in duration:
   - In the Seconds field, type the new duration in seconds.
   - In the Percentage field, type the percentage you wish to slow down or speed up the selected audio. For example, typing “50%” will speed up the selection to half its original duration, typing “200%” will slow down the selection to twice its original duration.
   - In the Beats per minute field, type the old tempo for the selected audio and then the desired new tempo, and Peak will compute the correct new duration. Use this field to change the duration of rhythmically-oriented material.
   - Click the Tempo Envelope radio button to Create a custom Tempo Envelope that will vary the tempo/duration dynamically.

4. If you wish to adjust the quality of the duration change, click on the Prefs button. The DSP Preferences dialog will appear, allowing you to choose the size of the Time Shifting Window and Sample Rate Conversion quality that will be used in processing. For the Time Shifting Window, a lower value is best for simpler, monophonic sounds, while a higher value yields the best results for more complex, polyrhythmic sounds. For the Sample Rate Conversion quality, 1 is lowest quality (and uses the least amount of CPU power) and 10 is the highest quality (using the most CPU power). Once you have set these preferences to your liking, click OK to exit the DSP Preferences dialog.

5. Click OK when you have finished. Peak changes the duration of the selection according to the settings that you chose.

A Sample Rate Conversion setting of 8 is the recommended starting point.

Peak LE features a more basic Change Duration algorithm. It features the same controls with the exception of the Tempo Envelope, and is limited in quality compared to the algorithm used in Peak Pro and Peak Pro XT.

Change Gain

The Change Gain function changes the gain (i.e., amplitude) of a selection. You can specify the amount of gain change either in decibels (dB) or as a percentage. If you wish to double the volume of a sound, you must apply approximately 6 dB of gain change, or add 200%. Enable the Clipguard checkbox in the Change Gain dialog to
protect against the possibility of clipping. Clipguard will search through the audio document or selection for the maximum peak in amplitude, and then limit the Change Gain slider’s range based on the maximum peak it finds in the audio document or selection.

The Change Gain dialog

**To change the gain of a selection:**

1. Select the portion of the audio that you wish to process.
2. Choose the Change Gain command from the DSP menu or from the Toolbar. The Change Gain dialog appears.
3. Enter the number of decibels or percentage by which you wish to change the amplitude of the selection by.
4. If you wish to protect against the possibility of clipping, enable Clipguard by checking the Clipguard checkbox.
5. Click OK when you have finished. Peak will change the gain of the signal by the amount you specified.

**Change Pitch**

Peak 5’s all new Change Pitch function allows you to alter the pitch of an audio selection by as much as an octave – with excellent sounding results.

The Change Pitch dialog

**To change the pitch of an audio selection:**

1. Select the portion of the audio that you wish to process.
2. Choose Change Pitch from the DSP menu or from the Toolbar. The Change Pitch dialog appears.
3. Select the interval of transposition up or down by entering a positive or negative value in cents in the “Change Pitch by” field or by using the pitch slider. Fine tune the interval of transposition by entering a positive or negative value in cents in the “Fine Tune by” field or by using the Fine Tune slider. Check the Preserve Duration checkbox to retain the original duration of the selected audio.

You can also choose to alter the length, or duration, of the selection just as you would by slowing down or speeding up analog tape, or you can choose to preserve the duration of the selection (something not possible with analog tape!).
4. If you wish to adjust the quality of the pitch change, click on the Prefs button. The DSP Preferences dialog will appear, allowing you to choose the size of the Time Shifting Window and Sample Rate Conversion quality that will be used in processing. For the Time Shifting Window, a lower value is best for simpler, monophonic sounds, while a higher value yields the best results for more complex, polyrhythmic sounds. For the Sample Rate Conversion quality, 1 is lowest quality (and uses the least amount of CPU power) and 10 is the highest quality (using the most CPU power). Once you have set these preferences to your liking, click OK to exit the DSP Preferences dialog.

5. Click OK when you have finished. Peak transposes the pitch of the selected audio up or down by the amount you specified.

A Sample Rate Conversion setting of 8 is the recommended starting point.

Peak LE features a more basic Change Pitch algorithm. It features the same controls, but is limited in quality compared to the algorithm used in Peak Pro and Peak Pro XT.

Convert Sample Rate

The Convert Sample Rate command allows you to change the sample rate of an audio document without changing its pitch. This feature is very useful for converting audio material into lower or higher sample rates as required by other applications. Please note that sample rate conversion is applied to an entire document. It cannot be applied to just a selection within a document. Refer to Chapters 3 and 4 for an explanation of commonly used sample rates.

Sample rate conversion quality may be set in the DSP Preferences section of the Preferences dialog. A setting of 1 is lowest quality (and uses the least amount of CPU power and takes the least amount of processing time) and 10 is the highest quality (using the most CPU power and taking the longest to process).

The default setting for sample rate conversion is 8, and this should work well in most cases. In a practical sense, use the highest setting possible for your particular computer system’s CPU.

To change the sample rate of a document:

1. Choose Convert Sample Rate from the DSP menu or Toolbar. The Convert Sample Rate dialog appears.

2. Type in the sample rate that you wish to convert the audio document to, or click the down arrow to select from a pop-up of commonly used sample rates.

3. Click OK. Peak converts the entire audio document to the selected sample rate.
The Macintosh’s built-in audio hardware is typically limited to sample rates from 11 kHz to 64 kHz, and support will vary depending on the model of Macintosh. Higher sample rates are possible with Core Audio depending on the particular audio hardware device and its Core Audio drivers.

Peak LE contains a basic sample rate conversion algorithm.

Convolve

The Convolve command is a unique and powerful sound design tool that allows you to apply the sonic (i.e., spectral) characteristics of one sound onto another. Convolution works by multiplying the frequency spectrum of the impulse contained in the clipboard and that of the target audio document, reinforcing the frequencies that are in common between the two. The results are always interesting and often quite unlike anything you’ve heard before. This is especially true when the character of the two sounds are very different, and when the clipboard impulse is harmonically rich (imagine, for example, convolving a rainfall sample with piano tinkling!). To use the Convolve DSP command, you must first copy a selection of audio. The copied material will provide the spectral “character” that you will apply to the target audio material. Convolution can be very useful not only for creating new and unusual sound, but also for giving an audio selection a sense of space. Try copying a small amount of room noise to the clipboard and then Convolve it with a selection of audio – the convolved audio will sound like it is being played in that room environment.

Users of the Convolve feature will also enjoy the additional parameters of the ImpulseVerb DSP tool, when set up to use the Clipboard contents as a convolution source (See the section on ImpulseVerb later in this chapter for more information).

To use Convolve:

1. Select the audio with the characteristics you wish to apply and choose Copy (⌘C) from the Edit menu or Toolbar.
2. Select the audio that you wish to modify with the copied audio impulse.
3. Choose Convolve from the DSP menu. Peak applies the spectral character of the copied material to the selection.
4. To hear the results, press the Spacebar.

Convolve is not available in Peak LE.

Crossfade Loop

Peak allows you to crossfade the start and end points of a loop. Crossfading a loop can be very useful for smoothing the transition between the end of the loop and its beginning as it repeats. Peak allows you to control the envelope of the crossfade, the duration, and other parameters in the Crossfade Loop dialog.

Because the clipboard contents that provide the spectrum for this process must be held in RAM, small clipboard impulses should be used, unless a large amount of RAM is available. This process can use a lot of RAM!
The four checkboxes at the top of the Crossfade Loop dialog allow you to customize how the end of the loop is faded into the beginning of the loop. These boxes indicate where in the loop the crossfade is applied. For most loops, you should be able to leave the default checkbox checked and get good results.

**Crossfade Variations**

If you consider the crossfades “A”, “B”, “C”, and “D” from left to right, then:

- “A” = Crossfade between A and C
- “B” = Crossfade between B and D
- “C” = Crossfade between C and A
- “D” = Crossfade between D and B

The way these crossfade variations are configured depends on where the loop is destined to be used – for most purposes the default crossfade position (Position “C”) works well – if however, you plan on transferring these loops to a sample playback instrument such as a SMDI sampler, then you may want to experiment with different crossfade positions/combinations. Some hardware based samplers offer advanced playback controls, allowing loops to be played forward, backward, and in various other ways. By changing where in the loop crossfades are applied, you can customize your audio content for a particular sampler and for the desired effect.

Another application that may require using loop crossfade position(s) other than the default position “C”, are when creating audio loops intended to be used in a proprietary video game audio engine. Depending on the requirements of a particular video game’s audio engine, users may need to adjust the position of the crossfades used in their loops to achieve the desired effect. Depending on the application requiring crossfades, users may need “loop with release” (plays the tail of the audio document – the section of audio that lies outside the loop markers – after the loop stops playing/sampler’s key is released) or “loop hold” (doesn’t play the audio after the loop when the key is released). Because of these different modes, users may need to turn some crossfades on or off.

**To crossfade a loop:**

1. Create a loop using one of the techniques explained earlier in this chapter.
2. Choose Crossfade Loop from the DSP menu or Toolbar.
3. In the Crossfade Loop dialog that appears, enter a duration for the crossfade-in milliseconds and click OK.
4. To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Options menu (⌘ L) or click the Loop button on the Transport, and press the Spacebar. You will hear the loop, complete with your crossfade.

**To edit a Crossfade Loop Envelope:**

- Click on the Envelope button in the Crossfade Loop dialog and the Blending Envelope Editor appears.

---

Note that this is the same Blending Envelope Editor that is accessed from the Blending dialog.

---

Chapter 7: DSP
2. Click anywhere on the line and a new moveable “breakpoint” will appear.

3. Drag the breakpoint to the desired location.

4. Continue creating and dragging breakpoints until you have created the envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

5. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.

6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope until you change it again.

To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Options menu or click the Loop button on the Toolbar, and press the Spacebar. You will hear the loop, complete with your crossfade.

If you save your custom Blending envelope into:

/MacintoshHD/Users/<YourAccount>/Library/Preferences/Peak Envelopes/

it will automatically appear in the Envelope pop-up menu in the Fade In/Out Envelope editor. Please note that you must apply the custom fade in/out for it to later appear in the pop-up menu.

Crossfade Loop is not available in Peak LE.

Envelope from Audio

The Envelope from Audio tool allows you to create an envelope from a selected portion of audio. For example, imagine a piece of music that has a specific type of fade out, and you would like to be able to apply that fade out “envelope” to other pieces of audio. By selecting the entire fade out, and then using the Envelope from Audio command, Peak is able to “reverse engineer” the fade out characteristics, and save them as an envelope that can later be recalled in any of Peak’s envelope based tools, such as Fade In/Out, Gain Envelope, etc. Once an envelope is saved, it is available for use in any of Peak’s DSP tools that are able to access the Peak Envelopes folder, stored in your Home directory’s Preferences folder. Other DSP tools that can access these envelopes include Fade In/Out, Blending, Panner, Gain Envelope, Amplitude Fit, and Plug-In Envelope.

Envelopes of varying precision may be created with this tool. For a more precise envelope, where more points define the shape, enter a smaller value in milliseconds in the “ms” field (or use the slider). For a less precise (or “smoother”) envelope, where fewer points define the shape of the envelope – use a larger value.
**Fade In & Fade Out**

The Fade In and Fade Out commands allow you to apply an amplitude envelope to an audio selection. The Fade In and Fade Out DSP functions, and the Fade Envelope Editor dialog are described at length in Chapter 5.

*To create a Fade In:*

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade In will be applied to the audio within this selection.

2. Choose Fade In from the DSP menu, or click the Fade In button in the Toolbar. Peak applies the Fade In to the selection you have made in the audio document.

3. To hear the completed Fade In, press `/commandSpacebar`. You will hear the selected audio complete with your Fade In.

*To create a Fade Out:*

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade Out will be applied to the selected audio.

2. Choose Fade Out from the DSP menu, or click the Fade Out button in the Toolbar. Peak applies the Fade Out to the selection you have made in the audio document.

3. To hear the Fade Out, press `/Spacebar`. You will hear the selected audio complete with your Fade Out.

---

**Find Peak**

The Find Peak operation will place the insertion point at the sample with the maximum amplitude value that it locates in the audio selection.

*To find the maximum amplitude point in an audio selection:*

1. Select the audio in which you wish to locate the maximum amplitude.

2. Choose Find Peak from the DSP menu.

3. A dialog will appear telling you what the peak value is, and where it is located. The insertion point will be placed at the sample where the greatest amplitude was located.

4. Press the left arrow to bring the insertion point into view or the Shift key to the view of the insertion point at the sample level.

---

**Gain Envelope**

The Gain Envelope operation allows you to enter an amplitude envelope to be applied to an audio selection. The selected audio’s amplitude will be boosted and/or attenuated according to the envelope you draw in the...
Gain Envelope editor. It is easy to cause samples to clip when using this feature, so use it carefully.

To apply variable gain and attenuation to an audio selection:

1. Select the audio material you wish to process.
2. Choose Gain Envelope from the DSP menu.
3. Draw the gain envelope you wish to apply to the audio selection in the envelope editor. Points above the 0% line will amplify the selected audio. Points below the 0% line will attenuate the selected audio. Note that the waveform display in the Gain Envelope editor will change according the envelope you draw.
4. To process the audio selection using the gain envelope, press Change.

Harmonic Rotate

The Harmonic Rotate tool is excellent for sound design experimentation. This command allows the frequency spectrum in a selected range of audio to be rotated around a horizontal axis, which has the effect of taking frequencies that were previously associated with one section of the frequency spectrum, and assigning them to different areas of the frequency spectrum. The Harmonic Rotate command can be previewed in real time, so that desired setting can be found before spending time processing. Options for processing include checkboxes for using Real & Imaginary calculations, and a slider & text field to set amount of rotation.

To apply Harmonic Rotate to an audio selection:

1. Select the audio material you wish to process.
2. Choose Harmonic Rotate from the DSP menu.
3. Click the Preview button, and select the desired settings for Real or Imaginary frequency spectrum calculation, and move the slider, or type in the desired value.
4. When you've made the desired settings, click OK.

ImpulseVerb

ImpulseVerb is an extremely high-quality reverb processing tool, that utilizes actual reverb impulses recorded in real spaces, such as performance halls, cathedrals, caves, and other spaces that have various reverberation qualities. The same convolution technology that is used in Peak’s Convolve DSP tool allows these natural reverb impulses to be applied to dry audio.
audio signals, giving the impression that a file was actually recorded in a particular environment.

ImpulseVerb offers real time preview, so that the ideal settings can be found before processing. In addition, ImpulseVerb offers an editable Space envelope, which controls reverb length and decay characteristics, and a Wet/Dry slider to control the amount of reverb being applied.

Enhancements to ImpulseVerb include a new user interface, as well as new Source Gain and Impulse Gain sliders, for even more control over reverb characteristics.

To apply reverb using ImpulseVerb:

1. Select the audio material you wish to process.
2. Choose ImpulseVerb from the DSP menu.
3. Select a Space using the Space pop-up menu, or choose clipboard to use the contents of the clipboard.
4. Click the Preview button, and adjust the Wet/Dry slider to the desired position.
5. To apply the current reverb characteristics, click the Apply button.

To modify reverb characteristics:

- Click the Space Envelope checkbox – a standard Peak envelope editor appears. The example below shows an envelope for a reverb that fades over time.

The ImpulseVerb dialog can also be used as a real time convolution tool, and is not limited to using impulse response files to create reverb effects. Any selection that is copied to the clipboard can be convolved with the selected range of audio. To add audio files to the Space pop-up menu within the ImpulseVerb dialog, simply save the desired file as a 24-bit Sound Designer II format file, and place into the Peak Impulses folder within:

/MacintoshHD/Library/ApplicationSupport/BIAS/Peak/Peak Impulses/

While the settings above describe how to simply modify the reverb effect, other types of settings may be useful for creative sound design. When using the ImpulseVerb interface for real time convolution, experiment with the type of Space Envelope used – especially when the content used is a non-impulse response file.

ImpulseVerb is not available in Peak LE!
Invert

The Invert function allows you to invert the phase of a selection or an entire audio document.

To invert the phase of a selection:

1. Select the portion of the audio that you wish to invert.
2. Choose Invert from the DSP menu. Peak inverts the phase of the selected audio.

Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop and listen to the effects of these adjustments as you make them. If you wish to “tune” a loop you’ve made, simply select Loop Tuner from the DSP menu or Toolbar, and a dialog will appear. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window to achieve a natural transition at the loop point by carefully adjusting the slope alignment. The arrows of the slider will move the loop markers sample by sample and clicking in the body of the slider will move the loop markers to the next zero crossing. The two zoom buttons (magnifying glass icons) in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample level. You can listen to the effects of the adjustments as you make them by clicking on the Play button. To exit this dialog, click on OK to accept the changes, or Cancel to leave the original loop unaffected.

Mono To Stereo/Stereo To Mono

These two DSP commands may be used to easily convert an audio document between one and two channel formats.

To change an audio document from mono to stereo

1. Select the entire audio document with the Select All command from the Edit menu (keyboard shortcut A).
2. Choose Mono To Stereo from the DSP menu or Toolbar.

Loop Tuner is not available in Peak LE.
3. In the dialog that appears, adjust the slider to adjust the left and right-channel balance in the mix.

![Mono to Stereo Conversion dialog](image)

4. Click OK. Peak converts the mono document to a stereo document.

To change an audio document from stereo to mono:

1. Select the entire audio document with the Select All command from the Edit menu (⌘-A).
2. Choose Stereo To Mono from the DSP menu or Toolbar.

![Stereo to Mono Conversion dialog](image)

3. In the dialog that appears, adjust the slider to adjust the left and right-channel balance in the mix.
4. Click OK. Peak converts the stereo document to a mono document.

While automatic Mono To Stereo/Stereo To Mono conversion is not available in Peak LE, you can achieve the same end result manually, by selecting all in an open mono or stereo document, and then opening a new, empty document. If you copy an entire document, open a new empty document, and attempt to paste in the contents of the clipboard, Peak will detect if there is a different number of channels, and will prompt you to enter a Left/Right panning value, and will then allow you to paste in the clipboard contents.

Mix

The Mix command allows you to mix material that you have copied to the clipboard with a target selection. This function can be used as a kind of “sound-on-sound” capability for mixing audio tracks together, or for blending sound elements. The Mix command is similar to the Add command, but it does not have the potential to clip because the target and clipboard contents are attenuated before mixing. To use the Mix command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material. The Mix command also allows an envelope to be applied to the copied material. This can be useful when the content being mixed needs to have variable levels in it. The Mix function differs slightly from the Add function, in that the percentage slider affects both the material being mixed, as well as the original target material. For example, a 50/50 mix will lower the amplitude level of the target material.

To use the Mix command:

1. Select the audio you wish to mix into another audio document and choose Copy from the Edit menu or Toolbar (or press ⌘-C).
2. Select the audio that you wish to mix the copied material into.
3. Choose Mix from the DSP menu.

4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to mix into the target audio document. To mix copied material with a variable level, click the envelope button, create the desired envelope, and then click the Change button.

5. Click OK – Peak mixes the two signals together.

6. To hear the results, press the Spacebar.

**Modulate**

This Modulate command functions as a “ring modulator” which multiplies two audio signals together (e.g., the material copied to the clipboard and the currently selected audio). The resulting audio includes the sum and difference tones of the frequency components of the modulated audio and the modulating audio. These are generally very complex timbres that often have a “metallic” (i.e., inharmonic) character to them.

`Try using generated tones, like sine, swept sine, square, or saw-tooth waves with the Modulate command.`

---

**To use the Modulate command:**

1. Select the desired source audio and choose Copy from the Edit menu or Toolbar (or press \(\text{Ctrl}-C\)).

2. Select the destination audio.

3. Choose Modulate from the DSP menu.

4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to use to modulate the destination audio document.

5. Click OK – Peak processes the two signals.

6. To hear the results, press the Spacebar.

---

**Normalize**

This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. The normalize function is very useful for boosting the volume of material that was recorded at too low a level, or if used on multiple audio documents, for making sure that the amplitude of each of the documents is uniform.

---

*Modulate is not available in Peak LE.*
Note that because normalization uniformly changes the amplitude of a selection (i.e., the proportions between loud and soft stay the same), it does not have the same effect as compression/limiting (which makes the soft parts louder and does not allow the loud part to exceed a specified amplitude).

To normalize a selection:

1. Select the audio that you wish to normalize. If you wish to normalize the entire audio document, choose Select All from the Edit menu (command-A).
2. Choose Normalize from the DSP menu.
3. In the dialog that appears, use the slider to adjust the percentage of normalization from the maximum level.

4. Click OK – Peak normalizes the selected audio.

Normalize (RMS)

This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. RMS Normalization is based on the RMS (Root Mean Square), or “average” signal level of the selected portion of audio. The RMS value of a file cannot be increased to an arbitrarily high value. If the desired RMS specified by the user is so high that will produce clipping in the signal, the Soft Clip feature will automatically activate and the resulting RMS level will be lower than the one specified by the user. The processed file will be as loud as possible while guaranteeing that the signal will be limited to the ceiling specified by the user.

The RMS Normalize dialog offers two parameters – RMS Level and Digital Ceiling. RMS Level allows you to enter the desired RMS Level (or average level), and the Digital Ceiling allows you to limit the maximum audio level, which is also the level at which Soft Clipping will activate, if the RMS Level exceeds it.

The RMS Normalize function is very useful for boosting the volume of material that was recorded at too low a level, or if used on multiple audio documents, for making sure that the amplitude of each of the documents is uniform.

To RMS Normalize a selection:

1. Select the audio that you wish to RMS normalize. If you wish to normalize the entire audio document, choose Select All from the Edit menu (command-A).
2. Choose Normalize (RMS) from the DSP menu.
3. In the dialog that appears, enter the desired RMS and Digital Ceiling levels, and click the OK button.

4. Click OK – Peak normalizes the selected audio.

RMS Normalize is not available in Peak LE.
**Panner**

The Panner allows you to adjust the panning, or left-to-right movement, of a stereo document by drawing an envelope in the Panner dialog. Left is at the top of the graph, and right is at the bottom.

The Panner also offers an option to keep volume constant as audio pans from side to side. When the Keep Volume Constant checkbox is enabled, Peak uses logarithmic calculation to determine volume levels while panning between the left and right channels — resulting in overall volume levels being preserved. When this option is not enabled, Peak uses linear calculations and does not preserve volume levels. When disabled, it is common to have dips in the overall audio level when panning from one channel to the other.

**To adjust the panning of a selection:**

1. Select the stereo document that you wish to adjust. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Panner from the DSP menu.
3. In the Panner editor dialog that appears, use the envelope to “draw in” the panning you desire.
4. Click OK. Peak will change the panning of the document to reflect the changes you’ve made.

---

**Phase Vocoder**

The Phase Vocoder is a type of audio spectrum analysis/resynthesis tool that allows you to modify the duration and/or pitch of an audio selection.

**To use the Phase Vocoder:**

1. Select the audio that you wish to process. If you wish to select the entire document, press ⌘-A.
2. Choose Phase Vocoder from the DSP menu. The Phase Vocoder dialog appears.
3. In the Change Duration field, you may enter a new duration for the selection by typing the time in seconds.
4. In the Change Pitch field, you can change the pitch of the selection by entering a new value in cents. (Cents are divisions of a musical octave – one octave is equivalent to 1200 cents.) Common musical intervals are stored in the interval pop-up menu, allowing you to enter a major third, octave,
or other intervals. Use the direction pop-up menu to control whether the pitch is shifted upward or downward.

5. In the Analysis Settings field, select the number of bands and FFT (Fast Fourier Transform) size to determine the quality of the output. The Phase Vocoder works by analyzing the frequency content of the audio selection and placing the found frequencies into tracks. These tracks are then used to control an oscillator-based resynthesis that uses the pitch and duration modifications you enter. In general, using a smaller FFT size brings less smearing of the audio output than higher FFT sizes. Using a larger number of bands setting used increases the accuracy while tracking of harmonic content of the source sound. In general, setting the FFT size larger than the number of bands will give undesirable results. Due to the nature of the Phase Vocoder’s algorithm, optimum results are achieved when it is used with solo instruments and steady state sounds (such as a voice or solo flute line) rather than complex tones (such as an orchestra playing).

6. Click OK. Peak processes the audio. To hear the results, initiate playback.

To Rappify a selection:

1. Select the audio that you wish to process. If you wish to select the entire document, press \textasciitilde\textasciitilde A.

2. Choose Rappify from the DSP menu.

3. In the dialog that appears, select the amount of “rappification” you wish to mix back into the original, with 100% being entirely rappified and 0% being unchanged.

4. Click OK. Peak processes the audio. To hear the results, initiate playback.

---

**Rappify**

The Rappify command applies extreme dynamic filtering to a selection. As one Peak user described it, “Rappify can turn your hi-fi into lo-fi!” If the target material has a pronounced beat, this has the effect of reducing the material to its most essential rhythmic components. Try using this function with a variety of different music material for some surprising and exciting results.

**Repair Click**

The Repair Click command will eliminate a selected click or “spike” in the waveform using the setting designated in the Repair Clicks dialog (explained next).
To repair a single click:

1. Place the Insertion Point over the click you wish to repair.
2. Choose Zoom To Sample Level from the action menu (Shift-Left arrow).
3. Select the click in the waveform. Please be sure that your selection is no more than 100 samples.
4. Choose Repair Click from the DSP menu.

**Repair Click is not available in Peak LE.**

Repair Clicks

The Repair Clicks command allows you to find and repair pops or clicks in an audio document. The Repair Clicks dialog automates the process of finding and removing clicks (usually indicated by a sharp “spike” in a waveform), much like a search and replace dialog in a word processor.

The Repair Clicks operation works by looking for any significant discontinuity from sample to sample. For example, a sample value of -100 followed by a sample value of 10,000 is likely to be a click. Once the area of the click is identified, a smoothing technique is used to maintain the original shape of the area being repaired.

If you are working with mostly digitally induced clicks, the Repair Clicks dialog will become an indispensable tool. Extremely damaged signals such as those of a scratching and popping vinyl record will require more careful repair in addition to using the Repair Clicks dialog, such as Change Gain, Delete, and the Pencil Tool. Clicks such as those of a scratching and popping vinyl record lose their detectability once they are sampled using Analog to Digital converters.

### Smoothing Factor

Smoothing Factor determines how much smoothing is applied to the click. Material with high frequency information may require lower smoothing factors to preserve the high frequencies. In general, a setting of 40-60 percent will repair most clicks.

### Detection Setting

The Detection Setting value determines how the clicks are located. Higher values locate only the most severe clicks, while lower values will detect less severe clicks. Note that lower values such as 10% also have a greater chance of misjudging audio for a click. In general, a setting of 40-80% works well.

### Repair Size

The Repair Size setting affects how many samples around the click are used in determining the new shape of the repair. Repair size can vary from 5 to 100 samples, with a repair size of 50 samples working well in most circumstances. Peak will then interpolate what the correct waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog allow you to control repairing, auditioning, and undoing click repairs:

- Click the Repair button when you wish to repair a click found by the Next Click button.
- Use the Next Click button to search for the next potential click in the audio selection.
- Once a click is located, you may listen to the click...
using the Audition button. The Audition button plays the click using the Pre-roll and Post-roll settings from the Auditioning dialog in the Preferences dialog.

• If you repair a click and are unsatisfied with the results, simply click on the Undo button.

• If you would like to repair all of the clicks in the audio document’s selection without having to repair each one individually, click the Repair All button.

Be sure not to confuse repair size with the size of the selection containing the audio you want to scan and repair. The repair size refers to the size of each individual repaired click.

To repair multiple clicks in an audio document:
1. Select the entire audio document or the area in the audio document you wish to repair click.
2. Choose Repair Clicks from the DSP menu.
3. Click the Next Click button. Peak will search for any clicks. If none are found, you can try again with a lower detection setting.
4. Audition the click using the Audition button. The click should sound in the middle of the auditioned area.
5. Once the click is found, click the Repair button. Click the Audition button to make sure the click was adequately repaired. If it was not adequately repaired, use the Undo button, modify the smoothing factor or repair size and click the Repair button again.
6. Proceed from step 3 until all clicks are removed, or simply click the Repair All button. If you wish to stop the Repair All process, press `period`.

To repair a single click from an audio document:
1. Select the area around the click, centering the click in the selection.
2. Choose Repair Clicks from the DSP menu or use Repair Click and skip step 3.
3. Click the Repair button. Then click the Audition button to make sure the click was adequately repaired. If it was not adequately repaired, use the Undo button, modify the smoothing factor or repair size and click the Repair button again.

You may need to lower the detection setting in the Repair Clicks dialog to find some clicks, depending upon their severity. Be careful not to lower the detection setting dramatically — lower it gradually for the best results.

Remove DC Offset

This function allows you to remove any DC Offset in your audio file. Peak scans the audio for DC offset and then removes it. Peak will scan the left and right channels of a stereo file independently. DC Offset is usually caused by problems in the analog to digital conversion process. The result is that the waveform is not centered on the base line — it is offset either higher or lower than the center line.
To use Remove DC Offset:

1. Select the audio that you wish to process. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).

2. Choose Remove DC Offset from the DSP menu. Peak will scan the audio, and automatically remove any DC offset that might be present.

Remove DC Offset is not available in Peak LE.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed copy of the selected audio with the original. This creates a variety of interesting and useful results. Try using Reverse Boomerang on drum loops, voice, and sound effects.

To use Reverse Boomerang:

1. Select the audio that you wish to process. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).

2. Choose Reverse Boomerang from the DSP menu.

3. In the dialog that appears, select the amount of reversed sound you wish to mix back into the original, with 100% being entirely reversed, and 0% being unchanged.

4. Click OK. Peak processes the audio. To hear the results, press the Spacebar to initiate playback.

Reverse

The Reverse command reverses the current selection. In a reversed selection, the last sample becomes the first sample, the second-to-last sample becomes the second sample, and so-forth. The effect is similar to playing a record or cassette tape backwards.

To reverse a selection:

1. Select the audio that you wish to reverse. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).

2. Choose Reverse from the DSP menu. Peak reverses the selected audio. To hear the results, start playback.

Strip Silence

Peak includes a Strip Silence tool, which allows areas of silence, or very low amplitude, to be automatically silenced, minimized, or completely removed from an audio document. This tool is useful for removing silence from recordings that predominantly contain silence (or very low level audio content), interspersed with some desired audio content. By adjusting the various Strip Silence parameters, you can control what content is preserved, and what is silenced completely or deleted from an audio document.

The Strip Silence tool is composed of two sections, the Noise Gate and the Stripper.
Noise Gate

The Noise Gate functions similarly to any other noise gate, and its controls include:

**Threshold Slider**

The Threshold slider determines the level at which all audio with a higher signal level is preserved, and at a lower level is either silenced/reduced in level. By default, the Threshold slider is set to a value of -20dB, and has a range of 0dB to -60dB.

Setting the Threshold slider is fairly straightforward — for example, if working with a dialogue recording in which the voice has a nice strong level, but the ambient room tone is still audible (around -30dB), you would set the Threshold slider right around -30dB. This control allows you designate a level above which audio will be preserved — and a level below which audio will be silenced, or removed.

A good technique for determining the Threshold slider setting is by first selecting a portion of audio containing just the background noise/room tone (what should be silence, and should be removed), and using Peak's Find Peak DSP tool to determine the exact level. This level can then be used as a Threshold slider setting in the Strip Silence tool.

**Reduction Ratio Slider**

This slider provides a proportional amount of reduction, based on the setting of the Threshold Slider. Whether audio below the threshold is completely silenced or simply reduced in level depends largely on the setting used for the Reduction Ratio slider. The Reduction Ratio slider provides a proportional amount of reduction for any audio with a signal level that falls below the threshold level.

A high setting on the Reduction Ratio slider will reduce low amplitude sections of the audio waveform (what is considered “low amplitude” depends on the level set with the Threshold slider) to complete silence. A lower setting on the Reduction Ratio slider will reduce low amplitude sections of the audio waveform slightly (again, what is considered “low amplitude” depends largely on what setting is made to the Threshold slider). By default, the Reduction Ratio slider is set to a value of 2.00, and has a range of 1.00 to 5.00.

Using the same example of working with a dialogue recording, which has an ambient room tone around -30dB, which we would like to minimize. If the Threshold slider is set to about -30dB, that targets the audio below that level only to be reduced — by how much depends on how the Reduction Ratio slider is set. To silence these sub -30dB sections completely, a high setting, such as 4 or 5 might be used for the Reduction Ratio slider. However, to maintain some amount of room tone, use a milder setting between 1 and 3.

**Attack Slider**

The Attack slider determines how quickly level reduction happens, once audio falls below the threshold level (which is set with the Threshold slider). By default, the Attack value is set to 20 milliseconds, and has a range of 10 milliseconds to 500 milliseconds.

**Release Slider**

The Release slider determines how quickly level reduction turns off, once audio exceeds the threshold level (which is set with the Threshold slider). By default, the Release value is set to 100 milliseconds, and has a range of 50 milliseconds to 1000 milliseconds.
A good rule of thumb for making settings to the Attack and Release sliders is to take into account the type of audio material that you’re with. For example, if working with dialogue, it takes a relatively long time for a spoken word to go from zero amplitude to full amplitude, (long attack time) so it’s best to use a higher attack setting. This will cause the reduction to be applied more gradually. Likewise, with this type of material, it’s best to use a longer release time setting as well, as spoken words tend to gradually diminish in amplitude, rather than end very abruptly.

On the other hand, consider a drum recording. Drums have a much faster attack time — that is, it takes much less time to hit a drum and have it go from zero amplitude to full amplitude. Once it’s been hit, it also takes a very short time to diminish to silence. This type of audio material would require much shorter attack and release times.

Stripper

The Stripper is the section of the Strip Silence tool that will delete sections of audio that fall below a certain level and stay below that level for a certain length of time. The Stripper’s behavior depends on the settings made with the following parameters:

Noise Floor

This slider functions much like the Threshold slider in the Noise Gate section of the Strip Silence tool. Setting this slider more to the left has the effect of using a lower threshold setting in the Noise Gate section — that is, only audio material with the lowest signal level would be deleted. On the other hand, when this slider is set to a more “aggressive” setting, audio with a higher amplitude level would also be deleted. Audio is only deleted when it stays below a certain level for a certain length of time. The Noise Floor Slider has a range of 0.0000 – 1.0000%.

Required Silence Before Strip Slider

This parameter controls how many milliseconds of consecutive silence (silence being any audio with a level below the level set with the Noise Floor slider) are required before silent areas can be eliminated.

Swap Channels

The Swap Channels command reverses the left and right channels in a stereo selection.

To swap channels for a stereo selection:

1. Select the audio that you wish to swap. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Swap Channels from the DSP menu. Peak swaps the left channel for the right channel and the right channel for the left channel. To hear the results, start playback.

Threshold

The Threshold command allows you to split up an audio document into its component parts by analyzing the amplitude levels in the audio document and setting a cutoff or threshold amplitude. For instance, you might use the Threshold command on an audio document that contains successive notes from a musical instrument to split them up, or on a drum loop to break it up into its component parts. You can save the segments with Markers, or as Regions.
To use the Threshold command:

1. Select the audio you wish to process and choose Threshold from the DSP menu. After Peak analyzes the amplitudes in the selection, the Threshold dialog will appear, allowing you to select a threshold amplitude for both attack and release values.

2. Drag the threshold indicator left or right to set the threshold amplitude. As you drag the indicator, new markers will appear in the audio document forming markers or regions, depending on your settings. The Offset sliders allow you to “nudge” the onsets of markers or regions by plus or minus 0 to 512 samples.

3. Select Create Regions to create regions instead of markers. The separate Release Threshold, attack and sludge settings affect the region end points, allowing you to eliminate silence from the region end points.

4. Adjust the Attack value. This parameter sets the amount of time that audio must stay above the given threshold to qualify as a new marker or region.

5. When you have finished, click OK.

6. After the audio document has been “thresholded” to your satisfaction, you can use the Export Regions command in the File menu to export the separated regions into new windows or files.

7. To select and play regions in order from left to right, press the Page Up key on your computer keyboard. To select and play regions in order from right to left, press the Page Down key.

Use the Threshold command to create several looping points. To convert a marker to a Loop Start or Loop End point, double-click on the marker and change it to “Loop Start” or “Loop End” in the Edit Marker dialog. Also, try rearranging the regions generated by the Threshold function in the Playlist or by using Cut and Paste to create new interesting compositional and rhythmic ideas!

Threshold is not available in Peak LE.
Conclusion

You have now learned how to manipulate and process audio using Peak’s native DSP capabilities. In the next chapter, you will learn how to use VST & Audio Units effect and instrument plug-ins with Peak.
Chapter 8
Plug-Ins
Chapter 8: Plug-Ins

Introduction

Peak supports Audio Units, and “carbonized” or “Mach-O” VST format effects plug-ins and virtual instruments. Audio Units is a plug-in standard, or format, created by Apple Computer, Inc. VST (“Virtual Studio Technology”) is a standard audio plug-in technology developed by Steinberg Media Technologies, AG.

Both Audio Units & VST plug-ins formats offer an exciting array of real-time effects and instruments from companies like BIAS, Cycling 74, Korg, Maxim Digital Audio, Native Instruments, Steinberg, Waves, and many others. Audio Units & VST plug-ins operate in real-time, and are “native”, or “host-based”. This type of plug-in is powered by your computer’s CPU, and does not require any additional processing hardware. They work in real-time, meaning that any parameter changes are heard instantaneously, and no processing time is required until the desired settings are found. This avoids having to experiment with settings, process, and then undo if the settings are not correct.

Plug-Ins Included with Peak LE 5

- BIAS Freq-2 v.2.0 – 2 Band Paragraphic EQ
- Dreampoint Freeverb-C – (Reverb)
  http://www.dreampoint.co.uk/
- MDA Ambiance – Ambiance/Reverb Processing
- MDA AutoPan – Automatic panning left/right channel
- MDA Bandisto – Multi-band distortion
- MDA BeatBox – Drum replacer
- MDA Combo – Amp & speaker simulator
- MDA De-ess – High frequency dynamics processor
- MDA Degrade – Low-quality sampling
- MDA Delay – Simple stereo delay with feedback tone control
- MDA Detune – A low-quality stereo pitch shifter
- MDA Dither – Range of dither types including noise shaping for reduction to 8- and 16-bit
- MDA DubDelay – Delay with feedback saturation and delay time modulation

Documentation for BIAS plug-ins is available in separate user’s guides, and is automatically installed into the following directory:

/Macintosh HD/Library/Documentation/BIAS/

BIAS user’s guides may also be downloaded from the BIAS website, at:

http://www.bias-inc.com/downloads/documentation/

For more information on the third-party plug-ins bundled with Peak, please visit the manufacturer’s website, listed below with each bundled plug-in.

Plug-Ins Included with Peak 5

Peak comes with a wide variety of plug-ins – some made by BIAS and others made by third party manufacturers. The list below shows which plug-ins are included in each edition of Peak.

Documentation for BIAS plug-ins is available in separate user’s guides, and is automatically installed into the following directory:

/Macintosh HD/Library/Documentation/BIAS/

Chapter 8: Plug-Ins
• MDA Dynamics — Compressor / Limiter / Gate
• MDA Envelope — Envelope follower / VCA
• MDA Image — Stereo image adjustment and M-S matrix
• MDA Leslie — Rotary speaker simulator
• MDA Limiter — Opto-electronic style limiter
• MDA Looplex — Interesting Loop Processing effect
• MDA Loudness — Equal loudness contours
• MDA Re-Psycho! — Drum loop pitch changer
• MDA RezFilter — Resonant filter with LFO and envelope follower
• MDA Round Panner — 3D panner
• MDA Shepard — Continuously rising/falling tone generator
• MDA Specmeter — Spectral Analyzer
• MDA Splitter — 2 way signal splitter
• MDA Stereo Simulator — Haas delay and comb filtering
• MDA Sub-Synth — Several low frequency enhancement methods
• MDA Talkbox — A simple talkbox plug-in
• MDA TestTone — Signal generator with pink and white noise, impulses and frequency sweeps
• MDA Thru-Zero Flanger — Flange / Chorus / ADT
• MDA Tracker — Pitch tracking oscillator / EQ
• MDA VocInput — Pitch tracking oscillator for vocoder carrier input
• MDA Vocoder — 16-band vocoder switchable to 8-band for low processor usage

http://mda-vst.com/

• The Sound Guy SFX Machine LT — Creative Sound Design/Sound Effects

http://www.sfxmachine.com/

Plug-Ins Included with Peak Pro 5

Includes all of the effects plug-ins listed above, as well as:

• BIAS Freq-4 v.2.0 — 4 Band Paragraphic EQ
• BIAS Sqweez v.1.03 — Compressor/Limiter
• BIAS Vbox 2.0 — Effects routing matrix

Plug-Ins Included with Peak Pro XT 5

Includes all of the effects plug-ins listed above, as well as:

• BIAS SoundSoap 2 — “One-Click” Noise Reduction
• BIAS SoundSoap Pro — Professional Audio Restoration/Noise Reduction
• BIAS Master Perfection Suite
  – GateEx — Gate/Expander
  – PitchCraft — Pitch Correction/Transposition
  – RepliQ — EQ Matching
  – Reveal — Advanced Analysis Tool
  – SuperFreq v.2.0 — Set of Paragraphic Equalizers (4, 6, 8, & 10-Band versions)
  – Sqweez 3 & 5 — Multiband Compressors

Documentation for BIAS GateEx, PitchCraft, RepliQ, Reveal, SoundSoap 2, SoundSoap Pro, SuperFreq, and Sqweez 3 & 5 is available in separate user's guides, included with Peak Pro XT. All documentation is available in electronic form to registered users, at:

http://www.bias-inc.com/documentation/
Installing Plug-Ins

While Peak includes a wide variety of plug-ins, there are hundreds of other Audio Units or VST plug-ins that are available separately, and that are compatible with Peak.

A list of compatible plug-ins is available on the BIAS website’s FAQ section, at:

http://www.bias-inc.com/support/faq/

Many third-party plug-in packages will include a custom installer program that automatically installs plug-ins in the correct directory, so that Peak and other Audio Units/VST hosts can access them. Be sure to consult the documentation that came with your plug-ins for the manufacturer’s installation instructions.

There are two locations that Audio Units or VST plug-ins may be installed so that Peak can access them – for more information, please see the next section.

Audio Units Plug-Ins

Installing a plug-in into the “global” Components directory at the root level allows any user account that is logged in to access these plug-ins.

/MacintoshHD/Library/Audio/Plug-Ins/Components/

Installing into the Components directory in a particular user’s Home directory allows only that user to access these plug-ins.

/MacintoshHD/Users/<YourUserAccount>/Library/Audio/Plug-Ins/Components/

BIAS Plug-Ins

The BIAS plug-ins included with Peak are technically VST plug-ins, but they are grouped separately from other VST plug-ins.

BIAS VST plug-ins are automatically installed into:

/MacintoshHD/Library/Audio/Plug-Ins/VST/

VST Plug-Ins

Installing a plug-in into the “global” VST directory at the root level allows any user account that is logged in to access these plug-ins.

/Macintosh HD/Library/Audio/Plug-Ins/VST/

Installing into the VST directory in a user’s Home directory allows only that user to access these plug-ins.

/MacintoshHD/Users/<YourUserAccount>/Library/Audio/Plug-Ins/VST/

While it does not matter whether you choose to install into the global plug-ins directory, or the plug-in directory in your Home directory, it is easier to maintain a single plug-ins directory. If you have plug-ins installed in both locations, and wish to consolidate into a single directory, it’s easy to move the plug-ins from one directory to the other. The simplest way to do this is to open two Finder windows next to each other, and drag the plug-ins from one directory to the other. For more information on organizing files in the Macintosh Finder, please consult the documentation that was included with your Macintosh.
Organizing Plug-ins with Folders

When using many types of plug-ins from various manufacturers, it is useful to be able to sort the plug-ins in a particular way. For example, you may want to group all of your EQ or reverb plug-ins together.

Audio Units plug-ins are automatically sorted into groups based on the manufacturer.

BIAS plug-ins are automatically sorted into their own plug-in category.

VST plug-ins may be organized in practically any way desired — you might choose to organize by the type of effect, or by manufacturer, etc. Peak allows you to organize your VST plug-ins into folders inside the “global” VST plug-ins folder (or the VST plug-ins folder within your Home directory). Each folder you create inside the VST plug-ins folder can store groups of plug-ins that will appear as submenus when assigning a VST plug-in on a channel insert or within Vbox.

Using Effects Plug-Ins

Peak can access Audio Units and VST format effects plug-ins in two different ways — using “Inserts”, or through the Vbox effects routing matrix. The method you choose will depend on how many plug-ins are being used simultaneously, and the functionality required for the task at hand.

Inserts

Peak features 5 individual channel inserts and each insert may contain a single plug-in. When using inserts, signal flows through the effect in each insert in the order of the insert number. For example, if an equalizer plug-in is used on Insert 1, and a reverb plug-in is used on Insert 2, the output of the equalizer plug-in will flow into the input of the reverb plug-in. Inserts are typically more convenient when using a small number of plug-ins.

Vbox

Peak includes BIAS Vbox for managing and mixing effects plug-ins. Think of Vbox as a virtual effects box, in which you can combine, repatch, and mix your effects plug-ins in real-time. Using its unique effects matrix, Vbox lets you combine multiple individual plug-ins. Vbox can patch plug-ins in series, in parallel, or in series and parallel, and you can hot-swap plug-ins. Vbox has controls for each plug-in to mute, solo, and edit parameters. Vbox also provides input and output gain controls both globally and for each individual plug-in, and a control for the global Wet/Dry mix. Use Vbox’s A/B comparison feature to get just the right settings, and use Vbox’s presets to store configurations and settings for later use.

Using Effects Plug-Ins with Inserts

To open an Audio Units plug-in on an insert:

1. Select Insert 1 from the Plug-Ins menu.
2. Select Audio Units from the submenu.
3. Select the manufacturer from the next submenu.
4. Select the plug-in you wish to use from the next submenu.

To open a BIAS or VST plug-in on an insert:

1. Select Insert 1 from the Plug-Ins menu.
2. Select BIAS or VST from the submenu.

3. Select the plug-in you wish to use from the next submenu.

If you have customized the organization of your VST plug-ins, you may have additional submenus to navigate through.

To apply a plug-in:

1. With an audio document open, open the desired effect plug-in as described above.

2. Configure the plug-in’s settings as desired (plug-ins from different manufacturers may have knobs, buttons, sliders and other types of controls).

3. Start playback to audition the audio document, and make any adjustments to the plug-in’s controls, if necessary. Effects plug-ins operate in real time, so any adjustments to controls are heard instantly.

To bounce/render a plug-in:

1. Follow the steps described above, for previewing effects plug-ins.

2. Select Bounce from the Plug-Ins menu. Peak will apply the current plug-in settings to the audio document in the foreground.

3. When processing (“Bouncing”) is finished, Peak will display a dialog asking if the plug-in should be disabled.

   • Clicking Yes will leave the plug-in active, but will put it into Bypass mode, so that no audio is being processed by the plug-in. This option is best if you plan to process additional files with the same plug-in, but you wish to temporarily disable the effect.

   • Clicking No will leave the plug-in active, and will allow audio to be processed through the plug-in in real-time. This option is best if you plan to process additional files with the same plug-in, and do not need to temporarily disable the effect.

   • Clicking Disable All will deactivate/close all open effects plug-ins. To use these plug-ins again, you would need to select them from the Plug-Ins menu(s).

To close a plug-in:

1. Select Insert 1 from the Plug-Ins menu.

2. Select VST from the submenu.

3. Select None from the second submenu.

Closing a plug-in’s editor window does not deactivate the plug-in! You must follow the steps outlined above to deactivate a plug-in.

Peak LE features a single insert and can host one plug-in at a time.
Using Effects Plug-Ins with Vbox

To open Vbox in Peak:

- Select Vbox from the Plug-Ins menu – The Vbox matrix appears.

### The Vbox Matrix

The Vbox matrix is ideal for working with multiple plug-ins. It consists of individual boxes where you can assign, route, and modify the flow of audio signals through Audio Units and VST plug-ins.

### Box Controls

The Vbox matrix is made up of individual boxes. Each box can be assigned an effect plug-in. When a box has an effect plug-in assigned to it, it is active. If there is no plug-in assigned to a box, it is inactive.

An active box has several features including the name of the assigned plug-in, input level control, output level control, solo button, bypass button, mute button, edit button, input meters, output meters, and input source.

#### Plug-In Assignment Pop-up

To assign an effect plug-in in an inactive box, click on the box. A pop-up menu displaying all the Audio Units, BIAS, and VST plug-ins installed in your system will appear, allowing you to assign a particular effect plug-in to the box.

To assign a plug-in:

1. Click in an inactive box for the Plug-In Assignment pop-up menu.
2. Select the desired plug-in from the pop-up menu.

---

Peak LE does not include Vbox. Peak LE users wishing to use more simultaneous plug-ins should contact BIAS for upgrade information.

---

If you play back with more plug-ins than your CPU can handle, audio may begin to play back erratically. The CPU meter at the top right of the Vbox window allows you to monitor CPU usage.
The Vbox Matrix Graphical User Interface

To deactivate a plug-in:
1. Click on the name of the currently assigned plug-in.
2. Choose None from the Plug-In Assignment pop-up menu.

To "hot swap" a plug-in:
1. Click on the name of the currently assigned plug-in.
2. Select a different effect plug-in.

When shopping for plug-ins, be sure that they are Mac OS X compatible. Peak supports Audio Units as well as "carbonized" and "Mach-O" format VST effects plug-ins.

Level controls

The small white triangular indicator located next to the input and output meters allow you to cut or boost the input or output of the box. Click and drag the indicator up or down to cut or boost the audio +/-6 dB (+/-100%). The center position of the indicator is 0 dB cut/boost. Hold down the Option key on your keyboard and click the indicator to return it to the center position.

---

Chapter 8: Plug-Ins 213
On the left and right side of the box are input and output meters. These meters show the audio levels input to the plug-in and output from the plug-in. The lights at the tops of the meters are clipping indicators. If the audio clips (reaches maximum level for more than 2 consecutive samples), the clip indicators will come on and stay lit for a few moments. To reset clip indicators, click with the mouse.

Virtual instrument plug-ins differ from effects plug-ins in that they do not have the capability to have audio routed into them — they do not have audio inputs. The only input a virtual instrument can receive is via MIDI. Due to this limitation, it is normal for the input level sliders to have no effect over the audio playback level for that instrument. In addition, it is normal for there to be no activity in the input level meters.

**Mute**

The Mute button mutes all audio output from the box. You can toggle the mute button on or off by pressing this button. Muting a box in a serial arrangement may mute all audio in that series, depending on how signal is routed.

**Bypass**

The Bypass button prevents the plug-in from processing the audio input to the box. The audio will flow through the box directly to the outputs, or to other boxes in the same series.

**Solo**

The Solo button bypasses all the other plug-ins on the same row. This allows you to audition just one box without processing the audio through the other boxes on the row.

**Edit**

The Edit button brings up the plug-in editor for the plug-in assigned to that box. The plug-in editor will appear in a new window, and contains the plug-ins own user interface, with all of its various controls available.

**Editing Effect Plug-In Parameters**

Clicking the Edit button on an active box opens its editor, which is the plug-in’s own user interface. Here, you will be able to access and adjust the parameters of the specific plug-in. You can modify the parameters and save your presets into a preset file using the Load and Save buttons at the bottom of the plug-in’s editor window. The arrow buttons allow you to move through any existing factory presets for the plug-in, or click on the name of the preset for the Presets pop-up menu.

**Moving Plug-Ins**

Vbox lets you move plug-ins from any active box to any other box, active or inactive, in the Vbox matrix.

**To move a plug-in from one box to another:**

- Click on the meters of the active box, the cursor will change to a grabbing hand – drag and drop it on any other box. There is no need to precisely align the plug-in within the borders of the target box — if the hand icon is placed over the target box, the selected plug-in will automatically snap into place.

Moving a plug-in to an inactive box will simply
move the plug-in from one box to the other. Moving a plug-in to an active box will replace the plug-in in the target box.

### Changing Input Routing

Vbox allows you to change the signal flow into parallel box configurations. To move an input from the left-box to the upper-left box, click on the green input indicator on the left center of the box.

#### Creating Serial Chains

Vbox will automatically assume you want to create serial chains of boxes. Simply activate boxes in rows, making sure there are no inactive boxes between the first and last active plug-ins in the row.

#### Creating Parallel Chains

Use the input indicator on the left center of a box to create parallel chains.

### Master Wet/Dry Controls

The slider in the Vbox window labeled Wet/Dry allows you to control the combination of dry signal with signal passed through the Vbox matrix. Drag the slider indicator upward to hear more of the effected signal from the Vbox matrix (wet), or downward for more of the original source signal (dry). Click on the Dry button to hear the original audio source only, without any processing through the Vbox matrix.

### Master Input/Output Levels

The small white triangular indicators at the bottom of the master input and output meters control...
input and output levels. Click and drag the indicator up or down to cut or boost the audio +/- 6 dB (+/-100%). The center position of the indicator is 0 dB cut/boost. Hold down the Option key on your keyboard and click the indicator to return it to the center position.

Virtual instrument plug-ins differ from effects plug-ins in that they do not have the capability to have audio routed into them – they do not have audio inputs. The only input a virtual instrument can receive is via MIDI. Due to this limitation, it is normal for Vbox's Master Input level slider to have no effect over the audio playback level for an instrument in the matrix. In addition, it is normal for there to be no activity in Vbox's Master Input level meters.

Loading and Restoring Vbox Presets

You can save your Vbox matrix as a preset or restore a Vbox matrix by clicking on the Presets pop-up menu at the top of the Vbox matrix. Any presets you save into the Vbox Presets folder will appear in the Presets pop-up menu. The Vbox Presets folder resides in the following directory on OS X:

/\MacintoshHDA/Us\ers/<\YourAccount>/Library/Preferences/

A/B Comparisons

You can do A/B comparisons of different Vbox matrices. Press the left arrow button to store the current Vbox matrix into storage location A. Press the right arrow button to store the current Vbox matrix into storage location B. Press the A or B button to restore a saved matrix.

Vbox Preferences

You can control the size of the Vbox matrix by clicking the Preferences button at the top of the Vbox matrix. Enter the height and width of the matrix you wish to build. Note the new matrix size will not take effect until the next time you launch Vbox. The Vbox matrix can grow as large as 99x99!

Recording Through Effect Plug-Ins

In addition to processing existing audio files, Peak also allows recording through effect plug-ins. This can be a very useful and timesaving step, especially when recording in a known environment, or when the exact same set of effects needs to be applied. While recording through plug-ins, you are free to adjust plug-in parameters – however, be aware that you will be making permanent changes to the material that is recorded, and will not be able to undo these adjustments.

While recording through plug-ins can be a timesaver, be aware that if you are not happy with the results, you cannot undo them. If you are not sure about the settings to use, record a dry signal, and apply effects later. This way, you can freely experiment with effects settings and not have to commit to them.
Regardless of whether you’re using effects plug-ins on channel inserts or within the Vbox matrix, the process for recording through them is the same.

To configure Peak to record through Plug-ins:

1. From the Plug-Ins menu, open and configure the plug-in(s) you wish to record through.
2. Select Record Settings from the Audio menu. The Record Settings dialog will appear.
3. Check the Record Through Plug-Ins checkbox and click OK.
4. Select Record from the Audio menu (⌘-R) or Transport. You are now ready to record audio through the plug-in(s).
5. Be sure to disable the active plug-in(s) after you have made the recording. If you do not disable/bypass the plug-in(s), when you play back the recording, you will hear a processed file being played through the active plug-in in real time and it will sound as if the recording has twice the desired effect.

Peak can only host (and record) through plug-ins when using Core Audio.

Plug-Ins Envelope

Peak features an editable plug-ins envelope, which allows applying a variable wet/dry mix over a selected portion of an audio waveform. For example, if you have a dialogue clip that you would like to apply reverb to, but would like the amount of reverb to vary dynamically, you can create a custom envelope that automatically varies the amount of reverb applied to different portions of the clip.

To apply effects plug-ins dynamically:

1. Make a selection of the audio document you want to process.
2. Choose Plug-Ins Envelope from the Peak’s Preferences dialog.
3. A dialog appears allowing you to draw a breakpoint envelope to control how much of the effect is applied over time. Points at the top of the graph represent 100% wet, while points at the bottom of the graph represent 0% wet (dry).

4. When you are finished drawing an envelope, click Change.
5. Configure the plug-ins you wish to apply.
6. Choose Bounce from the Plug-ins menu.

Plug-In Latency Compensation

Plug-ins may introduce a short delay, known as latency, into the audio they are being used to process. Depending on the type of processing the plug-in performs, the amount of latency can vary – so it is common for different plug-ins to produce varying amounts of latency.
Latency typically appears in audio documents after bouncing, by a shift in samples later in time relative to the document’s own timeline.

Peak features an automatic plug-in latency compensation feature called Auto Adjust Bounce for Latency – which automatically compensates for the latency introduced into a processed signal.

Automatic latency compensation may be toggled on and off from Peak’s Options menu.

**To Toggle Latency Compensation On/Off:**

- From Peak’s Options menu, select Auto Adjust Bounce for Latency.

A check next to the Auto Adjust Bounce for Latency item indicates that this feature is active. The absence of a check next to this item means it is inactive.

Plug-in latency compensation may also be used manually. To compensate for plug-in latency when bouncing effects on a selection, hold down the Option key when choosing Bounce, and enter the delay compensation you want in samples in the Bounce Effects dialog.

**To determine delay compensation:**

1. Bounce effect(s).
2. Measure the silence inserted by the bounce by selecting the silence and viewing the duration of the selection in samples. (You can use either the time display counter in the Transport, or turn on the Cursor Info overlay from the Options menu – either way will show the length of the selected piece of audio in the chosen Time Units. Time Units should be set to Samples for this process).
3. Undo the bounce.
4. Hold down the Option key while choosing Bounce from the Plug-Ins menu.
5. Enter the delay compensation amount from step 2.
6. Click OK or press Return.

---

**Using Effect Plug-Ins with the Batch File Processor**

Peak allows you to use your Audio Units and VST effect plug-ins with the Batch File Processor (see Chapter 9: Batch File Processor & Apple Events for a detailed description of the Batch File Processor). This can be a very powerful and timesaving processing option if you need to apply the same plug-in(s) to many audio files.

**To use plug-ins with the Batch File Processor:**

1. Open an Audio Document.
2. Open and configure the desired Audio Units or VST plug-in(s) that you wish to use in the batch process. (See the section on Using Effects Plug-Ins earlier in this chapter for detailed directions on opening plug-ins).
3. Choose Batch File Processor from the File menu.

4. Choose any other processes you want to use for the Batch File Processor and Set the Batch File Processor’s Output directory folder.

5. Add “Bounce” from the list of Available Processes to the list of Selected Processes for Batch.

6. Turn the Batch File Processor On and click OK.

7. In the Finder, locate the files/folders you wish to batch process — and drag and drop them over the Peak application icon in the Dock.

8. Peak will batch process these files and save them to the designated directory folder.

**Peak LE does not support Batch File Processing.**

### Using Virtual Instrument Plug-Ins

Peak supports Audio Units and VST format virtual instruments. Virtual instrument support in Peak offers a quick and easy way to record performances, and greatly expands the scope of Peak’s sound design possibilities.

Virtual instruments may be used in Peak in a variety of ways. A single virtual instrument may be loaded on a channel insert, or multiple virtual instruments may be loaded into Vbox and be played simultaneously. Instruments may be loaded for playback as well as for recording directly to a Peak audio document.

Virtual instruments may also have effects plug-ins chained in a series after them, so the effects plug-ins are used to modify the instrument’s output.

Before playing virtual instrument plug-ins, an input method must first be configured.

### Configuring Peak for Virtual Instrument Playback

In order to play virtual instruments, you must enable a keyboard input. Virtual instruments may be played by clicking keys in Peak’s MIDI keyboard window, or by enabling keyboard MIDI control (uses your computer’s keyboard as a MIDI input), or by using an external MIDI keyboard.

**With Peak’s MIDI Keyboard Window:**

- From the Window menu, select MIDI — Peak’s MIDI keyboard window appears.

Active virtual instruments now receive input when keys in Peak’s MIDI keyboard window are clicked.

**With your Computer keyboard:**

- From the Options menu, select Keyboard MIDI Input.

Active virtual instruments now receive input when keys on your computer’s keyboard are pressed.

**With an External MIDI Controller:**

1. Connect a MIDI interface to your Macintosh and follow its installation/setup instructions. After you have configured your MIDI interface, launch Peak.

2. Open Peak’s Preference Panel -> MIDI Preferences.
3. Select the desired MIDI device and click OK – then click the Save button to exit Peak's Preference panel.

Active virtual instruments now receive input when keys on your MIDI controller are pressed.

---

**To Load a VST Instrument on a Channel Insert:**
- From the Plug-Ins menu, select Insert 1 > VST > desired instrument

---

**Playing Virtual Instruments**

Once a MIDI input method has been configured, it’s very easy to play a virtual instrument in Peak.

**To Play an Instrument:**
1. Load the desired instrument plug-in.
2. Click a note in Peak’s MIDI keyboard window, using the keyboard on your computer, or using a MIDI controller.

---

**Recording Virtual Instruments**

At some point, you will probably want to record your virtual instrument performances. This is a very simple process.

Peak can record the audio output of virtual instruments directly into a Peak audio document. The configuration for recording virtual instruments is similar to recording through effects plug-ins.

**To Configure Peak to Record Virtual Instruments:**
1. From the Plug-Ins menu, open and configure the virtual instrument plug-in(s) you wish to record.
2. Select Record Settings from the Audio menu. The Record Settings dialog will appear.

---

**Loading Virtual Instruments on Inserts**

**To Load an Audio Units Instrument on a Channel Insert:**
- From the Plug-Ins menu, select Insert 1 > Audio Units > Manufacturer > desired instrument

---

*Depending on the MIDI interface you are using, you may need to install a driver (provided by the interface manufacturer). You may also need to restart Peak and/or your computer before the computer recognizes that a keyboard is connected – your computer needs to recognize that an interface is connected before Peak can use it for MIDI input.*
You may want to monitor your recording. To do this, open the Record Settings dialog and check the Monitor On/Off checkbox. If you are using direct monitoring through an audio interface, you may not need to enable software monitoring in Peak.

3. Check the Record Through Plug-Ins checkbox and click OK.

4. Select Record from the Audio menu (command - R) or Toolbar – Peak is now ready to record audio output from the virtual instrument plug-in(s).

5. Click the Record button in the Record dialog – Peak is now recording.

6. Be sure to disable the active plug-in(s) after you have made the recording, before playing it back. If you do not disable the plug-ins, no signal will be heard.

Peak can only host (and record) through plug-ins when using Core Audio.

Deactivating Virtual Instrument Plug-Ins

When you are finished using an instrument, you may close it by following the steps below.

To Deactivate a VST Instrument from a Channel Insert:

- From the Plug-Ins menu, select Insert 1>VST>None

To Deactivate an Audio Units Instrument on a Channel Insert:

- From the Plug-Ins menu, select Insert 1>Audio Units>None

Playing Virtual Instruments Alongside Audio Documents

There may be times when you wish to play a virtual instrument at the same time as an audio document, for example, if you are trying to learn a part of a song.

To do this, you will need to run the instrument within Vbox, and you will need to use the following setup.

To Configure and Play virtual instruments alongside audio documents:

1. With running, and the desired audio document already open, choose Vbox from the Plug-Ins menu.

2. In the Vbox interface, select the desired virtual instrument to be played.

3. In a parallel row, choose any effect plug-in – it does not matter which you use.

4. Bypass the effect plug-in by clicking the “B” button in the plug-in’s thumbnail.
5. Start playback of the audio document.

6. Send MIDI input to the instrument (via Peak's MIDI keyboard window, your computer keyboard, or using a MIDI controller).

---

**Conclusion**

You have now learned how to use Peak to manipulate and process audio using Audio Units and VST effects plug-ins. You've also learned how to open, play, and record virtual instrument plug-ins. In the next chapter, you will learn how to use Peak's powerful Batch File Processor as well as how to use Apple Events with Peak for file management.
Chapter 9: Batch File Processor and Apple Events

Introduction

Peak allows you to process any number of audio files at once with any number of possible processes using the Batch File Processor. Peak also supports Apple Events, which allows you to manage whole libraries of audio files quickly and easily with database applications such as FileMaker Pro.

Batch File Processor

Peak’s Batch File Processor is one of the most powerful, versatile, and useful features in Peak. Using the Batch File Processor, you can integrate any series of Peak processes (called a batch script), and apply these scripts to any number of audio files.

The currently open audio document and selection you make will be used for previewing processes sequenced into your batch script.

To use Batch Processing, go to the File menu and select Batch Processing. The Batch File Processor dialog appears.

Peak’s Batch File Processor is split into three areas: Input, Process, and Save Changes. Sequence a series of steps for Peak to execute in the Process section, then set your output file settings in the Save Changes area. Once

Peak’s Batch File Processor is configured, you may turn on the Batch File Processor in the Input area.

Once the Batch File Processor is configured and turned on, any files you drop onto the Peak application’s icon (or an alias) will be batch processed according to your settings. You can even drop folders or disks onto Peak’s icon and all of the supported audio contents will be batch processed. You can continue dropping files, folders, or disks, onto the Peak icon for batch processing while the Batch File Processor is turned on. All subfolders within folders or disks you drag onto the Peak application icon for Batch File Processing will be recreated in the Batch File Processor’s output directory, preserving all organization of your files. Audio documents opened using the Open command from the File menu will not be batch processed.
You can also have the Batch File Processor run in the background while you work in another application.

Supported contents include all file formats that Peak can read, including AIFF, Sound Designer II, WAVE, QuickTime, Raw, JAM image files, System 7 Sound, AU, MP3, and AAC/mp4.

New audio documents created with the Batch File Processor will have the same file name as the original input audio document and may also include an optional suffix.

**Input Area**

The Input Area allows you to enable or disable batch file processing. Once the Batch File Processor is configured, you may turn it on with the On button. If you have finished batch processing and no longer need to batch process files, you can use the Off button to disable batch file processing.

You can include/exclude mono or stereo files from the batch process by using the Process All Files, Only Mono Files, and Only Stereo Files buttons. Process All Files is the default setting. To have Peak's batch processor only work with mono files, click the Only Mono Files button. Similarly, to only process stereo files (excluding mono files), engage Only Stereo Files.

**Process Area**

The Process Area shows two lists; the list on the left, labeled Available Processes, allows you to select processes that will be used in your batch script. Almost every process that Peak is capable of will appear in this list. The list on the right is labeled Selected Processes For Batch and contains the Peak processes in the current batch script.

Double-click on a process in the Available Processes list to add it to the Selected Processes for Batch list. Alternatively, click on a process in the Available Processes list and then click the Add >> button. To remove items from the Selected Processes for Batch list, click on the items and then click on the << Remove button.

When you add a process to the Available Processes list, you may be required to supply settings for the process. The front-most audio document and selection will be used for any previewing the process may support. Peak's batch processor allows you to use multiple instances, or occurrences, of a single process – each with its own settings.

You may also specify which part of the file to apply the process to. Once a process has been added to the Selected Processes for Batch list, you may use one of the buttons Entire File, Apply Just To First x Seconds, or Apply Just To Last x Seconds. Use these buttons to configure how to apply the selected process to an audio document. For instance, if you are using a Fade In process and...
only wish to apply it to just the first three seconds
of the audio document, click the Fade In process
from the Selected Processes for Batch list and then
type a “3” into the Apply Just to First x Seconds
edit text field. All processes are applied by default
to Entire File unless you configure the process
otherwise.

Save Changes Area

Use the Save Changes Area to configure how your
audio documents will be stored after they have
been processed using your batch script. Click the
Set button to specify the output document format,
settings, and location.

After clicking Set you will be asked to provide the
output file format, bit depth, and compression
options using the Save As dialog described in
Chapter 4. Choose which folder to save the
processed audio files into with the Save As dialog.

Log File

You can create a text Log File during batch processing to
keep track of which files have been processed. This is
useful for lengthy batch processing sessions where the
possibility of a power failure or other circumstance could
prevent the batch process from completing. Click on the
Log File checkbox to specify that a log file should be
created for the batch process. After turning the Log File
feature on, Peak will ask you to provide a destination for
the log file. The log file can be viewed using TextEdit or
any application that can view text files. The Batch File
Processor will divert any error messages to the log file if
it is enabled. This is useful because any errors Peak
encounters during batch file processing will not require
user attention during processing. However, Peak will
issue a System Beep sound if an error occurs during
Batch File Processing. If this happens, check the log file
for errors.

Preserve File Attributes

If you wish to process a group of files with a variety
of attributes, such as file formats, bit depths, etc.
and have the processed files retain their original
attributes, click this box to enable file attribute
preservation. This option allows the Batch File
Processor to focus on all the available DSP
processes, rather than on file format (and other
attributes) conversion. If you wish to process a
group of files and also change them all to the same
output format, leave this box unchecked, and
select the desired output format by clicking the Set
button in the Save Changes area of the Batch File
Processor.

File Name Suffix

If you want the output audio files of your Batch
Process to be appended with a suffix, such as .WAV,
simply enter the suffix you want appended in the
File Name Suffix field. All resulting audio file
names will be appended with the suffix you specify.

Save Script

Peak allows you to save your batch script into a
settings file that can be recalled later. This feature

![Chapter 9: Batch File Processor & Apple Events](image)
is useful if you frequently process files using a specific sequence of processes. After configuring the Batch File Processor, click Save Script to save your batch sequence into a Batch Script file. You will be prompted to choose a save location and name for the batch script. The settings file holding your batch script will store the processes, each process' settings, and the output file format.

Load Script

To recall a batch script settings file that was stored using the Save Script button (as described above), click Load Script button. For example:

To convert a folder of files into AIFF IMA 4:1 files Normalized to 95% with a Log:

1. Choose the Batch Processor command from the File menu.
2. Double-click the Normalize item in the Available Processes list. Enter “95” in the following normalization settings dialog.
3. Click Set in the Save Changes Area of the Batch File Processor. Choose AIFF from the File Format pop-up menu. Choose IMA 4:1 from the Compression pop-up menu.
4. Choose the folder to save the output files into. Click Save.
5. You will be back in the Batch File Processing dialog. Click Log and choose the output folder to save the log file into.
6. Click the On button in the Input Area of the Batch File Processor. The Batch File Processor is now turned on.
7. Click OK to close the Batch File Processor dialog.
8. Switch to the Finder, and drag and drop a folder full of audio documents onto the Peak application's icon.
9. Peak will process all audio files in the folder that was dropped onto the Peak application icon.
10. Once the files have been processed, open an audio document, choose the Batch Processor command from the File menu. You may then turn off the Batch File Processor by clicking Off in the Batch Processing dialog.

Errors and Cancelling Batch Processes

Any errors during Batch File Processing will produce a System Beep to notify you of the trouble. If an error occurs during Batch File Processing, Peak will not place an error dialog on the screen. This happens so that processing can continue. If you have specified that you wish to create a log file, error messages that would appear in an error dialog will appear in the log file, indicating where in the batch file process the error occurred.

Once the batch file processor has started, it will continue to process files as quickly as possible. If you find it necessary to halt the batch process, press \&- Period. A dialog will appear allowing you to cancel the batch process. If you choose to cancel the batch process, Peak will finish processing the current file and then ignore any other files to be processed. Once batch processing has been cancelled, Peak will turn the batch file processor Off.

Batch File Processing is not available in Peak LE.
Peak’s Audio Librarian Tools

Peak’s Audio Librarian Tools are ideal for anyone who maintains a large number of sound effects or other types of samples. Through Apple Events, Peak allows users to catalog and audition sounds from ordinary database applications, such as FileMaker Pro (several ready-made templates are included). Peak also includes Batch Region Processing (via the Export Regions command in the File menu).

Apple Events™ Support

Peak understands a vocabulary of Apple Events. Apple Events can automate procedures for you, such as triggering the playback of an audio document.

The standard suite of Apple Events that “savvy” applications must understand includes the “odoc” (open document) event. For example, when you double-click on a Microsoft Word document, the Macintosh Finder sends an “odoc” Apple Event to the application Microsoft Word. Unfortunately, “odoc” requires the complete document path of the document you wish to open. You can use “odoc” with Peak, but Peak has another feature that makes opening and playing your documents much easier: simplified document descriptions instead of entire document paths. To illustrate this difference, compare the following:

Full Document Path:


Simplified Document Path:

Volume Name: John’s HD:
Document Name: C5-A6.aiff

Using the simplified document path, Peak searches the indicated volume for the first occurrence of a document matching the name described (called a Find File operation). Once it is found, it is opened up and ready for playback.

“Savvy” Core Suite of Apple Events ( event class = ‘aevt’ )

odoc (Open Document)

The “odoc” event instructs Peak to open an audio document with the document path provided in the data following the event.

quit (Quit Peak)

The “quit” event Quits Peak.

Peak has its own class of events that it understands, all of which have the ID “furp.” This class descriptor must be present for Peak to understand the events you send to it.

Peak events ( event class = ‘FURP’ )

sff (Set FindFile Volume)

The “sffv” event tells Peak to use the data following the event (a string of text) as the Volume name to search when providing a simplified document path. When specifying volumes, don’t use colons in the name of the volume.

sfff (Set FindFile File)

The “sfff” event tells Peak to use the data following the event as the name of the document to find when specifying a simplified document path.

offf (Open the FindFile File)

The “offf” event tells Peak to find the document on a volume specified by the most recent “sfff” and “sffv” events. If the
document is found, it is opened in a window. If the document is not found, Peak will beep once.

**stop (Stop any currently playing audio)**

The “stop” event takes no additional data and instructs Peak to stop playing any audio that is currently playing.

**clos (Close the front-most window)**

The “clos” event takes no additional data and instructs Peak to close the front-most window, if one exists.

**play (Play the front most window)**

The “play” event initiates playback of the front most opened audio document. Use the “stop” event to stop playback, or wait until the document completes it’s playback.

### Example Scripts

The FileMaker Pro documents included in the Peak Extras folder are intended to illustrate Peak’s functionality in an audio document database environment. To try out the scripts, open one of the FileMaker Pro documents, type in the Volume Name (the exact name of the hard disk the audio document resides on) and Document Name for an audio document on one of your hard drives, hit Enter and press the graphic play button. If the document is found, Peak will play the audio document. You can create new records with the \&N keystroke from FileMaker Pro to get a new empty record.

Below is an example Script Definition from FileMaker Pro that might be used to create a Play Button. There are six steps to this Script Definition:

1. Stop any currently playing audio documents (STOP).
2. Close any open digital audio windows (CLOS).
3. Pass the FindFile Volume name to Peak from some FileMaker Pro field (SFFV).
4. Pass the FindFile File name to Peak from some FileMaker Pro field (SFFF).
5. Tell Peak to find and open the document described by steps 3 and 4, above (OFFF).
6. Tell Peak to Play the front-most audio document (PLAY) (opened in step 5).

---

**FileMaker Pro is not included with Peak**

**Apple Events are not supported in Peak LE**

---

### Conclusion

You have now learned how to batch process audio using Peak’s Batch File Processor as well as how to use Apple Events to manage whole libraries of audio files with database software such as FileMaker Pro. In the next chapter, you will learn how to use Peak to edit and transfer samples to and from hardware (SMDI) Samplers.
Chapter 10: Samplers

Introduction

Peak allows you to import samples directly from compatible samplers, edit or process the audio using all of Peak's powerful editing and processing functions, and then send the modified sample back to the sampler, all in the digital domain. This capability allows you to use Peak as a powerful sample editing and sound design tool, giving you access to audio processing capabilities far more advanced than those typically found on sample playback instruments.

Peak LE does not support hardware samplers.

The following sections explain how to transfer audio documents between your sampler and your Macintosh.

Some samplers have a different interpretation of loop points than Peak does. To compensate, you may need to use the Sampler preference dialog to adjust loop points forward or backward by plus or minus one sample. You may enter independent settings for sending and receiving loop points, as well as loop start and loop end offsets for each. To adjust loop point offsets, select Sampler from the Preferences dialog.

Working with SMDI Samplers

Peak's SMDI Sampler Support makes it possible to transfer several audio documents at once to or from your SMDI sampler.

SMDI Samplers supported in Peak (at time of printing):

- E-mu – E-IV, ESI-32, ESI-4000, E-64, E5000
- KURZWEIL – K2000, K2500, K2600
- PEAVEY – SP/SX
- YAMAHA – A3000, A4000, A5000

SMDI Samplers

SMDI Samplers, such as the Kurzweil K2500 or the E-mu E-IV, use SCSI to transfer samples between devices. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler. Consult your sampler’s owner’s manual for instructions on how to connect the cable to your Macintosh with proper termination. Always use high-quality SCSI cables to avoid data transmission errors.

Peak allows the user to turn fast Asynchronous SCSI transfers On or Off in the Sampler dialog. Turn Asynchronous transfers OFF if you are having trouble transmitting samples to a SMDI device, or if your Macintosh does not support Asynchronous SCSI transfer.

To use the SMDI Sampler dialog:

1. Choose SMDI Sampler or the name of your sampler.
sampler from the Sampler menu. The SMDI Sampler Transfer dialog appears.

The SMDI Sampler Transfer dialog

List of Samples

This dialog features a list of samples stored in the SMDI device. Since there are hundreds of sample locations in a SMDI device, an exact range of samples to display is used. You may click on items in the list to view detailed information about the sample in the Info portion of the SMDI Sampler Transfer dialog. You may also Shift-click or Command-shift-click to select multiple items in the list of samples.

Update

The Update button rebuilds the list of samples shown in the SMDI Sampler Transfer dialog. Peak will scan the SMDI device starting at the sample number indicated in the Start edit text field until the number of samples entered in # Items edit text field have been scanned.

SMDI Device

Any SMDI devices Peak detects attached to your Macintosh will show up in this pop-up menu. Choose the device you would like to use from the pop-up menu. Peak will scan the device for sample information starting at the sample number indicated in the Start edit text field.

Start

Enter the first sample number stored in your sampler that you wish to view in the list of samples. If you change this value, you must click on the Update button for the list of samples to be updated. Some SMDI samplers start their samples at sample number zero, others start at 200. Refer to your SMDI Sampler’s manual for information on how samples are stored in your particular device.

# Items

The # Items edit text field controls how many samples are displayed in the list of samples. If you change this value, you must click on the Update button for the list of samples to be updated.

Send

To send the front-most Peak audio document to the SMDI Sampler, click on the sample in the list of samples that you wish to send the sample to and press the Send button. If a sample already exists at the chosen location in the SMDI Sampler, it will be replaced.

To send multiple opened Peak audio documents to the SMDI Sampler, shift-click or Command-click to select multiple destinations in the list of samples and click the Send button. Peak audio documents will be sent to the selected destinations in the order that they appear under Peak’s Windows menu.
Receive

To receive a sample from the SMDI sampler, click on the sample in the list of samples that you wish to receive and press the Receive button.

To receive multiple samples from your SMDI Sampler, shift-click or ⌘-click multiple destinations in the list of samples and click the Receive button.

To send an audio document to your SMDI sampler:

1. Choose Open from the File menu to locate and open the audio document you wish to send to your SMDI sampler, or open the audio document by double-clicking it in the Finder.
2. Choose the SMDI Sampler command from the Sampler menu. If Peak finds a SMDI sampler connected to your Macintosh, the SMDI Sampler Transfer dialog appears.
3. Make sure the correct SMDI device is selected in the SMDI Device pop-up menu.
4. Click on the sample in the List of Samples that you wish to replace.
5. Click Send. Peak will send the sample to your SMDI sampler.
6. When you are finished using the SMDI Transfer dialog, click the close box of the dialog or click the Cancel button.

To send a SMDI sample to Peak:

1. Choose the SMDI Sampler command from the Sampler menu. If your SMDI sampler is properly connected to the Macintosh SCSI chain, you will see the SMDI Sampler Transfer dialog appear.
2. Make sure the correct SMDI device is selected in the SMDI Sampler pop-up menu.
3. Click on a sample in the List of Samples that you wish to receive.
4. Click the Receive button. Peak will transfer the sample you identified to the Macintosh and place it into a new audio document window. Audio documents created by bringing samples over from a SMDI device are not saved until you use the Save command from the File menu.
5. When you are finished, click the SMDI Sampler Transfer dialog’s close box or click the Cancel button.

To browse through samples stored in your SMDI device:

- Click on a sample in the List of Samples. If your SMDI device has a sample stored at this sample number location, Peak will retrieve the information about the sample including its sample rate, size, bit depth, stereo/mono format, and loop points and display the information in the Info area of the SMDI Transfer dialog. If there is not a sample stored in the SMDI device with the sample number, “(Empty)” will appear in the sample Info area of the SMDI Transfer dialog.

SMDI Sampler Error Messages & Troubleshooting

If a SMDI device cannot be found connected to your Macintosh, Peak will display the message “No SMDI devices could be found connected to this Macintosh.” If this happens, and your SMDI device is connected to your
Macintosh with a SCSI cable, try the following:

- Make sure your SCSI cables are properly connected. SCSI cables can come loose if they are not tightened down using the cable's connector screws. Make sure you connect the SCSI cables to your Macintosh only when it is turned off.
- Make sure there is not another SCSI device connected to your Macintosh using the same SCSI ID as your SMDI device. Consult your SMDI device's owner manual for information on how to change the SCSI ID of your SMDI device.
- You may need to turn on your SCSI devices in the correct order. Turn all of the SCSI devices connected to your Macintosh on first, then turn on the Macintosh and launch the Peak application.

A note about the Yamaha A3000

Peak supports the Yamaha A3000 digital sampler. You can access the A3000 sampler using either the Yamaha A3000 or SMDI menu selection under Peak's Sampler menu. Please note the A3000 cannot replace existing samples, and any transfers to the A3000 will be placed in the next available empty sample in RAM, regardless of where you instruct Peak to place the sample. When "BulkProtect" is turned on, the A3000 does not respond to SMDI messages. "BulkProtect" is at UTILITY mode>MIDI function>Bulk page. BulkProtect is always ON after you turn on the A3000, so you will need to turn it off before you can do SMDI transfers.

The Sampler Preferences dialog

You can access the Sampler Preferences from Peak's Preferences dialog to set Loop Offsets and Asynchronous SCSI transfer.

Conclusion

You have now learned how to import samples directly from compatible samplers (to edit or process the audio using all of Peak's functions) and send the modified samples back to the sampler. In the next and final chapter, you will find detailed descriptions of each Peak command and function, menu by menu.
Chapter 11
Peak Menus
Chapter 11:  
Peak Menus

Introduction

This chapter explains each of the commands found in Peak’s menus. For step-by-step instructions on implementing these commands, refer to the index, and go to the appropriate chapter where use of the command is covered.

Peak Pro Menu

The following items and commands appear under the Peak Pro menu.

About Peak...

This menu shows information about the particular version of Peak you are using, including the exact version number and your serial number.

Help

This command will open the Peak User’s Guide, which is installed along with the Peak application.

Preferences...

The Preferences command opens Peak’s Preferences dialog, which contains many of the customizable elements of the application. Preferences details are listed below, for each category of Preferences found in Peak’s Preferences dialog.

Colors

Peak allows you to customize the colors used to display the elements in audio documents. You can use this dialog to set the background color, waveform color, and colors for markers and loops. You can select either a preset color combination, individual colors for each element in the audio document window, as well as picking your own custom colors from a color palette. Changes made using the Colors dialog affect both the current audio document’s colors, and any subsequent new audio document’s colors. See Chapter 3 for more information on this feature.
Scratch Disks

Because audio data can be very large, Peak utilizes a portion of your hard disk’s free space to hold audio documents that have been cut or copied, as well as for temporary or “scratch” files for undo purposes. If your hard disk is short on space, you may not be able to cut, copy, or modify large selections. If you have more than one hard drive attached to your Macintosh, the Scratch Disks command in the Preference menu allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose—usually you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the Allow Servers checkbox. Any available servers will then appear in the Scratch Disks pop-up menu. This feature is recommended only if you have access to a high speed Ethernet, or other fast server.

Blending

Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document when they are modified by cutting, pasting or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you are going to cut, paste, or insert audio into a document, you may wish to enable blending to smooth things out a bit. It can be toggled on or off by clicking the Blending button in the Audio Document Window, or pressing the Caps Lock key on your keyboard. For detailed instructions on how to use blending or how to edit the blending crossfade envelope, see Chapter 5: Editing.

Auditioning

Peak’s Auditioning command allows you to audition a selection along with a specific amount of audio preceding or following it. The Auditioning dialog allows you to select a desired amount of Pre-roll or Post-roll when you play the selection.
Fade In Envelope

The Fade In Envelope command allows you to edit Peak’s fade-in envelope. Fade-ins can be very useful for smoothly fading into an audio document, or for fading into one type of audio material from another. Very short fade ins can also be useful for smoothing or removing clicks and pops in a recording. The Fade In Envelope dialog allows you to control the exact shape of a fade in by providing you with user definable envelope controls. For detailed instructions on how to create fade ins and edit their envelopes, see Chapter 5: Editing.

Fade Out Envelope

The Fade Out Envelope command allows you to edit Peak’s fade-out envelope. Fade-outs can be very useful for smoothly fading out of an audio document, or for fading out of one type of audio material into another. The Fade Out Envelope dialog allows you to control the exact shape of a fade out by providing you with user-definable envelope controls. For detailed instructions on how to create fade out and edit their envelopes, see Chapter 5: Editing.

Plug-Ins Envelope

This command allows you to apply plug-in effects gradually according to the envelope you create in the Envelope Editor dialog. This is very useful for varying the intensity of effects over time.

Sampler Preferences

The Sampler command allows you to set an offset of one sample, for those samplers that require it, as well as choose SCSI preferences. See Chapter 10: Samplers, for more on the Sampler Preferences dialog.

DSP Preferences

Peak DSP Preferences allow you to set the size of the “window” used in time shifting, and the quality of sample rate conversion. A setting of 8 is recommended for Sample Rate Conversion Quality, (with 1 being lowest and 10 being the highest). A setting of 30ms is recommended for the time shifting window size — a lower setting is better for simpler, monophonic sounds, and a higher setting is better for more complex polyphonic.

Playback Preferences

Peak’s Playback Preferences dialog contains the following controls:
Playback Master Volume

Peak provides a master volume control for audio playback. In the Playback Preferences dialog, set Peak’s output volume to the level that you desire by adjusting the slider or entering a number value from 0 (silent) to 7 (loudest). If you are controlling your playback volume with the volume control of your playback system, you will most likely want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the program uses when playing back audio documents. In general, lower is better. A playback buffer of 32k is a good place to start. If you are experiencing clicks in your playback, working with fragmented files, using processor-intensive real-time DSP, or are using a slow hard drive, you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the program uses to keep audio documents buffered in RAM. Use larger values if you are working with a few large files, and smaller values if you are working with many smaller files. Experiment to find the best settings for your system and working style.

Shortcuts/Toolbar Preferences

Peak allows you to customize any Peak menu item with a keyboard shortcut. To change your keyboard shortcuts, go to the Preference menu and select the Shortcuts and Toolbar item. Keyboard shortcuts are stored in a preference file in the directory: /Users/<YourUserAccount>/Library/Preferences/.

Peak’s default Keyboard Shortcuts are listed in Appendix 1.

You may also customize the Peak Toolbar using the Shortcuts & Toolbar dialog. Just scroll to a function in the dialog list, and use the checkbox to toggle the icon on and off. This allows you to group only the items you use most frequently on the Toolbar for easy access.

Window Preferences

Peak’s Window Preferences allow you to designate which windows “float” above open documents. Use the Floaters dialog to specify which windows (Toolbar, Transport, Contents, Movie, or plug-ins) float or not.

Also contained in the Window Preferences dialog is a checkbox for Live Document Resizing. Live Document Resizing scales an audio document’s contents when the window is resized, allowing you to see the audio waveform’s size change as you change the size of the window. A check in the Live Document Resizing box indicates that the preference is turned on — an absence of a check indicates that it is turned off.
POW-r Dithering Preferences

The POW-r dithering preferences dialog allows you to choose which POW-r dithering algorithm is applied when saving files or bouncing Playlists. For mono files, or stereo files with a narrow stereo field (e.g., recordings of solo instruments), use POW-r 1; for more stereophonically complex material, use POW-r 2; for full-spectrum audio with a wide stereo field, use POW-r 3.

POW-r Dithering is not available in Peak LE

Hide Peak

Temporarily puts Peak into the background, and hides all windows. Peak can be brought back into the foreground by choosing its icon from the Dock.

Hide Others

Temporarily puts any other open applications into the background. This is a useful command if you have several applications open, and want to focus on working in Peak. Other applications can be brought back into the foreground by clicking on their icon in the Dock.

Quit Peak

Choosing Quit Peak closes the Peak application. If you haven’t saved changes to a currently open audio document, Peak will prompt you to do so before quitting.

File Menu

This menu contains all of the standard Macintosh commands for opening, closing, and saving files, as well as several additional commands specific to the Peak application.

New

This command allows you to create a new Peak audio document. When you choose this command, a submenu menu appears which allows you to choose either a mono or stereo format for the new audio document, or to create a Playlist document or a new audio document from an open Playlist document.

Mono Document

Choosing Mono Document (⌘-N) creates a mono (one channel) audio document.

Stereo Document
Choosing Stereo Document (Shift-N) creates a stereo (two channel) audio document.

**Document From Selection**

Choosing Document From Selection (Ctrl-N) creates a new audio document from any selected audio in an open audio document.

**Playlist Document**

Choosing Playlist Document (Shift-P) creates a new Playlist document.

**Document From Playlist**

Choosing Document From Playlist (Shift-B) creates a new audio document from an open Playlist document.

**Open**

The Open command (O) allows you to locate and open an audio document. Peak can open audio documents in a variety of formats including AIFF, Sound Designer II, WAVE, QuickTime, Raw, System 7 Sound, Sonic AIFF, Paris, Jam Image, AU, MP3, and MP4.

**Close**

The Close command (W) closes the currently active Peak audio document. If you haven’t saved changes, Peak will prompt you to do so before it closes the document. If you have many documents open and don’t wish to save any of the changes you’ve made, Option-click on the prompt dialog’s Don’t Save button.

**Close All**

The Close All command (Option-W) closes all open Peak audio documents. If you haven’t saved changes, Peak will prompt you to do so before it closes the documents. If you don’t wish to save any of the changes you’ve made, Option-click on the prompt dialog’s Don’t Save button.

**Save**

The Save command (S) saves the current audio document. Peak can save audio documents in a variety of audio file formats including:

- **AIFF**: This is Apple’s Audio Interchange File Format. It is also Peak’s default file format and is supported by many Macintosh software applications.

- **Sound Designer II**: This is one of Digidesign’s audio file formats for its digital audio products, which has become popular in other audio applications. This is a good format to use if you plan to use an audio file in a Digidesign audio application.

- **WAVE**: This is Microsoft’s Windows Audio File Format. It is supported by many Windows software applications and most Macintosh applications. The WAVE format is best if you plan to use an audio document in an application that supports or requires WAVE format files.

- **QuickTime**: This is Apple’s audio file format for
QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Final Cut Pro™ or Macromedia Director™.

- **Raw:** This is the headerless raw file format that may be useful for some game platforms.

- **System 7 Sound:** This is the Apple audio file format used for Macintosh Operating System Sounds.

- **Sonic AIFF:** The file format used by Sonic Solutions audio workstations.

- **.paf:** This is the file format used by E-mu’s Paris audio system.

- **.jam image file:** This is the Jam audio image file format. Jam audio image files may be created in Peak and used in Roxio Jam for burning audio CDs. (See Chapter 6: Playlists & CD Burning for more information.)

- **.au:** This file format is commonly used on the World Wide Web and in Java audio applets. .au is supported by many platforms and programs.

- **MP3:** Saves audio as MP3 encoded audio.

Different formats allow different information to be stored with the file. If you open a file created in a format other than Peak’s default AIFF format, Peak will preserve any format-specific information unless you save the file into a different file format. Saving a file in a different format than its original format, however, may cause some information stored in the file to be discarded. For instance, Sound Designer Regions cannot be stored in QuickTime, AU, System 7, or MP3 files; nor can copyright, author, or other file format-specific information be saved in a format which doesn’t support it.

### Save As

The Save As (Shift-Option-S) command allows you to save a copy of the current audio document under a different name, in a different location on your hard drive, or in a different audio file format. The saved copy will become the active open audio document. You can save the document with a variety of audio compression schemes. For detailed instructions on using this feature, see Chapter 3: Peak Basics.

### Save A Copy As

The Save A Copy As command (Option-S) allows you to save a copy of the currently active open audio document under a different name without replacing the active open audio document.

### Import CD Track

The Import CD Track command allows you to import tracks from an audio CD. CD tracks imported to Peak will be saved as AIFF files. For more detail on importing CD audio with Peak, see Chapter 4: Playback & Recording.
**Import Dual Mono**

The Import Dual Mono command lets you import two mono files and create an interleaved stereo file. Certain audio applications, such as BIAS Deck and Digidesign’s Pro Tools, use “dual mono”, rather than stereo interleaved files. Peak allows you to open such dual mono files, and in the process creates a new stereo audio document. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono files. For more information on opening dual mono files, see Chapter 3: Peak Basics.

**Recover Audio File**

Peak 5 includes a new tool called Recover Audio File, which allows you to open a damaged file, and attempt to recover the audio data contained in it. This tool extracts audio data only, and ignores all other information contained in the file’s header, such as information about loop points, regular markers, Region markers, etc. When audio data is successfully recovered, it is placed into a new audio document and must be saved.

There are a few pieces of information that Peak requires, in order to attempt file recovery – these include the number of channels, the file's bit depth and sample rate, the audio data location, and the byte order. With these few bits of information (and depending on the degree of damage), Peak may be able to recover many otherwise unusable audio files. To attempt to recover a file, you must supply correct information about the format the file was originally recorded in, otherwise, you may end up with white noise, or a file that plays at the wrong speed, etc.

When the Recover Audio File encounters corrupt sectors with media, file, or I/O errors, it will attempt to continue recovering whatever audio data is available, and will write the sections containing errors as silence in the new audio file that is created.

**Export Dual Mono**

The Export Dual Mono command allows you to save a stereo audio document as separate mono digital audio documents. This feature is convenient if you intend to use the audio document in a multitrack audio application, such as BIAS Deck or Pro Tools, which does not directly support stereo audio files. When you choose this command Peak will prompt you to name both the left and right sides with a Save dialog.

**Export Regions**

If you have placed markers or Regions in an audio document, Peak’s Export Regions command allows you to save each of these Regions as a separate audio document. This feature is very convenient if you wish to divide a larger file into Regions and transfer them as samples into a sample playback instrument, or divide a live concert record into Regions and export those Regions as separate files. Furthermore, you can use Peak’s Batch File Processor to process a file’s Regions with any of Peak’s DSP functions and third party plug-ins during the automatic exporting of Regions into new files. For more information on exporting Regions, see Chapter 5: Editing.
Export Regions is not available in Peak LE. However, Regions may be dragged from the Contents Window to the Finder as discrete files.

Export as Text

If you wish to keep a text record of your Playlist, you may export the Playlist into a new text document. The text document will show names, times, crossfade times, and gain levels of each Playlist Event.

Batch Processor

Peak’s Batch File Processor is one of the most powerful, versatile, and useful features in Peak. Using the Batch File Processor, you can integrate any series of Peak processes (called a batch script), and apply these scripts to any number of audio files.

Batch File Processor is not available in Peak LE.

To use Batch File Processing, go to the File menu and select Batch Processing. The Batch File Processor dialog appears.

Peak’s Batch File Processor is split into three areas: Input, Process, and Save Changes. Sequence a series of steps for Peak to execute in the Process section, then set your output file settings in the Save Changes area. Once Peak’s Batch File Processor is configured, you may turn on the Batch File Processor in the Input area.

Once the Batch File Processor is configured and turned on, any files you drop onto the Peak application’s icon (or an alias) will be batch processed according to your settings. You can even drop folders or disks onto Peak’s icon and all of the supported audio contents will be batch processed. You can continue dropping files, folder, or disks, onto the Peak icon for batch processing while the Batch File Processor is turned on. All subfolders or disks you drag onto the Peak application for Batch File Processing will be recreated in the Batch File Processor’s output directory, preserving all organization of your files. Audio documents opened using the Open command from the File menu will not be batch processed.

Burn Audio CD

Choosing the Burn Audio CD will burn the foreground audio document as an audio CD. If Regions are contained in the document, Peak will prompt you as to whether these should be used to designate different tracks on the finished audio CD.

Recently Opened Documents

Peak automatically remembers the last several audio documents or Playlists that you have opened and keeps a list of these at the bottom of the File menu. This allows you to easily select a document’s name and reopen it without having to
search for it on your hard drive. Peak can also find and open a document even if you have changed its location on your hard drive. And if you change the name of the file, the next time you open Peak, Peak will automatically update the name in its internal list.

**Edit Menu**

This menu contains all of the standard Macintosh commands for cutting, copying, and pasting, as well as several other commands specific to Peak.

**Undo**

The Undo command (⌘-Z) undoes the last action that you performed. Since Peak features unlimited undo and redo capability, repeatedly choosing this command will undo each action that you have performed on your audio document. If you wish, you can continue undoing actions until you return to the original state of the audio document. When there are no actions left to undo, the Undo command will be unavailable and appear grayed out.

**Redo**

The Redo command (⌘-Y) “undos” the undo command. If you wish, you can continue redoing actions until there are no items left to redo. In this case, the Redo command will be unavailable and appear grayed out. The only limitation in using the Redo command is that if you insert a new action when a redo action is available, you will no longer be able to redo. In other words, as soon as you perform an editing action other than Undo, Redo is no longer available.

**Edits**

The Edits command provides you with a second unique and powerful “unlimited undo” feature. You can think of the Edits command as a kind of “random access” undo with a list of all your editing actions since you last saved. Using this list, you can navigate back in time to the point at which you performed a particular edit, and if you wish, undo it. Once you have returned to an earlier state in the project, you are free to start editing from that point on, if you wish.

Be aware that if you do go back to a past action and perform a different action at that state in the project, any edits that originally followed will be gone and you won’t be able to redo them.

**Cut**

The Cut command (⌘-X) cuts selected data from an audio document and copies it to Peak’s Clipboard. Once you have cut a portion of an audio document and copies it to Peak’s Clipboard. Once you have cut a portion of an audio document, you can paste it or insert it at another location in the same document or a different document.
Copy

The Copy command (⌘-C) copies selected audio into Peak’s Clipboard. Once you have copied a portion of an audio document, you can paste it or insert it at another location in the same document or a different document.

Paste

The Paste command (⌘-V) allows you to paste the contents of the Clipboard into a location that you choose by placing an insertion point. Pasting audio deletes any selected audio and inserts the clipboard audio at the insertion point.

Replace

The Replace command allows you to paste audio from Peak’s Clipboard over existing audio, without pushing all data to the right of the insertion point farther to the right (later in time) to accommodate the newly pasted audio.

Duplicate

The Duplicate command has a number of different behaviors, depending on whether you are working in an audio document or in a Playlist. More information about this command is available in Chapters 5 & 6.

If no selection is made when this command is invoked, the Duplicate command allows you to paste multiple copies of audio data into an audio document without overwriting any existing data at the insertion point. When you paste data with the Duplicate command, all data to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio. The Duplicate command allows you to specify how many times you would like to Duplicate the audio data contained in the clipboard. The Duplicate command is very useful for creating longer audio documents that need to repeat a certain piece of audio, such as creating a 4 bar drum loop out of a 1 bar drum loop.

If there is a selection in the waveform when the Duplicate command is invoked, then Peak automatically fills the selection with the Clipboard contents. Peak determines how many times the Clipboard contents must be duplicated in order to fill the selection. If the selection is not evenly divisible by the duration of the Clipboard contents, Peak includes a fraction of the Clipboard contents to make the duplication completely sample accurate to the original selection.

Insert

The Insert command (⌘-D) allows you to paste audio into an audio document without overwriting any existing data at the insertion point. When you paste data with the Insert command, all audio to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio.

Insert Silence

The Insert Silence command allows you to insert a specific amount of silence into an audio document at the current insertion point. When you choose this command, Peak will prompt you to enter the amount of silence you wish to insert. You can enter this value in Samples, Milliseconds, or Seconds. All audio occurring after the insertion point is moved later in time by the amount of the silence that you insert.

Silence

The Silence command (⌘-E) replaces the selected audio in the audio document’s selection with silence.
Delete

The Delete command (the Delete key) allows you to cut an audio selection without transferring it to the Clipboard.

Delete Except Audio

The Delete Except Audio command (Option-Delete) allows you to easily remove all markers, Region markers and loops in the current audio document selection without removing the audio.

Crop

The Crop command ( Erotische) allows you to remove all other audio from the audio document except the selection.

Clear Clipboard

Peak utilizes a portion of your hard disk’s free space to hold audio that has been cut or copied. The Clear Clipboard command allows you to free up disk space occupied by the contents of the clipboard if you no longer need the audio contained there.

Select All

The Select All command ( Ellie) selects all audio in the audio document.

Insertion Point at Selection Start/End

The Insertion Point at Selection Start command (Up Arrow) places the insertion point at the beginning of a selection. The Insertion Point at Selection End command (Down Arrow) places the insertion point at the end of a selection.

Set Selection

The Set Selection command allows you to precisely edit the length, start and end times of an audio selection by entering numerical values in the Set Selection dialog. Use the Time Units pop-up menu at the top of the dialog to select the time units you want, and use the radio buttons to select whether you want to affect the Start or End of the selection.

Select Loop

The Select Loop command ( Ellie) will automatically select the audio within the loop start and loop end markers, if you have defined a loop in a document.

Previous Selection/Next Selection

If you have made a selection in an audio document, then made another selection, you can use Previous Selection ( Ellie-Shift-Left Arrow) to jump back to the previous selection. You can then use Next Selection ( Ellie-Shift-Right Arrow) to jump ahead again. This works for multiple selections.

Action Menu

This menu provides several commands for zooming in and out of the audio document window, creating loops,
markers and Regions, and navigating to specific locations in an audio document.

**Zoom Out**

The Zoom Out command (⌘-[) zooms the waveform view out allowing you to see more of the entire waveform, but in less detail. The Zoom Out command is useful for obtaining a better “big picture” view of audio material. To zoom progressively out from a waveform, select this command repeatedly or press ⌘-[ repeatedly on your computer keyboard.

**Zoom In**

The Zoom In command (⌘-]) zooms the waveform view in so that you can view audio data in greater detail. The Zoom In command is essential when you wish to select and edit audio with great precision. To view a waveform in progressively greater detail, select this command repeatedly or press ⌘-] repeatedly on your computer keyboard. Holding down the Option key while you make a selection will zoom the waveform view in so that your selection fills the audio document window after you release the mouse button.

**Increase Vertical Zoom**

The Increase Vertical Zoom command (Control-Up Arrow) makes the waveform “taller,” or increases the vertical zoom. The Increase Vertical Zoom command is useful for obtaining a better “big picture” view of quieter audio material.

**Decrease Vertical Zoom**

The Decrease Vertical Zoom command (Control-Down Arrow) makes the waveform “shorter,” or decreases the vertical zoom.

**Fit Selection**

The Fit Selection command (Shift-⌘-[) will zoom the view so that your selection fills the audio document window.

**Zoom Out All the Way**

The Zoom Out all the way command (Shift-⌘-[) zooms the audio document window to show an overview of the entire audio document.

**Zoom at Sample Level**

The Zoom at Sample Level command (Shift-⌘-Left Arrow) zooms the audio document window to the single-cycle level, allowing you to view the waveform a single sample at a time. This is useful for drawing on the sample with a pencil tool, or fine-tuning loops and markers.

**Zoom at Sample Level (End)**

The Zoom at Sample Level (End) command (Shift-⌘-Right Arrow) zooms the audio document window to the single-cycle level and places the insertion point at the end of the audio selection.
Snap To

This command will cause new selections in the audio waveform to move, or “snap” to the nearest selected Snap To unit. The Snap To units available are listed below:

- Zero Crossings
- Bars/Beats
- CD Frames (588 samples or multiple thereof)
- Sony PS2 Loop Boundaries (28 samples or multiple thereof)
- Microsoft Xbox Loop Boundaries (64 samples or multiple thereof)
- Custom Units (allow entry of a user-definable number of samples)

The Snap To units you choose will depend on the type of editing work you will be doing. Most users will probably use Zero Crossings or Bars/Beats for most musical applications. Multimedia and video game sound designers will especially appreciate these new options when producing audio for a particular delivery platform. For example, when creating audio loops and sound effects for a Playstation 2 video game, audio edits need to be made at increments of 28 samples in order to loop/play back smoothly in the PS2’s audio engine. By choosing the Snap To PS2 loop boundary setting, any edits that are made will automatically be made in units that will translate smoothly to the PS2’s playback system.

Snap Start & End

This command will cause the beginning and end of the current selection to move to the nearest selected Snap To unit.

Snap Start

This command will cause the beginning of the current selection to move to the nearest selected Snap To unit.

Snap End

This command will cause the end of the current selection to move to the nearest selected Snap To unit.

Loop This Selection

The Loop This Selection command (Shift-“~”) automatically creates a loop from the current selection by placing loop markers on either side of the selection. Since Peak supports a single loop per audio document, choosing this command in a document with a loop already defined will cause the loop markers to move to the current selection.

Nudge Loop Backward

The Nudge Loop Backward command (Option-Left Arrow) pushes, or “nudges,” the loop point backward. This allows you to fine-tune the loop.

Nudge Loop Forward

The Nudge Loop Forward command (Option-Right Arrow) pushes, or “nudges,” the loop point forward. This allows you to fine-tune the loop.

New Marker

The New Marker command (Shift-M) creates a new marker at the current insertion point in an audio document. Markers are locations in an audio document that you define as important. By marking specific locations in a recording, you can navigate easily to a location for selection, editing or playback purposes.
Once you have defined a marker, you can assign or edit a number of its attributes with the Edit Marker dialog that appears when you double-click the marker. This dialog and the attributes contained within are explained in Chapter 5: Editing.

Markers from Tempo

The Markers from Tempo command will automatically create markers at regular intervals based on the tempo that is entered. To use Markers from Tempo, you will either need to know the tempo of the audio material you are working with, or you can use Peak’s Guess Tempo feature to figure it out. Place Peak’s insertion point in the waveform at the point you wish to have the first marker placed. Designate whether you prefer to have markers placed every Beat or Bar, and then indicate the duration for which you wish to have markers placed. Peak will place markers either for the duration of a selected range of audio, or you can enter a specific value. Click OK to create markers. Markers from Tempo is described in more detail in Chapter 5: Editing.

New Region

The New Region command (Shift-R) defines a selection as a new Region and adds it to the Regions menu. Locate a Region by double-clicking the name of a Region in the Contents Window. The audio document will automatically scroll to display the selected Region, and the Region will become the current selection in the audio document. For more detail on Regions in Peak, see Chapter 5: Editing, and Chapter 6: Playlists & CD Burning.

New Region Split

The New Region Split command will subdivide an existing Region or audio document into two separate, back-to-back sections, one on either side of the insertion point. To use this feature, simply place the insertion point cursor within an existing Region or audio document, and choose the New Region Split command from the Action menu – the existing Region or document is split into two sections at the point where the insertion point was placed.

Capture Region to Playlist

The Capture Region to Playlist command (command-K) will create a Region based on a selection made in an audio document and automatically enter it into a Playlist. This feature is very useful when you need to quickly create Regions that will also be used immediately in a Playlist.

Markers to Regions

The Markers to Regions command will convert any markers in a selection to Regions. If you make a selection containing two markers, they will be converted to one Region with the name of the first marker. If you make a selection containing three or more markers, the markers will be converted to contiguous, butt-spliced Regions. For example, if you have three markers named “Foo 1”, “Foo 2”, and “Foo 3” and select them and apply Markers to Regions, the resulting two Regions will be named “Foo 1” and “Foo 2”-wherein the first marker has
become the begin Region marker of Region “Foo 1”, the second marker has become the end Region marker of Region “Foo 1” and the begin Region marker of “Foo 2”, and the third marker has become the end Region marker of Region “Foo 2”.

Alternatively, hold the Option key down when selecting the Markers To Regions command to make each marker a Region that ends at the next marker.

The Nudge command allows you to nudge all marker, loops and Regions in the current audio document selection by the number of seconds entered in the Nudge Markers dialog. Type either positive or negative numbers, and Peak nudges the marker by the value you entered in the dialog.

Go To

The Go To command (⌘-G) allows you to quickly and precisely navigate to the start or end of a selection, the start or end of a loop, a specific marker, or a specific time location in an audio document. This command is essential for speedily locating any of these important locations in an audio document. Choosing the Go To Time command allows you to enter the exact time location that you wish to navigate to. In addition, the Location submenu lists all markers, Regions and loops.

Loop Surfer

Peak’s Loop Surfer feature (⌘-J) automates some of the steps for setting up loop points. Loop Surfer allows you to “Loop Surf” (adjust your loops during playback) quickly, easily and in a musically intuitive manner.

If you’re working with music, and know the music’s tempo in beats per minute, you can use Loop Surfer to create a loop which lasts for a rhythmically “correct” length of time. For more detail regarding Loop Surfer, see Chapter 5: Editing.
Guess Tempo

If you are working with music and don’t know the tempo and your music has a relatively pronounced or obvious beat, you can use the Guess Tempo command to have Peak automatically guess the tempo of a selection. Make a selection and choose Guess Tempo from the Action menu. There will be a pause while Peak scans your selection and calculates the tempo for you. A dialog will then appear showing you the estimated tempo in BPM, or beats per minute. You can then enter the estimated tempo in BPM in the Loop Surfer dialog’s Tempo field or in the Audio Information dialog’s Tempo field or press the Loop It button to create a loop at the current insertion point with the detected BPM.

Audio Menu

The Audio menu contains commands for playing back and recording audio, as well as configuring Peak’s Recording Settings, your audio hardware, and Peak’s Meters.

Stop/Rewind

The Stop/Rewind command (Return) stops playback and places the insertion point at the beginning of the audio document.

Play/Pause

The Play/Pause command (Spacebar) starts playback of the audio file from the insertion point or pauses playback.

Play Selection

The Play Selection command plays only the selected portion of an audio document.

Play w/Auditioning

The Play w/Auditioning command (/Spacebar) plays the selected portion of an audio document with pre-roll and post-roll. The pre-roll and post-roll times are designated in the Auditioning dialog under the Preference menu.

Stop & Extend Selection

The Stop & Extend Selection command stops playback and extends any selection from the point at which playback was initiated. The Stop & Extend Selection command can also be used to start playback from the insertion point or selection start.
**Fast-Forward**

The Fast-Forward command places the insertion point at the end of the audio document.

**Record**

The Record command (⌘-R) opens the Record window. This window allows you to start and monitor recording.

When you select Record from the Audio menu (⌘-R), Transport, or Toolbar, the Record dialog appears. There are transport buttons—Record Settings, Pause, Stop, and Record—along the bottom, an Audio Source display that shows you the waveform as it is being recorded, and a Notepad window. The sample rate, bit depth, and number of channels you selected in the Record Settings dialog are also displayed, along with the amount of time you have available to record on the selected Record Disk with the recording settings you have chosen.

The Notepad feature in the Record Dialog allows you to type in text descriptions, transcribe a recording, or type in comments called Notepad Cues at specific points during the recording of an audio document. The Notepad feature is available from the Record dialog and may be used once a recording starts.

**Record Settings**

When you select Record Settings (Option-R) from the Audio menu or Toolbar, the Record Settings dialog appears. This dialog is used to configure your settings for recording with Peak.

You will notice several pop-up menus, buttons, and checkboxes in the Record Settings dialog. These allow you to select which hard drive to record to, what file format you’d like to record in, sampling rate, source input, and so on. The next few paragraphs describe how to set all of these parameters using the Record Settings dialog. More information about recording is available in Chapter 4.

**Record Disk**

The Record Disk pop-up menu allows you to choose which hard drive you would like to record to. If you have more than one hard drive connected to your Macintosh, use this pop-up to select your record drive. (This option will default to the largest drive currently available to your Macintosh unless you select otherwise.)

**File Format**

The File Format pop-up menu allows you to select the file format for the incoming audio. You can choose from AIFF or Sound Designer II. (If you need the newly recorded audio file to be in a different format, use the Save As function to save it as another format once recording is complete.) If you do not select a file format for recording, Peak will default to AIFF.
Auto Gain Control checkbox

The Auto Gain Control checkbox allows you to disable the Automatic Gain Control feature used by the Mac OS X Audio HAL (Sound Manager) system with some Macintosh microphone inputs. Auto Gain Control adjusts input gain automatically to get maximum recording levels. If the recording device you are using supports this feature, check the Auto Gain Control checkbox.

Monitor checkbox

The Monitor checkbox allows you to monitor the audio source while you are recording.

Split Stereo Files checkbox

The Split Stereo Files checkbox allows you to record the incoming stereo audio as dual mono files rather than a single stereo file. Dual mono files are used in programs like Digital Performer, Pro Tools, or BIAS Deck, so this option is useful if you need to record dual mono files (i.e., split stereo).

Append to document checkbox

The Append to document checkbox allows you to record into an existing audio document. To record into an existing audio document, place the insertion point in the existing audio document at the point where you want to insert the new audio. If the insertion point is at the beginning of the file, the newly recorded audio will be inserted at the beginning of the file. If the insertion point is at the end of the file, the newly recorded audio will be appended to the end of the existing file. If the insertion point is somewhere in the middle of the file, the newly recorded audio will be inserted at that point. If you make a selection, the Append to document feature will allow you to replace the selection with newly recorded audio from the beginning of the selection through the end of the selection or wherever you stop the recording.

Record timer checkbox

The Record timer checkbox allows you to designate a specific duration for recording. Peak will stop recording after this set time and bring up the Save dialog for your audio recording. Checking the Record timer checkbox will bring up the Recording Time dialog. In the Recording Time dialog, designate the duration for recording in seconds and click OK.

Open after saving checkbox

The Open after saving checkbox determines whether the audio document is opened in Peak after it is recorded.

Device and Sample Format button

Clicking on the Device and Sample Format button will open a different dialog depending on which audio engine Peak is using i.e., Sound Manager (Mac OS X Audio HAL or FireWire DV) or Core Audio.

Hardware Options

Clicking on the Hardware Options button in the Record Settings dialog brings up a dialog for the audio hardware you selected in the Source dialog. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound!). Some sound card’s drivers have control panels or utility applications that will launch when you click on the Hardware Options button. The actual third-party dialog will differ depending on the type of audio hardware you have.
Record Through Plug-Ins

If you have plug-ins installed, you can record through them in real-time when using Core Audio. This is useful if you want to use a noise reduction, equalizing, or dynamics plug-in during recording.

For complete instructions on recording audio in Peak, please see Chapter 4.

Hardware Settings

The Hardware Settings command brings up a dialog for the audio hardware you selected in the Source dialog. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound). Some audio hardware drivers have control panels or utility applications that will launch when you choose Hardware Settings. The actual third-party dialog will differ depending on the type of audio hardware you have.

Meters

The Meters command opens the Meters dialog, which allows you to configure the Meters display. Using the Meters dialog, you can select the Peak Hold time and the Clip Indicator Hold Time. The Peak Hold indicators appear as yellow bars at the far right of each of the bar graphs, and selecting a hold time causes the indicator to pause for easy reading of the peak value during playback. The Clip Indicators appear as red bars at the far right of each of the bar graphs, and are triggered when audio distorts, or “clips”, and selecting a hold time causes the indicator to pause for easy reading of any clipping or distortion that occurs during playback. Setting the Peak Hold and Clip Indicator Hold Times to None turns these features off.

DSP Menu

This menu contains Peak’s DSP-based audio processing and advanced editing tools. A complete description of Peak’s DSP functions and instructions on how to use them are given in Chapter 7: DSP.

Add

The Add command adds any selection of audio copied to the clipboard into the audio document at the selection point. To use the Add command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material. To add copied material with a variable level, click the envelope button, create the desired envelope, and then click the Change button, and then click the Add button. Be careful not to adjust too high an amount which can potentially clip the signal.
Add is not available in Peak LE.

Amplitude Fit

Amplitude Fit provides granular normalization of an audio selection on a grain-by-grain basis. Grains are small groups of samples, often around 30ms. As each grain is read in, it is normalized according to the Amplitude Fit Envelope—each normalized grain crossfaded with the previous grain and written out as the result. Amplitude Fit can be used to maximize the volume level of an audio selection, or to make quiet passages as loud as louder passages.

Amplitude Fit is not available in Peak LE.

Auto Define Tracks

The Auto Define Tracks tool allows you to automatically split audio recordings into separate Regions, each of which will become an individual CD track when an audio CD is burned. This tool is useful for quickly editing LP and cassette recordings, in preparation for burning them to CD.

This DSP tool works by automatically placing Region markers into an audio document based on audio level, minimum period of silence between songs, and minimum song duration. Peak analyzes the audio levels throughout a document, and places Region markers around each song. The louder parts are considered to be songs, and the quieter parts are the gaps between them.

Since some songs may contain very quiet parts that could mistakenly be interpreted as gaps between tracks, a few parameters are available to help Peak correctly distinguish between songs and the gaps between them.

Minimum Silence Between Tracks

This field is used to enter the minimum gap time between songs in the audio document you are working with. If a recording you are working with contains two second gaps between each song, start with the default value of “2.00” in this field. If the gaps between songs vary in length, enter the value of the shortest gap in the entire recording.
If you need to measure the gap time between songs, activate the Cursor Info overlay by selecting Show Cursor Info (Cmd-Shift-T) from the Options menu, and then select the gap between songs in the audio waveform — the Cursor Info overlay will tell you the length of the selected area. You may also need to set your preferred Time Units to Min:Sec:ms — this can be done in the Options Menu > Time Units.

**Minimum Track Duration**

Peak needs to have some information about the length of each song, in order to accurately divide a long recording into individual songs. The Minimum Track Duration parameter tells Peak how long the shortest song in a recording is, and helps ensure that Region markers are placed in the correct location in the audio waveform — that is, a begin Region marker just before a song starts, and an end Region marker just after a song ends — even if the audio level falls below the threshold value set with the Silence is Audio Below slider (see next section). If a recording you are working with contains songs that are all approximately 4-5 minutes long, a good value to enter in this field would be 240 seconds (4 minutes).

**Silence is Audio Below slider**

This slider controls the threshold level between audio material you wish to define as a Region and the gaps between it. As this slider is moved, you will notice Region markers appearing in the audio waveform in the background, and you will also notice the value in the Number of Songs field changing. (More information on the Number of Songs field is in the next section). For example, if you are working with a recording from a cassette, the gaps will typically contain hiss or other noise that is not completely silent, but has a significantly lower amplitude level than the program material that you are trying to isolate into tracks. By adjusting the Silence is Audio Below slider, you can make the judgment as to what should be silence, even if it does contain some low level audio such as tape hiss, or other background noise.

**Number of Songs field**

This numerical field is tied to the Silence is Audio Below slider, and displays the number of songs that Peak automatically detects in a recording, based on the settings used for Minimum Silence Between Songs, Minimum Track Duration, and Silence is Audio Below. Depending on the settings you choose, Peak will detect a different number of songs, and this field will display different numbers. When the Silence is Audio Below slider is moved, the number of songs detected will update, and typing in a new value in the Number of Songs field will update the Silence is Audio Below slider. Typically, the automatic number of songs detected is very accurate, provided you have entered accurate settings for the other parameters that define tracks. There may be times however, where Peak detects more or fewer songs than the recording actually contains. You may choose to define the number of tracks using the Silence is Audio Below slider, or by typing in a known number of songs in the recording, and then fine tuning with the Silence is Audio Below slider. Be aware that the values you enter in the Number of Songs field, and the values you set with the Silence is Audio Below slider may override each other. More information about Auto Define Tracks is available in Chapter 7: DSP.

**Bit Usage**

The Bit Usage meter allows you to monitor bit saturation, degradation, and the "true" bit depth of a file.
Change Duration

The Change Duration command allows you to slow down or speed up the selected material by a specified amount without changing its pitch. You can specify the change in duration by a value in seconds, a percentage of the original, or, for rhythmically-oriented material, beats per minute. A change in duration by a reasonable amount, about 85% to 115%, can be very convincing. Exaggerated time stretching, 200% or more, can result in some very interesting granular textures. Try experimenting with the Change Duration function on drums, rhythm loops, speech, sampled instruments or sound effects to achieve a wide variety of useful effects.

Change Gain

The Change Gain function changes the gain (i.e., amplitude) of a selection. You can specify the amount of gain change either in decibels (dB) or as a percentage. If you wish to double the volume of a sound, you must apply approximately 6 dB of gain change, or add 200%. Enable the Clipguard checkbox in the Change Gain dialog to protect against the possibility of clipping. Clipguard will search through the audio document or selection for the maximum peak in amplitude, and then limit the Change Gain slider’s range based on the maximum peak it finds in the audio document or selection.

Change Pitch

Peak’s Change Pitch function allows you to alter the pitch of an audio selection by as much as an octave. The Change Pitch dialog uses a pitch slider that allows you to choose a new pitch by musical interval, and “fine tune” the pitch change by smaller increments called “cents.” (Cents are divisions of a musical octave—one octave is equivalent to 1200 cents; thus, 100 cents is a semi-tone, 50 cents a quarter-tone, etc.) You can also choose to alter the length, or duration, of the selection just as you would by slowing down or speeding up analog tape, or you can choose to preserve the duration of the selection (something not possible with analog tape!).
**Convert Sample Rate**

The Convert Sample Rate command allows you to change the sample rate of a sound without changing its pitch. This feature is very useful for converting audio material into lower or higher sample rates as required by other applications. Please note that sample rate conversion is applied to an entire document. It cannot be applied to just a selection within a document. Refer to Chapters 3 and 4 for an explanation of commonly used sample rates.

![The Convert Sample Rate dialog](image)

---

**Crossfade Loop**

The Crossfade Loop function applies a “smoothing” effect to loops made in Peak audio documents. Crossfade Loop fades the end of the loop into the beginning of the loop to make the loop sound smoother. (It uses the Blending envelope you’ve set in Peak’s Preference menu’s Blending dialog.) Use the Crossfade Loop dialog to select the length of the crossfade in milliseconds.

![The Crossfade Loop dialog](image)

---

**Convolve**

The Convolve command is a unique and powerful sound design tool that allows you to apply the sonic (e.g., spectral) characteristics of one sound onto another. Convolution works by multiplying the frequency spectrum of the impulse contained in the clipboard and that of the target audio document, reinforcing the frequencies that are in common between the two. To use the Convolve DSP command, you must first copy a selection of audio. The copied material will provide the spectral “character” that you will apply to the target audio material.

![Convolve is not available in Peak LE](image)

---

**Envelope from Audio**

The Envelope from Audio tool allows you to create an envelope from a selected portion of audio. For example, imagine a piece of music that has a specific type of fade out, and you would like to be able to apply that fade out “envelope” to other pieces of audio. By selecting the entire fade out, and then using the Envelope from Audio command, Peak is able to “reverse engineer” the fade out characteristics, and save them as an envelope that can later be recalled in any of Peak’s envelope based tools, such as Fade In/Out, Gain Envelope, etc. Once an envelope is saved, it is available for use in any of Peak’s DSP tools that are able to access the Peak Envelopes folder, stored in your Home directory’s Preferences folder. Other DSP tools that can access these envelopes.
include Fade In/Out, Blending, Panner, Gain Envelope, Amplitude Fit, and Plug-In Envelope.

Envelopes of varying precision may be created with this tool. For a more precise envelope, where more points define the shape, enter a smaller value in milliseconds in the “ms” field (or use the slider). For a less precise (or “smoother”) envelope, where fewer points define the shape of the envelope – use a larger value.

**Fade In & Fade Out**

The Fade In and Fade Out commands allow you to apply an amplitude envelope to an audio selection. The Fade In and Fade Out DSP commands, and the Fade Envelope Editor dialog are described in detail in Chapter 5: Editing.

**Find Peak**

The Find Peak operation will place the insertion point at the sample with the maximum amplitude value that it locates in the audio selection.

*Find Peak is not available in Peak LE*

**Gain Envelope**

The Gain Envelope operation allows you to enter an amplitude envelope to be applied to an audio selection. The selected audio’s amplitude will be boosted and/or attenuated according to the envelope you draw in the Gain Envelope editor.

*Gain Envelope dialog*

**Harmonic Rotate**

The Harmonic Rotate tool is excellent for sound design experimentation. This command allows the frequency spectrum in a selected range of audio to be rotated around a horizontal axis, which has the effect of taking frequencies that were previously associated with one section of a file with a particular amplitude, and assigning them to different areas of audio with different amplitudes. The Harmonic Rotate command can be previewed in real time, so that desired setting can be found before spending time processing. Options for processing include checkboxes for using Real & Imaginary calculations, and a slider & text field to set amount of rotation.

*Harmonic Rotate is not available in Peak LE*
ImpulseVerb

ImpulseVerb™ is an extremely high-quality reverb processing tool, that utilizes actual reverb impulses recorded in real spaces, such as performance halls, cathedrals, caves, and other spaces that have various reverberation qualities. The same convolution technology that is used in Peak’s Convolve DSP tool allows these natural reverb impulses to be applied to dry audio signals, giving the impression that a file was actually recorded in a particular environment. ImpulseVerb offers real time preview, so that the ideal settings can be found before processing. In addition, ImpulseVerb offers an editable Space envelope, which controls reverb length and decay characteristics, and a Wet/Dry slider to control the amount of reverb being applied.

The ImpulseVerb dialog can also be used as a real time convolution tool, and is not limited to using impulse response files to create reverb effects. Any selection that is copied to the clipboard can be convolved with the selected range of audio. To add audio files to the Space pop-up menu within the ImpulseVerb dialog, simply save the desired file as a 24-bit Sound Designer II format file, and place into the Peak Impulses folder within

/ Macintosh HD/Users/Library/

LE  ImpulseVerb is not available in Peak LE!

Invert

The Invert function allows you to invert the phase of a selection or an entire audio document.

Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop and listen to the effects of these adjustments as you make them. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window to achieve a natural transition at the loop point by carefully adjusting the slope alignment. The arrows of the slider will move the loop markers sample by sample and clicking in the body of the slider will move the loop markers to the next zero crossing. The two zoom buttons (magnifying glass icons) in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample level. You can listen to the effects of the adjustments as you make them by clicking on the Play button.
Loop Tuner is not available in Peak LE.

Mono To Stereo/Stereo To Mono

These two DSP commands may be used to easily convert an audio document between one and two channel formats.

Mono To Stereo/Stereo To Mono is not available in Peak LE.

While automatic Mono To Stereo/Stereo To Mono conversion is not available in Peak LE, you can achieve the same end result manually, by selecting all in an open mono or stereo document, and then opening a new, empty document. If you copy an entire document, open a new empty document, and attempt to paste the contents of the clipboard, Peak will detect if there is a different number of channels, and will prompt you to enter a Left/Right panning value, and will then allow you to paste the clipboard contents.

Mix

The Mix command allows you to mix material that you have copied to the clipboard with a target selection. This function can be used as a kind of “sound-on-sound” capability for mixing audio tracks together, or for blending sound elements. The Mix command is similar to the Add command, but it does not have the potential to clip because the target and clipboard contents are attenuated before mixing. To use the Mix command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material.

Modulate

This Modulate command functions as a “ring modulator” which multiplies two audio signals together (e.g., the material copied to the clipboard and the currently selected audio). The resulting audio includes the sum and difference tones of the frequency components of the modulated audio and the modulating audio. These are generally very complex timbres that often have a “metallic” (i.e., inharmonic) character to them.
Normalize

This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. The normalize function is very useful for boosting the volume of material that was recorded at too low a level, or if used on multiple audio documents, for ensuring that the amplitude of each of the documents is uniform.

Normalize (RMS)

This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. RMS Normalization is based on the RMS (Root Mean Square), or “average” signal level of the selected portion of audio. The RMS value of a file cannot be increased to an arbitrarily high value. If the desired RMS specified by the user is so high that will produce clipping in the signal, the Soft Clip feature will automatically activate and the resulting RMS level will be lower than specified by the user. The processed file will be as loud as possible while guaranteeing that the signal will be limited to the ceiling specified by the user.

Panner

The Panner allows you to adjust the panning, or left-to-right movement, of a stereo document by drawing an envelope in the Panner dialog. Left is at the top of the graph, and right is at the bottom.
Phase Vocoder

The Phase Vocoder is a type of audio spectrum analysis/resynthesis that allows you to modify the duration and/or pitch of an audio selection.

Rappify

The Rappify command applies extreme dynamic filtering to a selection. As one Peak user described it, “Rappify can turn your hi-fi into lo-fi!” If the target material has a pronounced beat, this has the effect of reducing the material to its most essential rhythmic components. Try using this function with a variety of different music material for some surprising and exciting results.

Repair Click

The Repair Click command will eliminate a selected click or “spike” in the waveform using the setting designated in the Repair Clicks dialog (explained next).

Repair Clicks

The Repair Clicks command allows you to find and repair pops or clicks in an audio document. The Repair Clicks dialog automates the process of finding and removing clicks (usually indicated by a sharp “spike” in a waveform), much like a search and replace dialog in a word processor.
The Repair Clicks operation works by looking for discontinuity from sample to sample. For example, a sample value of -100 followed by a sample value of 10,000 is likely to be a click. Once the area of the click is identified, a smoothing technique is used to maintain the original shape of the area being repaired.

If you are working with mostly digitally induced clicks, the Repair Clicks dialog will become an indispensable tool. Extremely damaged signals such as those of a scratching and popping vinyl record will require more careful repair in addition to using the Repair Clicks dialog, such as Change Gain, Delete, and the Pencil Tool. Clicks such as those of a scratching and popping vinyl record lose their detectability once they are sampled using Analog to Digital converters.

Using BIAS SoundSoap or SoundSoap Pro will provide ideal click & crackle reduction for repairing audio recorded from vinyl. For more information, please visit the SoundSoap and SoundSoap Pro web pages, using the links in Peak’s Links menu.

Smoothing Factor

Smoothing Factor determines how much smoothing is applied to the click. Material with high frequency information may require lower smoothing factors to preserve the high frequencies. In general, a setting of 40-60 percent will repair most clicks.

Detection Setting

The Detection Setting value determines how the clicks are located. Higher values locate only the most severe clicks, while lower values will detect less severe clicks. Note that lower values such as 10% also have a greater chance of misjudging audio for a click. In general, a setting of 40-80% works well.

Repair Size

The Repair Size setting affects how many samples around the click are used in determining the new shape of the repair. Repair size can vary from 5 to 100 samples, with a repair size of 50 samples working well in most circumstances. Peak will then interpolate what the correct waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog allow you to control repairing, auditioning, and undoing click repairs:

- Click the Repair button when you wish to repair a click found by the Next Click button.
- Use the Next Click button to search for the next potential click in the audio selection.
- Once a click is located, you may listen to the click using the Audition button. The Audition button plays the click using the Pre-roll and Post-roll settings from the Auditioning dialog under the Preference menu.
- If you repair a click and are unsatisfied with the results, simply click on the Undo button.
- If you would like to repair all of the clicks in the audio document’s selection without having to repair each one individually, click the Repair All button.

You may need to lower the detection setting in the Repair Clicks dialog to find some clicks, depending upon their severity. Be careful not to lower the detection setting dramatically – lower it gradually for the best results.

Repair Clicks is not available in Peak LE.
Remove DC Offset

This function allows you to remove any DC Offset in your audio file. Peak scans the audio for DC offset and then removes it. Peak will scan the left and right channels of a stereo file independently. DC Offset is usually caused by problems in the analog to digital conversion process. The result is that the waveform is not centered on the base line—it is offset either higher or lower than the center line.

Strip Silence

Peak includes a Strip Silence tool, which allows areas of silence, or very low amplitude, to be automatically silenced, minimized, or completely removed from an audio document. This tool is useful for removing silence from recordings that predominantly contain silence (or very low level audio content), interspersed with some desired audio content.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed copy of the selected audio with the original. This creates a variety of interesting and useful results. Try using Boomerang on drum loops, voice, and sound effects.

Reverse

The Reverse command reverses the current selection. In a reversed selection, the last sample becomes the first sample, the second-to-last sample becomes the second sample, and so forth. The effect is similar to playing a record or cassette tape backwards.

Swap Channels

The Swap Channels command reverses the left and right channels in a stereo selection.

Remove DC Offset is not available in Peak LE.

Strip Silence is not available in Peak LE.

Swap Channels is not available in Peak LE.
Threshold

The Threshold command allows you to split up an audio document into its component parts by analyzing the amplitude levels in the audio document and setting a cutoff or threshold amplitude. For instance, you might use the Threshold command on an audio document that contains successive notes from a musical instrument to split them up, or on a drum loop to break it up into its component parts. You can save the segments with Markers, or as Regions. See Chapter 7: DSP for more info on using the Threshold command.

Threshold is not available in Peak LE.

Sampler Menu

This menu allows you to import samples directly from compatible samplers, edit or process the audio using all of Peak’s functions, and send the modified sample back to the sampler. Peak supports SMDI samplers. For detailed information on using Peak with SMDI samplers, see Chapter 10: Samplers.

Send to Sampler

The Send to Sampler command will send the selected sample from Peak to your sampler using the Sampler dialog.

Revert from Sampler

The Revert from Sampler command will revert to the previously received sample from Peak to your sampler using the Sampler dialog.

Send All to Sampler

The Send All to Sampler command will send all selected samples from Peak to your sampler using the Sampler dialog.

Revert All from Sampler

The Revert All from Sampler command will revert all previously received samples from Peak to your sampler using the Sampler dialog.
E-mu, Ensoniq ASR-X, Kurzweil, Peavey, Yamaha Sampler

A large number of samplers support SMDI sample transfer. Choosing the name of your sampler from the Sampler menu will open the Sampler dialog. SMDI Samplers, such as the Kurzweil K2500 or the E-mu E-IV, use SCSI to transfer samples between devices. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler. Consult your sampler’s owner’s manual for instructions on how to connect the cable to your Macintosh with proper termination. For detailed information on using Peak with Samplers, see Chapter 10: Samplers.

Sampler Support is not available in Peak LE

Plug-Ins Menu

The Plug-Ins menu provides access to any Audio Units, BIAS, or VST effects or virtual instrument plug-ins installed in your system.

Peak can access plug-ins in two different ways – using “Inserts” or through Vbox SE. An insert can contain a single plug-in, and up to 5 inserts are available. When using inserts, signal flows through the plug-in in each insert in the order of the insert number. For example, if an equalizer plug-in is used on Insert 1, and a reverb plug-in is used on Insert 2, the output of the equalizer plug-in will flow into the input of the reverb plug-in. Inserts are typically more convenient when using a small number of plug-ins is required.

Vbox SE

Peak includes BIAS Vbox SE for managing and mixing plug-ins. Think of Vbox SE as a virtual effects box, in which you can combine, repatch, and mix your plug-ins in real-time. Using its unique effects matrix, Vbox SE lets you combine multiple individual plug-ins. Vbox SE can patch plug-ins in series, in parallel, or in series and parallel, and you can hot-swap plug-ins. Vbox SE has controls for each plug-in to mute, solo, and edit parameters. Vbox SE also provides input and output gain controls both globally and for each individual plug-in, and a control for the global Wet/Dry mix. Use Vbox SE’s A/B comparison feature to get just the right settings, and use Vbox SE’s presets to store configurations and settings for later use.

To use multiple plug-ins within Vbox SE, you must select Vbox SE from an available insert. While Vbox SE can be used on one insert, and other VST plug-ins can be used on other inserts, it is recommended to use multiple plug-in within the Vbox SE matrix, as it offers much more control and flexibility.

Inserts (1-5)

Any installed VST or Audio Units plug-in may be assigned to any insert. Each insert can contain a single plug-in. VST & Audio Units plug-ins may be mixed and matched. When more than one plug-in/insert is active, the output of Insert 1 flows into the input of Insert 2, the output of Insert 2 flows into the input of Insert 3, and so on.

Peak LE supports only a single Insert, and can host only one plug-in at a time.
Bounce

Once you have the right settings for your plug-ins, you will probably want to apply the effects to the audio document. This process is called “bouncing.” Bounce the audio file to process the audio document with any active plug-ins. Bouncing changes the audio data stored on disk, allowing you to use the Save command to permanently apply the plug-in effects to your audio document (this action is undo-able before saving).

BIAS

Choosing BIAS from the Insert “X” submenu brings up another submenu, displaying all currently available BIAS plug-ins. Select the desired plug-in from this menu, and its editor window (interface) will appear.

VST

Choosing VST from the Insert “X” submenu brings up another submenu, displaying all currently available VST format plug-ins. Select the desired plug-in from this menu, and its editor window (interface) will appear.

Audio Units

Choosing Audio Units from the Insert “X” submenu brings up another submenu, displaying all currently available Audio Units format plug-ins. Select the desired plug-in from this menu, and its editor window (interface) will appear.

For more information on third-party plug-ins, please refer to the manufacturer’s documentation. For detailed information on using plug-ins and Vbox SE in Peak, see Chapter 8: Plug-Ins.

Options Menu

This menu contains a number of commands that allow you to customize aspects of your Peak software such as waveform display colors, output volume, and other user preferences.

Time Units

The Time Units command allows you to choose a time format for the audio timeline in Peak’s audio document window. You can choose Samples, Min:Sec:ms, SMPTE frames, and Bars|Beats. The format you choose will depend on the nature of the project that you are working on.

Sample Units

The Sample Units command allows you to select whether sample units will be displayed in decimal, percentage, or dB.

Use Loop in Playback

If an audio document contains a loop (defined by loop markers), the Use Loop in Playback command (⌘L) allows you to listen just to the Loop. If playback is initiated before the Loop, once the Loop is reached, it will begin repeating. A check mark next to this menu item indicates that it is enabled. To turn off loop...
playback, disable this command by selecting it a second time.

**Scroll During Play**

When the Scroll During Play command is enabled, Peak will “scroll” through the audio document as playback progresses. This conveniently allows you to visually follow the progress of audio playback. A check next to this menu item indicates that it is enabled. To disable this command, deselect it.

**Move Waveform During Playback**

The Move Waveform During Play command will move the waveform under the cursor as playback progresses, so that the insertion point is always in the middle of the waveform display. A check next to this menu item indicates that it is enabled.

**Compute File Max dB**

The Compute File Max dB command scans the audio document for its maximum amplitude, and gives you a readout of the maximum value and its precise location. This feature requires extra time, and is best used with smaller audio documents when needing to monitor overall volume during editing. Otherwise, keep this option off and option-click the “Max” text left of the overview to update the current audio document’s maximum volume indicator at the left of the overview.

**Show Edits**

The Show Edits command indicates areas of an audio document that you have edited by enclosing these areas with hatched lines. This provides you with a convenient visual reference to portions of the document that have been affected by your editing actions. Once you save a document, the edits are saved, and these indicators will no longer appear.

**Show Marker Times**

The Show Marker Times command will show a time value as well as a marker name for all Peak markers, loops, and Regions.

**Show Overview**

The Show Overview command (⌘-,) provides an Overview display of the entire audio waveform along the top of the Audio Document window under the title bar. This provides you with a convenient visual reference of the overall document when you are editing only a portion in the audio document window.

**Show Cursor Info**

The Show Cursor Info command (⌘-Shift-T) brings up a floating, translucent cursor information window, which follows along with the mouse cursor as it is moved. Choosing this command again turns the window off.

**Auto-Import Dual Mono**

Certain audio applications such as Digidesign’s Pro Tools do not directly support stereo interleaved documents, and instead use “dual mono” documents which comprise the right and left channels of stereo material. Enabling the Auto-Import Dual Mono command tells Peak to automatically convert such documents into new stereo audio documents when you attempt to open these documents with the Open command. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono documents.

---

Please note that the Import Dual Mono command requires that both files be mono files, have the same sample rate and bit depth, and the must have the exact same name followed by the suffixes “.L” and “.R”. If you are using file type extensions (.aif, .wav, etc) the format must be “Filename.Side.Extension”. For example — “Song1.L.aif” and “Song1.R.aif”.
Auto-Adjust Bounce for Latency

Plug-ins may introduce a short delay, known as latency, into the audio they are being used to process. Depending on the type of processing the plug-in performs, the amount of latency can vary — so it is common for different plug-ins to produce varying amounts of latency. Latency typically appears in audio documents after bouncing, by a shift in samples later in time relative to the document’s own timeline.

Peak features an automatic plug-in latency compensation feature called Auto Adjust Bounce for Latency — which automatically compensates for the latency introduced into a processed signal. Automatic latency compensation may be toggled on and off from Peak’s Options menu. A check next to the Auto Adjust Bounce for Latency item indicates that this feature is active. The absence of a check next to this item means it is inactive.

Plug-in latency compensation may also be used manually. To compensate for plug-in latency when bouncing effects on a selection, hold down the Option key when choosing Bounce, and enter the delay compensation you want in samples in the Bounce Effects dialog. More information about Plug-In latency is available in Chapter 8: Plug-Ins.

Audio Info

The Audio Info command (I) allows you to change an audio document’s length, sample rate, root key, low key, or high key parameters. When you choose this command, a dialog indicating the total time of the sample, its sample rate, and its key mapping information will appear. The Audio Info dialog allows you to change the sample rate, duration, root key (for use in a sample playback instrument), and high and low key range. Note that by changing the sample rate, the pitch and duration of the sample will be affected. (To change the sample rate of an audio document without changing the pitch, use the Convert Sample Rate command from the DSP menu.)

You can also adjust the key range (for use in a sample playback instrument) of a document by clicking on the miniature keyboard in this dialog. To set the lower limit of the key range, click on the keyboard at the desired key. To set the upper limit of the key range, hold down the Shift key and click on the keyboard. To set the root key of the audio document’s key range, hold down the Option key and click on the keyboard. You can also enter the desired numerical value in any of the appropriate fields to accomplish this.

Dynamic Scrub Time

Peak provides a unique audio auditioning technique called dynamic scrubbing. This feature is very useful for precisely pinpointing a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. You can control the tempo and direction (forward or backward) of playback by dragging the mouse slower or faster, forwards or backwards. When you have found the location you are looking for, you can commence editing or playback. The Dynamic Scrub Time command allows you to choose the length of this playback loop. Depending on the audio document’s content, a value of between 40 to 80 milliseconds typically works well. See Chapter 5: Editing, for step-by-step instructions on how to use the Dynamic Scrubbing feature.
Auto Snap

The Auto Snap command will automatically "snap" any selection to the specified Snap To units.

Keyboard MIDI Input

Choosing the Keyboard MIDI Input command makes your computer's keyboard function as a MIDI input device, able to send MIDI signals to virtual instrument plug-ins being hosted in Peak. Additional information about virtual instruments is available in Chapter 8: Plug-Ins.

Movie Sound Tracks

The Movie Sound Tracks command brings up a dialog that allows you to Enable or Disable the movie's existing soundtracks. You can use this dialog to toggle multiple soundtracks contained in a movie on and off to check balances or "solo" certain tracks. Click on the Set button to accept the changes, or Cancel to leave the movie unaffected.

Half Size

Selecting this menu command displays the open QuickTime movie at half of its original size.

Original Size

Selecting this menu command displays the open QuickTime movie at its original size.

Double Size

Selecting this menu command displays the open QuickTime movie at double its original size.

“Open” Dialog after Launch

The “Open” Dialog after Launch option allows you to choose whether an open dialog is automatically displayed when Peak is launched. A check next to this menu item indicates that it is active. The absence of a check indicates that it is inactive.

Window Menu

The commands in this menu allow you to display and manage Peak’s windows — including the Transport, Toolbar, Contents, Movie, Playlist, audio document, or active plug-in windows.

Transport

The Transport window is a floating, re-sizeable window. It contains three areas: a time display showing elapsed time, the Transport controls (Return to Zero, Stop, Play, Go to End, Record, and Loop during playback), audio
level meters with clip/peak indicators, and a master volume fader.

**Toolbar**

You may assign almost any Peak command as an icon in the Toolbar. The Toolbar menu allows you to group together the functions you use most often, so that you can simply click a button instead of going to the menus. For example, if you frequently use Normalize and Pitch Change, you can choose to have the icons for these functions in the Toolbar, so that all you have to do is to make an audio selection and click a button. The Toolbar is an easy way to make your work in Peak faster and more efficient, allowing you to customize the program to suit the way you work.

To add or subtract items from the Toolbar, use the Shortcuts & Toolbar command in the Preferences dialog.

**Contents**

Peak has a floating Contents Window that will display all Regions, Markers, and Loops contained in any open audio documents. There are three buttons at the bottom of the palette that allow you to select which items to view—Markers, Region, and Loop. Option-double-clicking on any item in the Contents window will bring up the Edit Region or Edit Marker dialog.

**Movie**

The Movie command toggles the Movie window on and off for any QuickTime movie you currently have open in Peak.

**MIDI**

The MIDI command opens Peak’s MIDI keyboard window, which can be used to send MIDI signals to virtual instruments being hosted in Peak. More information about the MIDI keyboard window is available in Chapter 8: Plug-Ins.

**Playlist**

The Playlist command (⌘P) allows you to open up the current Playlist window. For more information on using Playlists, see Chapter 6: Playlists & CD Burning.

**Tiling Windows**

The Tiling Windows command (⌘-T) arranges all open audio documents in a tile formation on your computer screen. This type of arrangement allows you to view multiple open audio documents at once, and is particularly convenient if you are cutting and pasting between several documents or jumping back and forth between them for editing purposes. You can press a ⌘-number key corresponding to an open audio document and the document will become the active window. (Click the Windows menu to see the numbers that correspond to each open audio document.)

When the Tiling Windows mode is used, windows tile to fit as additional audio documents are opened.

**Stacking Windows**

The Stack Windows command arranges all open audio documents into a stack, with each document overlapping the previous document, in the order that they were opened. This type of arrangement allows you to have the maximum number of documents open and use the minimum amount of screen real estate. You can then conveniently use the Windows menu to select any open document and make it the active window. Alternatively, you can press the ⌘-number key corresponding to the open document and the document will become the active window. (Click the Windows menu to see the ⌘-numbers that correspond to each open audio document.)

**Hide All Audio Document Windows**

This command temporarily hides all open audio document windows. This command is particularly useful
when working with Playlists, when the Playlist window is expanded to a large size. In this mode, Regions may still be pulled from hidden documents into Playlists. More information is available in Chapter 6: Playlists & CD Burning.

**Toggle Contents Drawer**

The Toggle Contents Drawer command opens and closes the Contents Drawer that is located on each audio document. Choosing this command will open the Contents Drawer on the right side of an audio document. Choosing this command when the Contents Drawer is open will close the drawer. Toggling the Contents Drawer can also be done with a button in the top right corner of each audio document window.

*The Contents Drawer is not available in Peak LE!*

**Links Menu**

The Links menu in Peak provides useful links to BIAS’s Web site. Included are the BIAS home page, the Peak updates page, technical support pages, online documentation, special offers, and current BIAS product information pages.

**Conclusion**

You should now be familiar with using Peak. For additional information about using Peak, tutorials, frequently asked questions, etc. please visit the BIAS website:

http://www.bias-inc.com
# Appendix 1: Keyboard Shortcuts

## Keyboard Shortcuts

This section lists the default keyboard shortcuts for Peak. As you learned in Chapter 3: Peak Basics, these keyboard shortcuts may be reassigned to any desired key or combination of keys, as well as to icons in the Toolbar.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Equivalent Menu Command</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘ N</td>
<td>New Mono Document</td>
<td>Creates a blank mono document</td>
</tr>
<tr>
<td>⌘ Shift-N</td>
<td>New Stereo Document</td>
<td>Creates a blank stereo document</td>
</tr>
<tr>
<td>Ctrl-N</td>
<td>New Document from selection</td>
<td>Creates a new document from selection</td>
</tr>
<tr>
<td>⌘ Shift-P</td>
<td>New Playlist Document</td>
<td>Creates a blank playlist</td>
</tr>
<tr>
<td>⌘ Shift-B</td>
<td>New Document From Playlist</td>
<td>Creates a document from a playlist</td>
</tr>
<tr>
<td>⌘ O</td>
<td>Open...</td>
<td>Opens a file from disk</td>
</tr>
<tr>
<td>⌘ W</td>
<td>Close</td>
<td>Closes the front-most document</td>
</tr>
<tr>
<td>⌘ Option-W</td>
<td>Close All</td>
<td>Closes all documents</td>
</tr>
<tr>
<td>⌘ S</td>
<td>Save</td>
<td>Saves the front-most document</td>
</tr>
<tr>
<td>⌘ Shift-S</td>
<td>Save As...</td>
<td>Saves the front-most document with a new name and/or new location</td>
</tr>
<tr>
<td>⌘ Option-S</td>
<td>Save a Copy As</td>
<td>Saves a copy of the front-most document with a new name and/or new location</td>
</tr>
<tr>
<td>⌘ Q</td>
<td>Quit</td>
<td>Quit Peak</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Edit Menu</strong></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ Z</td>
<td>Undo</td>
<td>Undo edits one by one (as long as you haven’t Saved)</td>
</tr>
<tr>
<td>⌘ Y</td>
<td>Redo</td>
<td>Redo edits one by one (as long as you haven’t Saved)</td>
</tr>
<tr>
<td>⌘ X</td>
<td>Cut</td>
<td>Cut selected audio</td>
</tr>
<tr>
<td>⌘ C</td>
<td>Copy</td>
<td>Copy selected audio to clipboard (useful for Clipboard based DSP effects like Mix and Convolve)</td>
</tr>
</tbody>
</table>
### Keyboard Shortcut | Equivalent Menu Command | Command Comments

#### Edit Menu (Cont.)

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Equivalent Menu Command</th>
<th>Command Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ V</td>
<td>Paste</td>
<td>Pastes Copied or Cut audio at insertion point</td>
</tr>
<tr>
<td>⌘ D</td>
<td>Insert</td>
<td>Pastes, pushing audio at insertion point further to the right.</td>
</tr>
<tr>
<td>⌘ E</td>
<td>Silence</td>
<td>Replaces audio selection with silence</td>
</tr>
<tr>
<td>Delete Key</td>
<td>Delete</td>
<td>Deletes selection, does not put in Clipboard</td>
</tr>
<tr>
<td>Option-Delete</td>
<td>Delete Except Audio</td>
<td>Deletes Markers, Loops &amp; Regions</td>
</tr>
<tr>
<td>⌘ -</td>
<td>Crop</td>
<td>Crops selected audio</td>
</tr>
<tr>
<td>⌘ A</td>
<td>Select All</td>
<td>Selects all audio and events</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Insertion Point at Selection Start</td>
<td>Places Insertion Point at beginning of selection</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Insertion Point at Selection End</td>
<td>Places Insertion Point at end of selection</td>
</tr>
<tr>
<td>⌘ - .</td>
<td>Select Loop</td>
<td>Selects loop</td>
</tr>
<tr>
<td>⌘ - Shift-Left Arrow</td>
<td>Previous Selection</td>
<td>Selects previous view or selection</td>
</tr>
<tr>
<td>⌘ - Shift-Right Arrow</td>
<td>Next Selection</td>
<td>Selects next view or selection</td>
</tr>
</tbody>
</table>

#### Action Menu

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Equivalent Menu Command</th>
<th>Command Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ -</td>
<td>+</td>
<td>Zoom In</td>
</tr>
<tr>
<td>⌘ -</td>
<td>-</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Control-Up Arrow</td>
<td>Increase Vertical Zoom</td>
<td></td>
</tr>
<tr>
<td>Control-Down Arrow</td>
<td>Decrease Vertical Zoom</td>
<td></td>
</tr>
<tr>
<td>⌘ - Shift-]</td>
<td>Fit Selection</td>
<td></td>
</tr>
<tr>
<td>⌘ - Shift-[</td>
<td>Zoom Out all the way</td>
<td></td>
</tr>
<tr>
<td>Shift-Left Arrow</td>
<td>Zoom To Sample Level</td>
<td>Zoom in to start of selection at sample level</td>
</tr>
<tr>
<td>Shift-Right Arrow</td>
<td>Zoom To Sample Level (End)</td>
<td>Zoom in to end of selection at sample level</td>
</tr>
<tr>
<td><strong>Keyboard Shortcut</strong></td>
<td><strong>Equivalent Menu Command</strong></td>
<td><strong>Command Comments</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td><strong>Action Menu (Cont.)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘-Shift-“—”</td>
<td>Loop this Selection</td>
<td></td>
</tr>
<tr>
<td>Option-Left Arrow</td>
<td>Nudge Loop Backward</td>
<td></td>
</tr>
<tr>
<td>Option-Right Arrow</td>
<td>Nudge Loop Forward</td>
<td></td>
</tr>
<tr>
<td>⌘-“—”</td>
<td>Select Loop</td>
<td></td>
</tr>
<tr>
<td>⌘-M</td>
<td>New Marker</td>
<td></td>
</tr>
<tr>
<td>⌘-Shift-R</td>
<td>New Region</td>
<td></td>
</tr>
<tr>
<td>⌘-G</td>
<td>Go to Time...</td>
<td></td>
</tr>
<tr>
<td>⌘-J</td>
<td>Loop Surfer</td>
<td></td>
</tr>
<tr>
<td>⌘-K</td>
<td>Capture Region to Playlist</td>
<td></td>
</tr>
<tr>
<td><strong>Audio Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spacebar</td>
<td>Play/Pause</td>
<td></td>
</tr>
<tr>
<td>⌘-Spacebar</td>
<td>Play with Auditioning</td>
<td>Plays audio with pre-roll amount designated in Auditioning Preferences</td>
</tr>
<tr>
<td>Return</td>
<td>Stop/Rewind</td>
<td></td>
</tr>
<tr>
<td>Shift-Return</td>
<td>Stop &amp; Extend Selection</td>
<td></td>
</tr>
<tr>
<td>⌘-R</td>
<td>Record</td>
<td></td>
</tr>
<tr>
<td>Option-R</td>
<td>Record Settings</td>
<td></td>
</tr>
<tr>
<td><strong>Option Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘-L</td>
<td>Use Loop in Playback</td>
<td></td>
</tr>
<tr>
<td>⌘-,</td>
<td>Show Overview</td>
<td>Toggles waveform overview on and off</td>
</tr>
<tr>
<td>⌘-I</td>
<td>Audio Info...</td>
<td></td>
</tr>
<tr>
<td>⌘-Shift-T</td>
<td>Show Cursor Info</td>
<td></td>
</tr>
<tr>
<td><strong>Window Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘-P</td>
<td>Playlist</td>
<td>Opens document’s Playlist.</td>
</tr>
<tr>
<td>⌘-T</td>
<td>Tile Windows</td>
<td>Arranges open documents in a tile formation.</td>
</tr>
<tr>
<td>⌘-1, -2, 3,...</td>
<td>Document Windows</td>
<td>Brings document windows to front by number, in the order they were opened.</td>
</tr>
<tr>
<td>⌘-Option-1, -2, 3,...</td>
<td>Plug-In Windows</td>
<td>Brings Plug-In windows to front by number, in the order they were opened.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcut

**Equivalent Menu Command**

**Command Comments**

**Commands not in a Menu**

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Equivalent Menu Command</th>
<th>Command Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>n/a</td>
<td>Moves playhead cursor to left by coarse increments</td>
</tr>
<tr>
<td>&gt;</td>
<td>n/a</td>
<td>Moves playhead cursor to right by coarse increments</td>
</tr>
<tr>
<td>Option + &lt;</td>
<td>n/a</td>
<td>Moves playhead cursor to left by fine increments</td>
</tr>
<tr>
<td>Option + &gt;</td>
<td>n/a</td>
<td>Moves playhead cursor to right by fine increments</td>
</tr>
</tbody>
</table>

### Playlist

The Playlist features a number of keyboard commands and modifier keys, which can speed up the editing process. These are described below.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Equivalent Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cmd-Shift-P</td>
<td>New Playlist Document</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Play/Stop</td>
</tr>
<tr>
<td>Cmd-S</td>
<td>Save Playlist</td>
</tr>
<tr>
<td>Cmd-W</td>
<td>Close Playlist</td>
</tr>
<tr>
<td>Cmd-Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Cmd-Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Cmd -]</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Cmd -[</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Cmd -Shift-[</td>
<td>Fit Selection</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Select Previous Track</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Select Next Track</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Go To Selection Start</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Go To Selection End</td>
</tr>
<tr>
<td>Ctrl Left Arrow</td>
<td>Scroll Earlier in Timeline</td>
</tr>
<tr>
<td>Ctrl Right Arrow</td>
<td>Scroll Later in Timeline</td>
</tr>
<tr>
<td><strong>Keyboard Shortcut</strong></td>
<td><strong>Equivalent Menu Command</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>Playlist (Cont.)</strong></td>
<td></td>
</tr>
<tr>
<td>Cmd-A</td>
<td>Select All</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete Selection</td>
</tr>
<tr>
<td>Tilde (~) or S</td>
<td>Toggle Between Slip/Shuffle Modes</td>
</tr>
<tr>
<td>I</td>
<td>Audition Crossfade In</td>
</tr>
<tr>
<td>O</td>
<td>Audition Crossfade Out</td>
</tr>
<tr>
<td>X</td>
<td>Audition Crossfade</td>
</tr>
<tr>
<td>Ctrl-I</td>
<td>Audition Crossfade In with Pre/Post-Roll</td>
</tr>
<tr>
<td>Ctrl-O</td>
<td>Audition Crossfade Out with Pre/Post-Roll</td>
</tr>
<tr>
<td>Ctrl-X</td>
<td>Audition Crossfade with Pre/Post-Roll</td>
</tr>
<tr>
<td>L</td>
<td>Loop Crossfade</td>
</tr>
<tr>
<td>Shift-Tab</td>
<td>Make Nudge Field Editable</td>
</tr>
<tr>
<td>Shift-Tab (x2)</td>
<td>Make Post-roll Field Editable</td>
</tr>
<tr>
<td>Shift-Tab (x3)</td>
<td>Make Pre-roll Field Editable</td>
</tr>
<tr>
<td>Tab</td>
<td>Move to Next Field (when fields are editable)</td>
</tr>
<tr>
<td>Return/Enter</td>
<td>Exit Editable field</td>
</tr>
<tr>
<td>Comma (&lt;)</td>
<td>Nudge “In” Event Earlier in Timeline</td>
</tr>
<tr>
<td>Period (&gt;)</td>
<td>Nudge “In” Event Later in Timeline</td>
</tr>
<tr>
<td>Shift-Comma (&lt;)</td>
<td>Nudge “Out” Event Earlier in Timeline</td>
</tr>
<tr>
<td>Shift-Period (&gt;)</td>
<td>Nudge “In” Event Later in Timeline</td>
</tr>
<tr>
<td>Option + Move Event Tool</td>
<td>Toggle to Scroll Regions Mode</td>
</tr>
<tr>
<td>Option + Trim Event Tool</td>
<td>Toggle to Preserve Timing Mode</td>
</tr>
<tr>
<td>Ctrl + Move Event Tool</td>
<td>Toggle to High Precision Move Event Mode</td>
</tr>
<tr>
<td>Ctrl + Trim Event Tool</td>
<td>Toggle to High Precision Trim Event Mode</td>
</tr>
<tr>
<td>Ctrl+Option+Move Event Tool</td>
<td>Toggle to High Precision Scroll Regions Mode</td>
</tr>
<tr>
<td>Ctrl+Option+Trim Event Tool</td>
<td>Toggle to High Precision Preserve Timing Mode</td>
</tr>
</tbody>
</table>
Appendix 2: Peak Actions

This section lists common Peak Actions not found in Peak’s menus. It is organized by Peak windows and functions.

Useful Peak Actions, General

To stop lengthy processes, Saves and recalculations:
• Press $command$-Period

Audio Document Window, General

To find the Max Level in an audio document:
• Option-click on Max Level Indicator (at bottom left of audio document window).

To bring up the Audio Info Dialog:
• Click on the Audio Info Area at the bottom left of the audio document window.

To navigate the Overview without playing audio:
• Option-drag in the Overview

Playback

To play from beginning of a document, or from the location of the insertion point:
• Press the Space bar, or click the Play button on the Toolbar

To stop playback:
• Press the Spacebar again, or click Stop on the Transport.

To play from a desired location in the audio document:
• Click cursor at desired location in track and press the Space bar, click the Play button on the Toolbar, or double-click mouse at desired location in the track.

Scrubbing

To begin dynamic “shuttle” scrubbing:
• Hold down the Control key and drag the mouse across the desired area.

To begin dynamic “jog” scrubbing:
• Hold down the Control and Option keys, and drag the mouse.

Selections

To make a selection:
• Click and drag the mouse.

To select all:
• $command$-A
To extend or shorten a selection:
• Shift-click on the end of the selection that you wish to modify, then drag the mouse to extend or shorten the selection.

To toggle selection start/end:
• Use the shift key.

To snap selection to the nearest zero crossing:
• Hold Option while making a selection.

Views

To zoom out by increments:
• Press ]

To zoom in by increments:
• Press [ ]

To scroll audio display left or right:
• Press control-arrow key left or right

Markers, Loops, and Regions

To find a Marker by name:
• Type in the first few letters of the marker name

To edit a Marker:
• Double-click on the triangular base of the Marker to open the Edit dialog

To name a Marker:
• Double-click the triangular base of the marker, and enter a name.

To select the audio between two markers:
• ⌘-click anywhere between the markers, or press the Tab key.

To select additional audio between markers:
• ⌘-Shift-click between another two markers, or press Shift-Tab.

To move a marker:
• Click on the triangular base of the marker and drag it.
• Or, double-click on the triangular base and enter a time.

To change regular markers into loop markers:
• Double-click the triangular base, and click the Loop Start or Loop End radio button.

To move a pair of loop markers together:
• Hold down the Option key and drag one of the loop markers, or select area containing loop markers and turn on Horizontal Lock – markers move together until Horizontal Lock is turned off.

To move a marker to a zero-crossing:
• Click on the triangular base of the marker, and hold down the Shift key while you drag the marker.

To move both ends of a loop or region marker simultaneously:
• Hold down the Option key while moving the marker, or select area containing loop markers and turn on Horizontal Lock - markers move together until Horizontal Lock is turned off.

To delete a marker:
• Double-click the triangular base. Click the Delete
button. A range of markers can be selected and deleted by clicking Option-Delete.

To delete all markers, loops and regions, leaving audio intact:
• Select all, then press Option-Delete.

To paste just markers, loops and/or regions, leaving audio intact:
• hold down option while selecting paste from the edit menu (Option-V).

Plug-Ins

To set the delay compensation offset:
• Hold down the Option key while choosing Bounce from the Plug-Ins menu.

Note that the Auto Adjust Bounce for Latency option must be disabled to manually compensate for plug-in latency.

Tools – Audio Document Window

To toggle between tools:
• Press the esc (Escape) key.

To toggle Blending on and off:
• Press the Caps Lock key.

To find the zoom factor amount:
• Option-click on the Zoom tool in the Cursor Palette.

To bring up the Smoothing dialog for the Pencil tool:
• Option-click on the Pencil tool in the Cursor Palette.

The Contents Palette

To edit a region, marker or loop in the Contents Palette:
• Option-double-click on its name in the Contents Palette or Contents Drawer.
The Movie Window

To change the size of the Movie Window:

- Click on the QuickTime movie’s “grow button” (at the upper left corner of the Movie window) to double the size of the movie window.

- Control-Option-click on the QuickTime movie’s “grow button” (at the upper left corner of the Movie window) to halve the size of the movie window.

- Select the desired size (original, half, or double) under the Options menu > Movie...
Appendix 3:
Troubleshooting -
Before Calling For Help

Before you call BIAS Technical Support for help, please take a moment to examine the Read Me file installed with Peak. This document contains late-breaking information not included in your User’s Guide.

Use the Apple System Profiler utility to gather information about the configuration of your computer. The information the Apple System Profiler reports is very helpful when reporting a problem to BIAS Tech Support.

Visit the BIAS web site for the latest technical support information, downloads, updates, and more at:

http://www.bias-inc.com

Please verify the following:

• Double check the authorization code you’ve typed in with the authorization code we’ve provided. Sometimes people mistake 1’s for 1’s and 8’s for B’s etc. Please note authorization codes always use the number zero, never the letter O.

• Make sure the version of the product you have installed on your computer matches the version listed on the registration card, as well as the product name in the authorization email you received from BIAS.

If you continue to have trouble, please contact the BIAS Technical Support Department at:

Email: support@bias-inc.com
Phone: +1-707-782-1865

Common problems and solutions

How do I set up my USB or FireWire audio hardware device?

1. Please download the latest USB or FireWire driver from your hardware manufacturer’s website.

2. Boot your computer system with your USB or FireWire device already installed to an available USB or FireWire port directly on your computer and NOT into a USB or FireWire hub.

3. Once your system has started up, locate the Peak application and launch it.

4. Then, from the Peak’s audio menu, choose “Hardware Options”. You should see the hardware options available for Peak (Fig. A).
To accept an input source, change the Input Device to your USB or FireWire audio device.

You can either listen to playback via your USB or FireWire audio device, or you can use the built-in audio hardware in your Mac. Depending on your preference, change the output device setting to your preferred listing environment.

5. After ensuring that you have connected your audio recording sources to your USB or FireWire device, and that the recording source is playing, press the Record button located on the Transport (Fig. B circled in red).

6. The Record Dialog will pop up (Fig. C) — Press the Record button (circled in red) in this window and you will see a preview waveform of your recording as well as metering at the transport bar.

7. Ensure that your audio hardware device is an option within the AudioMIDI Setup window. If it is not an option please contact your hardware manufacturer for support, as your operating system must recognize the device for Peak to be able to use it for recording or playback.
**Why am I getting clicks and pops with my USB device?**

1. Update to the most recent Mac OS. There were major improvements in CoreAudio in OS 10.2.3 and we recommend using the latest OS update.

2. If your USB audio device manufacturer provides drivers make sure you are using the most recent version.

3. Delete the “ACA Preference” preference file. This file is located in:

   MacintoshHD/Users/<YourUserAccount>/Library/Preferences

   After you delete this file, you will need to reset your hardware and recording settings in Audio MIDI Setup and in your audio applications.

4. Open the Audio MIDI Setup utility (this is available in Mac OS X v.10.2 or later, and is shown in Fig. E). Audio MIDI Setup is found at this location:

   MacintoshHD/Applications/Utilities

5. Make sure the sample rate you have selected is supported by your device

6. Open the Hardware Settings dialog. Make sure you have the USB device selected as your input AND output device. Also try experimenting with recording at different CoreAudio buffer sizes (increasing this buffer size normally helps). The hardware settings dialog is located in Audio > Hardware Settings. (See Fig. F)

7. If you are experiencing pops and clicks during recording, go to Audio > Record Settings > Device and Sample Format, and specify a bit depth and sample rate that is supported by your device. (See Fig. G)
8. Go to System Preferences > Energy Saver. Make sure you turn off any energy saving preferences, especially the option to spin down the hard drive.

**Peak will not launch:**

- Does your Macintosh have enough RAM to run Peak? You must have at least 256MB of RAM—512MB of RAM is recommended. To find out how much memory your Macintosh has, choose About This Macintosh in the Finder’s Apple Menu. A window will appear telling you how much memory is currently installed in your computer. If you have less than the amount required to run Peak, you will have to install additional RAM in your computer.

**Peak used to work but now acts strangely or won’t launch:**

- If Peak used to work but now won’t launch or suddenly started acting strangely, the Peak Preferences file may be corrupted. Try quitting Peak, dragging the Peak Preferences file from the Preferences folder (in your home directory’s Library folder) to the Trash icon on the Desktop, choosing Empty Trash from the Finder menu and then relaunching Peak.

**When I place the cursor on the waveform, it jumps to the right or the left. Why?**

- This is the result of Peak’s “Auto Snap To Zero” preference, that automatically places the cursor at a zero crossing in the waveform. You can turn it off by going to the Options menu and un-checking the option.

**I notice files on my hard drive with Peak file icons, called “AFM.temp”**

- These are temporary files that Peak created as you edited audio. If you change Scratch Disk preferences at the end of a session, or force-quit or crash in Peak, sometimes these temporary files won’t be deleted. You can either manually drag them into the Trash, or launch and then quit Peak.

**I know that I can process separate channels in Peak, but not edit them separately. Is there a workaround?**

- The workaround is to export dual mono files, open the Left and Right channels in Peak as two separate mono files, edit them, save them, and then Import as Dual Mono. You will then have a stereo file with your changes in it.

**Peak stops or stutters during recording or playback:**

- Is your hard disk too slow? For direct-from-disk recording and playback, your hard drive must have an average seek time of 18ms or faster. If you are not sure of the speed of your drive, check with the manufacturer or the dealer where you purchased the drive.

- Is the data on your hard disk fragmented? If the files on your hard drive have become fragmented (see Chapter 3 for an explanation of fragmentation) you may have to use a hard disk maintenance program such as Norton Speed Disk™ or the optimizer module of TechTool Pro™ to defragment your drive.

- Is Peak’s playback buffer in the Playback Preferences (found in Peak’s Preference menu) set too low? Try increasing the playback buffer to 128K or higher.

- Try turning off Interrupt-based metering in Peak’s Meters dialog.

- Is AppleTalk turned on? If so, use the Apple menu’s Chooser to turn it off if you don’t need it.

- Try increasing the playback buffer size in Peak’s
Appendix 3: Troubleshooting

Playback Preferences dialog. (Always use the smallest working setting, because this setting also affects how much memory is used per audio document window.)

I can’t access Tape Style Scrubbing:
• Make sure you have selected “Tape Style” from the Dynamic Scrub Time submenu, under the Options menu.

There are items in the DSP menu that are grayed out:
• You need to open an audio document before the DSP effects will be available.
• Not all DSP processes are available in Peak LE.

Problems using Peak with a SMDI sampler (via SCSI):
• Use high-quality, tested SCSI cables that are as short as possible.
• Check for SCSI ID conflicts. Make sure every SCSI device in the SCSI chain has a unique ID.
• Check for problems with SCSI termination. For more information, consult the manuals of your SCSI devices. SCSI termination should exist on each end of the SCSI chain: one termination inside the Macintosh (usually this is the case), and one termination on the last SCSI device in the chain.
• Try turning off Asynchronous transfers in Peak’s Samplers Preferences dialog.
• Reduce the number of components in your SCSI chain. If you have more than one device connected between the sampler and your Macintosh, try removing devices to determine if this affects the errors.
• Change the power-up order of your devices. Try turning all SCSI devices on first, including the sampler. Once the devices have powered up, turn on the Macintosh. If this does not help, try turning on your other SCSI devices, then the Macintosh, and finally the sampler.

When I try to move a region marker that’s in the same position as a marker, the marker moves instead:
• When editing markers that exist in the same space/sample, markers take priority. To get to a region marker, move or delete the marker first.

I try to save files in MP3 format, but the MP3 option is grayed out:
• Peak needs to have the LameLib encoder installed.

To install this encoder:
• Make sure Peak is not running.
• Download the LameLib.bundle from:
http://homepage.mac.com/awk/lame/
• Select the Peak 4 application and choose Get Info from the Finder’s File Menu.
• Open the Plug-Ins tab.
• Click the Add button.
• Locate the LameLib.bundle file, highlight it, and click the Choose button.
• The next time Peak is launched, MP3 will be an available option.

I try to instantiate a plug-in on an insert, but there is already a plug-in called Vbox SE running on that insert:
• Choosing the Vbox menu item automatically opens Vbox SE on the first available insert – perhaps this menu item was chosen and automatically assigned Vbox SE to the insert you are trying to use. To turn off Vbox SE, simply
select the insert it is running on, and then choose None from the submenu.

**How to I create a Scratch Disk?**

1. Create a folder called "Peak Scratch Disk" on a drive/volume you prefer. We recommend partitioning your hard drive or using an external drive for the scratch disk, however creating a scratch disk on the same drive as your operating system will work as well.

2. Open Peak's Preferences dialog.

3. Click on "Scratch Disk".

4. Be sure that only the "Primary" radio button and "Use" checkbox are selected for the drive you created your scratch disk folder on as mentioned in step 1. No other drive should have "Primary" or "Use" selected if you are using multiple hard drives or partitions.

5. Click the "Folder" checkbox, then navigate to the scratch disk folder you created in step 1. "Choose" that folder.

6. Click "OK" to exit the scratch disks dialog.

7. Locate the "Audio" menu (located next to the DSP menu) within Peak.

8. Click on "Record Settings".

9. From the ‘Record Disk’ pop-up menu, choose the hard drive on which you created the scratch disk, and click "OK".

---

**Burning to CD-RW media:**

Peak supports burning to CD-RW media, however the CD-RW media must be blank. Peak will not erase a CD-RW that already contains data.

**To erase CD-RW media:**

- Use the Mac OS X Disk Utility to erase a CD-RW before attempting to burn audio data to it. The Disk Utility is located in the Utilities folder, within the Applications folder.
Appendix 4: Recording & Playback with Mac OS X Audio HAL & FireWire DV

Introduction

The setup directions in this appendix should be used only if your audio hardware interface does not include a dedicated Core Audio driver, and is not supported natively by the Mac OS. If you are unsure about this, please contact the hardware manufacturer for details.

Devices that are typically not supported via Core Audio may include older audio interfaces designed for use in Mac OS 9.x and earlier, as well as FireWire devices such as DV camcorders.

While such devices will not allow recording and playback via Mac OS X’s advanced Core Audio system, they may still be able to be used for recording and playback via the Mac OS X Audio HAL system. The Mac OS X Audio HAL system is essentially the same as the Sound Manager audio system used in Mac OS 9.x and earlier.

When to Use Mac OS X Audio HAL, Mac OS X Audio HAL (System), or FireWire DV

The Audio Menu > Sound Out options include Mac OS X Audio HAL, Mac OS X Audio HAL (System), and FireWire DV. Mac OS X Audio HAL may be used for controlling third-party audio hardware devices, as well as for controlling the Mac’s built-in audio hardware. For example, on a Macintosh that does not feature a built-in microphone, you might want to use a third-party USB microphone that is not supported via Core Audio. In this case, you would have to use Mac OS X Audio HAL.

However, if you planned to use the built-in mic, you would need to select Mac OS X Audio HAL (System), as you would be using a component of the Mac’s built-in audio system.

In the example above, you should really be using Core Audio with the Mac’s built-in microphone.
FireWire DV would be used when you wish to use a FireWire DV device, such as a DV camcorder for recording or playback. For example, you might not have a built-in microphone on your Macintosh – you can use the microphone on the DV camcorder as an input source.

**Configuring Peak for Recording & Playback via Mac OS X Audio HAL, Mac OS X Audio HAL (System), & FireWire DV**

Configuring Peak to record & play back via these alternative audio engines is simple. The steps below will show you how to do it, but remember, it is recommended to use Core Audio whenever possible for optimal performance and quality.

**To Configure Peak to Record & Play Back Audio via Mac OS X Audio HAL, Mac OS X Audio HAL (System), & FireWire DV:**

1. From the Audio menu, choose Sound Out>Mac OS X Audio HAL (Mac OS X Audio HAL System or FireWire DV – see previous section for differences between these options).
2. From the Audio menu, choose Record Settings.
3. In the Record Settings dialog, click the Device and Sample Format button.
4. In the Sound dialog, click the Sample Tab, and choose the desired sample rate, bit depth, and recording format (mono or stereo).
5. Also in the Sound dialog, click the Source Tab, and choose which input you wish to record through.

**Recording with compression is not supported. If you need to apply compression, it is best to do so once the recording has been made, and after all editing and processing has happened.**

6. In the right side of the Sound dialog, choose the Speaker pop-up menu, and choose whether you wish to have the Macintosh’s speaker On, Off, or Off during Recording.

**If you are recording through a microphone, it is probably best to choose Off or Off during Recording to avoid feedback.**

7. In the right side of the Sound dialog, choose the desired Speaker Volume using the Volume slider.
8. In the right side of the Sound dialog, choose the desired Input Gain level using the Gain slider.

**You may wish to play your audio source at this point, to set the appropriate recording level. The VU meters in the Sound dialog should register about 2/3 of the way up as a good starting point. If the resulting recordings are at too low of a level, increase this setting, or increase the output level on the source being fed into the Macintosh. If the resulting recordings are “clipped” (distorted), then lower this setting, or decrease the level of the source being fed into the Macintosh.**
9. When you have configured the Sound dialog, click the OK button.

10. Configure the options in the Record Settings dialog as desired.

You have now configured Peak for recording and playback. Be sure that the audio source you plan to record is connected to the audio interface's inputs, and that its outputs are connected to a set of speakers or headphones.

---

### Record Settings

When you select Record Settings from the Audio menu (Option-R) or Toolbar, the Record Settings dialog appears. This dialog is used to configure your settings for recording with Peak. The Record Settings dialog is basically the same for Mac OS X Audio HAL, Mac OS X Audio HAL (System) FireWire DV.

Please note that the settings you choose here override any previously set within Sound Preferences.

---

You will notice several pop-up menus, buttons, and checkboxes in the Record Settings dialog. These allow you to select which hard drive to record to, what file format you’d like to record in, sampling rate, source input, and so on. You may also wish to record through VST plug-ins. The next few paragraphs describe how to set all of these parameters using the Record Settings dialog.

#### Record Disk

The Record Disk pop-up menu allows you to choose which hard drive you would like to record to. If you have more than one hard drive connected to your Macintosh, use this pop-up to select your record drive. (This option will default to the largest drive currently available to your Macintosh unless you select otherwise.) Peak requires that you save the audio file to the same drive on which it was recorded.

#### File Format

The File Format pop-up menu allows you to select the file format for the incoming audio. You can choose from AIFF or Sound Designer II. If you need the newly recorded audio file to be in a different format, you can always use the Save As function to save it as another format once recording is complete. If you do not select a file format for recording, Peak will default to AIFF.

#### Auto Gain Control checkbox

The Auto Gain Control checkbox allows you to disable the Automatic Gain Control feature used by the Mac OS X Audio HAL system with some Macintosh microphone inputs. If the recording device you are using supports this feature, check the Auto Gain Control checkbox.

#### Monitor checkbox

The Monitor checkbox allows you to monitor the audio throughput while you are recording.
Split Stereo Files checkbox

The Split Stereo Files checkbox allows you to record the incoming stereo audio as dual mono files rather than a single stereo file. Dual mono files are used in programs like Pro Tools, or BIAS Deck, so this option is useful if you need to record dual mono files (i.e., split stereo).

Append to document checkbox

The Append to document checkbox allows you to record into an existing audio document. To record new audio into an existing document, place the insertion point in the existing audio document at the point where you want to insert the new audio. If the insertion point is at the beginning of the file, the newly recorded audio will be inserted at the beginning of the file. If the insertion point is at the end of the file, the newly recorded audio will be appended to the end of the existing file. If the insertion point is somewhere in the middle of the file, the newly recorded audio will be inserted at that point. If you make a selection of audio, the Append to document feature will allow you to replace the current audio with newly recorded audio from the beginning of the selection through the end of the document or wherever you stop the recording.

Record timer checkbox

The Record timer checkbox allows you to designate a specific duration for recording. Peak will stop recording after this set time and then open the Save dialog for your audio recording. Checking the Record timer checkbox will bring up the Recording Time dialog. In the Recording Time dialog, designate the duration for recording in seconds and click OK.

Open after saving checkbox

The Open after saving checkbox determines whether the audio document is opened in Peak after it is recorded.

Device and Sample Format

Clicking on the Device and Sample Format button opens the Sound dialog. The Sound dialog contains three tabs — Compression, Sample, Source — with various options. The right side of the Sound dialog contains the Speaker pop-up menu, Volume and Gain control sliders, and an audio input level meter.

- The Speaker pop-up at the right of the Sound dialog can be set to Speaker On, Speaker Off or On While Recording. Selecting Speaker On will allow you to monitor audio to adjust the input levels prior to as well as during recording, while On While Recording will only allow you to monitor levels while you are actually recording. As you might expect, Speaker Off will mute the outputs completely.

Compression

Peak does not support recording to a compressed format, so the Compressor pop-up menu should be left set to None. To apply compression, make your recording, and once all editing and processing has taken place, apply compression via the Save dialog. This approach will yield the best sounding audio.

Sample

Selecting Sample from the Sound dialog pop-up menu allows you to choose the sample rate and bit depth, as
well as whether the incoming audio will be recorded as a Stereo or Mono file. To some degree, the choices that appear here will depend on your audio hardware. For more information on bit-depths and sample rates, see the Glossary.

**Source**

Selecting Source from the Sound dialog pop-up menu allows you to select and configure the audio input you wish to use for recording. If you are using third-party audio hardware with your Macintosh, you can select it as the input device using the Device pop-up. Use the Input pop-up to select the hardware inputs you wish to record through.

**Hardware Settings**

Clicking the Hardware Settings button in the Record Settings dialog brings up a dialog appropriate to the audio hardware that you are using with your Macintosh. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound). Some audio hardware drivers have control panels or utility applications that will launch when you click on the Hardware Options button.

**Conclusion**

You have now learned how to record and playback audio to and from hard disk using Mac OS X Audio HAL, Mac OS X Audio HAL (System) and FireWire DV. For more information, please see Chapter 4: Recording & Playback.

Once you have configured the options in the Sound dialog to your liking, click OK to return to the Record Settings dialog.
Glossary

AAC

Advanced Audio Coding - (Also known as AAC, MP4, or mpeg 1, layer 4) - A compressed audio file format that uses psychoacoustic modeling to reduce file size significantly, while audio quality rivals that of uncompressed CD audio. MP4 is a fairly new standard and rising in popularity for use on the Internet and in personal music players. Peak supports reading/writing AAC files.

AIFF

Apple's Audio Interchange File Format used for recording and storing digital audio. It is also Peak's default file format and is supported by many Macintosh software applications.

AU

AU, or .au, is the audio file format common to most Sun Unix workstations. It is one of the most commonly used audio file formats on the World Wide Web.

Audio Units

Audio Units is a real-time, native plug-in standard from Apple Computer, Inc. Audio Units plug-ins are accessed by compatible host applications from a central directory. Mac OS X includes several Audio Units plug-ins, which can be accessed in Peak, or by any other Audio Units compatible hosts. (Audio Units are sometimes referred to as “AU” plug-ins, not to be confused with the AU, or .au file format used on Sun Unix workstations)

audio hardware (audio interface, audio card)

Audio hardware can be any audio expansion card that plus into a PCI or PCMCIA slot in your Macintosh, with or without an additional break-out box, or an audio interface that connects to your computer by USB or FireWire. Third-party audio hardware enhances a computer’s audio recording and playback capabilities. Using Apple CoreAudio, Peak works with a variety of Macintosh audio interfaces from Digidesign, Digigram, Echo, Korg, Mark of the Unicorn, M-Audio, and others. CoreAudio Driver software from the manufacturer of the audio hardware may be required to work properly with Peak.

audio document

An audio document is a Macintosh audio data file created by Peak. Peak can create and open audio documents in a variety of common audio file formats. The AIFF file format is Peak's default file format. For more information, refer to AIFF, AU, WAVE, Sound Designer II, and QuickTime.
**bit resolution (bit rate or bit depth)**

Describes how many bits-as in “0s” and “1s”-are available to describe a digital recording. In practice, the bit resolution defines the dynamic range of a sound, whereas the sample rate defines the frequency range. 24-bit is a high-resolution bit depth used for professional audio recording, editing, and processing; 16-bit audio is the professional Compact Disc standard; 8-bit audio is suitable for less demanding applications, such as multimedia presentations. More bits result in better quality, but also require more hard drive storage space. Also refer to dynamic range, frequency, and sample rate.

**blending**

Blending is an automatic crossfade function that Peak applies to areas during cutting, pasting and other editing processes in order to smooth abrupt transitions between waveform amplitudes. Blending can be toggled on or off by choosing the Blending command from the Preference dialog, or by clicking the Bending enable/disable button in the Cursor Palette.

**clipping**

A type of audio distortion that occurs when a source signal (such as from an audio CD player) is recorded at such a high level that the recording device (such as a Macintosh running Peak) runs out of “headroom.” It can also occur when a signal is played back from a audio source into an audio destination at an excessive level, such as when a mixing console feeds a signal to a power amplifier at an extremely high level. In either case, clipping represents a mismatch in level between an audio source and an audio destination. When digital clipping occurs, such as during digital recording, the results can be a harsh “crackling” or “raspy” sound. When you use Peak, you can avoid digital clipping by ensuring that the record levels are set so that the loudest incoming audio passages stay below the maximum input level, as indicated on the record or playback meters. Peak’s Clip indicator will easily show any clipping that occurs. Also refer to headroom.

**dB (decibel)**

This is the most common unit used for measuring the level of audio. The greater the number of decibels, the higher the audio signal. Within Peak, the record and playback meters show a signal’s relative level in terms of dB. There are many different kinds of decibel scales, but for the purposes of using Peak, “dB” can be used to describe the relative gain of different passages of audio, or to describe the available headroom during recording. Also refer to gain and headroom.

**DSP**

DSP stands for digital signal processing. In the world of audio, DSP refers to manipulating a digital audio signal by processes such as level changes, reverberation, delay, or other such effects. Peak uses DSP to perform many of its audio processing tasks-including those found in the DSP menu or Toolbar.

**dynamic range**

In audio recording terminology, dynamic range refers to the range in level between the quietest and loudest passages of a selection of audio. It is usually expressed in
decibels. Bit resolution determines a recording’s dynamic range. An 8-bit recording has 256 available levels, which translates into a dynamic range of 48 dB. This may be suitable for some applications, but it may also sound noisy, since the difference in gain between the loudest passages and the quietest passages (which may contain hiss and other potential noise) is not that great. A 16-bit recording has 65,536 available levels, which translates into a high-quality dynamic range of 96 dB. As a rule of thumb, you can calculate dynamic range in decibels by multiplying the bit rate by “6.” Also refer to bit resolution, decibel, and gain.

**fade-in/fade-out**

A fade-in is a process where the gain of an audio signal is increased from zero (silence) to its full volume. A fade-out is a process where the gain of an audio signal is decreased from its full volume to zero (silence). Peak allows you to create fade-ins/fade-outs by making a selection and choosing the Fade In or Fade Out command from the DSP menu, or from the Toolbar. Envelope shapes can be editing with the Fade In Envelope or Fade Out Envelope commands in the Preference dialog.

**frequency**

Sound consists of waves, which occur in cycles. Frequency refers to how frequently these wave cycles occur in a given period of time (generally, one second). The higher the frequency of a sound, the higher its “pitch” as perceived by human ears. Frequency is measured in Hertz (Hz), or cycles per second. Roughly speaking, humans are able to hear sounds in the frequency range between 20 Hz and 20,000 Hz (20 kHz).

**gain**

1) The process of amplifying a signal. 2) A way to express relative signal levels for audio. For instance, by adding 6 decibels of level to a signal, we double the perceived loudness of the signal. Also refer to decibel and headroom.

**headroom**

Describes how much gain is left before a signal induces clipping or distortion. When recording with Peak, the record meters indicate how much headroom is left before clipping. When playing back audio in Peak, the meter strip at the bottom of the screen will indicate this as well. Most professional audio engineers leave between 3 dB and 12 dB of headroom while recording, to minimize the possibility of clipping. If you leave too much headroom, however, your signal may be recorded at too low a level, and you may end up with excessive noise or hiss. Also refer to clipping, decibel, and gain.

**Hz (Hertz)**

This is the unit of measurement for frequency, and refers to the number how many “cycles per second” a sound wave generates. In the world of sound, the higher the number of Hertz, the higher the frequency of a sound and hence the higher its “pitch” as perceived by human ears. A thousand Hertz can be expressed as 1 kHz (one kilohertz), so that 20,000 Hertz may also be referred to as 20 kHz.
**loop**

Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file. You can do this either by making a selection and choosing the Loop this Selection command (⌘L) from the Actions menu or Toolbar, or by placing markers at the desired start and end point of a region, and defining the markers as loop markers.

**Loop Tuner**

A feature of Peak that allows you to “fine tune” the start and end points of a loop.

**Loop Surfing**

Peak’s term for adjusting loops during playback.

**Loop Surfer™**

A proprietary feature of Peak, which automates many of the steps required to “loop surf.”

**marker**

A marker is a location in an audio document that you define as important; you can also think of a marker as a “memory location.” By marking a specific location in a recording, you can easily navigate to it for selection, editing or playback purposes. Peak allows you to define a marker by pressing ⌘M or clicking a Toolbar button, either when playback is stopped or while it is engaged.

**MP3**

(Also known as mpeg 1, layer 3) - A compressed audio file format that uses psychoacoustic modeling to reduce file size significantly, while retaining good audio quality. Popular for use on the Internet and in personal music players.

**MP4**

(Also known as AAC, or mpeg 1, layer 4) - A compressed audio file format that uses psychoacoustic modeling to reduce file size significantly, while audio quality rivals that of uncompressed CD audio. MP4 is a fairly new standard and rising in popularity for use on the Internet and in personal music players. Peak supports reading/writing MP4 files.

**playlist**

A playlist is a list of audio events, or “regions,” strung together in a specific order. See also region.

**Plug-Ins**

Plug-Ins are optional software enhancements for Peak that are available from BIAS and other third-party manufacturers. By installing plug-ins in Peak’s VstPlugIns folder, you can enhance Peak’s audio editing and processing capabilities with tools such as filtering, reverberation, chorusing and flanging, noise reduction, spatialization, and more.
**QuickTime**

This is an audio format developed by Apple Computer for QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Adobe Premiere or Macromedia Director.

**region**

A region is a portion of an audio document bounded by region markers. Regions are portions of an audio document defined using the New Region command (⌘-Shift-R) from the Actions menu or Toolbar. Regions can be saved into only AIFF and Sound Designer II files created by Peak. See also playlist.

**sample**

(verb) Sampling refers to the act of recording audio material digitally by a sampling instrument or other digital recording device. See sampler and sample rate.

**sample**

(noun) A sample refers to audio material which has recorded digitally or “sampled” by a sampling instrument or other digital recording device. Sample also refers to a single wave-cycle” snapshot” of sound. See also sampler and sample rate.

**sample rate**

Sample rate describes how frequently an analog audio signal is been “sampled” or analyzed as it is recorded and converted to a digital medium. Sample rate directly affects audio fidelity in terms of upper frequency response: the higher the sample rate, the higher the available frequency response. A fundamental principle of sampling states that to accurately capture a sound, the sample rate must be at least twice the highest frequency in the sound. The standard sample rate for Compact Discs is 44.1 kHz. The following are common sample rates which are supported by many Macintosh computers and Peak software.

**192.000 kHz**

This is the standard for HD (High-Definition) audio hardware/production. This rate results in an upper frequency response of 96 kHz-well above the range of human hearing.

**96.000 kHz**

This is the standard sample rate for Digital Video Disc (DVD) audio, and is often used by sound editors work-
This rate results in an upper frequency response of 48 kHz - well above the range of human hearing.

**48.000 kHz**

This is one of two standard sample rates for digital audio tape (DAT) recorders, and is often used by sound editors working in audio post-production for video or film. This rate results in an upper frequency response of 24 kHz - above most people’s hearing range.

**44.100 kHz**

This is the standard sample rate for Compact Discs, digital audio tape (DAT) recorders, and high-fidelity audio applications on Macintosh and PC-compatible computers with 16-bit playback capability. It is colloquially called “forty-four one” (as in 44.1 kHz). Most sound engineers working in music production - or anything that may be distributed on a CD - work at this rate. This rate results in an upper frequency response of 22,000 Hz - above most people’s hearing range.

**22.050 kHz & 11.025 kHz**

These sample rates are sometimes used for lower-fidelity audio playback on Macintosh and PC-compatible computers. Many games, websites and other multimedia productions utilize 22.050 kHz (or lower) 8-bit audio, since it uses half the disc space of CD-quality audio. The 22.050 kHz sample rate results in an upper frequency response of 12.025 kHz; this may sound “muffled,” since most people can hear considerably higher frequencies than 12.025 kHz.

Also refer to bit resolution, frequency, and Hertz.

**SCSI**

Stands for Small Computer System Interface. It is a standard developed to allow a variety of computers and peripheral devices such as hard disks, CD recorders, scanners, and other storage media, to connect and transfer data. Most external hard drives designed for use with the Macintosh are SCSI hard drives and must be connected to the SCSI port on the rear of the Macintosh. The SCSI specification allows up to seven SCSI-equipped devices to be connected or “daisy-chained” together.

**SMDI**

SMDI stands for SCSI Musical Data Interchange Protocol. SMDI Samplers use SCSI to send samples between devices several times more quickly than over MIDI. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler.

**Sound Designer II**

This is an audio file format developed by Digidesign for use with its digital audio products. The format can also be read by a wide variety of Macintosh-based audio editing and multimedia development programs, including Peak.

**VST**

“Virtual Studio Technology” - VST is a real-time, native
plug-in standard created by Steinberg Media Technologies, AG. Plug-ins conforming to the VST standard can be used in any compatible host application. VST plug-ins are accessed from a central directory in the Mac OS, making it very easy to maintain large collections of plug-ins. Peak supports “Mach-O” and “carbonized” VST 1.0 format effects plug-ins.

**WAVE**

This is Microsoft’s Windows Audio File Format. It is supported by many Windows software applications and some Macintosh applications. The WAVE format is best if you plan to use an audio document in an application that supports or requires WAVE format files.

**zero-crossing**

The zero-crossing is the point where the waveform meets the zero crossing line or the center line through the waveform. It is the point of zero amplitude in the waveform.
Symbols/Numbers

# Items 234
+4 dBu 69
-10 dBV 69
1/4-inch 69
1/8-inch 69
8-bit 33
16-bit 33
24-bit 33
32-bit 33
22.5 kHz 33
44.1 kHz 33

To-digital 33
Analysis 208
Settings field 197
Anchor to sample 78
Checkbox 95
Append to Document 67
Checkbox 63, 257
Apple
Audio MIDI Setup Utility 57
Events Support 229
Sound Preferences 57
AppleTalk 21
Applying Effects Plug-Ins to Playlist Events 167
Arranger 126, 139, 157
Arrow Cursor 40
Tool 41
ASR-X 270
Asynchronous SCSI transfers 233, 236
Attack
Slider 201
Threshold 203
Attenuate 190
AU 36, 226
Audio
Between Adjacent Markers 78
CD(s) 33, 67, 147
Checkbox 139
Copying 85
Cutting 84
Document Window 40, 76
Duplicating 86
Editing 84
Document, Exporting Regions from 107
File Info 40
File Meter 48
Files, Recovering Damaged 37
Hardware interfaces 55
Info 48, 273
Info Area 78

A

.au 38, 245
A/B Comparisons 210, 216
A/D converter 33
AAC 226
About Peak LE 22
About Peak.... 239
Abrupt transition 46, 90, 192
Action Menu 250
Authorization 28
Active box 212, 213
Adapter 69
Add 178, 258
Add Region Button 125
AIFF/AIFC 35, 38, 63, 68, 98, 126, 226, 244, 256
Alaw 35
Allow Servers 48
Authorization 28
Alternate Methods of 29
Without an Internet connection 30
Amplifier 68
Amplitude 76, 77, 78, 195
Fit 178, 259
Analog
Clicks 88

Index
Edits/splices 128, 148, 149, 161, 162
To Previous Event End Button 125, 148
To preceding Event in List View 161
To preceding Event in Waveform View 148

Button(s)
Add Region 125
Burn CD 126
Butt to Previous Event End 125, 148
Bypass 214
CD Info 126
Delete Playlist Event 126
Device and Sample Format 61, 64, 257
Dry Button 213
Fast-Forward 127
Hardware Settings 64
Next Track 127
Previous Track 127
Rewind 127
Shuffle Mode 131
Slip Mode 130
Stop 127
Vertical Scroll 213
View L+R Channels Waveform, Radio 141
View Left Channel Waveform, Radio 141
View Right Channel Waveform, Radio 141
Linear View 141
Play 127
Playlist Function 123
Previous Track 127
Staggered View 141
Zoom In 141
Zoom Out 142
Bypass 214

C

Cancelling Batch Processes 228
Caps lock 46, 90
Capture Region to Playlist 253
Carbonized 207, 213
CardBus 70
Cassette 68
CDDB 165
CD
Burner Compatibility 167
Burning Options 170
Frames(s) 77, 136, 147, 252
Import Track Range dialog 68
Info Button 126
Master 113
CD-R 170
CD-ROM drive 67
CD-TEXT 21, 113, 126, 140, 165
For Disc 139
For Track) 157, 165
Column 157
Cents 184, 196
Ceiling, Digital 195
Change Duration 182, 261
Transient mode 182
Change Gain 183, 261
Dialog 79
DSP function 79
Change Pitch 184, 196, 261
Change the sort order in the Contents Window 44
Changing
Input Routing 215
Names of Playlist Events 160
Order of Columns 159
Order of Playlist Events 160
Channel(s) 61

Independent Processing 77
Inserts 210
Radio Buttons 62
Choosing
Scratch Disk, a 48
Time Format, a 47
Colors 47
Clear 168
Clipboard 250
Clearing the Clipboard to Reclaim Disk Space 84
Click(s) 77, 169, 197, 198
Clip 45, 66, 194
Indicator 66, 213
Indicator Hold Time 43
Clipboard 85, 186, 249
Clearing the, to Reclaim Disk Space 84
Clipguard 183, 184
Clock Source 56, 57, 61, 62
Close 40, 51, 244
Colors 47, 239
Highlight 159
Palette, Macintosh 47
Components directory 209
Composer 126, 139, 157
Compression 40

Index
Compute File Max dB 272
Contents 275
   Drawer 42, 83, 96
   Window 43
Contiguous selections 147
Control Area 116, 123
Convert Sample Rate 79, 185, 261
Convolution 186, 190
Convolve 186, 262
Copy 84, 249
Copy Protection
   Column 157
   Add flag to a Track 166
Copying Audio 85
Core Audio 55, 62, 186, 217
   Playback dialog 56
   Record Settings 61
   Settings dialog 57, 58, 64
Corrupt sectors 246
Counter Display 127
   Scrub audio with 127
Country Code 156
CPU
   Macintosh 69, 70
   Meter 212
   Resources 58
   Requirements 21
   “Cue Card” 49
Creating Serial Chains 215
Crop 250
Cropping a Selection 87
Crossfade(s) 90, 128, 132
   Audition Controls 128
   Changing Type in List View 162
   Changing Type in Waveform View 149
   “In” Duration 143
   “In” Duration Column 156
   “In” Envelope 143
   “In” Shape Field/Column 154
   Loop 101, 186, 262
   “Out” Duration 144
   “Out” Duration Column 156
   “Out” Envelope 143
   “Out” Shape Column 155
   Preserving Duration of while moving 137
   Type Button 125
   Type pop-up menu 149
   Variations 101, 187
   Crossfading 113
Editing Loop Envelope 102, 187
Loops 101
   Playlist Events Together 148, 161
Cursor 40
   Information 272
   Modes 40, 117, 145
   Selection Information, and 42
   Transparent Overlay 42
Customize the colors of the waveform display 47
Cut 75, 77, 84, 90, 109, 248
Cycling ‘74 207

D

DAT 68, 167
Database 50
DDP 113, 126, 170, 173
DDPID 126, 172
DDPMS 172
Decibels 34
Delay 217
   Determining Compensation 218
Delete 77, 90, 109, 250
   Audio 85
   Except Audio 250
   Marker 96
   Playlist Event(s) 117, 126, 148, 159
Delta 144
Detection Setting 198, 199, 267
Device and Sample Format 61, 64, 257
Digital
   Audio 33
   Ceiling 195
   Clicks 89
   Signal Processing 177
Direct monitoring 58
Disc
   Identifier 126, 139
   Title 126, 139
   CD-TEXT for 139
Disclosure triangle 76
DJ mixes 182
Document
   Append to 67
   Audio Window 40, 76
   Creating a New 35
   From Playlist 244
From Selection 244
Documentation 208
Double Size 274
Dragging and Dropping Folders, Disks, and CD Audio Tracks 37, 79
Driver(s) 55, 71
Drum loop 202
‘drutil info’ 140
DSP 75, 77, 177
  Menu 177, 258
  Preferences 183, 185, 241
  Processing with 177
Dual mono 36, 63
  Auto-Import 46, 273
Duplicate 249
  Audio 86
  Playlist Event Button 125
  Slider 87
Duration 79, 137, 138
DV camera 55
Range 34
Dynamic Scrub Time 45, 274

E

E-mu 233, 270
  E-64 233
  E-IV 233
  E5000 233
EAN 126, 139
Edirol 55
Edit 214
  Blending Envelope button 91
  History in Contents Drawer 83
  Marker 44
  Marker dialog 94, 96
  Menu 83, 248
  Region 44
Editing
  Fade In/Fade Out Envelope 91, 92
  Audio 75
  Crossfades 162
  Essential Functions 84
  Effect Plug-In Parameters 214
  QuickTime Soundtracks in Peak 108
  Subcode Data 166
Edits 75, 248

Command, Undo a Series of Actions with 82
History in Contents Drawer 83
Eighth note 48
Elapsed time 43
Emphasis
  Column 157
  Adding Flag to a Track 166
Enable
  Auto-Import Dual Mono 47
  Move Waveform During Playback 45
  Scroll During Playback 45
  Show Marker Times 46
End time 68
Ensoniq 270
Envelope 90, 93, 193
  Custom 93
  From Audio 188, 262
  Pop-up menu 94
EQ Matching 208
Equal Power 149, 162
ESC key 40
ESI-32 233
ESI-4000 233
Example Scripts 230
Expander 208
Export
  As Text 247
  Audio between Markers 107
  Dual Mono 246
  Regions 246
Exporting
  DDP Fileset 172
  Jam Image File 173
  Text 174
  Regions 105, 106
  Extend a selection 79

F

Factory Preset Controls 214
Fade In(s) 92, 189, 263
Fade Out(s) 92, 189, 263
FAQ 209
FFT (Fast Fourier Transform) 197
Fast-Forward 127, 256
Feedback 70
File Format(s) 78, 256
AAC 226
.au 38, 245
mp3/MP3 36, 38, 226, 245
mp4/MP4 226
Sonic AIFF 36, 38, 245
Sound Designer II 36, 38, 63, 98, 113, 126, 191, 226, 244, 256
Paris 36
Pop-Up Menu 63
File
  Menu 243
  Name Suffix 227
  Overview 40
  Sharing 21
  Size 78
  Type extensions 273
FileMaker Pro 49, 229, 230
  Example Scripts 230
Find Peak 189, 263
Fine Tune 184
FireWire 55, 70
DV 55
Fit Selection 251
Floating windows 242
Fragmentation 34
Frequency
  Response 33
  Spectrum 190
Full Document Path 229

Gain
  Auto Control 63, 257
  Change Amount Column 156
  Envelope 189, 263
Gap 128, 151
Gap/Pause
  Duration Column 154
  Indicator 144
GarageBand 105
Gate 208
GateEx 208
Genre 126, 139
Getting Help with Peak 23
Gigabytes 64
Global 209

Go To 254
  End 43
  Time 43
Gracenote CDDB 165
Guess Tempo 105, 255
Guitar preamp 69

Half Size 274
Hand Cursor/Tool 40, 42
Hard Disk
  Maintenance 21, 34
  Storage Requirements 34
Hard drive 63
Hardware
  Options 257
  Settings 56, 258
  Settings Button 64
Harmonic Rotate 190, 263
Headphones 68
Hearing 70
Help 239
Hi-fi 197
Hide All Audio Document Windows 276
Hide
  Others 243
  Peak 243
High-Precision Editing Mode 147
Highlight color 159
Home directory 209, 210
Horizontal
  Lock 100
  Lock Button 41
  Scroll Arrow Buttons 145
  Scroll Arrows 158
  Scroll Buttons 213
  Scrollbar 145, 158
Host-based 207
Hosts 209
“Hot swap” plug-ins 213

I/O errors 246
IMA 4.1.35
Index

K

Keep Volume Constant 196
Key range 79, 273
Keyboard  
  MIDI control 219
  MIDI Input 274
Keyboard Shortcuts 49
  Adding new 49
  Deleting 49
  Custom “Cue Card”, creating 49
Korg 207
KURZWEIL 233, 270
K2000 233
K2500 233
K2600 233

L

.L 46
LAME encoder 38
Latency 58, 217
  Auto-Adjust Bounce for 273
LED 43
Left channel 37, 77
Left-box input 215
Level  
  Controls 213
  Input/Output Sliders 213
Line-matching transformer 69
Linear 34, 149, 162
  Blend Calculations checkbox 91
View Button 141
Links menu 23, 276
List of Samples 234
List View Area 116, 153
  Columns, Controls, and Data Fields 153
  Detail of 153
Live 105
Live recordings 182
Lo-Fi 197
Load Script 228
Load User Preset 214
Loading Virtual Instruments on Inserts 220
Locate marker 95
Log File 227
Long filenames 38

J

Jam 172
  Image file 36, 38, 113, 126, 170, 226, 245
Jog Scrubbing 81
Long Recordings 64
Loop(s) 75, 78
Activate for Previews: 129
Button 44
Creating 99
Crossfading 102, 187
Deleting 99
During playback 43
End 203
Hold 102, 187
Making into Regions 105
Markers 78
Offsets 236
Saving with Loop Flag On/Off 101
Start 203
Surfer 99, 105, 254
Surfing based on tempo 103
Surfing based on selection 104
This Selection 252
Tuner 99, 192, 264
With release 102, 187
LP (See also Vinyl, Clicks, Pops) 80

M

M-Audio 55
Mac OS X Audio HAL 55
MACE
3:1 35
6:1 35
Mach-O 207, 213
Macintosh color palette 47
Macintosh CPU 69, 70
Magnification 76, 77
Vertical Scaling 76
Magnifying Glass Tool 40, 42
Make Active 168
Making Audio Connections 68
Making Loops into Regions 105
Mark 67
Markers 78, 202
And Selections as Navigational Aids 80
Are Indexes checkbox 171
Audio Between Adjacent 78
Locate 59
Button 44
Copy/Paste Only 97
Creating 94, 96
Deleting 96
Edit 96
From Tempo 94, 253
Position 95
Loop Start/Loop End 95
Making into Loop markers 100
Moving 97, 100
Nudging 97
Reference Marker 95
Space between markers 80
To Regions 253
Master
CD 113
Fader 43
Input level 215
Input Level Slider 213
Input Level VU Meters 213
Output Level Slider 213
Output Level VU Meters 213
Output Levels 215
Output volume 44
Perfection Suite 208
Wet/Dry Controls 215
Matrix 210
Arrow buttons 212
Max
dB 79
Level Indicator 40
Maxim Digital Audio 207
Maximizing Peak’s Performance 21
Maximum
Amplitude 189
Maximum file size 64
MCN 126, 139
Message 126, 139
Metadata
Adding to Discs & Tracks 165
CD-TEXT 156, 157, 165, 166
Subcode 157, 166, 167
Meters 43, 258
Dialog 43
Microsoft Xbox Loop Boundaries 77, 252
MIDI 214, 275
Controller 59, 219
Interface 219
Keyboard 219
Keyboard window 59, 219
Milliseconds 45, 81
Min:Sec:ms 42, 48
Mini-plug 69
Minimum
  Silence Between Tracks 179, 259
  System Requirements 21
  Track Duration 180, 260
Minutes:Seconds:Milliseconds 136
Mix 193, 265
Mixer 68, 71
MM:SS:ms 136
Modulate 194, 265
Monitor 221
  Checkbox 63, 257
  Monitoring 70, 221
Mono 61
  Document 243
  To Stereo 192, 264
MOTU 55
Move Event
  Cursor 117
  Tool 145
Move Waveform During Playback 45, 272
Movie 275
  Icon 67
  Sound Tracks 108, 274
Moving Plug-Ins 214
mp3/MP3 36, 38, 226, 245
mp4/MP4 226
Multi-Document Recordings 64
Multiband Compressors 208
Multimedia speakers 68
Multiple audio documents 84
Multiple plug-ins 210
Mute 214

N

Name Prefix 107
Naming convention 64
Native 207
Native Instruments 207
New 243
  Document from Selection 87
  Marker 252
  Region 253
  Region Split 253
  Next Selection 250

Next Track Button 127
Noise
  Floor 202
 Gate 201
  Reduction 208
Non-adjacent selections 159
Non-destructive editing 34, 75, 113
Non-English characters 38
Nonlinear 34
Normalize 194, 265
Normalize (RMS) 195, 266
Notepad 96
  Checkbox 65
  Cues 65, 256
  Regions, Not Markers 65
Nudge 254
  Amount Field 136
  Amount Format 128
  Controls 131
  Format Pop-Up Menu 136
  In Event Earlier in Timeline 134
  In Event Later in Timeline 135
  Keyboard equivalents 131
  Loop Backward 252
  Loop Forward 252
  Markers 182
  Out Event Earlier in Timeline 133
  Out Event Later in Timeline 133
  Set Amount 136
  Set Format 136
  Number of Songs field 180, 260
Nyquist frequency 33

O

Octave 184, 196
Off 167
On 168
Only Regions button 107
Open 244
  After Saving Checkbox 64, 257
  Dialog after Launch 274
  Tracks after importing checkbox 68
Opening
  “Dual Mono” Files 36
  Compressed Audio Documents 35
  Existing Audio Documents 35
WAVE files 35
Options Menu 271
Organizing Plug-ins with Folders 210
Original Size 274
Output
  Device 57
  Device pop-up menu 58
  Directory 107
  Format 107
  Jacks 69
  Playlist, Options 170
  To New Windows 107
Output 70
Owner Code 156
Owner’s Certificate 28

P

.paf 38, 245
Palettes 40
Panner 196, 266
Paragraphic Equalizers 208
Parallel Effects Chains 215
Paris 36
Paste 75, 77, 84, 90, 98, 249
  Multiple copies 249
  Audio 85
Pause(s) 128, 151, 255
  Indicator 151
PCI 55, 70
PCMCIA 55, 70
Peak
  Audio Librarian Tools 229
  Audio Processing Tools 177
  Events 229
  Features 19
  Hold 43
  Impulses 191
  Menu 239
Peavey 233, 270
Pencil Tool 40, 42, 89
  Repairing clicks with 89
Performer 126, 139, 157
Phase 76
Vocoder 196, 266
Pitch 79
  Correction 208
PitchCraft 208
Play 43, 255
  Button 127
  Selection 255
  Through 56
  Through Pop-Up Menu 57
  With Auditioning 255
Playback 55
  Buffer 44, 45, 242
  Configuring Peak for 56
  Master Volume 45, 242
  Options 57
  Parameters 44
  Preferences 241
  With Core Audio 57
Playhead cursor 82, 144
Playing
  Audio 60
  Virtual Instruments 61, 220
  Virtual Instruments Alongside Audio Documents 221
Playlist 113, 116, 275
  Add Region to, from Contents Drawer: 122
  Add Region to, from Contents Window: 120
  Add Region to, using Add Regions button 116, 120
  Basic Concepts 116
  Capture Region to 253
  Closing 120
  Creating a 116
  Creating a New Document from 172
  Document 244
  Export As Text 247
  Export DDP from 172
  Export Jam Image File from 173
  Function Buttons 123
  Graphical User Interface 114
  Opening Playlists 120
  Output Options 170
  Program Duration Time Display 153
  Saving 120
  Scrubbing audio in 127
  Synchronize with Source Regions 124, 125
  Track Start Offsets 152, 164
Playlist Event(s) 113
  Applying Effects Plug-Ins to 167
  Begin Boundary 142
  Begin Time Display 143
  Changing order of 160
  Clearing a “snapshot” 169
  Creating a Gap between 163, 151
Disk-Based 34
Into a QuickTime movie 67
Long 64
Multi-Document 64
Notepad 65
Options 62
Through Effect Plug-Ins 216
Virtual Instruments 220
Recover Audio File 37, 246
Red Book 113, 119, 139, 170
Redo 75, 82, 118, 123, 248
Reduction Ratio Slider 201
Reference Marker 95
Distance 42
Region(s) 98, 105, 113, 171, 202
Adding to a Playlist 116, 120, 122
Are Tracks Checkbox 171
Button 44
Capture to Playlist 253
Changing name of 98
Copy/Paste Only 99
Defining 98
Detection area 107
Deleting 97
Editing 98
Locating 99
Moving while preserving duration 98
Split 99
Registration 28
Alternate Methods of 29
Without an Internet connection 30
Release
Slider 201
Threshold 203
Remix 105
Remove
Keyboard Shortcut: 49
Icon from the Toolbar 50
DC Offset 199, 268
Repair
Click 88, 197, 267
Clicks 88, 198, 267
Size 198, 268
Replace 249
Replacing Audio 86
RepliQ 208
Required Silence Before Strip Slider 202
Resize
Columns in Contents Window 44
Contents Window 44
Icons in Toolbar 51
Resolution 21
Restoration 208
Restoring Vbox Presets 216
Return to Zero 43
Reveal 208
Reverb 190
Reverse 200, 268
Boomerang 200, 268
Revert
All from Sampler 270
From Sampler 269
To Item 83
Rewind 255
Button 127
Right channel 37, 77
Ring modulator 194
RMS Level 195
Room tone 201
Root key 79, 273
Routing Switch 213
Roxio Jam 113
Sample(s) 42, 47, 136
Playback instrument 79
Rate 33, 56, 61, 78, 79
Rate Conversion 183, 185
Rate Conversion Quality 56, 58, 241
Rate Pop-Up Menu 57, 62
Units 272
Sampler Menu 269
Preferences 241
Samplers 233
Sampling 33
Save 38, 66, 83, 244
A Copy As 38, 39, 245
As 39, 65, 108, 245
Changes Area 227
Preferences Now 46
Script 227
To Disk 107
User Preset 214
Saving
A Playlist 119

Peak 5 User's Guide
And Closing Documents 38
Compressed Audio Documents 39
SCMS 157
Scratch Disks 84, 240
    Pop-up menu 48
Script Definition 230
Scroll
    During Play 272
Scroll Regions 147
    Mode Checkbox 138
Scroll wheel 145
Scrubbing 80, 81
    Controlling “Tape” Speed 82
    Dynamic 80
    Using Playlist Counter Display 127
Jog 81
Loop duration for 81
Shuttle 81
Tape-Style 45, 58, 82
SCSI 233, 236
    ID 236
Seconds 47, 63
Select
    All 80, 250
    Audio between two markers 79
    Loop 250
Selected crossfade 132
Selecting
    Audio 79
    Playlist Events 116, 147, 159
Selection(s) 76, 177
    Contiguous 147
    Creating a loop from 100
    Discontiguous 147, 159
    Extend a 79
    Fit 251
    Make a, with mouse 79
    Next 250
    Previous 250
    Set 250
    Shorten a 79
Self-powered speakers 68
Send 234
    All to Sampler 270
    To Sampler 269
Serial Number 28, 156
Set 168
    Import Times button 68
    Path 107
Selection 250
Setting
    Custom Gaps or Pauses between Playlist Events 113, 150, 163
    Preferences 44
    Track Start Offsets 152, 164
    Shortcuts/Toolbar 49, 50, 242
    Shorten a selection 79
Show
    Audio Waveform Overview 76
    Cursor Info 181, 272
    Edits 90, 272
    Marker Times 46, 272
    Overview 272
    List View disclosure triangle 153
    Waveform View Disclosure Triangle 140
Shuffle Mode Button 131
Signal flow 210, 213, 215
Silence 249
    Is Audio Below slider 180, 260
Silencing a Selection 88
Simpler Document Path 229
Sixteenth note 48
Slip Mode Button 130
Slip/Shuffle Mode Controls 130
    Toggling Between 131
Slow Out, Fast In 149, 162
Slowing down 184
SMDI
    Browse samples in device 235
    Device 234
    Sampler 233
    Sampler Error Messages 235
    Sampler Troubleshooting 235
    Send Sample to Peak 235
    Send Sample to Sampler 235
    Working with, Samplers 233
Smoothing Factor 198, 267
SMPTE 42, 47, 136
Snap To
    Custom Units 77, 252
    End 252
    Microsoft Xbox Loop Boundaries 77, 252
    Sony PS2 Loop Boundaries 77, 252
    Start 252
    To 252
    Unit 94
    Solo 214
    Songwriter 126, 139, 157
    Sonic AIFF 36, 38, 245

Index
Sony PS2 Loop Boundaries 77, 252
Sort columns in the Contents Window 44
Sound
   Design 190, 191, 219, 233, 263
   Designer II 36, 38, 63, 98, 113, 126, 191, 226, 244, 256
   Effects 200
   Manager 55, 63
   Out menu 56
Sound-on-Sound 193
SoundSoap 181, 208
SoundSoap Pro 181, 208
SoundTrack 105
Source Gain slider 191
Space
   Between markers 80
   Envelope 191
Speakers 68
Speed 82
Speeding up 184
Spike 197
Split
   Audio document 202
   Stereo Files 63, 257
   Sqweez 208
Stacking Windows 276
Staggered View Button 141
Start 234
   Time 68
Steinberg 207
Stereo 62
   Document 243
   Interleaved stereo files 46
   Mini-plug 69
   Receiver 68
   To Mono 192, 264
Stop 43, 255
   & Extend Selection 255
   Button 127
Strip Silence 200, 268
Stripper 202
Subcodes
   Copy Protection (CP) Flag 166
   Emphasis (Emp/PE) Flag 166
   ISRC 166
SUBCODES.DAT 172
Suffix 37, 226
SuperFreq 208
Swap Channels 202, 269
Synchronize
Playlist Events to Region Button 125
Playlist Events with Source Regions 124
Synthesizer 69
System 7 Sound 36, 38, 226, 245
System Preferences 56

T

Tab
   Key 80
   Delimited 50
Tape-Style Scrubbing 45, 58, 82
Tascam 55
Technical Support 24
Tempo 42, 48, 81, 105
   Calculator 103
   Guess 105, 255
Terminal 140
Text 95
Theme 47
Third-party audio hardware interface 55, 66, 68, 70
Threshold 202, 269
   Slider 201
Tiling Windows 275
Time
   Display 43, 127
   Format 42
   Shifting Window 185
   Stretching 182
   Units 47, 128, 136, 272
   Domain 76
Timeline 144
Timestamp 48
Title 157
Toggle Contents Drawer 83, 276
Toolbar 50, 275
   Adding new icons to 50
   Icon Size slider 51
Tools 145
Track
   Duration Column 154
   End Time Column 154
   Name button 67
   Name Column 154
   Number Column 153
   Number Display 127
   Start Offset Indicator 144
Start Offset Time Column 154
Start Offsets 152, 164
Start Time Column 154
Transient mode 182
Transitions 128
 Abrupt 46, 90, 106, 169
  Smooth 46, 90, 106, 192
Transparent cursor overlay 42
Transport 275
  Controls 60, 127
  Window 43
Transposition 184, 208
Triggering Playback of Multiple Audio Documents 60
Trim Event Cursor/ Tool 117, 145

V
Variable gain 190
Vbox 169, 210, 270
  Active Box 212, 214, 215
  Box Controls 212, 216
  Effects Pop-Up Menu 157
  Graphical User Interface 213
  Inactive box 212, 213
  Left-box input 215
  Matrix 212
  Menu 213
  Moving plug 214
  Parallel Effects Chains, creating in 215
  Preferences 216
Verify After Burn Checkbox 170
Vertical Lock Button 41
Vertical Scaling 76
Vertical Scroll Arrows 158
Vertical Scroll Buttons 213
Vertical Scrollbar 158
  View Controls 140
View L+R Channels Waveform Radio Button 141
View Left Channel Waveform Radio Button 141
View Right Channel Waveform Radio Button 141
Vinyl records (See also Clicks, LP, Pops) 88
Virtual instruments 55, 58
Virtual Studio Technology 207
Volume, Boosting 194
VST Plug-Ins 209
VU Meters 43

W
WAVE/.WAV 35, 38, 98, 226, 244
Waveform 76
  Display 40
  Display Area 142
    Detail of 142
Waveform View Area 116, 140
Waves 207
  Wet/Dry mix 191, 210, 213, 217
What Peak Installs 27
What’s New in Peak 5.0? 20
Window(s) 40
  Buffer 44, 45, 242
  Floating 242
Menu 274
Preferences 242
Working with SMDI Samplers 233
Write ISRC Codes Checkbox 171

X

XFade Block In 154
XFade Block Out 155
XFade Equal Power Blend 155
XFade Linear Blend 155, 156
XLR 69

Y

YAMAHA 233, 270
  A note about the A3000 236
  A3000 233
  A4000 233
  A5000 233
Year of Reference Code 156

Z

Zero crossing 77
Zero crossings 88, 252
Zoom 106
  At Sample Level 251
  At Sample Level (End) 251
  In 77, 251
  In Button 141
  Out 251
  Out All the Way 251
  Out Button 142
  To Sample Level 89, 198
  Tool 42
  Vertical 251